Preface

Preface ......................................................... i
  About This User’s Guide ............................... ii
  Finding the Latest Information .................... iv
  Assumptions .............................................. iv
  Do Not Use Database Tools to Modify Oracle Application Data ...................................... v
  Other Information Sources ............................ vi
  About Oracle .............................................. x
  Thank You .................................................. x

Chapter 1

Introduction ................................................. 1 – 1
Payroll Management and HRMS ............................. 1 – 2
  Separate v. Integrated HRMS Systems ................. 1 – 3
Oracle Payroll Overview .................................... 1 – 4
Oracle Payroll and Contractual Information ............... 1 – 8
Managing Change Over Time ............................... 1 – 11
  Dated Information and Hierarchy Versions .......... 1 – 12
  DateTrack ................................................. 1 – 13
  Setting Your Effective Date ............................ 1 – 13
  Viewing Datetracked Information and History ........ 1 – 15
  Updating and Correcting Datetracked Information ... 1 – 16
  Deleting Datetracked Information .................... 1 – 18
Work Structures and Key Flexfields ....................... 1 – 19
Chapter 2  

The Employer and Other Organizations  ................. 2 – 1 
Site Locations  ............................................. 2 – 2 
  Setting Up Site Locations  .................................. 2 – 3 
Representing Employers  .................................. 2 – 4 
  Single or Multiple Business Groups ................. 2 – 4 
  Defaults for the Business Group .................. 2 – 5 
Representing Organizations  .......................... 2 – 6 
  Levels of Internal Organizations .................. 2 – 6 
  Internal Organizations and Cost Centers .......... 2 – 7 
  External Organizations  ................................. 2 – 7 
Employer and Organization Setup ...................... 2 – 8 
  Accessing Business Groups ......................... 2 – 8 
Creating an Organization  ............................ 2 – 10 
  Additional Information for HR Organizations ...... 2 – 13 
Entering Business Group Information ................ 2 – 14 
Business Groups: Entering Budget Value Defaults .... 2 – 16 
Business Groups: Entering Sickness Control Rules .... 2 – 17 
Business Groups: Entering Tax Details ............. 2 – 18 
Business Groups and HR Organizations: Work Day 
  Defaults .................................................. 2 – 19 
HR Organizations: Entering Costing Information .... 2 – 20 
HR Organizations: Entering Parent Organizations .... 2 – 20 
Deleting an Organization  .............................. 2 – 22 
Organization Hierarchies  ............................ 2 – 23 
  Multiple Hierarchies .................................. 2 – 24 
  Organizational Change and Version Control ...... 2 – 25 
Creating Organization Hierarchies ................. 2 – 26 
Changing Organization Hierarchies ................ 2 – 28 
Deleting Organization Hierarchies .................. 2 – 28 
Organization Hierarchy Report ....................... 2 – 29 

Chapter 3  

Jobs and Positions  ..................................... 3 – 1 
Representing Jobs and Positions ....................... 3 – 2 
  Position Reporting Structures ....................... 3 – 3 
Deciding How to Use Organizations, Jobs, and Positions . 3 – 4 
Job and Position Names  ............................... 3 – 5 
  Adding Information About Jobs and Positions .... 3 – 6 
Defining Jobs ............................................. 3 – 8 
Defining Positions  ...................................... 3 – 10 
Evaluating Jobs and Positions ....................... 3 – 13
<table>
<thead>
<tr>
<th>Setting Up an Evaluation System</th>
<th>3 – 13</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entering Evaluation Information</td>
<td>3 – 14</td>
</tr>
<tr>
<td>Valid Grades</td>
<td>3 – 15</td>
</tr>
<tr>
<td>Entering Job and Position Requirements</td>
<td>3 – 16</td>
</tr>
<tr>
<td>Entering Work Choices for a Job or Position</td>
<td>3 – 17</td>
</tr>
<tr>
<td>Viewing Position Occupancy</td>
<td>3 – 20</td>
</tr>
<tr>
<td>Creating Position Hierarchies</td>
<td>3 – 22</td>
</tr>
<tr>
<td>Changing Position Hierarchies</td>
<td>3 – 24</td>
</tr>
<tr>
<td>Deleting Position Hierarchies</td>
<td>3 – 24</td>
</tr>
<tr>
<td>Position Hierarchy Report</td>
<td>3 – 25</td>
</tr>
<tr>
<td>Making Mass Updates</td>
<td>3 – 26</td>
</tr>
<tr>
<td>Preparing for Your Mass Move</td>
<td>3 – 27</td>
</tr>
<tr>
<td>Performing Mass Move Tasks</td>
<td>3 – 28</td>
</tr>
<tr>
<td>Describing Your Mass Move</td>
<td>3 – 28</td>
</tr>
<tr>
<td>Identifying Your Source Positions</td>
<td>3 – 29</td>
</tr>
<tr>
<td>Identifying Your Target Positions</td>
<td>3 – 31</td>
</tr>
<tr>
<td>Verifying Transferring Assignments for Each Source Position</td>
<td>3 – 32</td>
</tr>
<tr>
<td>Verifying or Adding Valid Grades for Each Target Position</td>
<td>3 – 34</td>
</tr>
<tr>
<td>Executing the Mass Move</td>
<td>3 – 35</td>
</tr>
<tr>
<td>Reviewing the Mass Move</td>
<td>3 – 35</td>
</tr>
<tr>
<td>Resolving Problems and Reexecuting a Mass Move</td>
<td>3 – 36</td>
</tr>
<tr>
<td>Managing Your Mass Move Collection</td>
<td>3 – 37</td>
</tr>
</tbody>
</table>

### Chapter 4

<table>
<thead>
<tr>
<th>Grades and Their Relationship to Pay</th>
<th>4 – 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Representing Grade Structures</td>
<td>4 – 2</td>
</tr>
<tr>
<td>Using Grades</td>
<td>4 – 3</td>
</tr>
<tr>
<td>Defining Grades</td>
<td>4 – 4</td>
</tr>
<tr>
<td>Deleting Grades</td>
<td>4 – 5</td>
</tr>
<tr>
<td>Grade Relationships to Compensation and Benefits</td>
<td>4 – 6</td>
</tr>
<tr>
<td>Relating Pay to Grades Directly: Using Grade Rates</td>
<td>4 – 8</td>
</tr>
<tr>
<td>Defining Grade Rates</td>
<td>4 – 9</td>
</tr>
<tr>
<td>Viewing Grade Comparisons</td>
<td>4 – 10</td>
</tr>
<tr>
<td>Relating Pay to Grades Indirectly: Using Pay Scales</td>
<td>4 – 12</td>
</tr>
<tr>
<td>Defining a Pay Scale</td>
<td>4 – 13</td>
</tr>
<tr>
<td>Defining Scale Rates</td>
<td>4 – 14</td>
</tr>
<tr>
<td>Relating Grades to Progression Points</td>
<td>4 – 15</td>
</tr>
<tr>
<td>Placing an Employee on a Grade Step</td>
<td>4 – 17</td>
</tr>
<tr>
<td>Incrementing Grade Step Placements</td>
<td>4 – 18</td>
</tr>
<tr>
<td>Current and Projected Progression Point Values Report</td>
<td>4 – 19</td>
</tr>
<tr>
<td>Employee Increment Results Report</td>
<td>4 – 19</td>
</tr>
</tbody>
</table>
Chapter 5  Payrolls and Other Employee Groups .......................... 5 – 1
   Representing Payrolls ............................................. 5 – 2
      Defining Payment Methods for the Enterprise .............. 5 – 3
      Defining a Payroll ............................................. 5 – 5
   Representing Other Employee Groups ......................... 5 – 10
      Setting Up the People Group Flexfield ...................... 5 – 10

Chapter 6  Controlling Costs ................................................. 6 – 1
   Costing in Oracle HRMS ........................................... 6 – 2
      Setting Up the Cost Allocation Key Flexfield .......... 6 – 3
      Setting up Earnings and Deductions for Cost Collection .. 6 – 4
      Setting Up Organizations for Cost Collection .......... 6 – 5
      Setting Up Assignments for Cost Collection ........... 6 – 5
      Mapping the Cost Allocation Flexfield to the GL Accounting Flexfield ................. 6 – 6

Chapter 7  Typical Models Based on Enterprise Culture ............... 7 – 1
   Project Based Enterprises ....................................... 7 – 2
   Rule Based Enterprises ......................................... 7 – 6
   Hybrid Enterprise Structures .................................. 7 – 10
   Contract Staff and Other Non-standard Assignments ....... 7 – 12

Chapter 8  Setup for Personal and Assignment Information ............ 8 – 1
   Person Types ....................................................... 8 – 2
      Defining Person Types ....................................... 8 – 3
      Person Types and Information Management ............... 8 – 4
   Assignment Statuses ............................................. 8 – 5
      Defining Assignment Statuses ............................... 8 – 7
      Setup To Allow Processing After Termination .......... 8 – 9
   Defining Special Information Types ......................... 8 – 10
      Enabling Special Information Types ....................... 8 – 11

Chapter 9  Personal Information ............................................ 9 – 1
   Displaying Personal Information ............................... 9 – 2
      Using the Find Person Window ............................... 9 – 3
      People Folders .................................................. 9 – 3
   Entering Personal Information ................................. 9 – 4
      Entering New People ........................................... 9 – 5
Contents

Element Qualifying Conditions .......................... 12 – 17
Costing Compensation and Benefits ....................... 12 – 19
Controlling Element Processing in Payroll Runs .......... 12 – 20

Setting Up Compensation and Benefits for Payroll Processing ........................................ 12 – 21
Defining an Element (Payroll Users) ....................... 12 – 22
Element Processing Option Examples ....................... 12 – 27
Defining an Element’s Input Values ......................... 12 – 28
Creating Balance Feeds for Individual Elements .......... 12 – 30
Creating Classes of Balance Feeds ......................... 12 – 31
Associating Processing Rules with Elements .............. 12 – 32
Defining Element Links ...................................... 12 – 35
Adjusting Input Values for an Eligibility Group .......... 12 – 37
Element Link Details Report ................................. 12 – 38
Customizing the Element Entries Window .................. 12 – 39
Tracking Compensation and Benefit Changes ............... 12 – 40
Entering Compensation and Benefits ....................... 12 – 42
Automatic or Manual Element Entry ....................... 12 – 43
Entering Elements ............................................. 12 – 44
Making Third Party Payments ............................... 12 – 47
MIX for Batch Entry ........................................... 12 – 50
Creating and Updating Batches of Element Entries .......... 12 – 51
Validating a BEE Batch ....................................... 12 – 56
Transferring a BEE Batch .................................... 12 – 56
Purging a Batch From the BEE Tables ..................... 12 – 57
Rolling Back a MIX Process .................................. 12 – 57
Inquiring on Compensation and Benefit Entries .......... 12 – 59
Listing Employees by Element ............................. 12 – 60
Viewing Element Entry History ........................... 12 – 61
Element Result Listing ....................................... 12 – 61

Chapter 13

Controlling Balance Information .......................... 13 – 1
Balances in Oracle Payroll ..................................... 13 – 2
Viewing and Creating Balance Feeds ....................... 13 – 2
Balance Dimensions .......................................... 13 – 5
Create Balance Dimension Process ....................... 13 – 7
Defining User Balances ....................................... 13 – 8
Making Balance Adjustments ................................ 13 – 11
Adjusting a Balance ........................................... 13 – 11
Uploading Initial Balances .................................... 13 – 13
Defining QuickPaint Reports 18 – 10
Running QuickPaint Reports 18 – 13
Creating an Assignment Set 18 – 15
Custom Reports 18 – 19

Chapter 19
Customizing Windows and Menus 19 – 1
Adding New Fields to Windows 19 – 2
Restricting the Data Displayed in a Window 19 – 3
  Types of Data Restrictions 19 – 5
  Defining an Element or Distribution Set 19 – 6
  Defining Customized Forms 19 – 8
Linking Windows in Task Flows 19 – 10
  Windows You Can Use in Task Flows 19 – 11
  Defining Task Flow Nodes 19 – 14
  Defining Task Flows 19 – 15
Setting Up Navigation Menus 19 – 18
  Setting Up Query–only Access to Forms 19 – 21
  Calling Customized Forms and Task Flows from Menus 19 – 22

Chapter 20
QuickCodes and User Tables 20 – 1
QuickCodes 20 – 2
  Adding QuickCode Values 20 – 3
  Removing QuickCode Values 20 – 4
Defining QuickCode Types 20 – 5
User and Extensible QuickCodes 20 – 6
User–defined Tables 20 – 9
  Setting Up User Tables 20 – 10
  Entering Table Values 20 – 13

Chapter 21
Integrating With Other Systems 21 – 1
Using Oracle Human Resources with Oracle Payroll 21 – 2
Using Oracle HRMS with Spreadsheets 21 – 5
Using Attachments 21 – 6

Chapter 22
System Administration 22 – 1
The Role of the System Administrator 22 – 2
Setting User Profile Options 22 – 4
Enabling Currencies 22 – 7
Chapter 23  Security and Control .......................... 23 – 1
  Security in Oracle HRMS ............................ 23 – 2
    Access Control through User Responsibilities 23 – 2
  Security Profiles .................................. 23 – 4
  Database Access Without Online Access ............ 23 – 8
  Menu Structures ................................... 23 – 8
  Security Groups .................................... 23 – 9
Setting Up Security in Oracle HRMS .................. 23 – 10
  Defining Security Profiles ......................... 23 – 13
  Running the HRMS Security Processes .............. 23 – 15

Chapter 24  AuditTrail ................................. 24 – 1
  AuditTrail ........................................ 24 – 2
    Setting Up AuditTrail ........................... 24 – 2
    Reporting on Audit Information ................. 24 – 4
    Designing Your Own Audit Report ............... 24 – 6

Appendix A  Default Menus .......................... A – 1
  Default Navigation Menus for Payroll Responsibility A – 2
  Default Navigation Menus for Payroll Responsibility A – 8
  Windows and their Navigation Paths A – 14

Appendix B  Key and Descriptive Flexfields ... B – 1
  User Definable Key Flexfields ............... B – 2
  User Definable Descriptive Flexfields ........ B – 5
    List of Descriptive Flexfields ............... B – 6
  Descriptive Flexfields with Startup Data ........ B – 9
    Changing Address Styles ....................... B – 9
  Protected Flexfields ........................... B – 10

Appendix C  Database Items ........................ C – 1
  Static Database Items ............................ C – 2
    Applicant Information ......................... C – 2
    Employee Assignment Information .......... C – 2
    Contact Addresses ............................ C – 7
    Contact Information ......................... C – 8
    Employee Hire Information ................. C – 10
    Location Details ............................. C – 10
Payroll Details .................................................. C – 12
People Addresses .............................................. C – 13
People Information ............................................. C – 15
Recruiter Information .......................................... C – 17
Supervisor Information ......................................... C – 18
Date Information ................................................ C – 18
Dynamic Database Items ..................................... C – 19
  Element Database Items .................................... C – 19
  Grade Rate Database Items ............................... C – 22
  Pay Scale Rate Database Items ......................... C – 22
  Descriptive Flexfield Database Items ...................... C – 23
  Key Flexfield Database Items ............................. C – 25
  Absence Database Items .................................. C – 26

Glossary

Index
Preface

Welcome to Release 11.0 of the Oracle Payroll UK User’s Guide.

This guide includes the information you need to set up Oracle Payroll to meet the requirements of your enterprise. It describes how you can represent your enterprise structures, policies and people on the system and use this information to manage your human resources. It contains detailed information about the following:

- Overview and reference information
- Oracle Payroll implementation suggestions
- Specific tasks you can accomplish using Oracle Payroll
- How to use Oracle Payroll forms and windows
- Oracle Payroll programs, reports, and listings
- Oracle Payroll functions and features

This preface explains how this user’s guide is organized and introduces other sources of information that can help you.
About This User’s Guide

The first part of this guide explains how you can set up Oracle Payroll to represent your enterprise structures and policies, and how you relate these to the people in your system.

- Chapter 1 describes the requirements of human resource and payroll management, and the processes they involve. This provides the context for the information model you can construct in Oracle HRMS.
- Chapters 2 through 5 explain how to represent your enterprise structures, including organizations, jobs and positions, grades, and payrolls.
- Chapter 6 explains how to set up the system to collect costing information during a payroll run.
- Chapter 7 describes three models appropriate to three different types of enterprise. It then covers the setup of each of these structures.
- Chapter 8 explains how to set up person types, assignment statuses and special information types.

Once you have set up this key information in the system, you can consider how to use Oracle Payroll to help you to administer employee compensation.

- Chapters 9 through 11 describe how you can enter people on the system, assign them to work structures, and hold various kinds of information about them. These chapters also explain how to manage information about employee absence.
- Chapter 12 introduces the way in which elements are used in payroll processing. It then describes how to define elements, control element processing priorities, and make employees eligible for the earnings and deductions that elements represent.
- Chapters 13 and 14 describe how to control balance information and how to administer employee salaries.
- Chapters 15 and 16 explain how to use Oracle Payroll to meet statutory requirements for deductions of Income Tax, National Insurance and attachment orders from employee earnings.

The next chapters explain how to use Oracle Payroll to process and control payroll information.

- Chapter 17 describes the processes associated with the payroll run. These include:
• Chapters 18 through 22 explain how you can customize the way information is entered and extracted from the system. This includes:
  – customizing inquiry windows and writing reports
  – customizing the user interface
  – adding your own fields to windows
  – setting up QuickCodes and user tables to add lists and tables of valid values to the system
  – integrating Oracle Payroll with Oracle Human Resources and using it with other software such as word processors and spreadsheets.

The final chapters of the guide focus on tasks for the system administrator and setup team.

• Chapter 22 describes the role of the system administrator.
• Chapter 23 explains how to maintain the security of your data.
• Chapter 24 explains how to set up an audit trail.

The Appendixes provide a reference source about the default menus, and about flexfields and database items in Oracle HRMS. Appendix C provides a template SQL*Plus script for use with standard letters.

This user’s guide is available online

All Oracle Applications user’s guides are available online, in both HTML and Adobe Acrobat format. Most other Oracle Applications documentation is available in Adobe Acrobat format.

The paper and online versions of this manual have identical content, and you can use whichever format is more convenient.

The HTML version of this book is optimized for on-screen reading, and lets you follow hypertext links for easy access to books across our entire library. You can also search for words and phrases if your national language is supported by Oracle’s Information Navigator. The HTML documentation is available from the Oracle Applications
toolbar, or from a URL provided by your system administrator. Note that the HTML documentation is translated into over twenty languages.

You can order an Oracle Applications Documentation Library CD containing Adobe Acrobat versions of each manual in the Oracle Applications documentation set. Using this CD, you can search for information, read it on-screen, and print individual pages, sections, or entire books. When you print from Adobe Acrobat, the resulting printouts look just like pages from an Oracle Applications hardcopy manual.

Finding the Latest Information

For information about any new features that were not available when this user’s guide was printed, look at the What’s New? section on the main Help menu. This information is updated for each new release of Oracle Payroll HTML Help.

Assumptions

This guide assumes you have a working knowledge of the following:

• the principles and customary practices of your business area
• Oracle Payroll
  If you have not yet used Oracle Payroll we suggest you attend one or more of the training classes for this product available through Oracle Education.
• the Oracle Applications graphical user interface.
  To learn more about this, read the Oracle Applications User’s Guide.

See Other Information Sources below for further details of Oracle Applications product information.
Do Not Use Database Tools to Modify Oracle Applications Data

Oracle provides powerful tools you can use to create, store, change, retrieve and maintain information in an Oracle database. But if you use Oracle tools like SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an Oracle Applications form can update many tables at once. But when you modify Oracle Applications data using anything other than Oracle Applications forms, you may change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications forms to modify your data, Oracle Applications automatically checks that your changes are valid. Oracle Applications also keeps track of who changes information. But, if you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.

Consequently, we STRONGLY RECOMMEND that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle Applications tables, unless we tell you to do so in our manuals.
Other Information Sources

You can choose from many sources of information, including documentation, training, and support services, to increase your knowledge and understanding of Oracle Payroll.

Most Oracle Applications documentation is available in Adobe Acrobat format on the Oracle Applications Documentation Library CD. We supply this CD with every software shipment.

If this guide refers you to other Oracle Applications documentation, use only the Release 11 versions of those books unless we specify otherwise.

Oracle Applications User's Guide

This guide explains how to navigate, enter data, query, run reports, and introduces other basic features of the graphical user interface (GUI) available with this release of Oracle Applications. It also includes information on setting user profiles, as well as running and reviewing reports and concurrent requests.

You can access this guide online by choosing “Getting Started with Oracle Applications” from any Oracle Applications help file.

Related User’s Guides

Oracle Payroll shares business and setup information with other Oracle Applications products. Even if you have not installed them as separate products, your Oracle Payroll application includes some forms and functionality from other Oracle Applications. Therefore, you may want to refer to other user’s guides when you set up and use Oracle Payroll.

If you do not have the hardcopy versions of these manuals, you can read them by choosing Library from the Help menu, or by reading from the Oracle Applications Document Library CD, or by using a web browser with a URL that your system administrator provides.

Oracle Human Resources User’s Guide

This guide is aimed at HR managers and explains how to set up and use Oracle Human Resources to meet the requirements of your enterprise. It describes how you can represent your enterprise structures, policies, and people on the system and use this information to manage your human resources.
Oracle Training Administration User’s Guide
This guide explains how you can use OTA with Oracle HR to support each part of your enterprise’s training cycle.

Application Data Export User’s Guide
This guide is aimed at end-users, system administrators and consultants. It describes how you can use ADE to export data from Oracle Payroll into either a spreadsheet or mail merge application. It also contains information on how to install ADE.

Oracle HRMS Implementation Guide
This guide includes modular implementation flowcharts and checklists to assist with your project planning. It contains a summary of the sequence of recommended steps for implementing Oracle Payroll and Oracle Payroll. Full instructions for each implementation step are contained in the User’s Guide.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup, and reference information for your implementation team, as well as for users responsible for the ongoing maintenance of Oracle Applications product data. This guide also provides information on creating custom reports on flexfields data.

Oracle Workflow Guide
This manual explains how to define new workflow business processes as well as customize existing Oracle Applications–embedded workflow processes. You also use this guide to complete the setup steps necessary for any Oracle Applications product that includes workflow–enabled processes.

Oracle Alert User’s Guide
Use this manual to define periodic and event alerts that monitor the status of your Oracle Applications data.

Country–Specific Manuals
Use these manuals to meet statutory requirements and common business practices in your country or region. They also describe
additional features added to Oracle Payroll to meet those requirements. Look for a User’s Guide appropriate to your country. For example, Oracle user’s guides for Japanese users exist in the Japanese language.

**Oracle Applications Implementation Wizard User’s Guide**
If you are implementing more than one Oracle product, you can use the Oracle Applications Implementation Wizard to coordinate your setup activities. This guide describes how to use the wizard.

**Oracle Applications Developer’s Guide**
This guide contains the coding standards followed by the Oracle Applications development staff. It describes the Oracle Application Object Library components needed to implement the Oracle Applications user interface described in the *Oracle Applications User Interface Standards*. It also provides information to help you build your custom Developer/2000 forms so that they integrate with Oracle Applications.

**Oracle Applications User Interface Standards**
This manual contains the user interface (UI) standards followed by the Oracle Applications development staff. It describes the UI for the Oracle Applications products and how to apply this UI to the design of an application built by using Oracle Forms 4.5.

**Installation and System Administration**

**Oracle Applications Installation Manual**
This manual and the accompanying release notes provide information you need to successfully install Oracle Financials, Oracle Public Sector Financials, Oracle Manufacturing, or Oracle Human Resources in your specific hardware and operating system software environment.

**Oracle Applications Upgrade Manual**
This manual explains how to prepare your Oracle Applications products for an upgrade. It also contains information on finishing the upgrade procedure for each product. Refer to this manual and the *Oracle Applications Installation Manual* when you plan to upgrade your products.
Oracle Applications System Administrator’s Guide

This manual provides planning and reference information for the Oracle Applications System Administrator. It contains information on how to define security, customize menus and online help, and manage processing.


This manual contains database diagrams and a description of Oracle HRMS database tables, forms, reports, and programs. This information helps you convert data from your existing applications, integrate Oracle HRMS with other non-Oracle applications, and write custom reports.

You can order a technical reference manual for any product you have licensed. Technical reference manuals are available in paper format only.

Other Information

Training

Oracle Education offers a complete set of training courses to help you and your staff master Oracle Applications. We can help you develop a training plan that provides thorough training for both your project team and your end users. We will work with you to organize courses appropriate to your job or area of responsibility.

Training professionals can show you how to plan your training throughout the implementation process so that the right amount of information is delivered to key people when they need it the most. You can attend courses at any one of our many Educational Centers, or you can arrange for our trainers to teach at your facility. In addition, we can tailor standard courses or develop custom courses to meet your needs.

Support

From on-site support to central support, our team of experienced professionals provides the help and information you need to keep Payables working for you. This team includes your Technical Representative, Account Manager, and Oracle’s large staff of consultants and support specialists with expertise in your business area, managing an Oracle server, and your hardware and software environment.
About Oracle

Oracle develops and markets an integrated line of software products for database management, applications development, decision support, and office automation, as well as a complete family of financial, manufacturing, and human resource applications.

Oracle products are available for mainframes, minicomputers, personal computers, network computers, and personal digital assistants, allowing organizations to integrate different computers, different operating systems, different networks, and even different database management systems, into a single, unified computing and information resource.

Oracle offers its products, along with related consulting, education, and support services, in over 140 countries around the world. Oracle Corporation is the world’s leading supplier of software for information management, and is the world’s second largest software company.

Thank You

Thank you for using Oracle Payroll and this user’s guide.

We value your comments and feedback. At the end of this manual is a Reader’s Comment Form you can use to explain what you like or dislike about Payables or this user’s guide. Mail your comments to the following address or call us directly at (650) 506–7000.

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Or, send electronic mail to appsdoc@us.oracle.com.
This chapter introduces Oracle HRMS and shows how it meets the business needs of human resource and payroll management. It also provides an introduction to key components and special features of the system.
Payroll Management and HRMS

Oracle Human Resource Management Systems is the family name for an integrated group of applications that comprehensively support the management of people in the work place.

With Oracle HRMS you define your own human resource model to reflect enterprise structures and policies. This information model lets you record the personal, work, and pay information for all the people you want to hold and process.

The model is both flexible and adaptable. It is flexible, so that you can reflect the needs of different companies, or different groups within the same company. It is adaptable, so that you can easily change the basic model as your enterprise changes.

See: Typical Models Based on Enterprise Culture: page 7 – 1
Separate v. Integrated HRMS Systems

Traditionally, Human Resources and Payroll groups have both been responsible for holding and managing human resource information – often in separate systems.

There is growing acknowledgement of the importance of complete, accurate, and timely information about the people within an enterprise. This has led to a greater demand for information derived from both Human Resources and Payroll sources.

Historically this was achieved by the development of interface products, which allowed technical specialists to transfer data between the two systems.

Many systems attempt to simplify the transfer of data between two systems. Oracle HRMS is one of the first to provide a truly integrated system, which both functions can genuinely share. At the same time, it is flexible enough to be implemented for use in a human resources only or a payroll only environment. In each case you have access to the full range of functionality associated with human resources or payroll.
Oracle Payroll Overview

Oracle Payroll is a major component of HRMS, enabling payroll departments to pay employees and carry out other aspects of payroll management. These include:

- transferring payroll information to the general ledger, and to other accounting systems, including project costing systems
- reporting on payroll results to tax offices and company executives
- maintaining full security and integrity of payroll information, including historical information
- enabling access to information when required for inquiries and responses to pay queries

Oracle Payroll’s integrated solution to managing payroll information and processing operates through the following information areas:

Work Structures

Work structures represent the organizational units of your enterprise, and there is one integrated set of work structures for Human Resources and Payroll users. The Business Group is the largest unit and represents your enterprise as a whole. Other structures include internal organizations such as departments or divisions, payrolls, jobs or positions, grading structures, and any special employee groupings you need to use.

The system of work structures enables you to manage information about your enterprise that is independent of your employees. Employees relate to this system through employee assignments.

See:
- Representing Employers: page 2 – 4
- Representing Organizations: page 2 – 6
- Representing Jobs and Positions: page 3 – 2
- Representing Grade Structures: page 4 – 2
- Representing Payrolls: page 5 – 2
- Representing Other Employee Groups: page 5 – 10

Employees and Assignments

Employee information includes personal information, employment information and assignment information. Employee assignments relate
employees to the work structures of the enterprise. They also control and validate element links and entries, and are themselves processed in payroll runs.

As with work structure information, the Oracle HRMS database holds one integrated set of employee-related information. Payroll users access the parts of this information they require, while enterprise business rules determine who is responsible for entering and maintaining it.

See:
Entering Personal Information: page 9 – 4
Entering Special Information: page 9 – 25
The Employee Assignment: page 11 – 4

Earnings, Deductions and Benefits

Oracle HRMS represents all earnings, deductions and benefits types by elements. These are structured information units that enable the system to identify, classify and process all payroll information for employee assignments. Elements can be associated with formulas to control processing and frequency rules and to calculate pay values. Users define the elements they require to reflect enterprise business rules and categories. In addition, Oracle Payroll comes with predefined elements for PAYE, NI, Court Orders and Car Benefit, together with their associated statutory balances and balance feeds.

See:
Introducing Elements: page 12 – 2
Salary Administration and Performance Reviews: page 14 – 2

Payroll Processing

The payroll run is the main engine of payroll processing. Oracle Payroll gives you full control to define payrolls, assign employees to them and control the frequency of payroll runs.

Run preparation can involve batch entry of data, such as timecard data. Oracle Payroll uses the MIX facility to enter batches of information that are held as element entries.

See:
MIX For Batch Entry: page 12 – 9
The Payroll Run: page 17 – 2
Transfer of Payroll Information

When the payroll run finishes, further processing determines the distribution of each employee’s net pay, produces cheques or BACS tapes as required, and assembles costing information for transfer to other systems. Costing processes and other post-run processes sort the information by different accounts and work structures, and transfer post-run costing data to the general ledger and other systems.

See:

Post–Run Processes: page 17 – 17
Costing in Oracle HRMS: page 6 – 2

Reports and Inquiries

To review the results of payroll processing, Oracle Payroll provides you with a range of standard reports and inquiry tools. The latter include folders, QuickPaint and DateTrack.

Standard reports enable you to see an employee’s assignment history and pay history, and to see lists of employees belonging to particular organizations or receiving particular earnings or deductions.

Folders are customizable, online views on which you can query employees or assignments and see other, related information. You can choose which fields of information are displayed, their labels, size, and the order in which they appear. You can save your folder definition for future use to recreate your information dynamically when required.

QuickPaint is a database query tool that retrieves information you want from the HRMS database, and then ‘paints’ reports with it about employees and assignments.

DateTrack enables you to view and report on information as it was on dates in the past, or as it is scheduled to be on dates in the future. You can also make past-dated or future-dated changes to datetracked information.

See:

Overview of Inquiry and Reporting Tools: page 18 – 2
Managing Change Over Time: page 1 – 11

Security of Payroll Information

Security is a major concern of all payroll and human resource departments. Oracle HRMS includes a planned system for keeping
information secure and preventing unauthorized access. The system enables you to control access to records, windows and functions by matching each employee’s access level to his or her work responsibilities.

See: Security in Oracle HRMS: page 23 – 2
Oracle Payroll and Contractual Information

It is at Business Group level that you set up the legislative rules and terms of employment rules necessary for paying employees and regulating their work. By default, all employees you enter in Oracle Payroll receive an assignment to their Business Group. When you give them assignments to internal organizations such as departments or divisions, these replace the default assignment, but their records continue to exist within the Business Group.

In the Person window and the Assignment window you enter employee information covering personal details, contract details and assignment details. You can enter information relating to a number of different person types including employees, ex–employees, applicants for employment, next of kin, contacts and other people.

See: Entering Personal Information: page 9 – 5

Employee Assignment Information

When you have entered the employee’s personal information onto the database, you need to enter his or her contract of employment details. In Oracle HRMS these details form part of the employee assignment. You set up the business rules relating to your enterprise’s terms and conditions of employment at Business Group level, and you enter assignment details in the Assignment window.

<table>
<thead>
<tr>
<th>Oracle HRMS Information Category</th>
<th>Contract of Employment Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job</td>
<td>Job Title</td>
</tr>
<tr>
<td>Organization and Location</td>
<td>Place of Work</td>
</tr>
<tr>
<td>Position</td>
<td>Job Description</td>
</tr>
<tr>
<td>Grade</td>
<td>Rate of Pay</td>
</tr>
<tr>
<td>Payroll</td>
<td>Payment frequency</td>
</tr>
<tr>
<td>Group and Employment Category</td>
<td>Terms and Conditions</td>
</tr>
<tr>
<td>Working Hours</td>
<td>Hours of Work</td>
</tr>
</tbody>
</table>

Table 1 – 1 Contract of Employment Categories in Oracle HRMS

See: The Employee Assignment: page 11 – 4
Multiple Assignments

For some Business Groups employees may have more than one concurrent assignment. In such cases you need to designate one assignment as being the primary assignment. You may want to use additional assignments to track additional responsibilities occasionally, with payments and deductions relating only to the primary assignment. In this case you can adjust labor costs for work done.

Time and Attendance

Specifying the hours of work is a contract of employment requirement. Payment for these hours may be automatic or based on the actual hours worked. At set up it is possible to enter the default working hours at one or more of the following levels:

- Business Group
- Organization
- Position
- Assignment

Assignment Statuses

The employee’s assignment status controls how this assignment information is to be used during a payroll run. To be included in the payroll run, an employee must have current assignment which includes an assignment to a payroll, and a payroll assignment status of Process.

See: Assignment Statuses: page 8 – 5

Paid Time Off

The contract of employment will state the entitlements to paid time off such as holiday pay, sickness and maternity leave pay. These may be the statutory entitlements only or the entitlements according to the business rules.

You can define these entitlements as absence types, which in turn can be linked to elements with simple reducing balances. At the start of the accounting year, for each absence type the entitlement may be entered. Then each time you enter an absence of a particular type this balance will reduce.

If your enterprise has more complex rules for paid time off entitlement, you can define formulas to calculate the entitlement in the first instance, and to calculate the payment as well if necessary.

For information about absence management, see Setting Up an Absence Recording System, Oracle Human Resources UK User’s Guide.
See Also

See: Absence Management Setup Steps: page 10 – 8

Termination

Your business rules determine the calculation of final pay for employees whose contract of employment terminates. You need to enter the following information into the system:

- the end of contract date
- the date you want the last normal payroll run to take place
- the date you expect the final payroll run to take place, if you expect this to be different from the last normal payment date

The payroll run checks the Last Standard Process date for inclusion for normal processing, and the Final Process date for the inclusion of late payments. If the employee is deceased you must enter that as the reason for termination so that the P45 will record it.

See: Ending an Assignment: page 11 – 13

Employee Payment Method and Frequency

Payment method and payment frequency are required information for the contract of employment. In addition, most employers agree with their employees the normal payment date within each pay period. For example, this could be the last Thursday in the month for a calendar monthly payroll, and every Thursday for a weekly payroll.

See: Defining Payment Methods for the Enterprise: page 5 – 3
Managing Change Over Time

A key requirement for any enterprise is the ability to manage change confidently and effectively. Typical enterprise changes include corporate restructuring, departmental reorganization, mergers and de-mergers of companies, centralization or decentralization of control and decision making, employee development and turnover.

In Oracle HRMS, you can change each of the major parts of your enterprise model without having to redefine the other parts.

Work Structures

You can attach dates to your work structures to manage different versions over time. You retain previous versions for historical information and you can create future-dated versions to prepare for reorganization in advance.

You can also set up in advance the business rules, including compensation and benefits, associated with the new structures. These become effective on the date you specify, avoiding a workload peak.

People, Assignments, and Compensation and Benefits

In contrast to work structures, which are simply dated, other key dynamic information in Oracle HRMS is datetracked. This includes information on employees, assignments, and compensation and benefits. DateTrack allows you to maintain a continuous history of the information over time.

When reviewing, entering, changing or deleting datetracked data, you can set an effective date in the past or future. The system uses only information in effect as of that date for whatever you do. When you make a change, you can choose whether it is a correction to the last update or a new update to be recorded in the history of the record. You can use DateTrack History to view a report of every update ever made to a record.

You can identify windows containing datetracked, rather than dated, information by the presence of a region labelled Effective Dates.
Dated Information and Hierarchy Versions

The information in Oracle HRMS about your locations, organizations, jobs, positions, grades, payrolls and other work structures is dated information. All dated information has From and To dates, that is, dates from and to which it is in effect in your enterprise. For example, when defining a position, you enter a date from which it starts. To close it down, you give it a date to which it remains valid.

Oracle HRMS does not permit you to assign employees to structures on dates earlier than their Date From, or later than their Date To. Similarly, the system protects you from building eligibility rules for compensation and benefits based on work structures that have not yet gone into effect, or are out of date.

Suggestion: Consider using a fixed date, such as 01–JAN–1901 as the start date for all your initial work structures. By choosing a date like this you can immediately identify all of your implementation definitions. You should use accurate dates for all subsequent definitions.

Dated Versions of Hierarchies

You can structure the organizations and positions you enter in Oracle HRMS into organization or position hierarchies that serve various purposes. Reporting hierarchies, for example, reflect reporting lines within your enterprise.

You maintain both dates and version numbers for these hierarchies, to keep a history of your hierarchies as they change over time.

To build a new version of a hierarchy, you can copy an existing one and make the necessary changes to it. When you save the new version the system automatically gives the previous version an end date.
DateTrack

All important dynamic information in Oracle HRMS is datetracked, including information about people, assignments, payrolls, and compensation and benefits.

You can enter datetracked information or make changes to it at any time. When you set an effective date for your work, DateTrack ensures that only information effective on that day is used for any processing, validation, and reporting you carry out. You can view a history of every change made to datetracked information.

Setting Your Effective Date

When you log on to Oracle HRMS, your effective date is always today’s date. To view information current at another date, or to make retrospective or future-dated changes, you need to change your effective date.

There is a DateTrack:Date Security user profile option, which determines whether you can change your effective date. Your system administrator sets this profile option. You can check its value on the Personal Profile Values window. There are four possible values:

- **All**: You can change to any other effective date.
- **Future**: You can change between today’s date and any future dates.
- **Past**: You can change between today’s date and any past dates.
- **Present**: You cannot change to a date other than today.

To set your effective date:

1. Save any outstanding information you have entered or changed, then choose the Alter Effective Date icon from the Toolbar.
The Alter Effective Date window opens.

2. Enter a new effective date and choose OK.

If your current window is a “top–level” window (one called directly from the Navigator), your new effective date remains in place until you reset it or exit Oracle HRMS. If your current window is not a top–level window, your new effective date only applies while you are working in the current window and any windows subsidiary to it. When you return to a top–level window, your effective date is reset to its previous value.

**Note:** In certain special cases, when you change your effective date on a subsidiary window, Oracle HRMS returns you to the previous window, and you may have to requery the records you want to view or update. This protects the integrity of these records.

So long as your effective date remains different from today’s date, it is displayed in the title bar of every window.

**Effective Date Reminder**

When you are new to DateTrack, you may find it useful to be reminded of your effective date whenever you open a window that contains datetracked information. The reminder appears in a Decision window and asks whether you want to change your effective date. If you choose Yes, the Alter Effective Date window displays.

There is a user profile option called **DateTrack:Reminder** that determines when the Decision window appears. There are three possible values for this profile option:

- Always
- Never
- Not Today

The Not Today value causes the reminder to appear when you navigate to a datetracked window and your effective date is not today’s date.

You can set the value of this profile option in the Personal Profile Values window.
Viewing Datetracked Information and History

Oracle HRMS maintains a continuous record of changes made to datetracked information. When you view a record in a datetracked window, it shows you a snapshot of the information on your effective date. The Effective Dates region on the datetracked window shows you the dates between which the snapshot is valid.

Suppose you are viewing an assignment with an effective start date of 01–JAN–1987 and no effective end date. This means that the assignment was created or last changed on 1 January 1987, and the snapshot information you are viewing is still valid. There have been no changes to the assignment since 1 January 1987, and there are no future dated changes.

To find out whether the assignment existed before 1 January 1987, you should use DateTrack History.

If there is an effective end date, you know that the record was either deleted or changed on the next day. To find out whether the record continues to exist, you can set your effective date to the day after this end date, or use DateTrack History.

Viewing the History of Datetracked Information

To see all the changes made to a datetracked record over time, use DateTrack History.

To view DateTrack History:

1. Choose the DateTrack History icon from the Toolbar.
   The DateTrack History Change Field Summary window opens. Each row shows which fields were changed on the From date.
2. Choose the Full History button if you want to open a DateTrack History folder showing the value of each field between the effective
dates. The row for the current snapshot (corresponding to your effective date) is highlighted.

You can use the Folder menu to select the fields to view in the folder.

**Note:** It is possible to customize the information displayed in the Folder by modifying the DateTrack History view for the underlying table.

See: How To Create and Modify DateTrack History Views, *(Oracle HRMS Implementation Guide)*

### Updating and Correcting Datetracked Information

When you update datetracked information, you are prompted to choose between Update and Correction.

If you choose Update, Oracle HRMS changes the record as from your effective date, but preserves the previous information. If you choose Correction, Oracle HRMS overrides the previous information with your new changes. The start and end dates of the snapshot you have corrected remain the same.

**Example**

Suppose you hire two new employees, Jack Lee and Julie Summers. A few weeks later Julie gets married. At the same time you discover an error in Jack’s record relating to his nationality.

You *update* Julie’s information by setting your effective date to the date of her wedding and entering her new married status, her change of name, and new next of kin information. Her previous personal information, which was valid until her wedding, remains in her record.

You *correct* Jack’s wrong nationality by setting your effective date to his hire date and entering the correct nationality. By choosing Correction,
you put the record right, from the beginning. You should check whether there is an end date in the Effective Dates region of Jack’s record. If there is, you have only corrected the first snapshot of the record. Set your effective date to the day after the end date, and make the correction again. Continue in this way until the To field is blank, indicating that you have reached the last snapshot of this record.

**Updating a New Record**

You cannot create a record and then update it on the same day. If you try to do this, Oracle HRMS warns you that the old record will be overridden, and then changes Update to Correction. This is because DateTrack maintains records for a minimum of a day at a time.

**Future Updates**

Using DateTrack, you can make future updates. For example, suppose you are relocating an employee, with six months notice. You decide to enter the relocation on the system straight away. So you set your effective date to the first day when the employee will be at the new location, and change the location on the assignment.

Later that month you promote the employee to a new grade. So you set your effective date to today’s date and change the grade on the assignment. Oracle HRMS checks to see whether the record has a future update scheduled. It finds that the location changes in the future and prompts you for the type of update you now want to make. You have two choices:

- **Insert:** This simply inserts the change before the next scheduled change. This is the correct choice for the example. The employee would be promoted from today. The future-dated relocation still takes place in six months time.

- **Replace:** This change replaces all future-dated changes. In the example, the employee would be promoted from today. However, the record of the relocation would be completely removed from the system.
Deleting Datetracked Information

When you delete datetracked information, Oracle HRMS prompts you with the following options:

- **End Date**: This ends the record on your effective date. When you requery the record, this end date displays in the To field.
- **Purge**: This totally removes the record from your database.

If there are any future updates to the record after your effective date, Oracle HRMS may prompt you with another two options:

- **All**: This removes all future updates to the record. The current snapshot is valid until you make another change.
- **Next**: This removes the next future update to the record. It then resets the current snapshot’s end date to the end date of the deleted update.

**Note**: You do not always see all of these options when you choose to delete. Some windows do not allow all four operations.

Removing an End Date

If you have mistakenly set an end date on a datetracked record, you can remove it.

► To remove an end date:

1. Set your effective date to the day the record ends.
2. Choose Delete Record from the Edit menu.
3. Choose the DateTrack delete option Next. This removes the next change to the record, which is the end date. Save your work.
Work Structures and Key Flexfields

Before you begin defining your enterprise’s work structures, you set up some key flexfields.

*Key flexfields* are a special feature of Oracle Applications. They help you customize applications, by holding particular information your enterprise needs where you need it. A key flexfield can hold as many as 30 separate segments of information. You can determine exactly what information to hold and how it must be entered.

Oracle HRMS includes six user-definable key flexfields. These are especially useful in helping you build information on work structures that suit the mission and culture of your enterprise.

**Job and Position Name**

Using these key flexfields, you determine the number of segments in your job and position names or codes, and the valid values for each segment.

For example, you may want names that are simple titles using one flexfield segment only, such as Account Manager or Programmer. Or, you may want multiple-segment names that convey more information, such as Senior.Account Manager or Part-time.Trainee.Programmer.

See: Representing Jobs and Positions: page 3 – 2

**Personal Analysis**

The Personal Analysis key flexfield is for holding information about:

- the various requirements for your jobs and positions, such as educational attainment, certification or license types and levels, or language skills
- the educational levels, qualifications, skills and other personal attributes of your employees or applicants, which match your job or position requirements
- a wide range of other types of information you need to keep on record for your workforce, for example, company car usage, workplace accidents, and immunizations for communicable diseases.

You can define up to 30 instances of the Personal Analysis flexfield structure, each holding one special information type.

Defining Special Information Types
*(Oracle Human Resources UK User’s Guide)*
Grade Name

You may want to use simple, single-segment grade names (A, B, C), or more complex grade names (Manual.A.1, Manual.A.2, Clerical.C.1, Clerical.C.2).

See: Representing Grade Structures: page 4 – 2

People Group

The People Group key flexfield is for setting up special groupings of employees. For example, you can set up a segment of this flexfield to hold all the unions present at your enterprise. When you give an employee an assignment, you can use this segment to record his or her union membership.

See: Representing Other Employee Groups: page 5 – 10

Cost Allocation

The Cost Allocation key flexfield is for maintaining data needed to transfer information on employee costs from your payrolls to the general ledger, and to labor distribution systems.

For example, you might define one segment of the Cost Allocation flexfield to hold a list of your cost centers, another to hold GL account codes, and a third to hold labor distribution codes.

You would then make choices from these lists to tell the system how to collect payroll costs. For example, when you enter a department into Oracle HRMS, you could select the cost center against which to collect the employee costs of the department.

If you are using Oracle General Ledger, you can map segments of the Cost Allocation flexfield to segments of the GL Accounting flexfield.

See: Costing in Oracle HRMS: page 6 – 2

See Also

Oracle Applications Flexfields Guide
This chapter explains how to represent your enterprise in Oracle HRMS, and how to set up default information applicable across the enterprise.

It further explains how to represent:

- the physical work locations of your employees
- organizations internal to your enterprise, such as companies, departments, divisions, or units
- external organizations of importance to human resource management, such as recruitment agencies, insurance providers and tax authorities
- reporting lines and other relationships among these organizations. You represent these relationships by building organization hierarchies.
Site Locations

In Oracle HRMS, you set up each physical site where your employees work as a separate location. Similarly, you enter the addresses of external organizations that you want to maintain in your system, such as employment agencies, tax authorities, and insurance or benefits carriers. When setting up internal or external organizations, you pick from a list of these locations.

This approach has these advantages:

- You enter information about each location only once, thereby saving data entry time.
- Central maintenance of locations ensures consistency of address standards.
- Your work sites exist as separate structures identifiable for reporting purposes, and for use in the rules that determine employee eligibility for various types of compensation and benefits.
Setting Up Site Locations

Enter site addresses in the Location window. Locations are shared across Business Groups in Oracle HRMS and with two other Oracle applications: Inventory and Purchasing. Oracle HRMS does not use some of the fields in the Location window. These fields are disabled for HRMS users.

To enter a work location and its address:
1. Enter the name of the location, and a description if required.
2. Select a national address style from the list. A window opens with the address format for the country you select.
3. Enter address information in this window and choose the OK button.

Additional Information: Default address styles are predefined for many countries. You can add address styles for other countries, if required.

Removing Site Locations

You cannot delete locations, but you can make them inactive.

To remove an address from the Location list:
- Enter an inactive date from which the location is no longer in use in your enterprise.
Representing Employers

The largest organizational unit you set up in Oracle HRMS to represent your enterprise as an employer is the *Business Group*. A Business Group may correspond to a company or corporation, or in large enterprises, to a holding or parent company or corporation.

It can be an organization with a physical location where people work, or it may simply be an abstract representative of a legal entity that employs people assigned to work in organizations beneath it.

By default, all employees you enter in Oracle HRMS receive an assignment to their Business Group. When you give them assignments to internal organizations such as divisions or departments, these replace the default assignment, but their records continue to exist within the Business Group.

Single or Multiple Business Groups

A Business Group holds a complete, self-contained set of information on work structures, remuneration policies and employees.

Each Business Group can have just one particular set of segments defined for its Job, Position, Grade, Employee Group and Cost Allocation key flexfields. You set up the key flexfields for a Business Group before setting up the Business Group itself.

Many enterprises decide to use a single Business Group to hold ‘live’ information, so they can display, report and manage information from all parts of the enterprise at the same time.

*Note:* You cannot view information online for more than one Business Group at a time.

However, there are reasons for setting up multiple Business Groups in the same installation, such as the following:

- You want to have a copy of your live system with example records for training or testing purposes.
- You are a holding company or a corporation with a number of subsidiary companies. Each subsidiary has its own structures, employees, and compensation and benefit policies. If your subsidiaries are in different countries you also have to deal with local legislative requirements.
- You are acquiring a company or merging with another company, and you want to maintain separate structures and compensation and benefits during the transition process.
The Startup Business Group

Oracle HRMS comes with one Business Group supplied as startup data. You can use this Business Group and its default definitions as the starting point for your own Business Group, or you can create a new Business Group.

If you create a new Business Group, you must create a new responsibility (or edit the default responsibility) to allow access to it, before beginning to create other work structures.

See Also

Accessing Business Groups: page 2 – 8

Defaults for the Business Group

You can enter certain types of information for the Business Group to appear as defaults throughout your enterprise structures:

- You can select a default currency.
- You can enter a default for the value each assignment contributes towards each staffing budget that you define. For example, by default an assignment may count as one for a headcount budget.
- You can enter default working hours for all the employees in the Business Group. You can override these defaults at organization, position, and assignment levels.

When defining a Business Group, you choose a method of creating identifying numbers for its employees and applicants. The choices are:

- automatic number generation
- manual entry
- for employees only, automatic use of a national identifier, such as the US social security number or the UK National Insurance number.

Note: Once you save an automatic number generation method, you can later change only to manual entry.
Representing Organizations

In Oracle HRMS, you represent your enterprise as an employer by means of the Business Group.

Below this level, you represent the groupings in which employees work, such as branches, departments or sections, by means of internal organizations. To enable the assignment of employees to an internal organization, you classify it as an HR Organization.

You also maintain information in the system about various types of external organizations relevant to human resources and payroll management and administration. You can never assign employees to external organizations, even those classified as HR Organizations.

Organization Types

When setting up an organization you can give it an organization type. The type may, for example, identify the function an organization performs, such as Administration or Service, or the level of each organization in your enterprise, such as Division, Department or Cost Center.

You create the organization types you require by entering values for the QuickCode Type ORG_TYPE.

Levels of Internal Organizations

You decide for yourself the level of organization detail your enterprise needs in Oracle HRMS.

At one extreme, a Business Group can be the only organization defined in the system. However this will severely limit your ability to manage and report on employee assignment and payroll information, and to control access to HRMS records. At the other extreme, you can define an organization for every grouping of employees, however small. But the costs of maintaining organizations at this level will probably outweigh the benefits.

When thinking about the internal organizations to set up for your enterprise in Oracle HRMS, consider what your current managerial groupings are. Then you can adjust up or down to determine the best level or organizational detail for your enterprise to maintain.

See Also

Organization Hierarchies: page 2 – 23
Internal Organizations and Cost Centers

Depending on the structure of your enterprise and your decisions about which organizations to represent in Oracle HRMS, there may not be a one-to-one correspondence between your cost centers and the organizations you enter.

When defining an internal organization, you can identify one cost center against which the payroll costs of the employees assigned to the organization should be collected. You simply select the cost center from a list in a segment of the Cost Allocation key flexfield.

For example, suppose you are defining in Oracle HRMS the organization Product Assembly, whose employee payroll costs go to the cost center Production. When entering the organization Product Assembly, you select Production from the list of cost centers in the Cost Allocation flexfield:

Cost Allocation Key Flexfield

*Segment 1: Cost Center*

- 410–Accounting
- 425–Production
- 503–Public Relations

**Note:** If employees’ costs are charged to cost centers other than those of their organizations, or if they work in an organization only part time, you can enter other cost centers, and the percentage of time to be charged to each, on their *employee assignments*. Costing information entered for employee assignments overrides that entered for organizations.

See Also

Setting Up the Cost Allocation Key Flexfield: page 6 – 3

External Organizations

Oracle HRMS can hold basic information on organizations not part of your own enterprise, such as training vendors, tax offices, benefits carriers or certification bodies.

You define *external* organizations in the same way as internal organizations. External organizations can appear in your organization hierarchies together with internal organizations.

**Attention:** The main difference in the system between internal and external organizations is that you cannot assign people to an external organization.
Employer and Organization Setup

Use the Organization window to set up:

- Business Groups
- internal organizations
- external organizations

The information you enter depends on the nature of the organization.

You must create a Business Group and a responsibility to allow access to it, before you create other organizations.

Accessing Business Groups

You access the startup Business Group using the default ‘Oracle Human Resources’ responsibility. A responsibility is linked to a security profile, which determines which records you can see. The default Oracle HRMS responsibilities allow you to see all the records for the startup Business Group.

You can adapt the startup Business Group or create a new one for your enterprise.

If you are creating a new Business Group, your system administrator must create a new responsibility for it after you save it, but before you use it. This responsibility must give access to all the records in the Business Group. Alternatively, the system administrator can simply update the default Oracle Human Resources responsibility by changing the HRSecurity Profile user profile option to the name of the view–all security profile generated for the new Business Group (see steps 8 to 10 below).

To define a “view–all” responsibility:

1. Navigate to the Responsibilities window.
2. Enter a Name for the responsibility and select the application for which you are defining it (such as Oracle Human Resources) in the Application field.
3. In the Menu field, select F4 HRMS Top Menu.
4. In the Report Group field, select one of the seeded report groups (such as US HRMS Reports and Processes).
5. Save your work.
6. Navigate to the System Profile Values window.
7. Select your new responsibility and query the HR:Security Profile option.
8. Enter the name of the view–all security profile for your new Business Group. By default this is the name of your Business Group.
9. Save your work.

See Also

Access Control Through User Responsibilities: page 23 – 2
Creating an Organization

Use the Organization window to set up:

- Business Groups
- internal organizations, such as departments, divisions, and sections
- external organizations, such as benefits carriers, tax authorities, and recruiting agencies.

Prerequisites for All Organizations

- Enter the names and addresses of your work sites in the Location window.
  See: Setting Up Site Locations: page 2 – 3
- Enter organization types you need in the QuickCodes window, for the QuickCode Type ORG_TYPE.
  See: Adding QuickCode Values: page 20 – 3

Prerequisites for Business Groups

- Enable the currencies you need. Normally your system administrator does this.
  See: Enabling Currencies: page 22 – 7
  Note: Oracle Payroll is capable of paying employees working in other countries in the currencies of these countries, but does not provide the formulas needed to process taxes for employees paid in foreign currencies under other national legislations. You can write your own formulas in Oracle FastFormula, or contract with local third party vendors for the installation of tax routines.
- Define the structures for the Job, Position and Grade Name key flexfields, and define the structures and at least one segment for the People Group and Cost Allocation key flexfields.
  See: Work Structures and Key Flexfields: page 1 – 20
- Make entries for the QuickCode Types FREQUENCY and BUDGET_MEASUREMENT_TYPE in the QuickCodes window.
  See: Adding QuickCode Values: page 20 – 3

Prerequisites for HR Organizations

- To enter cost codes for these organizations, check that the Cost Allocation key flexfield includes a cost code segment, with a
qualifier of Organization. This qualifier must be present for the segment to appear in the Organization window.

See: Setting Up the Cost Allocation Key Flexfield: page 6 – 3

To create a new organization:

1. Enter a name that is unique within the Business Group, and optionally select an organization type.
   
   **Note:** All Oracle applications you install share the information entered in the Organization window. Therefore organization names must be unique within a Business Group, and Business Group names must be unique across your applications network.

2. Enter a start date early enough for any historical information you must enter.
   
   You cannot assign an employee to an organization before the start date of the organization.

3. Select a location to record the site address, if one exists. You can also enter an internal address to add more details such as a floor or office number.

4. Select Internal or External. You cannot assign people to an external organization.

5. Save the organization. Then select at least one classification and enable it.

   **Note:** Your system administrator can limit the classifications you see to those relevant at your installation.
• Select **Business Group** to define a Business Group.

**Attention:** Classifying an organization as a Business Group is not reversible. Employees, organizations, and other data are partitioned by Business Group. Each Business Group must be viewed using a separate responsibility.

• Select **HR Organization** for all organizations (including Business Groups) to which you want to assign employees.

• Select **Payee Organization** when defining an external organization that is the recipient of a third party payment from an employee, for example a court-ordered payment. You can then select this organization on the Personal Payment Method window when entering a third party payment method.

6. Save all enabled classifications for this organization.

► **To enter additional information:**

1. In the Organization window, query the organization if it does not already appear there. In the Organization Classifications region, select the classification for which to enter additional information, and choose the Others button to open the Additional Organization Information window.

2. This window displays the entry options available for the selected classification. Choose the option you want. Another Additional Organization Information window opens. Click in a field of this window to open a window for information entry.

3. Enter additional information for the classification.

   **Note:** There is no additional information to enter for a Payee Organization.

**Additional Information for Business Groups**

► **To enter basic, required information for the Business Group:**

   See: Entering Business Group Information: page 2 – 14

► **To enter defaults for human resource budget values:**

   See: Business Groups: Entering Budget Value Defaults: page 2 – 16

► **To enter the Sickness Control Rule for the Business Group (SSP/SMP users only):**

   See: Business Groups: Entering Sickness Control Rules: page 2 – 17
To enter tax details:
See: Business Groups: Entering Tax Details: page 2 – 18

To enter defaults for work day start and end times:
See: Business Groups and HR Organizations: Work Day Defaults: page 2 – 19

To enter training default values for Oracle Training Administration:
See: Creating a Business Group for Oracle Training Administration, Oracle Training Administration User’s Guide.

Additional Information for HR Organizations

To enter cost codes for collection of costing information:
See: HR Organizations: Entering Costing Information: page 2 – 20

To place the organization in hierarchies:
See: HR Organizations: Entering Parent Organizations: page 2 – 20

To enter default work day start and end times.
See: Business Groups and HR Organizations: Work Day Defaults: page 2 – 19
Entering Business Group Information

The Business Group Information window is an example of a flexfield structure. The first window you see displays the information in a condensed format. Click the field to open the full window, which labels each segment of the flexfield.

To enter Business Group information:

1. In the Organization window, query the Business Group if it does not already appear there. In the Organization Classifications region, select Business Group, choose the Others button, and select Business Group Information.

2. Click in a field of the Additional Organization Information window to open the Business Group Information window.

3. You can enter a short name for the Business Group. Release 10 does not use this name. It is provided for compatibility with earlier releases, where it appeared in the header line of each form.

4. Select the method of creating identifying numbers for employees and applicants. The choices are:
• automatic number generation
• manual entry
• automatic use of the national identifier (for example, the social security number in the US, and the NI number in the UK). This option is available for employees only.

Attention: Once you save your method, you cannot later change to either of the automatic options. You can only change to manual entry.

5. Select the names of the key flexfield structures you want to use in this Business Group.

6. Select the appropriate Legislation Code and default currency.
   The Legislation Code determines the startup data you can access and the contents of some legislation–specific windows.

Attention: Selecting the correct legislation code is essential for the correct functioning of Oracle HRMS. You cannot change the legislation code after entering employees against the Business Group.

7. You can enter a Minimum and Maximum Working Age for the Business Group. When you enter or hire employees, you receive a warning if the person’s age is outside this range.

8. Save your work.
   
   Note: The Fiscal Year Start field is not used in Oracle Human Resources.
Business Groups: Entering Budget Value Defaults

You can set up budgets for non–monetary measures such as headcount or full–time equivalent. When you enter employee assignments to define the work an employee does for your enterprise, you can specify the value of the assignment towards these budgets. For example, all assignments typically count as one for headcount budgets, but may count as less than one for full–time equivalent budgets.

To remove the requirement to enter these values for every assignment, you can enter defaults for the whole Business Group. You can override the defaults for individual assignments.

Prerequisites

- Define units of measure (such as Headcount) by adding values to the QuickCode Type BUDGET_MEASUREMENT_TYPE in the QuickCodes window.

To define budget value defaults:

1. In the Organization window, query the Business Group if it does not already appear there. In the Organization Classifications region, select Business Group, choose the Others button, and select Budget Value Defaults.
2. Click in a field of the Additional Organization Information window to open the Budget Value Defaults window.
3. In the Units field, select a measurement type, such as Full Time Equivalent or Headcount.
4. Enter a default value in the Value field.
   
   You can enter a default value for as many budgetary units as you plan to use for the Business Group.

See Also

Human Resource Budgets, Oracle Human Resources UK User’s Guide
Business Groups: Entering Sickness Control Rules

If you have installed Oracle SSP/SMP, specify whether employees must submit medical evidence when they report a sickness absence.

To enter sickness control rules:

1. In the Organization window, query the Business Group if it does not already appear there. In the Organization Classifications region, select Business Group, choose the Others button, and select Sickness Control Rules.

2. Click in a field of the Additional Organization Information window to open the Sickness Control Rules window.

3. Select Yes or No in the Incapacity Evidence Required field.

If you select Yes, Oracle SSP/SMP automatically creates a stoppage for payment of SSP if an employee has not submitted medical evidence while on sickness absence.

See Also

- Entering Sickness Evidence
  *Oracle SSP/SMP User’s Guide*

- Viewing and Recording SSP Stoppages
  *Oracle SSP/SMP User’s Guide*
Business Groups: Entering Tax Details

Your Business Group must register one or more PAYE schemes with the Inland Revenue. You can enter the details of each scheme for reporting purposes.

To enter tax office information:

1. In the Organization window, query the Business Group if it does not already appear there. In the Organization Classifications region, select Business Group, choose the Others button, and select Tax Details References.

2. Click in a field of the Additional Organization Information window to open the Tax Details References window.

3. Enter tax district details and the statutory name and address of your Business Group.

4. If your enterprise runs a contracted out occupational pension scheme, enter your Employer’s Contracting Out number. This is issued by the Pension Schemes Office.
Business Groups and HR Organizations: Work Day Defaults

You can set up default working hours for all employees in the Business Group or in an HR Organization, saving data entry at lower levels. When necessary, you can override the defaults at lower levels, for example, for individual positions or employees.

The Salary Administration process uses working hours information to prorate the salary values against which it validates any salary proposals.

To define work day defaults:

1. In the Organization window, query the Business Group if it does not already appear there. In the Organization Classifications region, select Business Group, choose the Others button, and select Work Day Information.

2. Click in a field of the Additional Organization Information window to open the Work Day Information window.

3. Enter the normal start and end times in 24 hour format. For example, for 5.30 p.m., enter 17:30.

4. Enter a number in the Working Hours field, and select the corresponding period of time in the Frequency field. For example, enter 40 and select Week.

You can add to the list of available frequencies by making entries for the QuickCode Type FREQUENCY, using the QuickCodes window.
HR Organizations: Entering Costing Information

To enter costing information:

1. In the Organization window, query the HR Organization if it does not already appear there. In the Organization Classifications region, select HR Organizations, choose Others, and select Costing Information.

2. Click in the Additional Information window to display the segments of the Cost Allocation flexfield set up with the qualifier of Organization.

3. Select the appropriate cost code in each segment.
   For individual employees, you can override these organization-level codes by entering costing information on their assignments.
   See: Setting Up Assignments for Cost Collection: page 6 – 5

HR Organizations: Entering Parent Organizations

After you set up organization hierarchies, use the Parent Organization window to place a subordinate organization in hierarchies by naming its immediate parent in each hierarchy.

To enter a parent organization:

1. In the Organization window, query the HR Organization if it does not already appear there. In the Organization Classifications region, select HR Organization, choose Others, and select Parent Organization to open the Parent Organization window.

2. Select the hierarchy name.
3. Select the name of the parent organization to which the HR Organization is subordinate in this hierarchy.

4. To enter the HR Organization in another hierarchy, repeat steps 2 and 3.

See Also

Organization Hierarchies: page 2 – 23
Deleting an Organization

To remove an organization from the list of organizations available for employee assignments, enter an end date (Date To) on the organization record.

To entirely delete an organization from the system, you must first:

- remove any employee assignments to the organization
- remove the organization from any hierarchies
- disable its organization classifications in the Organization window.
Organization Hierarchies

In Oracle HRMS, organization hierarchies show reporting lines and other hierarchical relationships among the organizations in your enterprise.

You set up a primary reporting hierarchy reflecting the main reporting lines in your enterprise, as established in the organization chart of your enterprise. Below is an example of an organization chart showing the reporting lines of a single-company enterprise.

Figure 2 – 1
Chart Showing Primary Reporting Lines
Multiple Hierarchies

In addition to the primary reporting hierarchy, you can set up in Oracle HRMS as many other organization hierarchies as you need.

Hierarchies for Matrix Management

Your enterprise may have a matrix management structure in which organizations have more than one reporting line. For example, looking at the organization chart in Figure 2 – 1, the HR organization under Production may have a dotted-line reporting relationship to the organization Company HR. You can set up additional hierarchies to reflect secondary reporting relationships within your enterprise.

Security Hierarchies

As well as constructing hierarchies to reflect reporting lines, in Oracle HRMS you use hierarchies to control access to information. For example, in a decentralized enterprise you might want to give each regional manager access to the records of the employees in the organizations in his or her region.

Looking again at the organization chart in Figure 2 – 1, you want managers in the Sales East office to have access to the records of all employees in the eastern region sales groups. You can do this by building a geographical hierarchy of your regions and the organizations in each.

See: Security Profiles: page 23 – 4

Hierarchies for Reporting

When you run some of the Oracle HRMS standard reports, you can specify an organization hierarchy to determine which organizations and employees the report covers. You can also use this approach in your own standard or ad hoc reports. You can create additional organization hierarchies just for analysis and inquiry purposes.
Organizational Change and Version Control

Changing your hierarchies to reflect simple changes in reporting lines is not difficult. You create a new version of your existing hierarchy and modify parts of its structure. The system retains earlier versions of hierarchies for historical information.

However when you experience a major restructuring, it is often best to create new work structures, including new organizations and reporting lines.

Suggestion: You can create future-dated versions of your organization structures and use these to prepare for reorganization in advance. You retain previous versions of your hierarchies for historical information.

See Also

Dated Information and Hierarchy Versions: page 1 – 13
Creating Organization Hierarchies

You can create all types of organization hierarchies in two ways:

- using the Organization Hierarchy window
- using the Organization Hierarchy Diagrammer

The Hierarchy Diagrammer, included with Oracle HRMS, enables you to create your organization hierarchies graphically and make intuitive drag-and-drop changes to them.

See: Hierarchy Diagrammers Online Help

This topic explains how to use the Organization Hierarchy window. Always define hierarchies from the top organization down.

Prerequisites

- Define the top organization in the hierarchy, and at least one organization subordinate to it.

**To set up a new organization hierarchy:**

1. Enter a unique name, and check Primary if it is your main reporting hierarchy.
2. Enter the version number and start date for the hierarchy.
You can copy an existing hierarchy. See: **To copy an existing hierarchy**, below.

3. Query the top organization name into the Organization block.

4. In the Subordinates block, select the immediate subordinates for the top organization.

5. To add organizations below one of these immediate subordinates, check the Down check box for the organization.

   The Organization block now displays the organization you selected.

   You can add subordinates to *this* organization. To return to the previous level, check the Up check box.

   **Attention:** The list of organizations from which you can select in the Subordinates block includes organizations that are already in the hierarchy. If you select such an organization, you will move it and all its subordinates within the hierarchy.

   See: Changing Organization Hierarchies: page 2 – 28

**To create a new version of an existing hierarchy:**

1. Query the name of the hierarchy.

2. In the Version field, use the Down Arrow to move through existing versions of the hierarchy until you reach a version number for which no other data appears. Enter the start date for the new version.

   **Note:** Overlapping versions of a hierarchy cannot exist. Whenever you enter a new version of a hierarchy, the system automatically gives an end date to the existing version. Oracle HRMS retains the records of obsolete hierarchies so you do not lose historical information you may need.

   You can copy an existing hierarchy. See: **To copy an existing hierarchy**, below.

3. Query the top organization name into the Organization block.

4. In the Subordinates block, select the immediate subordinates for the top organization.

5. To add organizations below one of these immediate subordinates, select the Down check box for the organization.

   The Organization block now displays the organization you selected.

   You can add subordinates to *this* organization. To return to the previous level, select the Up check box.

**To copy an existing hierarchy:**

1. Enter or query the name and number of your new hierarchy version and choose the Copy Hierarchy button.
2. Select the name and version number of the hierarchy you want to copy.

Details of this hierarchy then appear in the Organization and Subordinates blocks. You can change these.

---

**Changing Organization Hierarchies**

To add new organizations to an existing hierarchy, query the hierarchy and version you want to change, query the parent organization for the one you are adding, and select the new organization in the Subordinates block.

To change the top organization of an existing hierarchy, query the hierarchy and version you want to change, query the new top organization, and select the previous top organization in the Subordinates block.

You can move an organization and all of its subordinates within a hierarchy. To move an organization, query the hierarchy and version you want to change, query the new parent organization for the one you want to move, and select the organization to move in the Subordinates block.

---

**Deleting Organization Hierarchies**

To delete an organization hierarchy, you must first remove the subordinate organizations from the hierarchy, starting at the lowest level. You cannot delete an organization hierarchy if other versions exist, or a security profile uses it.
Organization Hierarchy Report

Oracle HRMS includes a standard Organization Hierarchy Report to display the relationships between organizations in a hierarchy.

You run reports from the Submit Requests window.

► To run the Organization Hierarchy Report:

1. In the Name field, select Organization Hierarchy.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. In the Organization Structure field, select the hierarchy. If there are multiple versions, select a version.
   
   If the effective date lies between the version’s start and end dates, the report shows information for the effective date. If it lies outside these dates, the report shows information for the start date of the version.

5. In the Parent Organization field, select the highest organization in the hierarchy that you want to see on the report.
6. Enter Yes in the Managers Shown field to see managers’ names.
   
   If there are more than ten managers, you see the number of managers only.

7. Choose the Submit button.
This chapter explains the concepts of jobs and positions in Oracle HRMS and how you can use these work structures to represent the roles of your employees.

It further explains how to:

- use the Job Name and Position Name key flexfields to identify groups of employees in your enterprise
- hold information associated with jobs and positions, such as job descriptions, and standard working hours for positions
- represent the reporting lines and other relationships among positions. You represent these relationships by building position hierarchies
- reorganize jobs, positions and assignments within your Business Group.
Representing Jobs and Positions

In many enterprises the basic management units are roles, not individuals. In theory at least, organizations are able to continue in unchanged existence, in spite of frequent changes in staff. However, the definition of a ‘role’ varies from one enterprise to another. Like organization structures, it reflects the culture of the enterprise.

You define roles to represent the ways that different groups of employees work. In Oracle HRMS you can use jobs or positions, or a combination, to define roles.

**Job**
A job is a generic role within a Business Group, which is independent of any single organization. For example, the jobs ‘Manager’ and ‘Consultant’ can occur in many organizations.

**Position**
A position is a specific occurrence of one job, fixed within one organization. For example, the position ‘Finance Manager’ would be an instance of the job of ‘Manager’ in the ‘Finance’ organization. The position belongs to the organization. There may be one, many, or no holders of a position at any time.

**Example**
In a large structured organization, you may have a permanent establishment of positions for most of your employees.

However, you may also have groups of employees hired to perform specific tasks. This can be on a temporary or a permanent basis. Staff in this category can include agency workers, consultants and contractors. For these staff, you can define the role more flexibly as a job.
Position Reporting Structures

If you use positions to define roles, you can define position hierarchies to show the detailed line management reporting in each organization or throughout the enterprise.

Position hierarchies are very like organization hierarchies. You can set up a primary hierarchy and multiple secondary hierarchies to show reporting lines, including ‘dotted line’ reporting, and to control access to information.

Position hierarchies are dated, so you can create future-dated versions to prepare for reorganization in advance, and can retain previous versions for historical information.

Figure 3 – 1
Position Hierarchies
Deciding How to Use Organizations, Jobs, and Positions

When you plan how to model your organizations and roles, consider the following points:

• Positions are normally used in role–based enterprise structures where clearly defined rules largely determine the ways employees work, and the compensation and benefits they receive.

• To manage fixed establishments of posts that exist independently of the employee assignment, it is best to use positions.

If you decide to use positions to represent your enterprise structures you need to consider carefully how to use organizations.

Positions provide you with a finer degree of structural definition and control than organizations on their own. You can use both organizations and positions to represent your reporting structures. However, if you define both, you must also maintain both over time. This may lead you into duplication of effort and information.

Suggestion: If you decide to use positions to represent how people work in your enterprise, it is best to define most of the detail at the level of the position. Do not duplicate this detail in organization structures.

Use organizations to show your highest level of departments or divisions. Use positions and position hierarchies to show the reporting groups existing in your enterprise.

See Also

Rule Based Enterprises: page 7 – 6
Job and Position Names

Before you define your jobs and positions, decide whether you want to use simple names and codes, or multi-segment job and position names to hold more information.

The name can be a title only, as for example:

- Director
- Analyst
- Training Manager

You can add another segment to categorize the jobs or positions. In this way, you can use segments to identify subgroups of employees within your enterprise. For example, a job name can comprise a title and a job type, such as:

- Director of Finance.Director
- Assistant Director of Finance.Director
- Finance Officer.Professional

Similarly, a position name can comprise a title, a position number, and an indicator showing whether the position is part-time. For example:

- Training Manager.020001.F/T
- Secretary to the Training Manager.020013.P/T

You define the segments of the job and position names and their valid values by setting up the Job Name key flexfield and the Position Name key flexfield. Normally your system administrator does this.

See Also

User Definable Key Flexfields: page B – 2
Adding Information About Jobs and Positions

As you define roles in your enterprise, you can describe their responsibilities, requirements, and working conditions. There are a number of ways to add information about a role:

- For positions, you can enter in standard fields, the location, probation period, and working hours. Entering location and working hours for an organization provides a default for all positions within that organization.

- You can attach documents (such as word processed documents, spreadsheets, or simple text comments) to each job or position record. For example, you might attach text describing the objectives and tasks of the job or position.

  See: Using Attachments: page 21 – 6

- You can add up to twenty additional fields to each window to hold extra information you require. These fields can be global (they always appear), or context-sensitive (they appear only when triggered by another piece of information).

  For example, these fields can record the health and safety requirements of a position, or its suitability for job share. The additional fields appear in a descriptive flexfield.

  See: Adding New Fields to Windows: page 19 – 2

- You may need to add other information, such as required qualifications or valid experience, to help match people to roles. You define the sorts of Special Information Types you want to hold and set them up using a special field called the Personal Analysis key flexfield. For each job or position, you select the requirements from your Special Information Types relevant to that role.

  See Matching People to Vacancies (Oracle Human Resources User’s Guide)

Comparing and Relating Roles

You may also want to relate roles to each other and define the relative grading of the roles. You can relate roles in the following ways:

- By forming multiple hierarchies of positions to show reporting relationships or career paths.

  See: Creating Position Hierarchies: page 3 – 22

- By linking jobs into multiple career paths to show suggested progression paths.
See: Defining Career Paths Based on Jobs (*Oracle Human Resources User's Guide*)

- By recording successor positions and relief positions (to cover in the case of absence) against each position.
  See: Defining Positions: page 3 – 10

- By recording the grades that are valid for each job and position.
  See Valid Grades (*Oracle Human Resources User’s Guide*)

- If you use an evaluation system (such as the Hay Evaluation System) to compare roles, you can set up fields to hold evaluation information and an overall score for each job and position.
Defining Jobs

You use the Job window to define jobs, the skills that jobholders require, and the grades to which they can be assigned. You can also enter job evaluation scores, if you have set up a job evaluation system.

Prerequisites

- Define all the segments of the Job Name key flexfield that you want to use for the job name.
- If there are one or more valid grades to enter for this job, check that these grades are defined.

To define a job:

1. Enter a start date early enough to handle any historical information you want to enter.
2. Enter a unique name for the job. If there is more than one segment in the Job Name flexfield, a window opens when you enter the Name field. You must enter a unique combination of segments in this window.
3. Save the job.
4. Choose the Evaluation button to enter evaluation information and an overall evaluation score for the job.
5. Choose the Requirements button to enter job requirements, such as required qualifications or valid experience, to help you match people to roles.

**Note:** Check with your HR manager or system administrator whether this is the right window for entering job requirements.
You use this window if requirements were defined using Special Information Types. You use the Competency Requirements window if you have implemented Career Management.

6. Choose the Valid Grades button to enter the grades to which jobholders can be assigned.

See Also

Entering Work Choices for a Job or Position: page 3 – 17
Defining Positions

You use the Position window to define positions within your organizations and to add them to position hierarchies. You can also enter the skills that position holders require and the grades to which they can be assigned. You can enter position evaluation scores, if you have set up a position evaluation system.

Prerequisites

- Define all the segments of the Position Name key flexfield that you want to use for the position name.
- Define the organizations for the Business Group.
- Define the jobs for the Business Group.
- If you want to hold probation periods for positions, enter the units in which you measure probation periods as values for the QuickCode Type QUALIFYING_UNITS.
- If you want to add the position to a position hierarchy, define the hierarchy in the Position Hierarchy window.

To define a position:

1. Enter a start date early enough to handle any historical information you want to enter.
2. Enter a unique name for the position.
   - If there is more than one segment in the Position Name flexfield, a window opens when you enter the Name field. You must enter a unique combination of segments in this window.
3. Select the organization and job for this position. They must have a start date on or before the start date of this position.

**Attention:** You cannot change the organization or job once you have saved the definition.

You can set up several positions that have the same job in the same organization. Each position name must be unique.

4. Optionally, select a status for the position. If the status is Valid or blank, employees can be assigned to the position. If the status is Invalid or any other status defined at your site, employees cannot be assigned to the position.

5. Location and Standard Conditions default from the organization, but you can override the defaults.

6. If there is a probation period for this position, you can enter its length in the Probation Period alternative region.

7. In the Absence alternative region, select Yes in the Replacement Required field if you want users to be warned that they should enter the name of a replacement when they enter an absence for a holder of this position. You might want to do this for positions where it is essential that a person is ‘in charge’ at all times.

   You can select the position that should be held by the person to cover as relief in case of absence.

8. In the Planned Successor alternative region, you can select the position from which a successor will move to fill this position.

9. Save your position.

10. If you want to add the position to one or more position hierarchies, choose the Reporting To button. Select a hierarchy and the name of the position to which this position reports.

11. Choose the Evaluation button to enter evaluation information and an overall evaluation score for the position.

12. Choose the Requirements button to enter position requirements, such as required qualifications or valid experience, to help you match people to roles.

   **Note:** Check with your HR manager or system administrator whether this is the right window for entering position requirements. You use this window if requirements were defined using Special Information Types. You use the Competency Requirements window if you have implemented Career Management.

13. Choose the Valid Grades button to enter the grades to which position holders can be assigned.
See Also

Entering Work Choices for a Job or Position: page 3 – 17
Evaluating Jobs and Positions

Evaluation systems are common in large enterprises, which compare the responsibilities of roles to help in the definition of grades. Directly or indirectly, the evaluation can also contribute to setting compensation levels. The UK’s Local Government Scheme and the Hay Evaluation System, used internationally, are examples of evaluation systems.

Evaluation systems normally use a set of formal and systematic procedures to perform a comparison of roles. As such, evaluation is primarily concerned with the definition of the relative status of a role, and not with a set of absolutes. The objective of all evaluation systems is to place a role in a grading or salary structure.

There are two main types of evaluation system:

**Factor**

Key roles are examined factor by factor and a rank comparison order produced for each factor. A complex comparison of weighted factors then follows.

**Points Rating**

A wider range of factors is used. Each factor is weighted and has a numerical scoring system. The total points scored determines the placement of the role in a grade or salary structure.

These systems might incorporate benchmarking, where a few key roles determine the rank of all the others. Grades and compensation levels are determined after the evaluation and ranking of the jobs.

Setting Up an Evaluation System

- **To set up an evaluation system:**
  1. Decide whether to hold the evaluation information for jobs or for positions, depending on your own definitions of employees’ roles within the enterprise model.
  2. Define values for the QuickCodes Types EVAL_SYSTEM (evaluation system name) and EVAL_SYSTEM_MEAS (the units in which to measure the evaluation). If you use more than one system, you can define multiple values to provide a list of values in the Job Evaluation and Position Evaluation windows.
     
     See:  Adding QuickCode Values: page 20 – 3
  3. Define the structure and segments of the Additional Evaluation Details descriptive flexfield, which holds the evaluation
information. This descriptive flexfield displays on the Job Evaluation and Position Evaluation windows.

For example, you could define the following segments:

- Responsibility
- Problem Solving
- Know How
- Related Grade

If you are using more than one evaluation system in your enterprise, you should make the flexfield segments context sensitive to the evaluation system. Context sensitive segments ensure that each system has its own distinct set of evaluation information.

Your system administrator usually carries out this task as it requires access to parts of the system that control how Oracle Human Resources works.

### Entering Evaluation Information

Enter evaluation scores and details in the Job Evaluation or Position Evaluation window.

**Prerequisites**

- An evaluation system must be implemented.

To enter a job or position evaluation:

1. Select the evaluation system used to evaluate this job or position.
2. Enter the overall score and select the units of measurement.
3. Enter the date of the evaluation.
4. Open the descriptive flexfield window, and enter the information it prompts you for.

Valid Grades

When you have evaluated the relative status of your roles (using an evaluation system or some other approach), you can associate valid grades with each role. You may choose to define valid grades for a few key roles and then use these as benchmarks for all other roles.

When you assign an employee to a grade, the list of grades you select from indicates which grades are valid for the employee’s job or position.

You enter valid grades in the Valid Grades window for a job or position.

> **To enter valid grades:**

- Select as many valid grades as you require.

  The Date From defaults to the date the job or position becomes active, or the date the grade becomes active, if this is later. You can change this date.
Entering Job and Position Requirements

Using the Job Requirements window and Position Requirements window, you can store any personal attributes or experience required by a job or position. You can then use this information to list employees or applicants who might be suitable to hold the job or position.

**Note:** If you are using Career Management for suitability matching, enter competence requirements for jobs and positions in the Competence Requirements window.

- The implementation team at your site must set up one or more special information types to hold the requirements information.

See: Defining Special Information Types: page 8 – 10

To enter job or position requirements:

1. Select the name of a special information type.
2. Enter the Requirements field to open the window corresponding to this special information type.
3. In this window, enter the precise requirement of the job or position and choose OK.
4. If the requirement is essential to the job or position, check the Essential check box. This information is used in the Skills Matching Report.
5. Save the requirements.
See Also

Viewing and Reporting Skills Matching Information: (Oracle Human Resources UK User’s Guide)

Entering Work Choices for a Job or Position

You can enter work choices that can affect an employee’s, applicant’s, contractor’s, or ex–employee’s capacity to be deployed within your enterprise (or a customer’s). Work Choices include willingness to travel, willingness to relocate, and preferred working hours and work schedule. You can enter work choices for a job or position, and compare these with the personal work choices entered for people.

You enter this information in the Work Choices window, accessed from the Job or Position window.

Prerequisites

You need to enter the following QuickCodes for work factors:

- Define time scales as values for the QuickCode Type PER_TIME_SCALES.
- Define work schedules as values for the QuickCode Type PER_WORK_SCHEDULE.
- Define working hours as values for the QuickCode Type PER_WORK_HOURS.
- Define the full time equivalents as values for the QuickCode Type PER_FTE_CAPACITY.
- Define relocation preferences as values for the QuickCode Type PER_RELOCATION_PREFERENCES.
- Define lengths of service as values for the QuickCode Type PER_LENGTHS_OF_SERVICE.
To enter work choices for a job or position:

1. Check the relevant work requirements boxes if the job or position requires the holder to:
   - work in all locations
   - relocate
   - be willing to relocate
   - travel
   - hold a passport
2. Enter the length of time the jobholder must perform the job or position, for example, indefinite or two years.
3. Enter the normal working hours (for example, 9:00 to 5:30), the work schedule (the working days in the week or pattern of shifts), the proportion of full time hours required, and the minimum length of service required.
4. Check the relevant international deployment boxes if the job or position requires the jobholder to:
   - work in all countries
   - be willing to relocate
5. Select the countries to which the jobholder might be relocated.
6. Select the locations to which the jobholder might be relocated.
7. Enter any further job or position requirements, if required.

See Also

Entering Work Choices (Person): page 9 – 19
Viewing Position Occupancy

The Position Occupancy folder lists all those people who have held a selected position or who are applying for it, and the dates of their occupancy. This information could be relevant for selecting people with the necessary skills for similar positions.

**Note:** As supplied, this folder displays employees who have held the selected position or who are scheduled to hold it. Your system administrator can create a customized version of the form to display applicants who are currently applying for the position.

The supplied folder also contains a button to open the People window to see further details of an occupant. Your system administrator can change the buttons displayed on this window.

To view occupants of a position:

- In the Position window, query a position and choose the Occupancy button.

Occupants are listed in reverse date order. Where a person has occupied the same position at different times, a separate record is created for each occupancy.
To see further details of occupants or applicants:

- Select the person’s record in the Position Occupancy folder and choose the Person button.

**Note:** There is no restriction on the assignments you can view in the Position Occupancy folder. However, you cannot view further details if you do not have clearance to view that person’s records.
Creating Position Hierarchies

You can create and maintain your reporting structures in two ways:

• using the Position Hierarchy window
• using the Position Hierarchy Diagrammer

The Hierarchy Diagrammer, included with Oracle HRMS, enables you to create your position hierarchies graphically, and make intuitive drag-and-drop changes to them.

See: Hierarchy Diagrammers Online Help

This topic explains how to use the Position Hierarchy window. Always define hierarchies from the top position down.

Prerequisites

- Define the top position in the hierarchy, and at least one position subordinate to it.

To create a new position hierarchy:

1. Enter a unique name, and check Primary if it is your main reporting hierarchy.

2. Enter the version number and start date for the hierarchy.

You can copy an existing hierarchy. See: To copy an existing hierarchy, below.
3. Query the top position name into the Position block.

The Holder field displays the name of the employee who holds this position. If there is more than one holder, this field displays the number of holders. You can choose the List icon from the toolbar to display the list of holders.

4. In the Subordinates block, select the immediate subordinates for the top position.

5. To add organizations below one of these immediate subordinates, check the Down check box for the position.

The Position block now displays the position you selected. You can add subordinates to this position. To return to the previous level, check the Up check box.

Attention: The list of positions from which you can select in the Subordinates block includes positions that are already in the hierarchy. If you select such a position, you will move it and all its subordinates within the hierarchy.

See: Changing Position Hierarchies: page 3 – 24

To create a new version of an existing hierarchy:

1. Query the name of the hierarchy.

2. In the Version field, use the Down Arrow to move through existing versions of the hierarchy until you reach a version number for which no other data appears. Enter the start date for the new version.

   Note: Overlapping versions of a hierarchy cannot exist. Whenever you enter a new version of a hierarchy, the system automatically gives an end date to the existing version. Oracle HRMS retains the records of obsolete hierarchies so you do not lose historical information you may need.

   You can copy an existing hierarchy. See: To copy an existing hierarchy, below.

3. Query the top position name into the Position block.

4. In the Subordinates block, select the immediate subordinates for the top position.

5. To add positions below one of these immediate subordinates, check the Down check box for the position.

The Position block now displays the position you selected. You can add subordinates to this position. To return to the previous level, check the Up check box.
To copy an existing hierarchy:

1. Enter or query the name and number of your new hierarchy version and choose the Copy Hierarchy button.
2. Select the name and version number of the hierarchy you want to copy.

Details of this hierarchy then appear in the Position and Subordinates blocks. You can change these.

See Also

Dated Information and Hierarchy Versions: page 1 – 12

Changing Position Hierarchies

To add new positions to an existing hierarchy, query the hierarchy and version you want to change, query the parent position for the one you want to add, and select the new position in the Subordinates block.

To change the top position in an existing hierarchy, query the hierarchy and version you want to change, query the new top position, and select the previous top position in the Subordinates block.

You can move a position and all of its subordinates within a hierarchy. To move a position, query the hierarchy and version you want to change, query the new parent position for the one you want to move, and select the position to move in the Subordinates block.

Deleting Position Hierarchies

To delete a position hierarchy, you must first remove the subordinate positions from the hierarchy, starting at the lowest level. You cannot delete a position hierarchy if other versions exist, or if a security profile uses it.
Position Hierarchy Report

Oracle HRMS includes a standard Position Hierarchy Report to display the relationship between the positions in a hierarchy. The report also lists the current holders of each position in the hierarchy.

You run reports in the Submit Requests window.

To run the Position Hierarchy Report:

1. In the Name field, select Position Hierarchy.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. In the Position Structure field, select the hierarchy. If there are multiple versions, select a version.
   
   If the effective date lies between the version’s start and end dates, the report shows information for the effective date. If it lies outside these dates, the report shows information for the start date of the version.

5. In the Parent Position field, select the highest position in the hierarchy that you want to see on the report.
6. Enter Yes in the Holders Shown field to see holders’ names.
   
   If there are more than ten holders, you see the number of holders only.

7. Choose the Submit button.
Making Mass Updates

You can use the Mass Move feature to reorganize your Business Group, either within an organization or between organizations.

You can move assignments between existing positions, create new positions in which to move assignments, and change the grade, location, and standard conditions of an assignment.

Business Group reorganizations often entail changing many employee records in the same way. Because Mass Move allows you to modify multiple employee records at once, you can make such changes conveniently.

These topics are covered:

- Preparing for your mass move: page 3 – 27
- Performing tasks to complete your mass move: page 3 – 28
- Managing your collection of mass moves: page 3 – 37
Preparing for Your Mass Move

To prepare for your mass move, you must make certain decisions and ensure that certain prerequisites are in place.

**Making Decisions for Your Mass Move**

- What is my source organization? (The mass move transfers assignments from the source organization.)
- What is my target organization? (The mass move transfers assignments to the target organization. The target organization can differ from or be the same as the source organization.)
- What is the effective date for the mass move?
- What are the source position(s)? (The mass move transfers assignments from the source position(s) within the source organization).
- Do you want to deactivate the source position?
- What are my target position(s)?
- If my target position(s) are new, will their location and standard conditions be copied from the source position, target organization, or Business Group?
- What grades are valid for the target position(s)?
- Which assignment(s) will transfer from my source position(s) to my target position(s).
- Will the grade of any transferring assignment change during the mass move?
- Will the location and standard conditions of any transferring assignment change during the mass move?

**Prerequisites for Your Mass Move**

To prepare for your mass move:

- Make sure you have access to a responsibility linked to the Business Group within which the mass move will take place.
  See: Accessing Business Groups: page 2 – 8
- Check that the source and target organizations for your mass move already exist in the HRMS database.
  See: Creating an Organization: page 2 – 10

**See Also**

Performing Mass Move Tasks: page 3 – 28
Performing Mass Move Tasks

Executing a mass move includes the following tasks:

1. Describe your mass move: page 3 – 28
2. Identify your source position(s): page 3 – 29
3. Identify your target position(s): page 3 – 31
4. For each source position, verify the transferring assignments: page 3 – 32
5. For each target position, verify or add valid grades: page 3 – 34
6. Execute the mass move: page 3 – 35
7. Review the mass move: page 3 – 35
8. If necessary, resolve any problems and then reexecute the mass move: page 3 – 36

Describing Your Mass Move

To define your mass move, the first task involves entering a description, determining the source and target organizations for the mass move, and specifying the date on which the mass move will take effect.

To describe your mass move:

1. Navigate to the Mass Move window.
2. Enter a description of the mass move you want to perform.
   You can change this description at any time before the mass move is processed.
3. Select the source and target organizations for the mass move. The source and target organizations can differ or be the same. The list includes organizations that have been defined for the Business Group.
Note: You cannot create a target organization “on the fly.”

You can change the source and target organizations for this mass move at any time until you choose the Find button on the Find Positions window. These definitions then become part of the permanent definition of the mass move and cannot be changed.

Status is a display field that indicates whether the mass move has not yet been executed (Unprocessed), successfully executed without errors or warnings (Complete), successfully executed without errors but with warnings (Complete with Warnings), or unsuccessfully executed with no changes made (In Error).

4. If necessary, adjust the effective date of the mass move.
   You can adjust the effective date at any time before the mass move is processed.

5. Save your work.

Identifying Your Source Positions

After describing your mass move, you must identify source position(s) to be moved.

To identify your source positions:

1. In the Mass Move window, choose the Positions button.
2. In the resulting Find Positions window, select source job(s) and the source position(s) associated with those job(s).

You can select from a list of existing job(s) and position(s) in the source organization, or you can use generic search criteria (wildcards) to identify a pool of source jobs and source positions from which you will select your source positions in Step 3.

3. Choose the Find button.

When the Mass Move – Positions window is populated with information, the source and target organizations you defined in the Mass Move window appear in display fields.

4. If you used search criteria to identify a pool of source jobs and positions, make sure that the list includes all of the source jobs and positions you want to include in this mass move.

Attention: If you want to add source jobs or positions to this list, you must delete this mass move and define a new mass move; source job(s) and position(s) cannot be added to this list.

5. In the move check boxes, check each of the source positions you want to move.

Assignments associated with unchecked source positions will not be affected by the mass move in any way.

6. If you want to deactivate any source position on the effective date for the mass move, check the Deactivate Old Position check box when that position is selected.

Selected: Deactivating a source position does not delete it from the HRMS database, but enters the mass move effective date as the end date for the position.

Unselected: Leaving this check box unchecked allows assignments to be assigned to this source position after the effective date of the mass move, even though the source position may have no assignments immediately following the mass move.

Attention: Unchecking the Move check box for a record restores the original values for that record.

See Also

Defining Positions: page 3 – 10
Managing Your Mass Move Collection: page 3 – 37
Identifying Your Target Positions

Now that you have identified the source position(s) for your mass move, you are ready to identify its target position(s). For each of the target positions you will define, perform the following steps:

To identify your target positions:

1. On the Mass Move – Positions window, select one source position for your mass move.
2. Select a target job to correspond with that source position.
   The list includes existing jobs within the Business Group.
   Note: You cannot create a target job “on the fly.”
3. Choose Edit Field to enter a new target position, or select a target position.
   The list includes existing positions in the target organization.
   Note: Each source position can only have one target position.
   However you can use the same target position for multiple source positions.
4. Select the location and standard conditions for this target position.
   If this target position is a new position, you can enter location and standard conditions as follows:
   - **Source Position**: Indicates that the location and standard conditions of the source position will be applied to the new target position when the mass move takes effect.
   - **Target Organization**: Indicates that the location and standard conditions of the target organization will be applied to the new target position when the mass move takes effect.
   - **Business Group**: Indicates that the location and standard conditions of the Business Group will be applied to the new target position when the mass move takes effect.
   Attention: Unchecking the Move check box for a record restores the original values for that record.
5. When you have identified each of your source and target positions, choose the Assignments button.

See Also

- Verifying Transferring Assignments for Each Source Position: page 3 – 32
- Defining Positions: page 3 – 10
Verifying Transferring Assignments for Each Source Position

The content of the Mass Move – Assignments window depends on the source position you last selected in the Mass Move – Positions window. The Mass Move – Assignments window displays that selected source position, and its corresponding source organization and source job. It also displays the target position you have entered for this selected source position, and the target organization and job associated with this target position.

All of the (applicant as well as employee) assignments associated with the source position you selected in the Mass Move – Positions window are also displayed.

As the Move check boxes show, by default all assignments associated with this source position are selected to move to the target position. The Mass Move – Assignments window allows you to verify these assignments, indicate which ones, if any, will not be moving to the target position, and change the grade, location and standard conditions for any of the assignments to be moved.

To verify transferring assignments for each source position:

1. If you want to prevent any of these assignments from moving to the target position, uncheck the appropriate Move check boxes.
2. If you want to change the grade for any transferring assignment, select the assignment, and then select another grade for that assignment.
3. If you want to copy location and standard conditions for a transferring assignment from an entity other than the current assignment (default), select the assignment, and then select the new location and standard conditions for that assignment. The options follow:

**Current Assignment**: Indicates that the transferring assignment will maintain its current location and standard conditions when the mass move takes effect.

**Source Position**: Indicates that the location and standard conditions of the source position will be applied to the transferring assignment when the mass move takes effect.

**Target Organization**: Indicates that the location and standard conditions of the target organization will be applied to the transferring assignment when the mass move takes effect.

**Business Group**: Indicates that the location and standard conditions of the Business Group will be applied to the transferring assignment when the mass move takes effect.

**Attention**: Unchecking the Move check box for a record restores the original values for that record.

4. To save your work and then return to the Mass Move – Positions window, close the Mass Move – Assignment window.

When the Mass Move – Positions window reappears, you can repeat the above steps for any other source positions whose transferring assignments you choose to verify. Otherwise, you are ready to verify or add valid grades for any target(s) jobs/positions.

**See Also**

- Entering a New Assignment: page 11 – 8
- Site Locations: page 2 – 2
Verifying or Adding Valid Grades for Each Target Position

Because it is possible for the grade of a transferring assignment to be outside the bounds of the valid grades for the target job or target position, you can use Mass Move to add valid grades to the target position.

1. On the Mass Move – Positions window, choose the Valid Grades button.

   The resulting Mass Move – Valid Grades window displays information for the source position you last selected in the Mass Moves – Positions window. It displays the valid grades for the target position:
   
   - A newly-created target position has the same valid grades as the source position.
   - An existing target position retains its existing valid grades and Mass Move adds any other grades that are valid for the source position.

   Thus Mass Move accommodates the grade(s) of the transferring assignment(s). You cannot delete any of the valid grades.

2. Optionally, select additional valid grades for the target position.

3. To save your work and then return to the Mass Move – Positions window, close the Mass Move – Valid Grade window.

   When the Mass Move – Positions window reappears, you can select any other records, to verify or add valid grades for that target position.
See Also

Human Resource Management, Oracle Human Resources UK User’s Guide

Executing the Mass Move

2. Save your work when prompted to do so.
3. On the Mass Move window, choose the Execute button.
   If the number of changes being made is large, executing the mass move may take some time.

Reviewing the Mass Move

After you have chosen the Execute button on the Mass Move window, you are ready to review the results.

To review the mass move:

1. On the Mass Move window, review the contents of the Status field.
   Unprocessed: Indicates that you have not yet executed the mass move.
   Complete: Indicates that the mass move completed successfully without errors. For historical purposes, completed mass moves are automatically archived and cannot be modified.
   Complete with Warnings: Indicates that the mass move completed successfully. Nevertheless, you should still review any warning messages the mass move generates. It is possible for a mass move to execute with Status=Complete with Warnings, yet without all assignments moving as you intended.
   In Error: Indicates that the mass move did not complete successfully and that no changes took effect. You must first resolve the offending conditions before you can successfully reexecute the mass move.
   Attention: If the Status field shows In Error or Complete with Warnings, the Message button appears next to the Positions button.

2. If the Message button is displayed, review the messages.
   The Message window that appears includes the following fields:
   Type: Type of message; Warning or Error.
Row Information: If this field displays a position name, the message applies to a source position. If this field displays the name of a person, this field applies to the assignment associated with that person.

Message: Text of the message.

Note: The Explain button on the Message window is disabled if no additional information is available.

3. If the Status field shows Complete or Complete with Warnings, navigate to the Mass Move – Assignments window and verify that the mass move changes you wanted to make did in fact take effect. Then navigate back to the Mass Move window.

Resolving Problems and Reexecuting a Mass Move

If the Status field on the Mass Move window shows In Error, you need to resolve the problems and reexecute the mass move until the Status field shows Complete or Complete with Warnings. If the Status field shows Complete with Warnings, you will want to investigate those Warnings, and then determine whether you want to resolve the warning conditions and reexecute the mass move to eliminate the warnings. (However, it is important to remember that a mass move complete with warnings has in fact executed successfully.)

Resolving problems may require that you exit Mass Move. For example, an applicant assignment associated with a vacancy will not move during a mass move. To move that assignment to the target position, you would need to use the Assignment window to disassociate this applicant assignment from the source position, and then assign this applicant to a target position.

To reexecute a mass move:

1. Navigate to the Mass Move window.
2. Query the mass move that you previously saved and want to reexecute.
3. After the Mass Move window is populated with data, make whatever changes you need to make to correct the mass move definition.

Attention: Since assignments are datetracked, you may only update a given assignment once a day. To bypass this rule, you can alter the mass move effective date.
If you query a previously saved mass move and then choose the Positions button, the Find Positions window is not displayed. Instead, the Mass Move – Assignments window immediately appears and is populated with data.

4. Choose the Re–execute button.

5. Review your mass move in the standard manner.

---

**Managing Your Mass Move Collection**

As you reorganize your Business Group over time, you will develop an historical archive of mass moves. This archive consists of:

- All executed mass moves for which Status=Complete
- Any executed mass moves for which Status=Complete with Warnings
- Any saved but unexecuted mass moves (Status=Unprocessed or Status=In Error) that you have not deleted

Because it is important to maintain an historical record of Business Group reorganizations, you cannot delete a mass move when its status is Complete or Complete with Warnings. However, you can delete any unexecuted mass moves you chose to save but which have a status of Unprocessed or In Error.

Reexecuting a mass move overwrites its original contents. Thus, only the latest reexecution of that mass move would appear in the historical archive.
This chapter explains how to represent the grade structures used in your enterprise and how to relate compensation to grades. You can relate compensation to grades directly, using grade rates, or indirectly, using grade scales.
Representing Grade Structures

Grades can have different levels of complexity, which need to be represented in the overall structure of the grade.

In its simplest form, a grade can be a single character, or number, in a logical sequence. For example:

- grade A
- grade B
- grade C

By adding a second segment to the grade name, you can identify sub–grades, such as:

- grades A.1, A.2, A.3, and A.4
- grades B.1 and B.2
- grades C.1, C.2, and C.3

A more complex structure could be used to distinguish grades for different staff groups, such as:

- Clerical.C.1 and Clerical.C.2

In this example, there are three segments in the grade name. A grade is the combination of segments you define. You set up the segments and their valid values using the Grade Name Key Flexfield. Normally this is done by the system administrator.
Using Grades

Grades are normally used to record the relative status of employee assignments and to determine compensation and benefits, such as salary, overtime rates, and company car.

Using Grades to Compare Roles

You can define one or more valid grades for each job or position. You enter this information in the Valid Grades window, which opens from the Job window or the Position window.

When you enter a grade assignment, the list of grades shows which ones are valid for the job or position you select.

See: Valid Grades (Oracle Human Resources User’s Guide)

Associating Grades with Compensation and Benefits

You can associate compensation and benefits with your grades. For example, you can record a minimum or maximum salary for a grade. There are two approaches:

- Using grade rates, you can either enter a fixed value for each grade, or you can enter a minimum, maximum, and mid-point values for each grade.
- Using grade scales, you can associate each grade with several points on a pay scale, and enter compensation values for these points.

Attention: The compensation information can change independently of the grade. Therefore, you should not define it as part of the grade name. Instead you should relate it to the grade, either directly or indirectly.
Defining Grades

Prerequisites

- Define all the segments of the Grade Name key flexfield that you want to use for the grade name.

To define a grade:

1. Enter your grades in sequence number order.
   
   The sequence number can be any number from 1 upwards. The number indicates the rank order of the grade; 1 indicates the highest grade.
   
   This is the sequence in which the grades appear to users in lists of values.
   
   Consider sequencing each grade at intervals of 10 or more, to accommodate any future changes to grades.

2. Enter a unique name for the grade. If there is more than one segment in the grade name structure, a window opens when you enter the Name field. You must enter a unique combination of segments.

3. Enter a start date early enough to handle any historical information you want to enter.

4. Save your work.
Deleting Grades

To remove a grade from the list of grades to which employees can be assigned, enter an end date against the grade.

To delete a grade entirely from the system, you must first reassign anyone assigned to the grade. If you have historical records using the grade, you cannot delete it. Instead, enter an end date.
Grade Relationships to Compensation and Benefits

In many enterprises there are rule based reward structures based on grade. These rules can relate grades and pay *directly* or *indirectly*.

**Direct Relationship**

You may have a salary administration system in which the actual level of pay normally falls between a minimum and a maximum value for a grade. Regular performance reviews and ratings can involve comparison with the mid-point value of pay for your grade. In Oracle HRMS, this is a *grade rate*.

**Figure 4 – 2**
Relating Grades and Pay Directly and Indirectly

<table>
<thead>
<tr>
<th>Name</th>
<th>Fixed</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>A.1</td>
<td>10000</td>
<td>10000 – 12500</td>
</tr>
<tr>
<td>A.2</td>
<td>10500</td>
<td>10500 – 13250</td>
</tr>
<tr>
<td>B.1</td>
<td>12000</td>
<td>12000 – 14500</td>
</tr>
<tr>
<td>B.2</td>
<td>13000</td>
<td>13000 – 16000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Range</th>
<th>Point</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>A.1</td>
<td>28 – 32</td>
<td>28</td>
<td>10000</td>
</tr>
<tr>
<td>A.2</td>
<td>30 – 34</td>
<td>29</td>
<td>10250</td>
</tr>
<tr>
<td>B.1</td>
<td>31 – 36</td>
<td>30</td>
<td>10625</td>
</tr>
<tr>
<td>B.2</td>
<td>33 – 38</td>
<td>31</td>
<td>10900</td>
</tr>
</tbody>
</table>

**Indirect Relationship**

You may be using a step based system of progression points within grades, in which each point has a fixed value in a pay schedule or table. In Oracle HRMS this is a *pay scale*. 
Relating pay to grades indirectly is common in government, education and health enterprises. It is also common in large commercial enterprises that negotiate pay levels with staff or union representatives.
Relating Pay to Grades Directly: Using Grade Rates

In Oracle HRMS, you can set up a table of values related to each grade. These are called grade rates. You can enter a fixed value or a range of valid values for each grade.

For example, you might define a salary rate and an overtime rate of pay for every grade, with minimum, maximum, and midpoint values. Both rates would be in monetary units. However, you can also define rates with non-monetary units, such as days, hours, or numbers.

Grade rates are datetracked and this means that you can keep the history of the actual values you use. You can also set up rate values at a future date and be sure that this information will automatically take effect on the date you set, and not before.

You can use your grade rate values:
- as part of a QuickPaint report or inquiry
- to validate salary proposals
- to validate other compensation entries you make for employees
The salary administration process validates salary proposals automatically against the appropriate grade rate. You can use formula validation to check other compensation entries.

See Also

Salary Administration and Performance Reviews: page 14 – 2
Using Oracle FastFormula for Validation: (Oracle FastFormula User’s Guide)

Defining Grade Rates

You define grade rates in the Grade Rate window.

When you save your definition, an automatic process creates corresponding database items that formulas can access.


▶ To define grade rates:

1. Set your effective date to a date early enough for any historical information you want to enter.
2. Enter a name for the grade rate and select the units for measuring it. Save your new rate.
3. In the Grade Rate Values block, select the grades for which you want to define rates. For each grade, enter a fixed value and/or a minimum, maximum and mid value.
To use this grade rate to validate salary proposals entered in the Salary Administration window, you must enter a minimum and maximum value.

To view comparatio values using this grade rate, you must enter a mid value.

See Also

Setting Up Salary Administration: page 14 – 4

Viewing Grade Comparatios

The View Employee Grade Comparatio window compares the compensation values you enter for employees with the minimum, maximum, and mid values you define for their grades.

Prerequisites

- Define a grade rate and enter minimum, maximum, and mid values for each grade.
- Enter salary or other compensation values for your employees.

To view employee grade comparatio values:

1. Select an element, an input value, and a grade.

   The inquiry finds assignments that are on this grade and that have an entry for this input value.
2. Select a grade rate for which you have defined a range of valid values.

The inquiry compares the minimum, maximum, and mid values for your chosen grade with the element entries of the list of assignments.

3. Choose the Find button to run the inquiry.

The folder in the lower part of the window lists the assignments that match your selection criteria:

- The **value** is the element entry value for each assignment.
- The **comparatio** shows the assignment’s element entry as a percentage of the mid–value defined for the grade rate.
- The **percent of range** shows the position of the assignment’s element entry between the minimum value for the grade rate (0%) and the maximum value (100%).

**Part Time Employees**

Employee are part time if the hours on their assignment’s standard conditions are less than the work day hours entered for their organization. For part time employees, the system prorates the minimum, maximum, and mid grade rate values before calculating the comparatio and percent of range.
Relating Pay to Grades Indirectly: Using Pay Scales

If you are involved in negotiating pay levels with staff or union groups, you may be using a system of grade steps or points with specific values of pay for each step, or point. For example, you may have negotiated different pay scales with different union groups. Or, you may have negotiated a single set of pay points for all of your employees.

Typically, employees are placed on a step within their grade. They move up the steps for the grade by a periodic incrementing process. This process might run automatically at a fixed time each year or it might be based on a review process specific to the employee.

In Oracle HRMS you set up a pay scale to show the separate points and the value negotiated for each point. You can set up any number of pay scales, for example for negotiated pay scales with different unions.

Setting Up Pay Scales

To set up a pay scale:
1. Create the pay scale itself, which is a set of progression points.
2. Define one or more rates associated with the pay scale, entering a value for each progression point.
3. Define your grade scales, which are the points of the pay scale that are valid for each grade.

You can define the rates before or after you define the grade scales.

Using Pay Scales

You manually place an employee on the appropriate grade step. You can use a process to automate the periodic incrementing of the grade step placements for some or all employees.

See Also

Incrementing Grade Step Placements: page 4 – 18
Placing an Employee on a Grade Step: page 4 – 17
Defining a Pay Scale

You define a pay scale, which is a set of progression points for compensation, in the Pay Scale window.

![Pay Scale Window]

To define a pay scale:

1. Enter a unique name for the pay scale.
2. Enter the Increment Frequency for this pay scale. For example, if you want to increment the placement of assignments on the pay scale once each year, enter 1 in the Number field and select Year in the Per Period field.

   **Note:** These values provide information only. You can use the Submit Requests window to set up automatic regular incrementing of grade step placements by the Increment Progression Points process.

   See: Incrementing Grade Step Placements: page 4 – 18

   The Automatic Increment field shows the date of the last automatic increment.

3. Save the pay scale.
4. Enter the names of the points (or steps) of the scale. The Point names can be numeric or alphanumeric. Enter them in ascending order.
5. Enter a sequence number, in ascending order, for each point. The sequence determines the progression order for the incrementing process. Then save the scale again.

**Suggestion:** Enter sequence numbers in multiples of 5 or 10, for example 5, 10, 15, 20. This makes it easier to enter new points between existing points in the sequence if you need to in the future.

---

**Defining Scale Rates**

In the Scale Rate window, you can create a rate and enter a fixed value for each progression point on a pay scale. You can create as many rates as you require, such as one for a shift allowance, and another for overtime. Notice that, unlike grade rates, you can only enter a fixed value for each point; you cannot enter a range of valid values.

The values are datetrack so that you can keep the history of the actual values you use. You can also set up rate values at a future date and be sure that this information will automatically take effect on the date you set, and not before.

The rates can be defined in monetary units, or as integers, numbers, days, or hours, in various formats. For example, you could define a rate in hours to specify the maximum number of overtime hours that can be worked per week.

When you define rates, an automatic process creates corresponding *database items* that formulas can access.

See: Dynamic Database Items: page C – 19
To create a scale rate:

1. Set your effective date early enough to handle any historical information you want to enter.
2. Enter a unique Name for the rate.
3. Select the Units for measuring the rate, such as hours, money, or integer.
4. Select the Pay Scale for which you are defining the rate.
5. Save the rate.
6. In the Progression Point Values block, select the points for which you want to define rates. For each point, enter a fixed value. Save the rate again.

Relating Grades to Progression Points

A pay scale defines a complete set of progression points. You can associate a subset of these points with each grade.

The group of points valid for a grade is called a grade scale. Each point in the grade scale is called a step because it represents the steps for incrementing an employee’s pay. The steps must follow the sequence of points on the pay scale but they can jump several points, if appropriate to the specific grade.

<table>
<thead>
<tr>
<th>Pay Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td>Point</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>20</td>
</tr>
<tr>
<td>30</td>
</tr>
<tr>
<td>40</td>
</tr>
<tr>
<td>50</td>
</tr>
<tr>
<td>60</td>
</tr>
<tr>
<td>70</td>
</tr>
<tr>
<td>80</td>
</tr>
</tbody>
</table>

Figure 4 – 4
Grade Scales
To create a grade scale:

1. Set your effective date early enough to handle any historical information you want to enter.

2. Select a grade, and select the pay scale from which you want to choose progression points.

3. Select the highest point (or ceiling) to which employees on this grade can be automatically incremented by the Increment Progression Points process. Save the grade scale.
   
   You can override this ceiling for individual employee assignments.

4. In the Grade Steps block, select the points you want to include on this grade scale.
   
   When you save, the system sorts the points into ascending order by their sequence numbers (defined in the Pay Scale window).
Placing an Employee on a Grade Step

If you include a grade as part of an employee’s assignment, you can place the employee on a step on the associated grade scale.

You place an employee using the Grade Step Placement window. When you open this window, information about the grade and scale appears automatically. By default, the ceiling point is the one you defined for the grade. However, you can enter a special ceiling point for individual employees in the Assignment window.

To place an employee on a grade step:

1. Set your effective date to the date when the placement should come into effect.
2. Select the point or step on which to place the employee assignment.
3. If you want the employee’s placement to increment automatically when you run the Increment Progression Points Process, check Auto-Increment.
4. You can select a reason for manually entering a placement. You can add values to the list of valid reasons by defining values for the QuickCode Type PLACEMENT_REASON.
5. Save your work.
The Progression Point Values block displays the rates you have defined for the pay scale, and the values corresponding to the selected progression point.

## Incrementing Grade Step Placements

You can increment grade step placements manually, using the Grade Step Placement window, or automatically, by running the Increment Progression Points process.

### To run the Increment Progression Points process:

1. Navigate to the Submit Requests window.
2. In the Name field, select Increment Progression Points.
3. Enter the Parameters field to open the Parameters window.
4. Enter the name of the pay scale.
5. Enter the date on which the increment becomes effective.
6. You can also enter values for some or all of the segments of your People Group Flexfield. This restricts the assignments incremented by the process to those in the group matching the values you enter.

**Attention:** An assignment’s grade step placement is incremented automatically only if:

- it is still below the ceiling point, and
- the automatic increment check box on the Grade Step Placement window is checked for the assignment, and
- there are no future changes or deletions to the assignment’s grade step placement, or to the assignment itself, or to the grade scale for the assignment’s grade, or to the new grade step for the assignment.

Oracle HRMS supplies two predefined reports to help you predict and check the results of the Increment Progression Points process.
Current and Projected Progression Point Values Report

Run this report before running the Increment Progression Points process, to assess its effects. The report shows what changes would be made by the process and how much it would cost for a particular scale rate, such as salary, or for all rates.

You run reports in the Submit Requests window.

► To run the Points Values Report:
1. In the Name field, select Current and Projected Progression Points Values Report.
2. Enter the Parameters field to open the Parameters window.
3. Select a Pay Scale and enter the date on which the increment would become effective.
4. You can also select an organization, a group, and a rate, to reduce the scope of the report.
5. Choose the Submit button.

Employee Increment Results Report

Run this report after running the Increment Progression Points process. This report shows the results of the process.

You run reports in the Submit Requests window.

► To run the Employee Increment Results Report:
1. In the Name field, select Employee Increment Results Report.
2. Enter the Parameters field to open the Parameters window.
3. Select a Pay Scale and the increment process run for which you want to see the results.
4. You can also select an organization, a group, and a rate, to reduce the scope of the report.
5. Choose the Submit button.
Payrolls and Other Employee Groups

This chapter explains how to set up payrolls to pay your employees and to define groups of employees who are eligible to receive particular compensation and benefit elements. It also explains how to define payment methods for paying employees and making third party payments.

Using all the work structures you set up, you can identify groups of employees by organization, job, position, grade, employment category, salary basis, or payroll. Additionally, you may need to set up your own groups, for example to identify employees within a trade union, or a pension group. This chapter explains how you can set up your own groups using the People Group Key Flexfield.
Representing Payrolls

In Oracle Payroll you set up payrolls to pay your employees. An employee must have an assignment to a payroll in order to receive pay. Both human resources and payroll users can also use payrolls for other purposes:

- to identify specific groups of employees for inquiry or reporting purposes
- to define eligibility for certain compensation elements
- as part of security definitions, to restrict access to the records of certain groups of employees on the system.

**Note:** You must define payrolls in order to use nonrecurring elements. You can use these elements to represent types of compensation and benefits, and to maintain absence balances for your employees.

See: Element Entries: page 12 – 11

You can define as many payrolls as you require to represent groups within your workforce. You might need to define multiple payrolls for the following reasons:

- You require different payment frequencies (weekly or monthly) for different groups of employees.
- Your enterprise has registered more than one PAYE scheme.
- You need to restrict access to certain payroll information for reasons of confidentiality.
Each payroll has its own processing calendar, key dates, costing information, tax details and available payment methods.

**Defining Payment Methods for the Enterprise**

Oracle HRMS provides three possible payment method types. These are BACS, cheque and cash.

Within these payment method types, you can define as many payment methods as you require for your enterprise. When you create a payroll you can select which of these methods are valid for employees assigned to that payroll. You select one of these methods as the default method for the payroll.

Employees can be paid by one or more of the valid methods for their payroll. You select the appropriate methods and enter bank account information, if required, in the Personal Payment Method window. If you do not enter any personal payment methods, the employee is paid using the default method for his or her payroll.

You can also define payment methods for third party payments, such as court-ordered wage attachments. Third party payments are always made by check, so methods for these payments must have the type Check.

Define payment methods for the enterprise in the Organizational Payment Method window.

**To define a payment method:**

1. Set your effective date to the date you want to begin using the payment method.
2. Enter a name for the payment method, and select its type.
   You can create as many payment methods for each type as you require. For example, if you have different source bank accounts for different payrolls, you must create separate payment methods.

3. The base currency for the Business Group appears. For some payment methods, you can select another currency.

4. Select the Third Party Payment check box if this method is for making payments to third parties, for example for employee benefits or court–ordered deductions.

5. Enter the Bank Details field to open the Bank Details window. Enter information about the account from which payments are coming.

6. Enter further details for BACS Tape in the Further Information descriptive flexfield.
   BACS User Number is required.
   Enter bureau details only if your enterprise uses a payments bureau.
   In the two Limit fields, set maximum values for the total payment and for each individual transaction. These are BACS security procedures.
   The Contra narrative is text you enter to further identify the file of transactions being sent to BACS. It appears on the Contra record and on the Acceptance Advice received from BACS as confirmation that the data has been accepted.

7. Save your work.

See Also

Entering Payment Methods for an Employee Assignment: page 11 – 19
Defining a Payroll

A payroll is a set of employees whose pay you process with a single frequency, for example, weekly or monthly. You can define as many payrolls as you require to meet the pay policies of your enterprise. You put an employee on a payroll by assigning him or her to the payroll. Use the Payroll window to define a payroll, including its calendar and valid payment methods.

Period Types and Calendars

Since a payroll has only one pay frequency, you must define at least one payroll for each pay frequency you use. Table 5–1 shows the valid period types for pay frequency.

<table>
<thead>
<tr>
<th>Payroll Period Types</th>
<th>Periods per Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year</td>
<td>1</td>
</tr>
<tr>
<td>Semi–Year</td>
<td>2</td>
</tr>
<tr>
<td>Quarter</td>
<td>4</td>
</tr>
<tr>
<td>Bi–Month</td>
<td>6</td>
</tr>
<tr>
<td>Calendar Month</td>
<td>12</td>
</tr>
<tr>
<td>Lunar Month</td>
<td>13</td>
</tr>
<tr>
<td>Semi–Month</td>
<td>24</td>
</tr>
<tr>
<td>Bi–Week</td>
<td>26</td>
</tr>
<tr>
<td>Week</td>
<td>52</td>
</tr>
</tbody>
</table>

Table 5–1 Payroll Period Types

Prerequisites

- Define the payment methods available for your employees.
- If you need more than one consolidation set for payroll processing, define these sets.

See: Consolidation Sets: page 18–17
To create a new payroll:

1. Set your effective date to a date early enough to handle any historical information you want to enter. Your effective date must be on or before the first period start date of the payroll calendar.

2. Enter the payroll’s name and select its period type from the list.

3. Enter the end date of the payroll’s first period, and the number of years for which the system should initially generate the payroll’s calendar. You can increase this number later to generate additional years.

   When you enter the First Period End Date, make sure that the corresponding start date of the first period is after the start date of the payroll.

4. Enter any date offsets you require for the payroll. Offsets are calculated from the last day of the payroll period. As UK legislation requires all offset dates to be within the payroll period, your choice is between a negative integer, such as –2, and zero, which is the default. You can specify offsets for:

   • the normal payment date: this is the effective taxpoint date for the period which determines statutory processing
   • the BACS processing date: the date you specify appears on the BACS header and is the effective date of the BACS process
   • the date you issue pay advices: this date appears on your pay advices
   • the cut off date for entries to the current payroll period: this is informational
These offsets are the defaults for the calendar. You can manually make date changes in the calendar, for example when an offset date falls on a weekend or holiday, by choosing the Period Dates button.

5. Select a default payment method for employees who have no valid personal payment method. You cannot select a method using magnetic tape because this requires information about employees’ bank accounts.

6. Select a default consolidation set for this payroll. One consolidation set is created automatically when you define your Business Group. Oracle Payroll users can create other consolidation sets for payroll processing.

7. In the Costing region, you can enter information about the set of books and suspense account holding costing information for this payroll.

The information you enter here depends on the setup of your Cost Allocation key flexfield.

See: Setting Up the Cost Allocation Key Flexfield: page 6 – 3

8. Check the Arrears Payroll checkbox if you want to use Advance Pay for an arrears payroll. You do not need to check the box just to run an arrears payroll.

See: Advance Pay Process (Oracle Payroll UK User’s Guide)

9. Check the Negative Payment Allowed checkbox if you want the pre–payments process to include negative payments. If you leave the box unchecked, pre–payments ignores negative payments.

10. If you are an Oracle Payroll user, enter the Statutory Information field to open the Statutory Information window.

**Note:** The Statutory Information field is not visible if your HR:User Type profile option is set to HR User.

- **Tax Reference:** Each payroll has a separate tax reference number that is recorded on statutory reports.
- **Permit Number:** This is the DSS permit number for sending end of year returns on magnetic tape.
- The payment of holiday pay in advance and the method of calculating National Insurance within your enterprise are determined by your business rules.
- **HM Forces:** HM Forces establishments should enter Yes to enable Oracle Payroll formulas to process NI at the appropriate Forces rate. Other enterprises enter No.
- **BACS Payment Rule:** Select either Next banking day or Previous banking day. This becomes the alternative payment day when BACS payments fall due on a weekend or public holiday.
• **SMP Recovered**: At the end of each year you enter the amount of SMP to be recovered for the year.

• **SMP Compensation**: At the end of each year you enter the additional amount you can claim under small employer's relief for SMP, if applicable.

• **SSP Recovered**: At the end of each year you enter the amount of SSP to be recovered for the year.

  **Note**: The information you enter in these last three fields appears in the End of Year report. Enter the amounts as figures only in the form you want them to appear in the report, for example, 1000.00.

11. Save your work.

12. Choose the Period Dates button to view the calendar generated for your payroll. In the Period Dates window:

   • You can view the default offset dates for every period, and you can manually override any of these dates in any record.

   • You can change the payroll’s default Open status in any period to Closed to prevent further element entries. You can also reopen the period if necessary.

  **Attention**: Use this feature with caution. When you perform certain important tasks in Oracle HRMS, the system may automatically create or delete element entries. These tasks include hiring and terminating people, and updating assignments. You cannot change any element entries that span a closed payroll period, and so you may be prevented from performing these tasks.

13. Choose the Valid Payment Methods button to add valid payment methods for this payroll.

   In the Valid Payment Methods window, the default payment method for the payroll appears automatically. You can add other methods. First set your effective date to the date you want the method to become valid.

   **Note**: An employee assigned to this payroll can have any number of personal payment methods chosen from those you enter here for the payroll.

   See: Entering Payment Methods for an Employee Assignment: page 11 – 19
Deleting Payrolls

You can delete a payroll if there are no active employee assignments or element links to it. However, if you have run processing for a payroll it is not advisable to delete it. If necessary, define a new payroll and simply discontinue use of the old payroll.
Representing Other Employee Groups

All the work structures provide ways of defining groups of employees at your enterprise, such as groups working at a particular location, or on a certain grade, or in a department. You create the groups by assigning employees to the work structures in the Assignment window.

You can also assign people to:

- an employment category: full-time – regular, full-time – temporary, part time – regular, or part time – temporary
- a salary basis, such as weekly or annual, which defines the duration for which the employee’s salary is quoted

See: Components of the Assignment: page 11 – 5

Oracle HRMS provides a special structure you can use to define any other special groupings of employees your enterprise requires. This structure is called the People Group. Just as with payrolls and other work structures, you can assign employees to these groups, and use them to define employee eligibility for compensation and benefits elements.

Examples of group definitions might be:

- members of a union
- members of a pension plan.

Setting Up the People Group Flexfield

The People Group is a key flexfield, like Job Name, Position Name, and Grade Name. As with these other key flexfields, you can define up to 30 segments to hold information you use to identify employee groups in your enterprise.

Using the People Group key flexfield to define your groups is a powerful mechanism because you can:

- link elements to Group flexfield segments so that only employees within the group are eligible for the elements
- inquire and report on individual segments in Inquiry windows and in reports
- use DateTrack to build up a history of the group information

If your enterprise uses pay scales to relate compensation levels to grades indirectly, you can use a People Group segment to specify which employees are processed by the Increment Progression Points process.
Once you decide how to define the Group key flexfield structure and segments, it is the responsibility of the System Administrator to set up this and the other key flexfields. At least one segment of this flexfield must be set up before you can begin entering employee assignments.

**Attention:** If you make any of the People Group segments required, they are required in the Element Link window, as well as the Assignment window. This means that you may have to create multiple element links if you want to use a People Group segment in the eligibility criteria for a link.

For example, suppose you have defined two segments: a Yes/No segment called Fast Track, which is required, and a segment called Pension Plan, which is not required. You want to make an element available only to members of a certain pension plan. However, you must create two element links: one for members of the pension plan who are on the Fast Track, and another for members who are not on the Fast Track.

If there are many possible values for the required segment, the maintenance of multiple links can become a burden so be cautious in making segments of this flexfield required.

**See Also**

*Oracle Applications Flexfield Guide*
In any human resource environment you must be able to enter the labor costs associated with your employees. This chapter explains how you can use the Cost Allocation key flexfield to set up the account and cost centers against which you want to collect costs, and the levels at which the costs should be recorded. If you use Oracle Payroll, you can automatically accumulate these costs after a payroll run.
Costing in Oracle HRMS

In Oracle Human Resources, you can:

- estimate current labor costs from the compensation definitions you have entered on the system
- project future labor costs by modelling organizational change and salary reviews
- allocate costs to cost centers and project codes at any level, from the organization to individual element entries for assignments
- allocate costs to account codes for transfer to the General Ledger

However, the accurate accumulation of labor costs can only be done following a payroll run. Using Oracle Payroll, you can run the supplied Costing process to accumulate actual payroll costs under the headings you set up in the Cost Allocation flexfield. You can run another supplied process to transfer the costs to accounts in Oracle General Ledger.

If you do not use Oracle Payroll or Oracle General Ledger, you need to consider how the salary information and cost codes you enter in Oracle Human Resources relate to your payroll and financial systems where real costs are recorded.

In a human resource system, there are typically three types of heading under which you want to collect labor costs:

- account codes, to transfer earnings and deductions to the appropriate General Ledger accounts
- cost centers, to show the costs of particular departments
- project (or product) codes, to transfer costs to a project management or labor distribution system

You set up each of these types, and any others required by your enterprise, as segments of the Cost Allocation key flexfield.

See Also

Costing Process: page 17 – 31
Setting Up the Cost Allocation Key Flexfield

You must define at least one segment of the Cost Allocation key flexfield; you can define up to thirty. You can define a list of valid codes or values for each segment. If you plan to transfer costing information to Oracle General Ledger, you should set up at least one segment of the Cost Allocation key flexfield that maps onto segments of the Oracle General Ledger Accounting key flexfield.

Users can enter values in the flexfield segments in the following windows:

- Costing Information (for an organization)
- Payroll
- Element Link
- Costing (for an assignment)
- Element Entries

You decide which segments of your flexfield appear in which window. For example, suppose you define a Cost Center segment. You may want it to appear in the Costing Information window for the organization, so that users can associate one cost center with each organization. You may also want it to appear in the Costing window for the assignment so that users can override the organization’s cost center code for employees who do not spend all their time working for one organization.

Notice that you can override a code entered at a higher level by a code entered at a lower level. For example, if an employee normally works on Project 501, you enter this code at the assignment level. If the employee works temporarily on Project 602, you can allocate some of the assignment’s costs to that code at the element entry level for one or more pay periods.

You define which flexfields segments appear in which windows by qualifying each segment with the levels at which it should be displayed. Table 6 – 1 lists the six levels and the types of segment that are typically displayed for user entry at each level.

<table>
<thead>
<tr>
<th>Level</th>
<th>Qualifiers for this Level</th>
<th>Typical Segments Displayed at this Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>Organization</td>
<td>cost centers</td>
</tr>
<tr>
<td>Payroll</td>
<td>Payroll</td>
<td>company code, set of books</td>
</tr>
<tr>
<td>Element Link</td>
<td>Element, Balancing</td>
<td>GL account codes for costing and balancing</td>
</tr>
</tbody>
</table>

Table 6 – 1 Choosing Where To Display Segments
Typical Segments Displayed at this Level

<table>
<thead>
<tr>
<th>Level</th>
<th>Qualifiers for this Level</th>
<th>Typical Segments Displayed at this Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment</td>
<td>Assignment</td>
<td>project or product codes, or cost centers that do not map onto organizations</td>
</tr>
<tr>
<td>Element Entry</td>
<td>Element Entry</td>
<td>project or product codes (for employees who submit timesheets)</td>
</tr>
</tbody>
</table>

Table 6–1 Choosing Where To Display Segments

See Also

*Oracle Applications Flexfields Guide*

**Setting up Earnings and Deductions for Cost Collection**

If you want to collect earnings and deductions costs for transfer to General Ledger accounts, you must set up a segment of the Cost Allocation key flexfield with a name such as GL Account, and with the qualifier Element set to Yes. If you want to be able to override the account codes for elements at the assignment or element entry level, set these qualifiers to Yes also.

Define your account codes as valid values for this segment. If you use Oracle General Ledger, you should use the same set of values when you define the GL flexfield called Accounting.

**Suggestion:** If you are not using Oracle General Ledger you could set up your own table of financial codes and values and use *Table Validation* for your cost headings. You can set up a table in the Table Structure window.

You could also consider populating this table from your existing financial systems.

See: User–defined Tables: page 20 – 9

If you want to do double entry accounting, you should also set the qualifier Balancing to Yes. This allows you to enter two account codes for each element link: one to credit and one to debit. You enter these codes in the Costing and Balancing fields in the Element Link window.
Setting Up Organizations for Cost Collection

If you want to collect organization costs for allocation to a cost center, you must set up a segment of the Cost Allocation key flexfield with a name such as Cost Center, and with the qualifier Organization set to Yes. If you want to be able to override the cost center codes at the assignment or element entry level, set these qualifiers to Yes also. Define your cost centers as valid values for this segment.

Then, when setting up an organization, you can specify the cost center to which the earnings and deductions of all employees in that organization should be allocated.

Setting Up Assignments for Cost Collection

When you choose a cost center for an organization in Oracle Human Resources you are saying that the payroll costs of employees in the organization default to that cost center.

This works well if each organization equates to one cost center. However, there may not be a one-to-one relationship between your organizations and your cost centers.

Some employees may regularly work for fixed amounts of time in two or more cost centers. To handle these employee assignments, you need to set the Assignment qualifier to Yes for the Cost Center segment of the Cost Allocation key flexfield. This allows you to enter multiple Cost Centers in the Costing window for the Assignment. You can also enter the proportion of time worked in each center.

For example, if someone works half time in PR and half time in Sales, you can enter 50% for each. This indicates that you should collect half of the employee’s payroll costs against each cost center.
Notice that costing entries for assignments are datetracked so you can enter changes ahead of time.

**Note:** Information you enter in the Costing window for the assignment should override any information entered for an organization. If you use Oracle Payroll this happens automatically.

**Mapping the Cost Allocation Flexfield to the GL Accounting Flexfield**

If your installation includes Oracle Payroll and Oracle General Ledger, you can run the Transfer to GL process in each payroll period, after you have run the Costing process to calculate payroll costs.
For each payroll for which you want to transfer costing information, you must map segments of the Cost Allocation key flexfield onto segments of the Oracle General Ledger Accounting key flexfield. This enables the transfer to be made directly to the general ledger accounts, not just to the interface table.

You specify this mapping in the GL Map window, provided Oracle General Ledger is fully installed.

**Prerequisites**

- Set up of the Cost Allocation key flexfield in Oracle Payroll.
- Define your sets of books and Accounting key flexfield segments in Oracle General Ledger.
- Check that your Oracle Payroll currency codes match the Oracle General Ledger currency codes. If necessary, use the international set of currency codes to make sure they do.

**To map Cost Allocation segments to Accounting segments:**

1. Set your effective date to the date when the mapping should take effect.
2. Query the payroll for which you want to transfer costing information to the general ledger.
3. Select the general ledger set of books to which you want to transfer the payroll information. Costing information from a payroll can go to only one set of books. The payroll and set of books must have the same currency code.
4. Select a Cost Allocation flexfield segment and a corresponding GL Accounting flexfield segment. Repeat this for all the Cost Allocation segments for which there is a corresponding segment in the Accounting flexfield.
5. Save your entries.
Each enterprise has its own unique ‘culture’, which is reflected in the organization of work and in the management of people within the enterprise. Culture also affects the reward systems in operation and the control systems that are required. Although each enterprise is unique, it is possible to identify some common types of enterprise.

This chapter describes three typical enterprise models and suggests how you might implement Oracle HRMS for each of these.

These suggestions are not intended to provide a blueprint for your own implementation, but they should help you to see how you can implement and use different combinations of organizations and jobs, or positions in your own situation.
Project Based Enterprises

Project based enterprises are typically service based industries in which flexibility and organizational change is a key feature. Examples of this type of enterprise are consultancy or construction companies, or small manufacturing or software companies.

At its simplest level, an employee is assigned to work on a single project for a given period of time. For example, an engineer working on a large scale construction project might be assigned to the project for a period of six months. All of his or her work, and costs, are associated with this one project. When this is complete the employee moves on to perform a similar role in another project. In this example you would expect the employee to have a single assignment, with 100% of the assignment costs allocated to a single project. The employee assignment might also contain project specific information, such as location or group information.

In a different situation, an employee might be assigned to a number of projects at the same time. For example, consider an Applications Consultant working for Oracle Corporation. This person is employed as a consultant by a specific organization within Oracle but the project work is undertaken outside Oracle. The consultant performs similar tasks in different implementation projects, and costs are allocated on the basis of actual time spent working on each project. In this example you would expect the consultant to have a single assignment in Oracle HRMS and the project allocation and costs to be entered as timecard information.

In both of these examples, employees perform specific roles, but they work on different tasks or projects at different times. Project based enterprises normally have a fluid organization structure with regularly changing reporting and management lines. This fluidity provides the flexibility required to compete in rapidly changing markets.

Organizations can be formed or transformed at short notice as different projects or management groups are formed. Employees can be assigned and reassigned to these organizations, also at short notice, although they normally retain their basic role, or job.

Representing Organizations and Jobs

In both of the examples given, you need the ability to define and change organization structures easily and quickly. You also must be able to move employees between organizations while keeping the same job. For both of these reasons, you would probably use organizations and jobs to show how people are assigned and managed.
Jobs are independent of organizations. In the Assignment window, you can change the assignment organization or job independently.

Typically, you would not define Positions to show this type of working. Positions require additional definition and maintenance, and do not reflect the sort of flexible working environment found in this type of enterprise.

Working with organizations and jobs as the basis of the employee assignment, you can also consider how you would reflect the assignment of the employee to individual projects. There are a number of possible options to consider.

- Use organizations to show actual projects, and assign employees to projects.
  - Useful for single projects. For multiple project assignments you would need to use multiple assignments.

- Use a People Group flexfield segment to hold the project code.
  - An alternative for single projects, where you want to use the organization to show internal management structures. However, for multiple project assignments you would still need to use multiple assignments.

- Use a Cost Allocation Flexfield segment to hold the project code.
  - Useful for both single and multiple project assignments. You can collect project cost information at the work assignment or the timecard entry level.

**Organization Structures**

You should define organizations down to the level of individual managers, and use the manager flag on the Assignment window to identify the manager of each organization. Also, define your primary organization hierarchy to show the detailed management reporting lines among organizations and managers. In this way you can show that employees assigned to an organization are managed by the organization’s manager.
Attention: It is best not to use the Supervisor field of the assignment window to identify managers for individual employees. This field is used to identify a personal supervisor for an employee and is not updated if the supervisor moves to another job or organization.

Job Structures

In this type of environment, jobs show the specific roles employees perform. Therefore, you are likely to have multi-segment job names to distinguish different types and different levels of jobs in the enterprise. For example, you might define a three segment job name with Job Group, Title, and Job Level. An actual job combination might then be ‘Applications.Consultant.Senior’.

Project Allocation and Costing

With this type of implementation, you would probably use the assignment to identify management type reporting. You would identify project-working using a segment of the Cost Allocation flexfield to show Project Code for each assignment.

If you set the qualifier Assignment to Yes for this segment, you could enter percentage costs for the assignment to different project codes. If you set the qualifier Element Entry to Yes for this segment, you could use a timecard element to record and cost the actual hours worked on each project.

See: Setting Up Assignments for Cost Collection: page 6 – 5

Other Management Issues

When you consider this environment there are other areas your decisions may affect:

Remuneration Policies

Individual compensation and benefits are often based on personal negotiation, or performance reviews. Therefore you will probably have fewer rules to determine policy and more consideration of the actual values entered for an employee.

Grades and Jobs

Typically grades and jobs are very closely linked. For example, the name Senior Consultant may identify both the role of an employee and his or her relative status and eligibility for compensation and benefits.
You may decide to set up the same structures for both the job and the grade. This will be true if you want to set up rates of pay with minimum and maximum values associated with your grades.

**Budgets**

Headcount budgets are usually allocated at the level of the organization, or to the combination of organization and job.

You can calculate your salary budgets from the definition of organization and job headcount budgets, combined with valid grades and grade rate information.

Actual salary costs in an HR environment can be calculated from the actual salaries of assigned employees.

Actual salary costs in an environment including Oracle Payroll can be calculated directly from payroll results.

See: Salary Budgeting: page 14 – 18

**Vacancies and Recruitment**

Vacancies are not created by default whenever an employee leaves. Managers often have the freedom to decide if they want to replace an employee, or to recruit to a different role.

The recruitment process is often informal and allows for recruitment by resume, or cv. Individual managers are usually responsible for interviewing and selecting candidates. This may be on a one–to–one basis.

**Career Planning and Development**

The need for individual career planning and development is matched by the need to identify skilled employees for specific projects.

Using Special Information Types you can easily define experience, education, qualifications or skills requirements for different jobs. Using these sane information types you can enter information under these headings for individual employees. Oracle HRMS includes a skills matching report.
Rule Based Enterprises

The rule–based enterprise is typically a highly structured environment in which all aspects of work and remuneration are well organized and regulated. Common examples of this type of enterprise are found in government, education, health and other public sector industries. A key feature of this type of enterprise is the concern with managing positions, or posts. Positions exist, and are managed independently of people in post.

You can picture the role type organization as a ‘Greek temple’, which rests its strength in its pillars. These pillars are the specialist functions or departments that exist within the enterprise. They are strong and almost independent organizations. For example, the Finance department would have very little involvement in the working of the HR department.

Coordination between the groups takes place at the top of the structure by a narrow band of senior management – the pediment. In this environment it is assumed that this should be the only personal coordination needed. “If the separate pillars do their job, as laid down by the rules and procedures, the ultimate result will be predictable.”

Roles are usually more important than individuals. People are selected for satisfactory performance of a role, which is described so that a range of individuals could fill it. Reward systems are likely to be role or rule–based.

Often, clearly defined procedures exist for every task and process within the enterprise. For example, job descriptions and job evaluation procedures define individual roles and positions of authority. Also, it is common to find that procedures exist to govern communications, such as colored and numbered forms, committee reports, and so forth.

Representing Positions

‘Positions’ are most appropriate for this type of enterprise and provide the finer detail on work structure and line management that is needed in a fixed establishment. Employees are assigned to a position, and by definition to the organization and job for that position.
Because you are focussing on the use of positions and position hierarchies you define organizations to show only the major divisions in your enterprise. You can model the details of these departments and sections using your position hierarchies. (If you also define detailed organizations and hierarchies, you are defining the same structural information twice.)

In this situation, jobs provide an additional level of information for positions, which is independent of any specific organization. For example, you might want to define job types of 'Managerial', 'Executive' or 'Clerical' so that you can identify skill requirements and levels of benefits for each job.

**Position Name**

In this environment you should consider using the segments of the position name to hold other key information about the position. For example you might want to consider using the following as segment values:

- **Cost Code**
  
  You might want to show the cost center, or a cost code for each position in your establishment. Using the segment of the key flexfield you could use the same list of cost codes as your general ledger.

- **Funding Organization.**
  
  You might have funding for a position from an external source. For example, government funding.

- **Multiple assignments allowed – Y/N?**
  
  In Oracle HRMS a position can have any number of holders. You can set headcount budget values to track any variance on budget, or you could use this type of segment to prompt users.
• Current status.

As part of your position control procedures you may need to mark the status of a position for reporting or management purposes. For example, you can label a position as ‘Frozen’, ‘Vacant’ or ‘Active’.

Note: You can use the Additional Position Details descriptive flexfield to hold this type of information about positions if you do not want the information to be visible to all users.

Management Reporting Lines

You can define a primary position hierarchy to show the management reporting lines for all of your positions. You should find that most of your security and reporting needs are based on this primary hierarchy. Groups are identified by selecting a manager and all the positions that report to it in this hierarchy.

Other Management Issues

When you consider this environment there are other areas your decisions may affect:

<table>
<thead>
<tr>
<th>Remuneration Policies</th>
<th>Individual compensation and benefits are often regulated, or based on union negotiated agreements.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Reward systems are usually based on the role performed rather than on personal or performance assessment. This may mean that you have to define detailed eligibility rules for compensation and benefits.</td>
</tr>
<tr>
<td>Comparative Grades and Positions</td>
<td>Valid grades are defined for positions and it is common to use grade steps and progression points.</td>
</tr>
<tr>
<td></td>
<td>National or union pay scales establish actual rates of pay for a grade and this is independent of performance. An employee is paid the rate for his or her grade and step. Incrementing rules, which determine progression to the next step, are usually part of the plan and are often time–based.</td>
</tr>
<tr>
<td></td>
<td>Job evaluation methods exist to compare roles across the industry with agreed grading structures and rates of pay.</td>
</tr>
<tr>
<td>Budgeting</td>
<td>Headcount or full–time equivalent budgets are usually set for each position.</td>
</tr>
</tbody>
</table>
You can calculate your Salary budgets from the position budgets, combined with valid grades and progression point information.

In an HR environment you would calculate actual salary costs, at any time, from the current salaries of assigned employees.

In an environment including Oracle Payroll, you would calculate actual salary costs directly from payroll run results.

See: Salary Budgeting: page 14 – 18

**Vacancies and Recruitment**

There is an automatic vacancy when an employee terminates employment. The position exists even when there are no holders.

The stages of the recruitment process and the procedures surrounding these are probably well defined and regulated.

Standard letters for each stage of the process are also likely to be well established.

In this environment people are recruited for their ability to perform a role. You would hold job descriptions and skill requirements for each position using attachments for text and the Special Information Type for structured data.

**Standard Reports**

Typically there is a well defined set of standard reports needed in this environment. Often these are required by government.
Hybrid Enterprise Structures

Many enterprises combine different types of structure for different groups of employees. Typical of these hybrid types are large manufacturing or corporate enterprises where management and administrative roles are fixed into specific organizations, but other roles are managed in a more flexible manner.

In Oracle HRMS you would set up this type of hybrid enterprise using positions for some groups of employees, and organization and jobs for others. For example, in one factory organization you might define a position for the Production Manager, and one job for all production line workers.

Employee Assignments

In this type of enterprise most of your workers would be assigned to an organization and a job. However you would define management positions because they have the characteristics of fixed roles within specific organizations, including the idea of automatic vacancy on termination of the assignment. In each organization you would have only one position. This would be the manager, and by default, any other employee who works in the organization would report to the manager.

Other Management Issues

Other issues for managing groups of employees by position, or by organization and job are the same as for the previous examples.
**Remuneration Policy**

Employees working in unionized jobs participate in negotiated rates of pay and conditions. You would define grade rates or progression points to deal with negotiated pay rates for workers in jobs.

**Salary Administration**

Employees in management positions are more likely to have their salary administered personally and be reviewed on their performance. You define grade rates and salary bases to deal with salary administration for employees in positions.
Contract Staff and Other Non-standard Assignments

It is common to find individuals working within an enterprise who do not fit into the general definition of work structures. For example, you may have agency or contract staff working temporarily to cover a vacancy, or you may have external contract staff working as part of a project team.

The way in which you record information for these individuals depends on how you manage them:

• You can treat the assignment for this type of employee in exactly the same way as any regular employee.

• Alternatively, you could set up a different person type to distinguish this type of employee.

• You could define your own types of employment category to distinguish different ways of working at the assignment level.

• You could define and use your own assignment statuses to identify different ways of working in a particular job or position.

However, you might decide that the person does not work in a predefined role, but is simply working in a particular organization for a set period of time. To do this you would assign the employee to an organization only, and focus on the other assignment information for further information.

Attention: A basic rule in Oracle HRMS is that an employee must have an assignment. The minimum work structure required for an assignment is the Business Group.
This chapter focuses on three aspects of setup that affect how you record and track people in your system:

- **Person Types** – choosing the types of people you need to identify and the sorts of information you want to hold about each type
- **Assignment Statuses** – choosing statuses to track temporary or permanent departures of employees from your enterprise
- **Special Information Types** – designing fields to hold any special information, not provided by the main system, you want to hold about people, jobs and positions, and training activities
Person Types

In any enterprise there is a need to identify different groups of people. For each group that exists in your enterprise there may be different types of information you need to keep. You may also want to control access to the records of different groups of people.

There are three basic types of people for whom you maintain information in your human resource system. These are:

- Employees, both current and ex-employees
- Applicants, both current and ex-applicants
- External people

A special category of the External type is contact. A contact is someone associated with an employee or an applicant.

For example, you may want to record the name, address and phone number of an emergency contact for every employee. Or, you may need to keep information on dependents of an employee for medical insurance purposes, or for calculation of additional payments.

Using Person Types

Oracle HRMS comes with a set of Person Types. You can change the names of these types when you install the system, and you can add your own subgroups of Person Types. For example, you might have two types of employee in your enterprise:

- Regular Employee
- Contractor

You can define these as subgroups of the Employee person type to:

- enable fast identification of these groups
- manage different kinds of personal information for each group
- change employees from Contractor to Regular Employee, without changing current work information

**Note:** Each employee’s assignment can be described by an employment category such as Full Time – Regular or Part Time – Temporary. So you do not use Person Types to distinguish the category of assignment.

In another example, you might want to distinguish between internal and external applicants for vacancies. You may also be involved in a redundancy program or a program of staff layoffs, and need to identify employees as preferred candidates for any vacancies. You can do this with the following subgroups of applicant:
Defining Person Types

There are eight Person Types recognized by the system, and identified by a system name. For each, there is a predefined user name. You can change the predefined name and you can enter other user names.

One user name must be the default. This is the name the system enters in certain circumstances if you do not select a Person Type manually. For example, when you hire an applicant, the system automatically updates the Person Type to the default user name for the system name `Employee`.

You enter user names for person types in the Person Types window.

First consider whether the existing user names are meaningful in your enterprise.

- **To change a user name for a person type:**
  - Delete the contents of the User Name field and type in your preferred name.

- **To map other user names to a person-type system name:**
  1. Select New Record from the Edit menu.
  2. Enter a unique User Name and select the System Name you want to map on to.
Deactivating User Names

You cannot delete user names in use in the system, but you can deactivate them by unchecking the Active check box. Notice that you cannot deactivate a default User Name. You must first select another user name as the default.

Person Types and Information Management

The system uses its Person Types to control the type of information you can enter. For example, you cannot enter earnings or deductions for an applicant. You can use Person Types in the following ways:

- To control access to people’s records on the system, according to their Person Type. For example, you might give all managers in a department access to employee records, but only give recruitment officers access to records of applicants and ex-employees.

  Your system administrator can achieve this by creating customized versions of the People window.

  See: Restricting the Data Displayed in a Window: page 21 – 3

- When you set up your own fields to hold additional information, you can tie them to particular Person Types. For example, you might want a user-defined field holding visa information for foreign workers to appear for employees and applicants, but not for other people.

  You can do this by setting up the descriptive flexfield on the People window.

  See: Adding New Fields to Windows: page 21 – 2

  **Suggestion:** If you want to define rules of eligibility for a compensation or benefits element based on the type of employee, you cannot use the Person Type directly. However, you can use Person Type in a *formula* to validate the values entered for an employee.

  Also, consider whether you can meet your needs using the assignment status and employment category to control eligibility for compensation and benefits.

  See: Components of the Assignment: page 11 – 5
**Assignment Statuses**

You use assignment statuses to track temporary or permanent departures of employees from your enterprise. Temporary departures include paid or unpaid leaves of absence that you may allow employees to take for a number of reasons. Examples may include absences caused by industrial action or jury service.

**Primary Statuses**

There are four system statuses for employee assignments:

- **Active Assignment**, used to show that the employee is working in accordance with his or her usual conditions of employment.
- **Suspend Assignment**, used to show that the employee is on leave of absence, but remains an employee of your enterprise.
- **Terminate Assignment**, used to show that your enterprise no longer employs the person in that assignment. It can still be possible to make payments through Oracle Payroll for assignments at this status.
- **End**, meaning that all payroll processing for the assignment is complete and the assignment has become a historical record. This status is not recorded on the assignment; it causes the assignment to end.

On your system, you may give these statuses different *user statuses* appropriate to your enterprise. Each system status can have several user statuses related to it. For example, for the system status Suspend Assignment, you can have the user statuses Maternity Leave, Paternity Leave, and Military Leave.

These statuses are *primary* because they determine how the system processes and manages the assignment. An assignment must have one, and only one, primary status at a given time. You enter this status in the Assignment window.

See: Entering a New Assignment: page 11 – 8

**Using Assignment Statuses to Control Compensation**

When you define user statuses, consider how you will use them in reports, inquiries, and processing.

When you use a validation formula to validate entries to element input values, you can make the valid values for an entry dependent on the assignment status.
To use the statuses to control whether the payroll run processes an employee assignment, you choose a payroll status of Process or Do not Process for each user status. Additionally, in Oracle Payroll you can set up your pay calculation formulas so that a status change also changes the formula used to calculate the employee’s pay. For example, an employee might receive half pay while on Military Leave.


**Additional Information:** Refer to your Oracle Payroll manual for information on the use of assignment statuses in the Formula Result Rules window to control the payroll formula that processes for an employee.

### Secondary Assignment Statuses

For analysis and reporting purposes, you can set up and use *secondary* assignment statuses, for both employee and applicant assignments. These statuses have no effect on assignment processing.

For example, suppose your primary status Maternity Leave applies to employees both when a child is born and when one is adopted, and you want to study its use in these two cases. To accomplish this you can set up the secondary statuses Maternity Birth and Maternity Adopt, and enter them for employees taking maternity leave.

You enter secondary statuses for an employee assignment or an applicant assignment in the Secondary Statuses window.

To enter reasons for giving secondary statuses to assignments, define valid reasons as values for the QuickCode Type EMP_SEC_ASSIGN_REASON (for employee assignments) and APL_SEC_ASSIGN_REASON (for applicant assignments).
Defining Assignment Statuses

You define both primary and secondary user statuses your enterprise uses for employee and applicant assignments in the Assignment Statuses window.

Defining Primary User Statuses

You can give your own user status names to the predefined system statuses. For example, for applicants you could use the user status “Rejected” for the system status “Terminate Application”. Oracle HRMS users see user statuses only.

You can also supply more than one user status for each system status. For example, for employees you can define several different user statuses for the system status Suspend Assignment, such as Maternity Leave, Paternity Leave, Disability Leave, Military Leave or Education Leave.

For applicants, you can track the stages of your selection process by means of user statuses. You can define user statuses such as Application Received, Application Acknowledged, First Interview, and Second Interview for the system status Active Application. These statuses can trigger production of standard letters.

▶ To rename a user status:
- Delete the contents of the User Status field and type in your preferred name.

▶ To supply additional user statuses for a system status:
1. Select New Record from the Edit menu.
2. Type in your user status, and select an HR System Status.
3. For an employee assignment status, also select a Payroll System Status. The payroll system status controls whether Oracle Payroll processes the assignment in a payroll run.

4. Save the new status.

*Note:* For each HR System Status, you must have one default user status. The system automatically uses the default in certain situations. For example, when you create a new employee assignment, it automatically has the default user status corresponding to the system status ‘Active Assignment’. You can override this default.

You cannot delete a user status, but you can prevent its use by deactivating it. To deactivate a user status, uncheck the Active check box.

**Defining Secondary Statuses**

A user status associated with a system status is called a *primary* status because it determines how the system processes the assignment. You can also define *secondary* statuses not associated with a system status. You use secondary statuses for analysis and reporting, but not to control pay processing for assignments.

**To create a secondary status:**

1. Select New Record from the Edit menu in the Assignment Statuses window.
2. Type in a user status and do not select a system status.
   
   The Type field displays *Secondary.*
Setup To Allow Processing After Termination

To enable payroll processing for employees after they leave your enterprise, in your system setup you must do the following:

- Set the Termination Rule to *Final* on the element definition of all elements you want to process after the actual leaving date.

  If you use Oracle Payroll and have a Payroll responsibility, you can set the Termination Rule to *Last Standard Process* for elements whose entries should close down after the last normal payroll run. Set the Termination Rule to *Final* for elements you want to process as late payments after the last normal payroll run.

- Use the Assignment Statuses window to make sure your system has a user status that corresponds to:
  
  - the HR system status of *Terminate Assignment*
  - the Payroll system status of *Process*

  Your startup data includes the user status Terminate Process Assignment, which matches this definition. Use this status (or your own equivalent status) when you terminate employment or end an assignment.
Defining Special Information Types

In Oracle HRMS, you use the **Personal Analysis key flexfield** to define any special information not provided by the main system that you want to hold about people, jobs and positions, and training activities.

You can define any number of instances of the Personal Analysis key flexfield. Each instance is called a Special Information Type. For example, you might set up types to hold performance reviews or medical details.

Each Special Information Type can have up to thirty fields (where each field is a segment of the flexfield). You can set up cross-validation to ensure that users enter correct combinations of segments. You can also speed up data entry and minimize errors by defining an ‘Alias’ for common combinations of segment values.

When you enable Special Information Types for your Business Group, you select how you plan to use each type.

In Oracle Human Resources, you can use Special Information Types for:

- job requirements
- position requirements
- personal information

In Oracle Training Administration, you can use Special Information Types for:

- skills provided by training activities

Each Special Information Type can be used for one or more of these purposes. The options you select control the windows in which each Special Information Type appears.

Special Information Setup Steps

**To set up Special Information Types:**

1. Define each Special Information Type as an instance of the Personal Analysis key flexfield.
   
   See: *Oracle Applications Flexfields Guide*

2. Enable the Special Information Types you want to use in your Business Group and select how you want to use them.

See Also

The Special Information Approach to Skills Matching (*Oracle HRMS User’s Guide*)
Enabling Special Information Types

Use the Special Information Types window to enable Special Information Types for the Business Group, and to select how you want to use them.

To enable Special Information Types:

1. Select the Special Information Types you want to use in your Business Group.
2. Enable each Type by checking the Enabled check box.
3. Check the other boxes to specify how you plan to use the Special Information Type. This makes it available in the list of values in other windows as follows:
   - **Job**: in the Job Requirements window
   - **Position**: in the Position Requirements window
   - **Other**: in the Special Information window
   - **Skill**: in the Skill Provisions and Search for Event windows in Oracle Training Administration

The OSHA and ADA check boxes are used in Oracle Human Resources in the US only.
This chapter focuses on how to enter people and personal information on the system. You can choose to hold a wide range of personal information, such as medical details, work schedule, and preferred language for correspondence, as well as the basics such as date of birth, employee number, and addresses.

It also explains how to hire people, how to enter personal contacts, including dependents and beneficiaries, and how to inquire and report on the people held in the system.

For people who are your employees, there is assignment information and other information to hold. Chapter 11 Employment Information looks at information to record specifically for employees.
Displaying Personal Information

There are lots of ways to view information about people held in Oracle HRMS. For example, you can:

- use Employee Direct Access to view and update your own personal details using a web browser
- use Line Manager Direct Access to view information about people in your organization
- use the Find Person window or a People folder to display the people who interest you, then ‘drill down’. by clicking on buttons, to the information you need
- use an inquiry window to view specific information about a person, such as employment or absence history
- use QuickPaint to design a report incorporating personal, assignment, application, or compensation information

See Also

Web and Workflow Access (Oracle Human Resources UK User’s Guide)
Inquiry Windows and Folders: page 18 – 3
QuickPaint: page 18 – 9
Using the Find Person Window

When you navigate to the People window, the Find Person window automatically displays in front of it.

To query a person using the Find Person window:

1. Do one or both of the following:
   - Enter a full or partial query on the person’s name. Where a prefix has been defined for the person, a full name query should be in the format ‘Maddox, Miss Julie’.
   - If relevant, enter a query on employee number, applicant number or NI number.

2. Choose the Find button.

The person or people found by the query are displayed in the People window. If the query found more than one person, you can use the [Down Arrow] key or choose Next Record from the Go menu to display the next person.

People Folders

Using the People Folder window, you can enter inquiries about the people held on Oracle HRMS. You select the fields of personal information you want to see, and position them in the order you prefer. For example, you can produce an alphabetical listing of all applicants and their gender, nationality, and disability registration.

The system saves your inquiry and field formatting as a folder so you can rerun the inquiry at any time. You can make this folder available to all users, or save it as a private folder.

Note: The system administrator can create customized versions of the People Folder window so that you use each version for one person type only.
Entering Personal Information

Every enterprise must be able to record personal information for its employees, applicants, and contacts. Some of this information is standard, including basic information such as name, address, birth date, hire date, and nationality.

Oracle HRMS enables you to enter and update this information for all person types on one form – the People window. You can also use this window to update people’s statuses, for example, from applicant to employee.

Note: The system administrator can create customized versions of the People window so that you use each version for certain person types only or for certain functions only (entering employees, entering applicants, or hiring applicants).
Entering New People

Use the People window to enter and maintain basic personal information for all person types, including employees.

The minimum information to enter for all categories of people is name and type. In addition, for employees you must enter gender, employee number and date of birth (for assignment to a payroll). All other personal information is optional.

To enter a new person:

1. If the Find Person window opens, choose New.
2. Set your effective date to the appropriate date for adding the person to the system. If you are entering an employee, this should be his or her hire date.
3. Enter the person’s name and other details in the Name region. Only the last name is required.
   • You can use the Title field to enter a title such as Mrs. or Doctor for the person.
   • You can use the Prefix field to enter the first part of the person’s name, such as Van or De. This field allows you to sort by the main part of the last name, Zee instead of van der Zee, if you choose to do so.
   • You can use the Suffix field to hold part of the last name, such as Junior or II. This enables the suffix to be reported on separately, as required in some government–mandated reports.
4. Select a type. If you select Employee, the Hire Date field displays your effective date. You can change the hire date, and this changes the employee’s effective start date.
5. Enter the person’s identification information in the Identification region.
   If your enterprise uses manual number entry, use the Employee or Applicant fields to enter an employee or applicant number as appropriate. If your enterprise uses automatic number generation, the employee or applicant number automatically displays when you save your entries in this window.
6. Enter details for the person as required in the Personal Information region:
   • To assign an employee to a payroll, you must enter his or her date of birth.
• In the Mail To field, select Home or Office to indicate the person’s preferred mail destination
• In the Date Last Verified field, you can enter the date the person last checked this personal information for accuracy.
• In the Status field, select the person’s marital status
• In the Email field, enter the person’s email ID

Optionally, you can enter additional information for people in the alternative regions described in the following steps.

Note: The Background Information, Medical Information and Rehire Information alternative regions appear only if your system administrator has enabled them for you.

▶ To enter employment information for employees and applicants:
1. Choose the Employment Information alternative region.
2. Select the person’s ethnic origin.
3. Enter the work permit number for a non-EEA person.
4. Check the boxes to indicate that the person is a director, a pensioner, or has multiple assignments that you want to aggregate for processing.
5. For reporting purposes, enter any period of service that is not recorded on the system but that should count for pension calculations.

▶ To enter office location information for a new hire or an existing employee:
1. Choose the Office Location Information alternative region.
2. Enter the office number for this office.
3. Enter the internal location of this office.
4. Enter the office identifier for internal mail.

▶ To enter information for an applicant:
1. Choose the Applicant Information alternative region.
2. If the applicant’s resume is on file, check the Exists check box.
3. If the applicant’s resume is on file, select the date indicating when the resume was last updated.
4. Select the date up to which a file is to be maintained for this applicant.
To enter information concerning the background check for an employee:
1. Choose the Background Information alternative region.
2. Check whether the employee’s background check has been performed.
3. Select the date on which the background check was performed.

To enter rehire recommendation information for an applicant who was a former employee:
1. Choose the Rehire Information alternative region.
2. Check whether the former manager has recommended the applicant for rehire.
3. Select the reason for this recommendation.

To enter further name information:
1. Choose the Further Name Information alternative region.
2. Enter one or more honors/degrees (BA, MBA, or JD, for example) which the employee has earned.
3. Enter the name (perhaps a nickname) by which the employee prefers to be known.
4. If the employee previously was known by a different last name, enter the previous last name.

To enter medical information for an employee:
1. Choose the Medical Information alternative region.
2. Select the employee’s blood type.
   You cannot change this value once you enter it.
3. Select the date of this employee’s last medical test.
4. Enter the name of the physician who performed this test.

To enter other information for a person:
1. Choose the Other Information alternative region.
2. Select the type of schedule the employee will work.
3. Select the current status of the student.
4. Enter the person’s current full time/part time availability to work with your company.
5. Select the language the person prefers for correspondence.  
This language can differ from the person’s native language, depending on the nature of the correspondence.

6. Check the Military Service check box if the person is employed in a military service in some capacity.  
The value of this field can impact benefits calculations.

7. Check the Second Passport Exists check box if the person possesses multiple passports.

---

**Hiring**

When you enter a new person as an employee, he or she is automatically hired as of your effective date.

► **To hire an applicant:**

1. Update the applicant assignment status to Accepted in the Application window.

2. Set your effective date to the applicant’s hire date and query the applicant in the People window.

3. In the Type field, select Employee. The Hire Date field displays your effective date.

4. Save your work.

**Note:** You cannot update the applicant assignment status to Accepted and change the Person Type to Employee on the same date, since these are both datetracked changes.

► **To rehire an ex-employee:**

1. Set your effective date to the new hire date and query the ex-employee in the People window.

2. In the Type field, select Employee. The Hire Date field displays your effective date.

3. Save your work.

► **To cancel a hire:**

- Query the employee in the People window and clear the Hire Date field. Then save.
The system warns you that any changes made to the person’s records after their hire date will be lost. You can choose whether to continue or cancel.

You cannot cancel a hire if:

- Oracle Payroll has processed the employee in a payroll run.
- The person’s type has changed since the hire date.
- New assignments have been created for the person after the hire date.
- The person was initially entered on the system as an employee and therefore has no previous history as an applicant or contact. In this case you must delete the person’s records from the system using the Delete Person window.

See: Deleting a Person from the System: page 9 – 30
Entering Addresses

You can enter as many addresses as necessary for each person, using the Address window.

Prerequisites

- Set up any address types you want to use (such as home or business) as QuickCodes for the QuickCode Type ADDRESS_TYPE.

  See: Adding QuickCode Values: page  20 – 3

To enter an address for a person:

1. Select a national address style and click in the Address field.
   A window opens with the address format for the country you select.

2. Enter your address information in this window. You can enter up to three telephone numbers to associate with the address. Choose the OK button.
   This returns you to the Address window.
   **Note:** Telephone numbers you enter here are held separately from the numbers you enter in the Phone Numbers window. You have to enter and maintain them separately.

3. Select an address type, such as home, or weekend, or business.
   You can only have one address of each type at any time.

4. You can check Primary for the address you are creating, to identify the person’s main address. By default, the first address you enter is the Primary address.
   Only one address at any time can be a person’s Primary address.

5. Save your work.

**Additional Information:** Default address styles are predefined for many countries. You can change these defaults and you can create address styles for other countries.
To change the primary address:
- End the existing primary address, and create the new primary address starting the next day.

Adding Telephone Information

You can enter multiple telephone numbers for people in the HRMS database. To enter telephone information for a person, use the Phone Numbers window.

To enter a telephone number:
1. In the Type field, select the type of the telephone device.
2. In the Phone Number field, enter the telephone number. Any format is allowed.
3. In the From field, select the start date for the telephone number.
4. In the To field, optionally select the date when the telephone number is no longer valid.
5. Save your work.

Note: If you want to maintain a history of telephone numbers for this person, be sure to add a new entry for the new telephone number and enter an end date for the existing
existing telephone number. If you do not want to maintain such a history, simply update the record for the existing telephone number.
Entering Pictures

You can store a picture associated with each person on your system, perhaps holding a photograph or digitized image of the person’s signature. These may be useful for approval or identification purposes. You must digitize the image and save it in one of the following file formats:

- BMP
- JFIF
- JPEG
- PCX
- PICT
- TIFF

You enter pictures in Oracle HRMS in the Picture window.

To enter a person’s picture in Oracle HRMS:

1. In the Picture window, choose the Load Picture button.
2. Enter the file path to locate the directory in which you saved the graphic file.
3. Highlight the filename and choose the OK button. The graphic is loaded in the format indicated by the filename. For example, a file called image.bmp would be loaded as a BMP file.

Entering Next of Kin and Other Contacts

Use the Contact window to hold information about an employee’s contacts, for example:

- people to contact in an emergency
- dependents
- beneficiaries of benefits such as insurance policies or stock purchase plans
- people receiving a third party payment withheld from the employee’s salary

A person entered as a contact can be one, some, or all of the above.

Prerequisite

- Set up any relationship types (such as spouse, child, or friend) you want to use as values for the QuickCode Type CONTACT.
To enter a contact:

1. Do one of the following:
   - Enter the name of a new person.
   - Select from a list of people already entered on the system.
2. If you enter a new person, you can select their gender and enter their birth date.
3. Optionally, select a relationship type for the contact.
4. If this contact is the recipient of a third party payment (for example, from a court-ordered deduction), check the Payments Recipient check box.
   This allows you to select this person on the Personal Payment Method window when entering a third party payment method for the employee.
5. Save your work.
6. To enter addresses for the contact, choose the Address button.
Competence Profiles, Qualifications, School Attendances and Work Choices

As you recruit new people and develop existing employees, you need to track their competencies and work preferences. This enables you to match them to projects and vacancies, develop succession plans, and organize further training and certification. In Oracle HRMS, you can record the following information:

- A competence profile – this is a list of the competencies held by a person and their level of proficiency in each competence.
- Qualifications, including details of individual subjects, grades, licenses, status of ongoing training and tuition fees.
- Attendances at educational establishments, such as schools and colleges.
- Work choices, including willingness to travel and relocate; preferred working hours, work schedule, and duration within post and preferred countries for international relocation.

You can enter this information when an employee first joins the enterprise, taking the details from their resume or from tests or interviews. You might update it after the employee successfully completes a training course, and after periodic assessments or appraisals.

You can either enter this information using standard Oracle HRMS windows or using the web–based Line Manager Direct Access.

Copying Core or Primary Assignment Competencies

Some competencies are important for all employees throughout your enterprise; others are required for particular jobs, positions, or organizations. If competencies have been entered as core competencies for your enterprise or as requirements against a person’s job, position, or organization, you can copy them to the person’s competence profile. Copying competencies not only saves you time from having to enter the details yourself, but it also ensures that you do not miss entering relevant competencies.

To assist you in entering applicants and evaluating employees against vacancies, you can also copy competencies from a vacancy. The system checks all the competence requirements of the organization, job and/or position for which the vacancy is defined. It enters these against the person so that you can record the person’s proficiency in each competence and then compare applicants against the vacancy’s requirements.
Managing Competencies Over Time

You can make changes to the competencies and proficiency levels your employees possess over time, enabling you to see both the latest and historical information. When you view a competence profile, you can choose whether to see just the current profile or all historical information, if you want to see changes in proficiency levels over time.

Use Oracle Alert’s automatic mail notification to keep you informed when an employee’s competencies need certification and renewal. This frees your time for more essential tasks. For example, use the competence Renewal Period to drive Oracle Alert—it compares the renewal period date with the date on the person’s Competence Profile, or the last training class delivering the skill.


Creating a Competence Profile

Use the Competence Profile window to create and update a personal competence profile.

![Competence Profile Window]

When you open this window, you will see all competencies, past and present, held by the person. If you want to see only current
To create a competence profile:

1. Select the first competence this person possesses.
   You can also automatically enter all competencies required for the person’s primary assignment or a vacancy, or the enterprise’s core competencies. See: To copy competencies from requirements: page 9 – 17.

2. Select the proficiency level at which the person performs the competence.

3. Enter the date from which the person possesses the competence at this level. For example, if the person gained the competence through a qualification, enter the date the qualification was gained. You can enter a date when the competence expires, if required.

4. In the Source of Proficiency Rating field, you can select the method by which the person gained the competence, such as training course or previous experience.

5. Select the method of certifying that the person attained the competence at the recorded level, such as by examination.

6. Enter the date when the person’s proficiency in this competence should be reviewed.

7. Continue to enter the competencies the person possesses, then save your changes.

To copy competencies from requirements:

1. Choose the Copy Competencies button. A Copy Competencies window appears.

2. Do one of the following:
   • Check the Core Competencies box to copy all the competencies required throughout your enterprise.
   • Check the Primary Assignment Competencies box to copy all the competencies required in the organization, job and position to which the person is assigned.
   • Select a vacancy to copy all the competencies required in the organization, job and position for which the vacancy is defined.

3. Enter the dates between which the competencies are valid (you must have a From date, but you can leave the To date blank).
4. Choose the Copy button.

You can now enter proficiency levels, certification methods, and so on for each of these competencies held by the person.

**To update a competence profile:**

1. Check the current check box if you want to see only the current competencies the person possesses, otherwise leave this box blank.

2. Enter new competencies for this person, or update proficiency levels and other details for existing competencies.

   **Note:** If you update a proficiency level, enter the date when the new level was attained. Then, when you save your changes, you will see that the system keeps a record of the old proficiency level, ending the day before the start date of the new level.

3. Save your changes.
Entering Work Choices

You can a person’s work choices, such as their willingness to travel or relocate, their preferred working hours and work schedule, and the length of time they would like to stay in their next post. You can then compare these choices with the work requirements of jobs or positions when you are planning redeployment.

You enter personal deployment choices in the Work Choices window, accessed from the People window.

To enter work choices for a person:

1. Check the relevant work capabilities boxes if the person is:
   - willing to work in all locations
   - willing to relocate
   - willing to travel
   - prepared to work in their current location only
   - willing to visit internationally

2. Select the length of time the person wants to stay in a role, for example, indefinite or two years.

3. Select the person’s preferred working hours (for example, 9.00 to 5.30), work schedule (the working days in the week or pattern of shifts), the proportion of full time hours available and any relocation preferences (for example, with family).
4. Check the relevant international deployment boxes if the person is willing to:
   • work in all countries
   • relocate

5. Select the countries in which the person prefers to work, and any countries in which they are not prepared to work.

6. Save your work.
## Entering Qualifications

You can enter an employee's qualifications when they first join the enterprise, and then update them after periodic assessments or appraisals or after completion of a training course.

Use the Qualifications window, accessed from the People window, to enter and update qualifications.

![Qualifications Window](image.png)

**To enter qualifications:**

1. Select the type of qualification this person possesses and the title of the qualification.
2. Select the status of the qualification, for example, whether training is ongoing or completed.
3. Enter the grade at which the person holds the qualification, if appropriate.
4. Select the establishment at which the person gained the qualification.
5. Enter the awarding body which bestowed the qualification, if you want.
6. Enter the dates between which the qualification is gained. You must enter a Start date but you can leave the End date blank if the qualification is still incomplete.
7. Enter the date the qualification was awarded, if you want.
8. Enter the projected completion date the qualification is awarded, if relevant.
9. Enter the ranked position within the class, if relevant.
10. Enter any comments, for example, what percentage of the award was course work or examination, if you want.
11. Save your work.

► **To enter tuition fees for reimbursement:**
1. In the Tuition Details alternative region, enter the amount and select the currency to reimburse the person.
2. Select the method of tuition, for example, day release.
3. Enter the method of reimbursement, for example, bank transfer to be paid when qualification is awarded.
4. Save your changes.

► **To enter training details:**
1. Choose the Training Details alternative region.
2. Enter the amount of training completed. For example, enter 30 days completed of a training program that lasts 60 days.
3. Enter the total amount of training required to deliver the qualification.
4. Enter the units in which the training is measured, for example, days.

► **To enter license details:**
1. Choose the License Details alternative region.
2. Enter the licence number, for example, a driving licence number.
3. Enter any restrictions, for example, licence not valid in certain states.
4. Enter the licence expiry date.

► **To enter subjects:**
1. Enter the first subject the qualification comprises.
2. Select the status at which the subject is awarded, for example, whether training in the subject is ongoing.
3. Enter the dates between which the subject is studied. You must enter a Start date but you can leave the End date blank (if the subject is still incomplete).

4. If the subject forms a major part of the qualification, check the Major box.

5. Enter the grade at which the subject is studied, if you want.

6. Continue to enter further subjects until you have entered them all for the qualification, then save your changes.

**Entering Schools and Colleges Attended**

You can enter the school or college at which the person gained a qualification.

Use the School and College Attendances window, accessed from the People window, to enter attendance at an establishment.

![Schools and Colleges Attended](image)

**To enter schools and colleges attended:**

1. Select the name of the school or college that the person attended.

2. Enter the dates of the attendance. You must enter a Start date but you can leave the End date blank (if the attendance is ongoing).

3. If attendance is full time at the school or college, check the Full Time box.

4. Continue to enter schools or colleges, if required, then save your changes.
Entering Special Information

Basic personnel information is handled in a fairly standard way from enterprise to enterprise. However, other types of information are recorded and used in quite different ways. Examples include training records, disciplinary records, competence, and medical records. Oracle HRMS does not restrict you to any predefined format for holding this information. You can set up your own user-defined fields for recording, analyzing, and reporting on whatever special information you require.

You set up each area of information that you want to handle separately as a Special Information Type. For example, you might define special information types for medical details and disciplinary records. You can enter a person’s information under these sorts of headings in the Special Information window.

**Note:** Your system administrator can create customized versions of the Special Information window, for entry of information for only one or a selected set of information types.
To enter special information for a person:

1. In the Name field, select the type of information you want to enter for the person.
2. In the Details block, click in the Detail field to open a window for entering information of this type.
3. Choose the OK button when you have completed your entries, then save your work.

See Also

Skills Matching Report (*Oracle Human Resources UK User’s Guide*)
Listing People by Special Information

To view a list of people who match a particular profile for one Special Information Type, use the List People By Special Information window.

**Note:** The system administrator can create customized versions of the List People By Special Information window so that you use each version for one information type only. For example, one version could be called List People By Technical Skills.

To list people by special information:

1. Select a Special Information Type.
2. Click in the Details field. A window opens prompting you for the details you have defined for this information type.
3. Enter values in the fields against which you want to match people, then choose OK. If you leave a field blank, it is not used in the matching process.
4. Choose the Find button.
Employees and applicants who match your selection criteria are listed in the folder in the lower part of the window. You can enter a query here to further restrict the list of people. If you have access to the Folder menu you can remove, rearrange, or resize the fields displayed.
Tracking People’s Roles and Activities

Table 9 – 1 lists the windows you can use to track the roles and activities of employees and applicants. These windows are described in context in other topics, as listed in the table.

You can also use the web–based Line Manager Direct Access to enter some information, such as assessments and appraisals, and to view a wide range of employee data, including employment history, roles (who they manage, supervise etc.) and absence history.

See: Web and Workflow Access (Oracle Human Resources UK User’s Guide)

<table>
<thead>
<tr>
<th>Window</th>
<th>Used For</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment</td>
<td>describing the work role of an employee</td>
<td>The Employee Assignment: page 11 – 4</td>
</tr>
<tr>
<td>Application</td>
<td>describing the vacancy for which an applicant has applied</td>
<td></td>
</tr>
<tr>
<td>Absence Detail</td>
<td>recording an employee’s absence from work</td>
<td>Entering Absences: page 10 – 13</td>
</tr>
<tr>
<td>Book Events</td>
<td>recording that an employee or applicant will attend an event. The event must be already defined in the Event Bookings window.</td>
<td></td>
</tr>
<tr>
<td>Employee Review</td>
<td>scheduling and recording details of an employee’s review or other interview type</td>
<td></td>
</tr>
<tr>
<td>Applicant Interview</td>
<td>scheduling and recording details of an applicant’s interviews</td>
<td></td>
</tr>
</tbody>
</table>

Table 9 – 1 Other Windows for Personal Information

You can enter other work–related information for employees, such as salary and payment methods, after entering the employee’s assignment.

See Also

Managing Employment Information: page 11 – 2
Full Personal Details Report Set

To create printed reports of the personal information held for one person, you can run the Full Personal Details report set. It comprises four reports that meet employees’ rights to view their own personal details under data protection legislation:

- Full Person Details 1 reports on addresses and information entered in the People window, such as name, date of birth, nationality, and work telephone number.
- Full Person Details 2 reports on applications and applicant interviews.
- Full Person Details 3 reports on assignment information including periods of service, payment methods, and element entries.
- Full Person Details 4 reports on miscellaneous work information, including special information, absences, recruitment activities, and contacts.

If you do not need to see all this information for the employee, you can run individual reports rather than the report set. The Full Person Details report, Full Assignment Details report, and Full Work Details report are equivalent to reports 1, 3, and 4 in the report set, respectively. The Full Applicant Details report is equivalent to report 2 in the report set, but you can only run this as a separate report for an applicant, not an employee.

You run report sets from the Submit Request Set window.

▶ To run the Full Personal Details report set:

1. In the Request Set field, select Full Personal Details.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the reports.
4. Enter the name of the person for whom you want to print the reports.
5. Choose the Submit Request button.

See Also

Employee Summary Report: page 11 – 30
Deleting a Person from the System

If you mistakenly save information in the People window, you can remove the person by selecting Delete Record from the Edit menu. Notice that you are prevented from performing this action if you have entered information about that person in other windows.

If you want to remove all records of a person, use the Delete Person window. Notice, however, that you cannot use this window to remove the records of an employee or ex-employee whom Oracle Payroll processed in any payroll runs.

To delete all records of a person:

- Query the person in the Delete Person window and choose the Delete Person button.

  If there is a contact for the person you are deleting, there are two possibilities:
  - If the only information held about the contact is the basic person details entered in the Contacts window, then the record of the contact is deleted.
  - If there is other information held about the contact (for example, assignment or applicant information), the contact is not deleted. However, the record of their relationship to the person you are removing from the system is deleted.
To manage your employees’ absences from work, you must be able to:

- identify the types of absence your enterprise recognizes
- record the reasons, dates and times for projected and actual absences, and maintain records of time taken for each absence type
- group related absence types together for reporting and analysis
- set up and administer PTO accrual plans, whereby employees can accrue time off for vacation or sick leave as they put in time at work.
- calculate Sick Pay and Maternity Pay according to statutory legislation.

This chapter explains how to set up an effective absence recording system in Oracle HRMS, how to enter and obtain information about employee absences, and how to set up, maintain and report on plans for accrual of paid time off.
Absence Management

Employees take paid or unpaid time off from work for a variety of purposes, such as illness or injury, vacation, medical appointments, childbirth, death of a close relative, jury duty, labor representation, and professional activities. Maintaining information on employee absences for reporting and analysis is an important aspect of human resource management.

Many enterprises permit employees to accrue hours or days of PTO (paid time off) as they work, to use for sick or vacation leave. In such enterprises, setting up and maintaining PTO plans is another part of absence management.

In the UK there is also government legislation regarding the payment of employees during periods of sickness and maternity leave. (SSP and SMP).

See Also

Absence Types: page 10 – 3
Absence Management Setup Steps: page 10 – 8
Entering Absences: page 10 – 13
Viewing and Reporting on Absence Information: page 10 – 15
Introduction to SSP and SMP,
*Oracle SSP/SMP User’s Guide*
Absence Types

Oracle HRMS provides a convenient way to maintain information about the various absence types your enterprise recognizes. To facilitate reporting and analysis of employee absences, you can distinguish between absence types and absence categories. An absence category is a group of related absence types, as for example:

<table>
<thead>
<tr>
<th>Absence Category</th>
<th>Absence Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medical Leave</td>
<td>Illness or Injury</td>
</tr>
<tr>
<td></td>
<td>Work-related Injury</td>
</tr>
<tr>
<td></td>
<td>Work-related Illness</td>
</tr>
<tr>
<td></td>
<td>Medical Appointment</td>
</tr>
<tr>
<td>Family Leave</td>
<td>Paid Maternity/Paternity</td>
</tr>
<tr>
<td></td>
<td>Unpaid Maternity/Paternity</td>
</tr>
<tr>
<td></td>
<td>Dependent Care</td>
</tr>
<tr>
<td>Personal Leave</td>
<td>Compassionate Leave</td>
</tr>
<tr>
<td></td>
<td>Personal Business</td>
</tr>
<tr>
<td>Professional Leave</td>
<td>Certification Classes</td>
</tr>
<tr>
<td></td>
<td>Meeting Attendance</td>
</tr>
</tbody>
</table>

Table 10 – 1  Example Absence Categories and Types

Also to assist with absence reporting and analysis, you can provide reasons to select from when recording employees’ time taken for an absence type. For example, if you need information to analyze the particular family-related responsibilities that cause employees to miss work, you can define reasons for absence types as follows:

<table>
<thead>
<tr>
<th>Absence Category</th>
<th>Absence Type</th>
<th>Absence Reasons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Family Leave</td>
<td>Paid Maternity/Paternity</td>
<td>Birth of a child</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Adoption of a child</td>
</tr>
<tr>
<td></td>
<td>Dependent Care</td>
<td>Child Care</td>
</tr>
</tbody>
</table>

Table 10 – 2  Example Absence Category, Types and Reasons
Table 10 – 2  Example Absence Category, Types and Reasons

<table>
<thead>
<tr>
<th>Absence Category</th>
<th>Absence Type</th>
<th>Absence Reasons</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Elder Care</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disabled Care</td>
<td></td>
</tr>
</tbody>
</table>

**Setup of Absence Types**

Setting up each absence type is essentially a two–step process. One step involves defining the type, that is, entering its name, and optionally selecting a category and reasons for it. The other step involves defining an element to associate with the type. This element serves two important purposes:

- It provides a way to maintain a running total of time taken for the absence type. When you record an absence for an employee, the amount of time taken goes as an entry to the input value of the element associated with the absence type.

  For example, if you record 8 hours of Compassionate Leave for an employee, the input value of the element for this absence type receives an entry of 8. If a second 4 hour absence of this type occurs the input value gets an entry of 4, which adds in for a total of 12 hours Compassionate Leave taken to date.

- It provides a way to restrict employee eligibility for the absence type. The links you build for the element establish which employees are eligible to use the type.

  For example, if the absence type Compassionate Leave is available only to full time employees, you link its element to the employment category Full Time.

  See: Element Eligibility Rules: page 12 – 16

To hold a single running total of time taken for two or more absence types, you associate all the types with the same absence element. For example, your absence category Personal Leave may include two absence types you need for certain reporting purposes, Compassionate Leave and Personal Business. However, you require just one running total to be kept of employees’ time taken for both types of personal leave. In this case you simply associate both absence types with the same absence element.
Note: If you have a use for absence types for which you do not maintain running totals of time taken or time remaining, and which do not require any eligibility rules, you can define the type with no associated element.

Absence Elements

Each element you define and associate with an absence type has an input value with either hours or days as its unit of measure. To maintain a running total of the hours or days a employee has taken for an absence type, this input value is said to hold an increasing balance.

Increasing Balances of Time Taken

As you would expect, an increasing balance for an absence type starts with no time entered, and increases as you enter employees’ hours or days absent. For example, if the absence type Compassionate Leave has an increasing balance, the balance starts from zero for each employee and increases by the number of hours entered for each absence of this type.

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit of Measure</th>
<th>Initial Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hours</td>
<td>Hours in decimal format</td>
<td>(none)</td>
</tr>
</tbody>
</table>

Table 10 – 3 Example Element for the Absence Type Compassionate Leave

Increasing balances are appropriate for most or all absence types. For absence types for which your enterprise sets a maximum time allowed, the system issues a message when an entry of time absent exceeds this maximum, or Oracle Alert can notify you when an employee reaches the maximum time or takes excess time.

See: Oracle Alert User’s Guide

When defining an absence type for a PTO accrual plan, you give it an increasing balance that will show accrued time the employee has used. To see the amount of accrued time a plan participant has available for use as vacation or sick leave, you use the Accruals window.

Decreasing Balances of Time Remaining

If your enterprise sets a maximum time allowed for an absence type that is not connected to a PTO accrual plan, you have the option of setting up a decreasing balance for this type, instead of an increasing balance.
For example, suppose your enterprise allows certain employees 32 hours leave per year for professional development. The Professional Leave absence element can have a decreasing balance, and an initial entry of 32 hours.

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit of Measure</th>
<th>Initial Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>Hours in decimal format</td>
<td>32</td>
</tr>
</tbody>
</table>

Table 10 – 4 Example Element for the Absence Type Professional Leave

If you record an employee absence of 4 hours for this absence type, the decreasing balance shows 28 hours still available to be taken.

Decreasing absence balances require more maintenance than increasing balances. They need a prorated initial balance entry for all eligible new hires throughout the year, and require resetting each year for all eligible employees.

Notice that an absence element cannot have both a decreasing and an increasing balance; it has one or the other.

Initializing an Absence Balance

Oracle HRMS provides two ways to initialize both increasing and decreasing absence balances at the year’s start, and to enter initial amounts of any decreasing balances:

- the Element Entries window, for individual employees
  
  See: Entering Elements: page 12 – 44

- the MIX batch entry facility, for batches of employees.
  
  See: Creating and Updating Batches of Element Entries: page 12 – 51

Referencing Absent Time in Payroll Runs

You can reference absence time taken (amount of an increasing balance) or absence time remaining (amount of a decreasing balance) for absence types in formulas for earnings, deductions, or other items Oracle Payroll processes in payroll runs. When defining the input value to hold the absence balance for an absence type’s element, you can check the Database Item box. Entries to this input value then become database items that formulas for payroll calculations can access.
Absence Recording

When you record an absence for an employee using the Absence Detail window, you must always select an absence type. This ensures that you always have on record, information about the nature of and reasons for the absence.

Dates and Times

In the Absence Detail window you can conveniently record for an employee either a projected or an actual start and end dates and times of a particular type of absence, as well as the date you receive notification of the absence. When an actual absence occurs in accordance with projected absence information already entered, you record this by simply clicking a button.

The system records an employee’s absences using the same calendar upon which the employee’s payroll is based. This means that all employees for whom you record absence information must have a payroll component in their assignments.

See: Components of the Assignment: page 11 – 5

Authorization and Replacement

When recording a projected or actual absence in the Absence Detail window, you can select both the name of an employee authorizing the absence, and of an employee replacing the absent worker.
Absence Management Setup Steps

To set up absence recording:

1. Define a nonrecurring absence element, with the Termination Rule Actual Termination and with at least one input value, for each absence type. Link this element.

   See: Defining and Linking an Absence Element: page 10 – 9

   **Note:** To set up an absence type for which you do not need to maintain a running total of time taken or remaining, and do not need eligibility rules, omit this step.

   To keep a single record of employees’ time taken for two or more different absence types, you can define one element only to associate with all the types.

   See: Setup of Absence Types: page 10 – 4

2. Define categories of absence types as values for the QuickCode Type ABSENCE_CATEGORY, and your absence reasons as values for the QuickCode Type ABSENCE_REASON.

   You can select the same reason for different absence types.

   See: Adding QuickCode Values: page 20 – 3

3. Define each absence type, associating with the type its absence element.

   See: Defining an Absence Type: page 10 – 11

4. For an absence type with a decreasing balance, use the Element Entries window or the MIX batch facility to make initial element entries for employees eligible for the type.

   See:

   Entering Elements: page 12 – 44

   Creating and Updating Batches of Element Entries: page 12 – 51
Defining and Linking an Absence Element

Define an absence element in the Element window.

**To define an absence element:**

1. Set your effective date to a day on or before the start of the first payroll period for which you want to enter absences.
2. Enter a name for the element, and select the classification Information.

   **Suggestion:** Give the absence element and its absence type the same name, or coordinate the element name with the type name. For example, for the absence type Compassionate Leave, name the element Compassionate Leave or Compassionate Leave Absence.

3. Select the processing type Nonrecurring, and the termination rule Actual Termination.
4. Check the Multiple Entries Allowed box to enable employees to have several instances of this type of absence in a pay period.
5. If this is an absence element for a PTO accruals plan, do not select Process in Run. Uncheck this box if necessary.
6. If employees must be a certain age or have served for a certain number of years to be allowed this absence, enter this information in the Qualifying Conditions region.

   **Note:** If this is an absence element for a PTO accrual plan, the plan setup relates length of service to accrued time off. Do not make an entry here for length of service.

7. Save the element, then choose the Input Values button.
8. In the Input Values window, create an input value to hold the amount of time taken. Select units of Day, Hours in "HH" format, or Hours in Decimal Format (to one, two, or three decimal places).

   **Attention:** If this is an absence element for a PTO accrual plan, give the input value the name Hours or Days, to accord with the unit of measure of the plan. When you define the plan using the Accrual Plan window, this input value name appears in the Units field of the Absence Information region.

9. You can define minimum and maximum days or hours that can be entered in an absence record. If you do this, select what happens if these limits are breached:
   - Select Warning for the system to warn users but allow them to breach the limits.
• Select Error for the system to issue an error message and prevent users from saving an entry that breaches the limits.

10. Save your work.

▶ To link the absence element:

1. Set your effective date to a day on or before the start of the first payroll period for which you want to enter absences.
2. In the Element Link window, select the absence element.
3. Select eligibility criteria for this absence element. If you want to make the element available to all employees, do not select any criteria.
4. Save the link. Then define the absence type associated with this absence element.

See Also

Defining an Element (Payroll Users): page 12 – 22
Defining Element Links: page 12 – 35
Defining an Absence Type

Use the Absence Attendance Type window to define an absence type for association with the nonrecurring element representing an absence.

Prerequisites

- Define and link the element for the absence type.
  See: Defining and Linking an Absence Element: page 10 – 9
- Define categories of absence types as values for the QuickCode Type ABSENCE_CATEGORY, and define your absence reasons as values for the QuickCode Type ABSENCE_REASON.
  You can select the same reason for different absence types.
  See: Adding QuickCode Values: page 20 – 3

To define an absence type:

1. Enter a name and category for the absence type.

   Suggestion: Give the absence type and its associated element the same name, or coordinate the type name with its element name. For example, name the absence type for a PTO accrual plan Salaried Sick PTO Plan, and its associated element, Salaried Sick PTO Absence.
2. In the Associated Element region, select the element defined for this absence type. The name of the element’s input value that holds the time taken or time remaining for this absence type appears in the Input Value field, and the unit of measure for the input value appears in the Units region.

3. In the Balance region, select Increasing for each entry to the absence element’s input value to add to a running total of time taken to date for this absence type. Select increasing balances for absence types for PTO accrual plans, and for most other absence types.

For absence types that have a set maximum amount of hours or days allowed, you may select Decreasing. In this case, each absence recorded reduces an initial balance entered for the absence type, to show time remaining to be taken for the type.

Decreasing balances require more maintenance. You must enter an initial balance amount for each new hire eligible for the absence type, and must initialize the balance for all eligible employees at the start of each year.

4. Optionally, select reasons that are valid for entries of this type of absence.

5. Save the absence type.
Entering Absences

To enter projected or actual absences for an employee, use the Absence Detail window.

Prerequisites

- Because the calendar holding absence records for an employee is the same as that of the employee’s payroll, the assignments of employees for whom you enter absence information must include an assignment to a payroll. The effective date of this assignment must be no later than the start of the current payroll period.
  
  See: Entering a New Assignment: page 11 – 8

- Similarly, the definition and linking of the element associated with the absence type must have occurred on or before the start of the current payroll period.
  
  See: Defining and Linking an Absence Element: page 10 – 11

To enter absences for an employee:

1. Select the absence type. The following information appears:
   - The category of the type.
   - The occurrence of the new absence record you are entering. For example, if the employee has already incurred two absences of this type, the occurrence of the new record is 3.
The running total of hours or days absent for the absence type. For absence types with increasing balances, this is the number of days or hours absent already recorded (in the past or future). For any types with decreasing balances, this is or the number of hours or days remaining to be taken.

The number of days absence recorded for the absence type in the current calendar year.

The name of the element that maintains each employee’s time taken or time remaining for this absence type.

2. Do one of the following:

• Enter projected dates for the absence. You can later copy them to the Actual Date fields by choosing the Confirm Projected Dates button.

• Enter actual dates and duration as days or hours, according to the units of the balance. For a duration in hours, you must enter start and end times, as well as start and end dates.

3. You can also select:

• reasons for the absence

• the employee authorizing the absence

• the employee who replaces the absent employee for the duration of the absence

4. Save your work.
Viewing and Reporting on Absence Information

For monitoring and analyzing recorded employee absences unconnected with a PTO accrual plan, use:
- the View Absence History window: page 10 – 15
- the List Employees by Absence Type window: page 10 – 16
- the Absences Report: page 10 – 17

For reviewing PTO plan participants’ accrued time earned and taken, use the Accruals window.

Viewing Absence History

Use the View Absence History window to view all absences for an employee.

To view absences for an employee:
- Select an employee then choose the Find button.
The absences appear in the lower part of the window. Use the standard Folder features to select a subset of these absence records, and to choose the fields to see.

**Listing Employees by Absence Type**

Use the List Employees by Absence Type window to see all the absence records for a particular absence type, or category of types.

![List Employees by Absence Type](image)

- **To list employees by absence type:**
  - Enter any combination of absence type, category, and start and end dates to define the absences to view. Choose the Find button.

  The absences appear in the lower part of the window. Use the standard Folder features to select a subset of these absence records, and to choose the fields to see.
Absences Report

The Absences Report shows information about employee absences during a specified period. It can show absences:

- for an individual employee, or for all the employees in an organization
- for all types of absence, or as many as 10 selected types.

The report summarizes the information as totals for each absence type since the employee was first hired.

Run reports in the Submit Requests window.

► To run the Absences Report:

1. In the Name field, select Absences Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Select either an organization or an employee.
5. Enter the start and end dates of the period for which you want to report absences.
6. You can choose up to 10 absence types for the report. To report on all types, leave the absence type fields blank. Choose OK.
7. Choose the Submit button.
Plans for Accrual of PTO

Accrual plans permit eligible employees to accrue PTO (paid time off) each year as they work, to use for vacation or sick leave. Oracle HRMS has no restrictions on the number of plans you can set up, each with its own units of accrued time (hours or days) and its own rules.

The system calculates accruals for all plans on a calendar year basis. That is, on 1 January of each year, accruals for that year begin. Accruals for new hires can begin on their hire date, six months after their hire date, or at the beginning of the next calendar year.

For all plans, participants’ payroll periods determine the frequency with which they accrue PTO. Employees on a monthly payroll accrue time each month, employees on semi-monthly payrolls accrue time twice each month, and so on. PTO accrual occurs automatically for each eligible plan participant on the last day of his or her pay period, independently of any payroll run.

For example, if employees on a semi-monthly payroll participate in a vacation PTO plan permitting the accrual of 84 hours per year, they accrue 3.5 hours on the last day of the year’s first pay period, say 15 January. They then accrue another 3.5 hours on 31 January, another 3.5 hours on 14 February and so forth.

Because accrual plans use employees’ payroll calendars to schedule accruals, the assignment of every employee participating in an accrual plan must include an assignment to a payroll.

Accrual Plan Structure

Just as elements constitute the underlying structure of absence types, so they provide the structure of accrual plans. To set up an accrual plan, you first set up absence recording for the plan, including an element to hold information about absences taken under the plan.

See: Absence Management Setup Steps: page 10 – 8

With absence recording in place, you can then enter information for setup of the accrual plan itself. This information includes:

- a start rule, to determine when employees can begin to accrue PTO under the plan
- length of service bands, which establish how PTO accrued under the plan increases with employees’ length of service.

In response to the information entered for plan setup, the system generates three elements for the plan:

- an element representing the plan. You use this element to enroll participants in the plan.
• an element to hold participants’ unused PTO that is available for carryover to the next year
• an element to hold residual PTO, that is, unused PTO not available for carryover under plan rules.

### Accrual Start Rules

Accrual plans differ with respect to the date from which they permit plan participants to start accruing PTO. In Oracle HRMS, the accrual start rule determines this date for a plan. The system includes these accrual start rules:

- **Hire Date**
- **Beginning of Calendar Year**
- **Six Months after Hire Date**

Enterprises have many different rules governing their accrual starts, so you may need start rules other than the three provided. You can either modify the existing rules, or add new ones.

#### Start Rule: Hire Date

For plans with this rule, participants’ accruals begin from the first full period following their hire date. For example, if the hire date of a participant on a semi-monthly payroll falls on the first day of either the first or second period in the month, PTO accrual starts as of that date.

If the hire date falls sometime after the first of the month but before the end of the first period, accruals start in the second period of the month. If the hire date falls after the first day of the second period but before its end, accruals start with the first period in the next month.

#### Start Rule: Beginning of Calendar Year

With this start rule, participants’ accruals begin from the start of the year following the year in which they are hired. This means that a participant with a hire date of 2 January 1996 and another with a hire date of 31 December 1996 both start to accrue time as of 1 January 1997.

Notice that the amount of PTO each accrues may not be the same, as accrual amounts often depend on employees’ length of service.

#### Period of Ineligibility

Plans with the start rule Hire Date or Beginning of Year can require participants to work for a period of time, perhaps three or six months,
before they are eligible to accrue PTO. If plan participants in fact take vacation or sick leave during this period, the system does not accept entry of this time against the accrual plan. Many enterprises set up an absence type for “approved but unpaid leave” to use for absences taken during periods of ineligibility.

The period of ineligibility is not applicable to plans with the start rule Six Months After Hire.

**Start Rule: Six Months After Hire**

For plans with this start rule, participants’ accruals do not begin until the first full pay period after the six-month anniversary of their hire date. For example, someone on a semi-monthly payroll who is hired on 5 February 1996, completes six months of service on 5 August 1996, and starts to accrue PTO in the second period in August.

Notice that if people are hired on the first day of a period, their accruals begin with the pay period of the six-month anniversary of their hire date. For example, someone on a semi-monthly payroll who is hired on 1 February 1996 completes six months of service on 1 August 1996, and hence starts to accrue PTO in the first period in August.
Length of Service and Accrual Amount Rules

In Oracle HRMS, the first day of the month of an employee’s hire date is the default date from which his or her length of service is calculated for accrual purposes. For example, someone hired on 18 January 1997 completes one year of service on 1 January 1997, and someone hired on 31 December 1996 completes one year of service on 1 December 1997.

Length of Service Override

For individual accrual plan participants, you can override the default date from which a plan starts its length of service calculations. This is useful for managing exceptional cases that arise when, for example, employees who already have accumulated periods of service in your enterprise transfer from one place to another. You enter the date override when enrolling a participant in a plan.

See: Enrolling Employees in PTO Accrual Plans: page 10 – 29

Length of Service Bands

For many accrual plans, the time off that plan participants can accrue increases with their length of service. That is, length of service bands determine accrual amounts. In addition, these bands can determine ceiling and maximum carryover amounts for plans that have these rules.

For each accrual plan in Oracle HRMS, you set up one or more length of service bands, supplying for each the hours or days of PTO that participants can accrue each year, together with any ceiling and maximum carryover of accrued time.

Ceiling Rules

The ceiling rule, found in some vacation accrual plans, sets a maximum amount of PTO an employee can hold at any time. When a participant’s accrued PTO reaches the ceiling, no additional time accrues. Accruals begin again only after the participant uses some accrued time.

Maximum Carryover Rules

Maximum carryover rules, found in both vacation and sick leave plans, set the maximum amount of unused PTO a participant can carry over from one year to the next.

Carried Over and Residual PTO

To manage the carryover to a new calendar year of employees’ unused PTO, you run the PTO Carry Over process at year end. This process
first calculates participants’ net PTO as of the last day of the year’s last pay period. This calculation insures that this period’s accruals do not exceed any plan ceilings that may exist. The process then checks the maximum carryover permitted, to determine for each participant both the amount to carry over, and the amount of any residual PTO that cannot be carried over.

For employees with unused, accrued time to carry over, it enters this time on the element generated to hold carried over time for the plan. Similarly, for employees with unused, accrued time they cannot carry over, it enters this time on the element generated for the plan to hold residual time.

**PTO Sale or Purchase**

Your enterprise may have policies permitting accrual plan participants, under certain circumstances, to sell back PTO they have accrued but not used. You may also permit them to purchase additional PTO. Because such policies and rules are not standard across enterprises, Oracle HRMS has no method in place for managing PTO sale or purchase. However, you can design a method and define elements for doing this, customized to your own requirements.

See: Reviewing or Changing Net Accrual Calculations: page 10 – 26
Accrual Plan Setup Steps

To set up a PTO accrual plans:

1. Define and link an element for the plan’s absence type.
   See: Defining and Linking an Absence Element: page 10 – 9

2. If you expect to record accrued time taken under the plan using the Absence Detail window, define an absence type for the plan, associating its absence element with this type.
   See: Defining an Absence Type: page 10 – 11

3. Define the accrual plan.
   See: Defining a PTO Accrual Plan: page 10 – 23

4. Set up length of service bands for the plan.
   See: Setting Up Length of Service Bands: page 10 – 25

Defining a PTO Accrual Plan

Use the Accrual Plan window to define an accrual plan.

Prerequisite

☐ Before setting up the plan, set up a way to track absences taken under the plan. To do this you define and link an element for recording accrued time taken under this plan, and optionally, associate this element with absence type information.

See: Absence Management Setup Steps: page 10 – 8
To define a PTO accrual plan:

1. Enter the plan name, and select an accrual category of either Sick or Vacation for it.

   **Suggestion:** Coordinate the names of the accrual plan, the plan’s absence type if any, and the element used to record absences taken under the plan. For example, for the Hrly Vacation PTO Plan for your hourly workers, you could name the absence type and its element Hrly Vacation PTO Absence.

2. Select the start rule for the plan in the Accrual Start field. This rule determines the date on which a plan participant begins to accrue PTO.

   See: Accrual Start Rules: page 10 – 19

3. Select Days or Hours in the Accrual Units field. This selection must accord with the input value units selected for the element that records accrued time taken under this plan.

   See: Defining an Absence Type: page 10 – 11

4. In the Name field of the Absence Information region, select the element associated with the plan’s absence type. The name of the element’s input value that holds the entries or hours or days absent appears in the Units field.
5. If the start rule for this plan is Hire Date or Beginning of Year you can enter a period of ineligibility, during which a plan participant can accrue PTO but cannot use accrued PTO. For example, enter 3 in the Length field and select Calendar Month in the next field. See: Period of Ineligibility: page 10 – 19

6. Save your work, and then set up length of service bands for the plan. Choose the Accrual Bands button to go to the Accrual Bands window.

Choose the Net Calculation Rules button to view or change the rules for calculating employees’ net PTO.

### Setting Up Length of Service Bands

Use the Accrual Bands window to define length of service bands for an accrual plan.

**Prerequisite**

- Define the accrual plan for which you are entering length of service bands.

To set up length of service bands for a PTO plan:

1. For each length of service band applicable to this plan, establish the band’s duration by making an entry in the To field. The first band
starts from zero years of service. If it extends for five years, enter 5 in the To field. The system then sets the From field for the second band at 5, as the second band starts after five years of service.

For the last band you enter, in order to cover all participants with any length of service beyond the band’s From entry, enter 99 in the To field. For example, if your bands cover service of 0–5 years, 5–10 years and 10+ years, the third band’s From and To entries should be 10 and 99.

If length of service is not relevant for this plan, define one band only for it, with a From entry of 0 and a To entry of 99.

2. For each band, enter in the Yearly Accrual field the number of hours or days that participants whose length of service falls into this band can accrue each year. For example, if plan participants accrue 80 hours of vacation per year during their first five years of service (band 0–5), enter 80 in the Yearly Accrual field.

3. If a band does not permit participants to carry unused accrued time over to the next year, leave the Accrual Carryover field blank. Otherwise, enter in this field the maximum number of accrued, unused hours or days that participants at this band may carry forward.

See: Length of Service and Accrual Amount Rules: page 10 – 21

4. If a band has no ceiling that limits the total number of hours or days participants at this band can accrue at any one time, leave the Ceiling field blank. Otherwise, enter the ceiling number for the band.

5. Save your work.

When you do this, the system generates three new elements for the plan, one to represent the plan and one each to hold carried over and residual amounts of accrued, unused PTO. Define for these elements, the same links as those of the plan’s absence element.

---

**Reviewing or Changing Net Accrual Calculations**

The rules for automatic calculation of employees’ net PTO appear in the Net Calculation Rules window. Here the system displays the rules that carried over time adds to net PTO, and hours or days absent subtract from the net. You enter this window by choosing the Net Calculation Rules button in the Accrual Plan window.
The Net Accrual Calculation for Net Entitlement of PTO

The calculation dynamically adds up a plan participant’s regular accruals to date. Then it adds in any carried over PTO from the previous year, obtained from the plan’s Carried Over element, to produce the gross accrual to date.

The calculation next adds up all PTO taken to date, obtained from the entries in each period to the element of the plan’s absence type. It then subtracts the amount of time taken to date from the gross accrual to date, to obtain the net accrual to date.

\[
\text{Gross PTO accrual} = \text{Accrued PTO} + \text{PTO carried over} \\
\text{Net PTO accrual} = \text{Gross PTO accrual} - \text{PTO taken this year}
\]

If your enterprise allows employees to purchase additional PTO or sell unused PTO, you can define elements to record information about purchased or sold amounts, query them in the Net Calculation Rules window, and select for the elements’ input values, rules governing their addition or subtraction in the net accruals calculation.

Residual PTO

Notice that the system does no automatic processing of the entries of employees’ residual PTO. Your enterprise may want to use these entries to inform employees of accrued but unused time they may forfeit, or to make payments for part or all of this time.
Linking the Accrual Plan Elements

When you save your entries in the Accrual Bands window, the system creates three elements:

- An element representing the plan that has the plan name, for example, Hrly Vacation PTO Plan. Use this element to enroll employees in the plan.
- An element to hold for each plan participant, any accrued, unused hours or days that can be carried over to the next year.
- An element to hold each participant’s residual time, that is, any accrued, unused hours or days that cannot be carried over.

The Carried Over and Residual elements each have an input value Hours or Days (depending on the plan’s units), which automatically receive entries when you run the PTO Carryover process at year end.

For the three elements generated for each PTO accrual plan, you must build links that are the same as those of the plan’s absence element, whose name appears in the Absence Information region of the Accrual Plan window.

To link the accrual plan elements:

1. Set your effective date to the date the accrual plan goes into effect.
2. In the Element Link window, select one of the following:
   - the element representing the plan (for example, Hrly Vacation PTO Plan)
   - the plan’s Carried Over element (for example, Carried Over Hrly Vacation PTO Plan)
   - the plan’s Residual element (for example, Residual Hrly Vacation PTO Plan)
3. Select the same eligibility criteria for the element as those selected for the plan’s absence element. If you save a link without selecting any criteria, the element is available to all employees.
4. Save the link.

You are now ready to enroll employees in the plan, and record absences for plan participants when they use time they have accrued.
Maintaining PTO Plan Records

When a PTO accrual plan setup is complete, you enroll employees in their plans, and record their accrued time taken. At year end, you run the PTO Carry Over process to clear down each employee’s balance of unused accrued time, recording both unused time available for carryover, and residual time unavailable for carryover.

The net accrual calculation produces for an employee, his or her amount of accrued PTO at a given point in time. The results of this calculation are always available for review.

Enrolling Employees in PTO Accrual Plans

Enroll individual participants in an accrual plan by entering for them the element generated to represent the plan.

To enroll participants in a PTO accrual plan:

- Do one of the following:
  - For enrollment of an individual employee, perhaps as a part of the hiring process, enter the element representing the plan for him or her using the Element Entries window.
    See: Entering Elements: page 12 – 44
  - For enrollment of a batch of employees in a plan, perhaps a newly-developed plan, use the MIX batch entry facility.
    See: Creating and Updating Batches of Element Entries: page 12 – 51

If an accrual plan should calculate a participant’s length of service from a date other than the default date deriving from the plan’s start rule, give the plan a date to use for this participant when enrolling him or her.

See: Length of Service Override: page 10 – 21

To override the date for calculating length of service:

- When enrolling the participant, enter the override date in the input value Continuous Service Date of the element representing the plan. This entry overrides the default date derived from the plan’s accrual start rule.
Recording Accrued Time Taken

For PTO accrual plans associated with an absence type, you can use the Absence Detail window to record a plan participant’s accrued time taken.

See: Entering Absences: page 10 – 13

For plans not associated with an absence type, you can make entries for individual participants directly to the plan’s absence element, using the Element Entries window.

Recording PTO Sold or Purchased

If your enterprise pays employees for time they have accrued but not used, or if you permit employees to buy additional time, you may decide to define your own PTO–related elements to record information about these transactions. In this case, you can enter these elements and select the rules governing the subtraction or addition of sold or purchased PTO in the Net Calculation Rules window.

Running the PTO Carry Over Process

Run this process at year end for each PTO accrual plan, to clear down participants’ balances of unused, accrued time. For each participant, the process stores time available for carryover to the new year on the plan’s Carried Over <plan name> element, and stores time they cannot carry over on the plan’s Residual <plan name> element.

Run the PTO Carry Over process from the Submit Requests window.

 ► To run the PTO Carry Over process:

1. Select PTO Carry Over in the Name field. If the Parameters window does not open automatically, click in the Parameters field.
2. The date in the PTO Year Earned field defaults to the year before the current year. You can enter a different year.
3. Select the name and category of the accrual plan for which you are running the process.
4. The Reprocess All Participants field defaults to No, so that the process affects only those plan participants not previously processed for this year. To process all participants regardless of any previous processing, select Yes in this field.
5. When the entry of parameters is complete, choose OK. Choose Submit to submit the request.
The net accrual calculation for PTO includes carried over PTO in determining an employee’s accrued PTO to date. To set the net calculation rules, use the Net Calculation Rules window. To review an employee’s carryover of accrued time, use the Accruals window.

See Also

Reviewing or Changing Net Accrual Calculations: page 10 – 26
Reviewing Employees’ PTO Accruals

To view information on employees’ accrued PTO, use the Accruals window.

To view an employee’s net PTO accrual:

1. In the Assignments Folder, query the employee’s name. Choose the Accruals button to go to the Accruals window.

2. Query the accrual plan in the Name window. The field Net Entitlement displays the net accrued days or hours as of the effective dates that appear. If you allow maintenance of negative balances of accrued time at your installation and an employee’s time absent exceeds time accrued, the net entitlement appears as a negative number.

The Entitlement Details region shows the amounts of current accrued time, the accrued time carried over and accrued time taken used in the calculation of the net PTO accrual.

Attention: When reviewing employee accruals at year end, remember that:

- the last day of the final period of the current calendar year may fall between a date in late December and one in early January
- accruals for the new calendar year do not go on record until the last day of the first period of the new year
- carried over and residual PTO appear only after the PTO Carry Over process is run.
The previous chapter focussed on the personal information you hold for all types of people. Employees require additional information on where they fit into your enterprise, and on their compensation and benefits.

This information is the substance of a contract an enterprise has with each of its employees. It associates the employee to the enterprise’s work structures and compensation and benefit policies.

This chapter describes the key types of employment information, how you hold them in Oracle HRMS, how you track changes in employment for employees, and how you can report and inquire about employment information.
Managing Employment Information

Table 11 – 1 below summarizes the information typically held for an employee, and how you can hold this information in Oracle HRMS.

<table>
<thead>
<tr>
<th>Information</th>
<th>How to set it up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Title or Position</td>
<td>Assign the employee to work structures in the Assignment window.</td>
</tr>
<tr>
<td>Department</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td></td>
</tr>
<tr>
<td>Grade</td>
<td></td>
</tr>
<tr>
<td>Grade Step Placement</td>
<td>Enter in the Grade Step Placement window; enter any special ceiling in the Assignment window.</td>
</tr>
<tr>
<td>Name of manager or position to report to</td>
<td>Use a position hierarchy or enter supervisor name in the Assignment window.</td>
</tr>
<tr>
<td>Salary</td>
<td>Assign to a salary basis in the Assignment window; enter amount in the Salary Administration window.</td>
</tr>
<tr>
<td>Benefits</td>
<td>Define and link elements; enter values in the Element Entries window.</td>
</tr>
<tr>
<td>Pay Frequency</td>
<td>Assign to a payroll in the Assignment window.</td>
</tr>
<tr>
<td>Pay Method</td>
<td>Accept the default from the Payroll to which the employee is assigned or select a method in the Personal Payment Method window.</td>
</tr>
<tr>
<td>Full time/part time status</td>
<td>Assign to an employment category.</td>
</tr>
<tr>
<td>Standard Work Day</td>
<td>Enter in the Assignment window or accept the default from the organization or position to which the employee is assigned.</td>
</tr>
<tr>
<td>Overtime rules</td>
<td>Define an element, using links to define eligibility rules, and element entry defaults or validation to control the values given.</td>
</tr>
<tr>
<td>Vacation Entitlement</td>
<td>Define Absence Types and set up increasing or decreasing balances for the employee; enroll employee in appropriate accrual plans.</td>
</tr>
<tr>
<td>Sickness Entitlement</td>
<td></td>
</tr>
<tr>
<td>Maternity Entitlement</td>
<td></td>
</tr>
<tr>
<td>Notice Period</td>
<td>You should hold full text procedures and regulations outside the system, perhaps using Oracle Book to hold the information online. You can associate groups of people with different rules or procedures using the People Group key flexfield.</td>
</tr>
<tr>
<td>Disciplinary procedure</td>
<td></td>
</tr>
</tbody>
</table>

Table 11 – 1 Employment Information
### Employment Information

<table>
<thead>
<tr>
<th>Information</th>
<th>How to set it up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Costing</td>
<td>Enter cost codes for the assignment in the Costing window, or accept the default from the organization to which the employee is assigned.</td>
</tr>
<tr>
<td>Probation Period</td>
<td>Enter in the Assignment window.</td>
</tr>
</tbody>
</table>

Table 11–1 Employment Information

Every enterprise needs to track the changes in employment information for each employee over the lifetime of their employment:

- Where a change affects a group, the human resource system must be able to effect that change for every individual in the group according to a set of rules.
- Where a change affects only a few individuals, the system must allow entry of changes for those individuals.

In Oracle HRMS, you manage these changes through the employee assignment:

- The assignment connects employees to your enterprise’s work structures and policies, so that changes to the structures and policies are reflected in the employee’s records.
- You can query groups of employees with similar assignments (such as all assignments on grade C2) and make changes for each employee in these groups.
- The assignment is datetracked to maintain a work history as the employee moves through your enterprise.
The Employee Assignment

The assignment is the central concept that relates employees to the structures in which they work, and the compensation and benefits for which they are eligible.

In Oracle HRMS, many of the activities you undertake in human resource management, such as vacancy management and budget planning, are based around assignments and not people. In particular, you enter all earnings, deductions, and other pay-related elements for the employee assignment, rather than the employee. This makes it possible to give an employee two or more assignments when this is necessary.

For example, if an employee has two or more open contracts of employment with your enterprise, he or she can have a separate assignment for each contract.

An employee must have a current assignment at all times. You record relocations, promotions, transfers and so on as changes to the existing
assignment. These changes are datetracked so that you can view the history of changes to an assignment, and can make future–dated changes in advance.

**Components of the Assignment**

At a minimum, an assignment defines the Business Group for which an employee works, the date the assignment began, and its current status, such as active or suspended.

You can use the assignment to define more precisely the place of the employee in the enterprise, including his or her job, position, organization, location, grade, and supervisor. You can also assign the employee to any of the employee groups you set up using the People Group key flexfield, such as pension groups or unions.

You can assign employees to an employment category, such as Part Time – Regular or Full Time – Temporary. Your startup data includes four categories, and you can add others for the QuickCode Type EMP_CAT.

You can assign employees to a *salary basis* and maintain their salaries or wages using the Salary Administration procedure.

**See Also**

Salary Administration and Performance Reviews: page 14 – 2
Contract Staff and Other Non–Standard Assignments: page 7 – 12

**Using Multiple Assignments**

Relocations, transfers, promotions and so on go on record as datetracked changes to employees’ existing assignments; you do not enter new assignments for changes like these.

However if your enterprise permits employees to work in two or more different capacities at once and thereby become eligible for different benefits, you can enter additional assignments for them.

You can maintain multiple assignments for any employee, but must designate one as the primary assignment. Oracle HRMS separately manages each assignment, and its associated compensation and benefits.
To show that an assignment is part time, you use the employment categories Part Time – Regular or Part Time – Temporary. You could also set up a Full Time Equivalent budget, and weight each assignment as a fraction of a full time equivalent for the calculation of actual values.

Notice that when employees split their time between two departments performing the same job, or fulfill two different roles in one organization, you do not need to define two separate assignments to maintain accurate costing records. You can set up cost allocation to distribute proportions of one assignment’s payroll costs to different cost centers.

See Also

Planning Runs for Multiple Payroll Assignments: page 15 – 25
Setting Up Assignments for Cost Collection: page 6 – 5

Identifying Employees and Assignments

Oracle HRMS uses two unique identifiers for employees:

- Employee Number
- Employee Assignment Number

Employee Number

The Employee Number uniquely identifies every employee in your Business Group.

An employee can have only one Employee Number. You decide how this number is to be generated when you define your Business Group:

- Automatic
- Manual
- National Identifier (for example, the US Social Security Number or the UK National Insurance Number)

If you choose automatic or national identifier number generation, the employee number, by default, remains the same for an employee who has multiple periods of service. If you choose manual number entry, you can update the number at any time.

The employee name and number appear together in people information windows, such as the People window and View Absence History.
window. In these windows you can select an employee by name or by employee number.

**Employee Assignment Number**

The employee assignment number uniquely identifies every assignment that exists within your Business Group. An employee can have one or more than one assignment, and therefore more than one assignment number.

The system automatically generates the assignment number, which is the same as the employee number by default. You can manually override the default assignment numbers the system generates. For example, you might want to use this number to store a payroll code.

If an employee has a second current assignment, the system also generates the second Assignment Number by default from the Employee Number, as in the following example:

<table>
<thead>
<tr>
<th>Employee Name</th>
<th>Samantha Green</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Number</td>
<td>1012</td>
</tr>
<tr>
<td>1st Assignment Number</td>
<td>1012</td>
</tr>
<tr>
<td>2nd Assignment Number</td>
<td>1012–02</td>
</tr>
</tbody>
</table>
Entering a New Assignment

Enter new assignments in the Assignment window. You must hire applicants before you can create an employee assignment for them. The details of the employee assignment default from their accepted application.

To enter a new assignment:

1. Set your effective date to the start date of the new assignment.
2. Select the organization to which you want to assign the employee. By default, the employee has an assignment either to the Business Group organization, or to the organization to which he or she was an applicant. If a location is defined for the Business Group or other organization, it also appears as a default.

   If you overwrite these defaults, a window appears asking if the change is an update or a correction. Select Correction.

3. Select a payroll if you are paying the employee using Oracle Payroll, or if you intend to record for the employee certain types of compensation and benefits (represented on the system by nonrecurring elements).

   Note: If Oracle Payroll is installed and you are an HR User, you cannot assign employees to payrolls. Ask your system administrator to change your HR:User Type profile option if you need to assign employees to payrolls.

4. Select a grade if you use grade rates or grade scales to determine the appropriate compensation levels for employees.
5. Select any other components which you want to include in the assignment. These are optional.
6. Select a Status for the assignment. By default a new assignment has the status Active Assignment (or an equivalent user status defined on your system).
   See: Assignment Statuses: page 8 – 5
7. Enter an Assignment Number to uniquely identify the assignment. By default, this number is the same as the Employee Number, for the employee’s first assignment.
8. Enter the information you want to hold in the alternative regions.

**Supervisor Region**

Enter the name and employee number of the employee’s personal supervisor.

*Note:* This information shows the personal supervisor for an employee and is not updated by the system. Use organization and position hierarchies to show management reporting lines.

*Note:* The Auto WGI uses this information.

**Probation Period and Standard Conditions Regions**

The probation period and standard work day information default from the employee’s position. If standard conditions are not defined for the position, they may default from the employee’s organization or Business Group.

**Miscellaneous Region**

The Internal Address adds address details (such as the floor or office number) to the location address.

You can select a reason for adding or changing the assignment. You define valid reasons as values for the QuickCode Type EMP_ASSIGN_REASON.

Check the Manager check box if the assignment is at the level of manager.

Check the Primary check box if it is the employee’s only assignment or main assignment.

**Special Ceiling Region**

A special ceiling progression point is the highest point to which the Increment Progression Points process can automatically progress the employee.
You can enter a special ceiling if the employee is assigned to a grade, and a grade scale is defined for this grade. This special ceiling overrides the ceiling defined for the grade scale.

Salary Information Region

Using the Salary Administration window, you can enter a proposed salary change for an employee, associate this change with a performance review, and accept or revise the change later. To administer an employee’s salary in this way, you first assign the employee to a salary basis in the Salary Information region.

You can also enter the frequency of salary and performance reviews.

**Attention:** If you change an employee’s salary basis to a basis that uses a different salary element, the employee’s existing salary element entry will be ended. Using the Salary Administration window, you should make a new salary entry for the employee, effective from the date of the salary basis change.

See Also

Salary Administration and Performance Reviews: page 14 – 2
Additional Employment Information: page 11 – 18
Changing Assignment Information

When an employee experiences changes such as a promotion, transfer, or move from full time to part time, you change a component of the assignment. A change to any of the assignment components produces the DateTrack prompt.

- If you choose Correction, Oracle HRMS overwrites the existing assignment information.
- If you choose Update, Oracle HRMS records the date and change, and retains the original information.

By changing your effective date on the system, you can see the employee’s assignment at any point in time. You can also view the changes made to the assignment over time using DateTrack History.

DateTrack History shows the changes made to one assignment. Use the Assignment History window to view the history of all the employee’s assignments, both currently and in any previous periods of service.

Effects of Changing an Assignment

Changing any assignment component can have the following effects:

- The employee may lose eligibility for some compensation types, benefits or deductions, and gain eligibility for others. You receive a warning that the system automatically ends any unprocessed element entries for which the employee is no longer eligible.

- The employee may have a different level of access to Oracle HRMS, since the system’s security is based on assignment to work structures.

- If you change the employee’s grade when a grade step placement exists for the assignment, you receive a warning message that the placement will be date effectively ended and any future placements will be deleted. Also, the special ceiling point field is cleared.

  **Note:** If an assignment change causes the system to change element entries, you may not be able to save the change if a current or future pay period is closed. You must reopen the period or change your effective date to make the change.

Changing Primary Assignments

Over time, a secondary assignment may need to be elevated to a primary assignment. Most companies have requirements to show the history of changes in an employee’s record.
This process will create two historical records: one showing a secondary assignment that lasted from x day to y date, and the other showing that the primary assignment started as one set of components and then changed to another set of components (which are the same as the secondary assignment) as of a particular date.

To change a primary assignment:

1. Create a new assignment “B” as a secondary assignment.
   See Entering a New Assignment: page 11 – 8
2. Set an effective date for the assignment to become the employee’s primary assignment.
3. Change Assignment “B” to be the primary assignment by selecting the Primary checkbox in the Miscellaneous alternative region.

See Also

Assignment History: page 11 – 32
Viewing Datetracked Information and History: page 1 – 16
Updating and Correcting Datetracked Information: page 1 – 17
Ending an Assignment

Oracle HRMS does not permit an employee to exist in the system without an active assignment. That is, an employee must always have at least one active assignment at any point in time. This means that for an employee with just one active assignment, the only way to end the assignment is to terminate the employee, using the Terminate window.

See: Ending Employment: page 11 – 14

For employees with more than one active assignment, you can end all but one of their assignments by selecting an assignment status of End or Terminate in the Assignment window. Sites not using Oracle Payroll can use these two statuses to provide information. For example, End may mean that further pay processing cannot occur for the assignment, while Terminate may mean that further processing can occur. Alternatively, these sites can simply use the status End.

At sites using Oracle Payroll, the choice of End or Terminate controls the ability to include the assignment in a payroll run after the date the assignment ends, as explained in the procedure below.

To end one of many assignments:

1. Set your effective date to the actual termination date for the assignment.
2. Update the assignment status to End or Terminate Process Assignment (or the equivalent user status on your system):
   • Use Terminate Process Assignment (with a Payroll system status of Process) if further pay processing of the assignment is required after the date the assignment ends. This leaves the assignment’s final processing date open so that further processing can occur.
   • Use End (with a Payroll system status of Do Not Process) if all pay processing for the assignment is finished. This makes your effective date the assignment’s final processing date, after which no further processing for the assignment can occur.

Note: The End status is not recorded on the assignment; it causes the assignment to end as of the effective date of entry of this status.

• To temporarily prevent pay processing for this assignment, use the status Terminate Assignment (with a Payroll system status of Do Not Process). When no further processing is required and you are ready to set a final processing date, update the status to End.
Ending Employment

If an employee is leaving your enterprise, you terminate him or her. This changes the person type to ex-employee and ends all assignments.

If an employee is leaving your agency, you terminate him or her. This changes the person type to ex-employee and ends all assignments.

The ex-employee’s records remain in the database. You can reinstate, or rehire, the person to create a new period of service.

Since terminating ends all assignments, the system does not permit you to terminate an employee who has future-dated assignments.

Note: If you have mistakenly added someone to the database or you want to remove all records for an ex-employee, you can delete the person in the Delete Person window. You cannot delete an employee whom Oracle Payroll has processed in a payroll run.

See: Deleting a Person from the System: page 9 – 31

If you mistakenly hired an applicant, you can cancel the hire in the Person window.

See: Hiring: page 9 – 8

Terminating an Employee

You end employment in the Terminate window.

To terminate an employee:

1. Optionally, enter the reason for the termination. You can define valid reasons as values for the QuickCode Type LEAV_REAS.
If you use Oracle Payroll and the employee is deceased, you must select the reason Deceased so that this is recorded on the P45.

2. Enter the termination dates. Only the Actual date is required. This is the date when the employee’s person type changes to Ex-employee. The Notified and Projected dates are for information only. The Final Process date is a date after which no further pay processing for the employee can occur, if you are using Oracle Payroll.

For the Final Process date:

- If you may need to process pay for the employee after termination, set the Final Process date later than the Actual date, or leave it blank.

  This means that the employee’s assignments are given the default user status for the HR System Status Terminate Assignment. If there is more than one user status defined for this system status, when you choose the Terminate button the system prompts you to select which status to enter on the employee’s assignments.

- If you do not need to continue processing, set the Final Process date to the Actual date.

  **Note:** If you are an Oracle Payroll user, you must also enter a Last Standard Process Date. This is the last date for normal processing, while the Final Process date is the last date for late payments. Element entries are closed down on the Last Standard Process, the Actual date, or Final Process date, depending on how you have defined the elements.

3. When the information is complete, choose the Terminate button to complete the termination.

**Setup To Allow Processing After Termination**
Cancelling a Termination

If the employee decides not to leave, or the date of leaving changes, you can cancel a termination. You can cancel a termination at any time provided that you have not rehired the employee. (You rehire an employee by changing his or her person type to Employee in the Person window.)

Oracle HRMS reopens the assignments previously closed down and gives each assignment the status it had before termination. It also restores other information to its state before termination. For example, it removes the end date put on recurring element entries for the assignment.

Notice, however, that any nonrecurring element entries that were deleted for processing periods after the termination date cannot be automatically restored. You must act to reenter these entries.

► To cancel a termination:
  ▪ Choose the Reverse Termination button in the Terminate window.

► To change the termination date:
  1. Cancel the termination by choosing the Reverse Termination button.
  2. Enter a new Actual date and choose the Terminate button.

Terminations Report

Oracle HRMS includes a standard report showing the reasons why employees left your organization within a specified period.

You run reports from the Submit Requests window.

► To run the Terminations Report:
  1. In the Name field, select Terminations.
  2. Enter the Parameters field to open the Parameters window.
  3. Enter the effective date for which you want to see the report.
  4. In the Organization Structure field, select an organization hierarchy name, if you want to see terminations in a number of subordinate organizations. If there are multiple versions, select a version.
  5. In the Parent Organization field, select the parent organization within the hierarchy whose subordinate organizations you want to see in the report.
If you have not selected an organization hierarchy, use the Parent Organization field to enter the name of the organization for which you want to view terminations.

6. Enter the start and end dates defining the period in which you are interested.

7. Select at least one termination reason to include in the report.

8. Choose the Submit button.

See Also

Employee Movements Report: page 11 – 30
Additional Employment Information

Just as you can record additional information about people, such as their addresses, contacts, and skills, you can also record additional information associated with each employee assignment. The main items of information are as follows:

- You can propose or approve a salary change in the Salary Administration window.
  See: Entering Salaries and Salary Changes: page 14 – 9
- You can make entries to the earnings, deductions, benefits and other elements the employee is eligible for, using the Element Entries window.
  See: Entering Elements: page 12 – 3
- If you use a pay scale and progression point system, you can place the assignment on a pay scale using the Grade Step Placement window.
  See: Placing an Employee on a Grade Step: page 4 – 17
- You can select the cost centers or accounts to which the costs of the assignment should be allocated, using the Costing window.
  See: Setting Up Assignments for Cost Collection: page 6 – 5
- You can use the Assignment Budget Values window to specify the value of the assignment in terms of headcount, full time equivalent (FTE), or any other budgets you have defined.
- For employees who have assignments to payrolls, you can select the methods by which the employee wants to receive pay for this assignment in the Personal Payment Method window.
  See: Entering Payment Methods for an Employee Assignment: page 11 – 19
- You can enter secondary assignment statuses for analysis and reporting, if these have been defined on your system.
  See: Entering Secondary Assignment Statuses: page 11 – 21
Entering Payment Methods for an Employee Assignment

For each employee assignment, you can enter one or more payment methods, selecting from the list of valid methods for the employee’s payroll.

If you enter multiple methods (for example because the employee is paid from more than one source account), you can enter the proportion of pay for each method and its processing priority. An assignment can have two instances of the same payment method, for example if salary is divided between two bank accounts.

Employees with no personal payment method on record receive pay by the default payment method of their payrolls.

You enter payment methods for employee assignments in the Personal Payment Method window. You can also use this window to enter the payee for third party payments.

Prerequisites

- Define all the payment methods available in your Business Group using the Organizational Payment Method window.
  See: Defining Payment Methods for the Enterprise: page 5 – 3

- Select at least one valid payment method for each payroll you define in the Payroll window.
  See: Defining a Payroll: page 5 – 5

- Assign the employee to a payroll.

- For third party payment methods, define the payee in the Organization window (using the classification Payee Organization) or the Contact window (using the relationship Payments Recipient).
To enter a personal payment method for remuneration:

1. Set your effective date to the date on which to begin paying the employee by this method.
2. In the Name field, select a payment method.
3. Enter a number in the Priority field to determine the order for Oracle Payroll to use each payment method. It uses the method with the lowest number first.
4. Enter either the amount or percentage of the assignment’s pay to be paid by this method.
   If the total of the amounts you allocate to payment methods is less than the amount to be paid, Oracle Payroll uses the payment method with the highest priority number to pay the excess.
5. If the payment method type is BACS, open the Bank Details window for entry of information about the employee’s bank account.

To enter a third party payment method:

1. Set your effective date to the date on which to begin making payments using this method.
2. In the Name field, select a third party payment method.
   Third party payment methods automatically receive priority 1 (the highest priority) and you cannot change this. You cannot split a third party payment between different payment methods; the Percentage field always displays 100%.
3. In the Payee region, select an organization or a person.
4. Save your work.

You can select this third party payment method in the Payee Details entry value when you enter a deduction to be paid as a third party payment.

**Entering Secondary Assignment Statuses**

Your implementation team may have created secondary assignment statuses for analysis and reporting of employee or applicant assignments.

For example, suppose your primary status Maternity Leave applies to employees both when a child is born and when one is adopted, and you want to study its use in these two cases. To accomplish this you can set up the secondary statuses Maternity Birth and Maternity Adopt, and enter them for employees taking maternity leave.

You enter secondary statuses for an employee assignment or an applicant assignment in the Secondary Statuses window.

![Secondary Statuses](image)

**To give a secondary status to an assignment:**

1. Select the status and enter a start date.
2. You can also select a reason for giving the new status.

When a status no longer applies, simply enter an end date.

**See Also**

Assignment Statuses: page 8 – 5
Inquiring and Reporting on Employment Information

Oracle HRMS provides a number of predefined inquiry windows and reports for employment information. You can also create your own inquiries and reports using QuickPaint or other reporting tools.

Listing Assignments

There are three predefined inquiry windows for producing lists of assignments that match criteria you enter:

- Assignments Folder
- List Assignments
- List People by Assignment

Assignments Folder

Using the Assignments Folder window, you can query lists of current assignments, past assignments, or both. You select the fields of assignment information you want to see, and position them in the order you prefer. For example, you can produce a listing of all current employees ordered by organization, and by grade within organization.

The system saves your inquiry and field formatting as a folder so you can rerun the inquiry at any time. You can make this folder available to all users, or save it as a private folder.
Note: The system administrator can create customized versions of the Assignments Folder window so that you use each version for one person type only.

The system administrator can also link this window in a task flow so that you use it to access other windows of employment information. Notice that if you select a past assignment in the folder, you cannot open other windows of employment information.

List Assignments Window

In this window, you can view current employees and applicants. If you enter the Job, Position, Grade, or Group fields, a window opens prompting you for individual segments of the flexfield. You can enter selection criteria in one or more segments. This means that you can search on parts of the job name, for example.
**List People by Assignment Window**

In this window you can choose whether to view current or former employees/applicants, or both. However, you must search on a whole Job, Position, or Grade name, not on segments of these flexfields.

![List People by Assignment Window](image)

**To produce lists of assignments:**

1. Select values in one or more fields in the top part of the window, and choose the Find button.
   
   The folder in the lower part of the window lists the assignments that match the selection criteria you entered.

2. You can enter a query in the folder to reduce further the list of assignments displayed. For example, you could run the query "C%" in the Full Name field to view the assignments of people whose names begin with C.

3. You can remove, rearrange, add, or resize fields in the folder if you have access to the Folder menu.
Listing Employees by Organization

In the List Employees by Organization window, you can view lists of employees within one organization or within all organizations below a specified level in a hierarchy you select.

To list employees in several organizations:
- Select an organization hierarchy and select the highest organization in this hierarchy for which you want to list employees. Choose the Find button.

To list employees in one organization only:
- Leave the Organization Hierarchy field blank and select an organization. Choose the Find button.
  You can enter a query in the Employees block to further restrict the list of employees to be displayed.

Manager Field
The Manager field identifies any employee for whom the Manager check box is checked in the Miscellaneous region of the Assignment window.

If there is more than one manager in the organization you select, the Manager field displays the number of managers. You can view the names of these managers by choosing the List icon from the Toolbar.
**Organization Field**

If an employee belongs to more than one organization within the hierarchy you selected, the number of organizations appears in the Organization field. You can view the names of these organizations by choosing the List icon from the Toolbar.
Listing Employees by Position

There are two windows for viewing lists of employees by position:

- List Employees by Position
- List Employees by Position Hierarchy

List Employees by Position Window

To view employees in a single position, or in all positions corresponding to a job or organization, use the List Employees by Position window.

To view employee names by position:

1. Select any combination of an organization, job, or position.
2. Choose the Find button.

The folder displays the positions that match your selection criteria, together with the holder’s name and employee number.

If there is more than one holder for a position, the number of holders is displayed in the Holder Name field. You can view the names of these holders by choosing the List icon from the Toolbar.

**Note:** You can enter a query in the folder to reduce further the list of positions displayed. You can remove, rearrange, add, or resize fields in the folder if you have access to the Folder menu.
List Employees by Position Hierarchy Window

To view lists of employees in a number of positions within a hierarchy, use the List Employees by Position Hierarchy window.

To view lists of positions within a position hierarchy:

1. Select a position hierarchy and the highest position in the hierarchy for which you want to list employees.

2. Choose the Find button.

   The folder displays all positions below the one you selected in the hierarchy. It also lists the employees who hold these positions.

   If there is more than one holder for a position, the number of holders appears in the Holder Name field. You can view the names of these holders by choosing the List icon from the Toolbar.

   **Note:** You can enter a query in the folder to reduce further the list of positions displayed. You can remove, rearrange, add, or resize fields in the folder if you have access to the Folder menu.
Assignment Status Report

Use this report to see a list of people assigned to particular organizations, jobs, positions and grades, with specific assignment statuses. If you select both applicants and employees as person types, the report prints out in two sections. Otherwise it prints for the type you select.

Run reports from the Submit Requests window.

To run the Assignment Status Report:
1. In the Name field, select Assignment Status Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Leave the Organization Structure field blank to see information about all organizations. Select an organization hierarchy name to see assignment statuses in a number of subordinate organizations.
5. If there are multiple versions, select a version.
   If the effective date lies between the version’s start and end dates, the report is effective as of this date. If it lies outside these dates, the report is effective as of the start date of the version you select.
6. Leave the Parent Organization field blank to see information about all organizations. Select a name in this field to see information on all subordinate organizations in the hierarchy.
   **Note:** You must enter a value in this field if you have entered a value in the Organization Structure field, and you must leave this field blank if you left that field blank.
7. Make entries in the Group, Job, Position, Grade and Payroll fields as required.
   If you leave all segments of the Group flexfield blank, you see information about employees in any groups. If you leave one segment blank you see employees with any value for that segment.
8. Enter Yes in the Primary field if you want to report on primary assignments only. Leave blank to include all assignments.
9. Select Employee, Applicant or Both in the Person Type field. This determines which sections of the report are printed.
10. Select up to four assignment statuses, or leave blank to list employees and/or applicants with any assignment status.
11. Choose the Submit button.
Employee Summary Report

This report is a current summary of information for an employee, covering addresses, contacts, period of service, assignments, special information, personal payment methods, and element entries.

Run reports from the Submit Requests window.

► To run the Employee Summary Report:
   1. In the Name field, select Employee Summary.
   2. Enter the Parameters field to open the Parameters window.
   3. Enter the effective date for which you want to see the report.
   4. Enter the name of the employee whose summary you want to see.
   5. Choose the Submit button.

See Also

Full Personal Details Report Set: page 9 – 30

Employee Movements Report

There are two versions of the Employee Movements Report:

► Employee Organization Movements Report shows employee movements into and out of a particular organization or hierarchy.

► Employee Payroll Movements Report shows employee assignment changes to and from a particular payroll.

Both versions list the following movements: New Hires, Terminations, Transfers In, and Transfers Out. You can use this information to monitor employee assignment changes for turnover analysis.

Run reports from the Submit Requests window.

► To run the Employee Organization Movements Report:
   1. In the Name field, select Employee Organization Movements Report.
   2. Enter the Parameters field to open the Parameters window.
   3. Do one of the following:
• If you want to see information for a whole organization hierarchy, select the Organization Hierarchy name and version number, and leave Parent Organization blank.

• If you want to see information for one organization, select the organization name in the Parent Organization field, and leave Organization Hierarchy name and version number blank.

• If you want to see information for an organization and its subordinates in a particular hierarchy, select the name of the organization and the name and version of the organization hierarchy to which it belongs.

4. Select the period for which you want to see the information.

5. In the Employee Detail field, do one of the following:
   • Select Summary Only to see total numbers for each category of change.
   • Select Order by Assignment Number or Order by Employee Name to see a full listing of employee assignments for New Hires, Terminations, Transfers In, and Transfers Out. This information will be listed in the order you select.

6. Choose the Submit button.

To run the Employee Payroll Movements Report:

1. In the Name field, select Employee Payroll Movements Report.

2. Enter the Parameters field to open the Parameters window.

3. Select the payroll and payroll period for which you want to see the information.

4. In the Employee Detail field, do one of the following:
   • Select Summary Only to see total numbers for each category of change.
   • Select Order by Assignment Number or Order by Employee Name to see a full listing of employee assignments for New Hires, Terminations, Transfers In, and Transfers Out. This information will be listed in the order you select.

5. Choose the Submit button.
Assignment History

Use the Assignment History window to view the history of all an employee’s assignments, both current and in previous periods of service.

To view an employee’s assignment history:

1. In the Current field, select Yes, No or All.
   - Yes selects the list of current employees. No selects the list of ex–employees. All selects the list of both current and ex–employees.

2. In the Name or Number field, select an employee or ex–employee and choose the Find button.
   - The Service History region displays the employee’s final period of service. It shows three periods of time:
     - **This Period** shows the number of complete years and months worked in this period of service to date.
     - **All Periods** shows the number of complete years and months worked in all periods of service to date.
     - **Including Breaks** shows the total elapsed time (in complete years and months) from the employee’s initial hire date to date.

You can view previous periods of service by choosing Next Record from the Go menu.
Elements are the structured units of information used by Oracle HRMS to represent the compensation and benefit types you give to your employees. All the types of earnings, deductions, employer charges and non-payroll payments that go through the payroll are called elements. This chapter explains how to use these basic HRMS information units, and covers the following areas:

- defining and classifying elements
- controlling element processing priorities and balance feeds
- costing elements
- making employees eligible for the earnings, deductions and other values that elements represent
Introducing Elements

Elements represent the compensation and benefit types that you give to your employees. In a payroll environment these are also the earnings and deductions that contribute to the overall pay of an employee and appear on a pay advice. Typical examples include regular salary and wages, bonus payments, health insurance enrolment, tax and insurance payments, stock purchase plans and pension contributions.

You can also define elements to represent direct payments to employees that are not part of their pay (such as expense reimbursements) or employer payments on behalf of employees (such as pension contributions).

A further use of elements is to hold information that is a non-payment type. For example, you might use elements to track which employees have received non-payment benefits or equipment such as mobile telephones, company cars, or uniforms.

There is no limit to the number of elements you can define and all your definitions are datetracked.
Processing Elements in Payroll Runs

You have flexible control over the values that elements represent. You can define elements to be for set amounts or for calculated amounts based on formulas that fire during payroll runs. You can validate the data entered by using formulas or by providing a valid list of values. You can enter defaults that can be overwritten or defaults that are fixed. You can also define the processing frequency of elements. For example, you can define an element to process regularly in every payroll period, to process once only unless you enter it again, or to process according to some other frequency requirement.

Elements are processed during payroll runs according to the business rules for each element that you define at setup. The processed result from each element is called the run result, and the processed run results become balance feeds for different balances. Some balance feeds are predefined to feed required statutory balances, and you can create your own balance feeds to your own user defined balances.

See Also

Defining User Balances: page 13 – 8
Controlling Element Processing in Payroll Runs: page 12 – 20
Element Classifications

In Oracle HRMS, elements are grouped into primary classifications such as Earnings and Voluntary Deductions. In a human resources department, you can use the classifications to identify groups of elements for information and analysis purposes. In a payroll department, you use the classifications to control processing, including the order in which elements are processed, and the balances they feed.

These primary element classifications are supplied. You cannot change them as they are designed to meet the legislative requirements of your country.

Classifications and Balance Feeds

In Oracle Payroll, primary classifications are predefined to feed certain statutory balances, used in tax and NI calculations. You cannot create new primary classifications and you cannot disable any balance feeds created for primary classifications.

You can define your own secondary classifications to feed your own user defined balances. These secondary classifications are subsets of the primary classification. This means that an element defined for a secondary classification feeds the following balances:

- all balances fed by its primary classification
- the balance or balances fed by its secondary classification

Some secondary classifications have been predefined. For example, Earnings is a primary classification. Some earnings are taxable, but not all. There is, therefore a predefined secondary classification, Taxable Earnings, that feeds the Taxable Pay balance.

As with primary classifications, you cannot remove or change any predefined secondary classifications, and you cannot disable any of the predefined balance feeds created for them.

User Balances

You have full control over the balance feeds to your own user balances. This means:

- You can create and remove your own user defined secondary element classifications and their balance feeds.
- You can select from all primary and all secondary classifications to feed user balances.
• You can create feeds from individual elements to user balances and these feeds are datetracked.

See Also

Balances in Oracle Payroll: page 13 – 2
Primary Element Classifications

Primary element classifications are supplied as startup data, and you cannot delete or update them as they are designed to meet local legislative requirements. The following list gives the names and meanings of UK predefined element classifications:

<table>
<thead>
<tr>
<th>Classification</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Earnings</td>
<td>Earnings elements represent most payments made to an employee. These payments are usually subject to deductions of tax and NI, and are normally processed in the regular payroll run each period.</td>
</tr>
<tr>
<td>Direct Payment</td>
<td>Direct Payment elements are for expenses or loans made through the payroll that are not subject to tax. They are not included in gross or net pay balances.</td>
</tr>
<tr>
<td>Pre–Tax Deductions</td>
<td>Pre–Tax Deductions elements are for voluntary deductions, such as GAYE contributions, made before taxation.</td>
</tr>
<tr>
<td>NI</td>
<td>NI elements represent all the categories of employee NI payments, and also maintain information for statutory reporting.</td>
</tr>
<tr>
<td>PAYE</td>
<td>PAYE elements represent tax deductions and maintain information for statutory reporting.</td>
</tr>
<tr>
<td>Court Orders</td>
<td>Court Orders elements represent deductions made from employee earnings under orders from courts, local authorities or the Child Support Agency.</td>
</tr>
<tr>
<td>Voluntary Deductions</td>
<td>Voluntary Deductions elements are for deductions, such as union dues, that the employee authorizes the employer to make voluntarily on his or her behalf after tax.</td>
</tr>
<tr>
<td>Employer Charges</td>
<td>Employer Charges elements represent payments, such as contributions to the company pension scheme or employer’s NI, made to statutory bodies and third parties by the employer for the employee.</td>
</tr>
<tr>
<td>Information</td>
<td>Information elements can be used to represent information items that are not used in payroll processing. They can also</td>
</tr>
</tbody>
</table>
be set up to hold information for use in other elements, and to trigger the processing of other elements, for example, PAYE Details.

**Balance Initialization**

Balance Initialization elements are used specifically for the loading of initial values into balances. You would mainly use these elements when transferring data from another payroll system.

**Primary Classification Checklist**

The following table shows processing priority and costing details for the primary classifications supplied to UK users.

You cannot change any of these predefined details at element classification level. However, you can define a new default processing priority for individual elements on the Element window, provided it is within the assigned range for the classification. In addition, on the Entry Values window for the element entry, you can give a subpriority number to multiple recurring entries of the same element. In the case of multiple Court Order entries, for example, you can specify the sequence they process in.

<table>
<thead>
<tr>
<th>Primary Classification</th>
<th>Priority Range</th>
<th>Default Priority</th>
<th>Cost Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information</td>
<td>1 – 1000</td>
<td>500</td>
<td>Debit</td>
</tr>
<tr>
<td>Direct Payment</td>
<td>1001 – 1500</td>
<td>1250</td>
<td>Debit</td>
</tr>
<tr>
<td>Earnings</td>
<td>2001 – 3000</td>
<td>2500</td>
<td>Debit</td>
</tr>
<tr>
<td>Employer Charges</td>
<td>3001 – 4000</td>
<td>3500</td>
<td>Debit</td>
</tr>
<tr>
<td>Pre-Tax Deductions</td>
<td>4001 – 5000</td>
<td>4500</td>
<td>Credit</td>
</tr>
<tr>
<td>NI</td>
<td>5001 – 5500</td>
<td>5300</td>
<td>Credit</td>
</tr>
<tr>
<td>PAYE</td>
<td>5501 – 6000</td>
<td>5800</td>
<td>Credit</td>
</tr>
<tr>
<td>Court Orders</td>
<td>6001 – 6099</td>
<td>6050</td>
<td>Credit</td>
</tr>
<tr>
<td>Voluntary Deductions</td>
<td>6100 – 7000</td>
<td>6500</td>
<td>Credit</td>
</tr>
</tbody>
</table>

*Table 12 – 1 Primary Element Classifications*
Defining Secondary Element Classifications

Oracle Payroll users can define secondary classifications to create subsets within primary classifications. You select these classifications to control discretionary balance feeds. ‘Discretionary’ means that, for each element of the parent primary classification, you can determine the following:

• whether the secondary classification applies to that element
• which user balance feeds the secondary classification is going to control
• the date the classification commences as a balance feed control
• the date it ceases as a balance feed control

To create secondary element classifications:

1. Query an existing primary element classification. The check box indicates whether it is for nonpayment elements. These are elements that do not feed the Payments balance.

The defined priority and costing details for the classification also display.

Priority: The processing range displays together with the default priority.

Costable: If this check box is checked, you can select all costing options on the element link for elements of this classification,
including Not Costed. All UK primary classifications are costable except for Balance Initialization.

**Distributable**: If this check box is checked, you can create a distribution set from elements of this classification over which you can distribute costs. All UK primary classifications are distributable except for Balance Initialization.

**Debit** or **Credit**: These option buttons display the cost type for elements in the classification, that is, whether the accounts they feed are to be debited or credited.

2. Enter a unique name for the secondary classification you want to associate with the displayed primary classification. You can also add a description.

3. Select the Default check box if you want the secondary classification to appear automatically in the Balance Feed Control window. If you do not make the classification a default, you can still select it manually in Balance Feed Control.

**Note**: Oracle Payroll has already defined a number of secondary classifications for legislation purposes. Some of these are default classifications, but not all. You cannot delete these classifications, and you cannot delete them from the Balance Feed Control window for predefined elements.
Predefined Secondary Element Classifications

This table shows the predefined secondary classifications supplied to UK users. You cannot update or delete these predefined classifications.

<table>
<thead>
<tr>
<th>Primary Classification</th>
<th>Secondary Classifications</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Earnings</td>
<td>Attachable Earnings</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>NIable Earnings</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>SMP Earnings</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>SSP Earnings</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Taxable Earnings</td>
<td>Yes</td>
</tr>
<tr>
<td>Direct Payment</td>
<td>(None)</td>
<td>N/A</td>
</tr>
<tr>
<td>Pre–Tax Deductions</td>
<td>Attachable Pre–Tax</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Superannuation</td>
<td>Yes</td>
</tr>
<tr>
<td>NI</td>
<td>(None)</td>
<td>N/A</td>
</tr>
<tr>
<td>PAYE</td>
<td>(None)</td>
<td>N/A</td>
</tr>
<tr>
<td>Court Orders</td>
<td>(None)</td>
<td>N/A</td>
</tr>
<tr>
<td>Voluntary Deductions</td>
<td>Widows and Orphans</td>
<td>No</td>
</tr>
<tr>
<td>Employer Charges</td>
<td>(None)</td>
<td>N/A</td>
</tr>
<tr>
<td>Information</td>
<td>Feed Taxable Pay</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Feed NIable Pay</td>
<td>No</td>
</tr>
</tbody>
</table>

Table 12 – 2 Secondary Element Classifications
Element Entries

To enter details of any compensation or benefit type for an employee you make an *element entry* for that employee.

Effective Duration of an Entry

Some entries are relevant to one pay period only, while others represent payments to be made every pay period.

For example, when you enter salary for an employee you probably expect to continue payment of this until you change or end the entry. In contrast, you would probably expect an entry of overtime hours to be dealt with as a single payment in the period in which it is entered.

When you define an element in Oracle HRMS, you specify whether its entries are *recurring* or *nonrecurring*.

**Recurring**

This means that, once the element is entered for an employee, the values apply in every subsequent pay period. For example, your salaried employees expect to receive their salary once every pay period regardless of any other variable factor.

**Nonrecurring**

This means that any entry for this element applies only in the pay period in which it is given to the employee. For example, you might define an overtime element to record the number of overtime hours worked in any pay period. You would use this information to pay the employee once only.
Attention: For each employee, the pay periods are derived from the definition of the payroll to which the employee is assigned.

See Also

Entering Compensation and Benefits: page 12 – 1
Element Input Values

When you define an element, you must consider what information you want to record each time you make an entry of the element for an employee.

Typically, you would expect to record more than just the name of the element. For example, if you defined an element to record employee expenses, you might want to record the Type, as a code value, and the Claim Amount as a monetary value.

In Oracle HRMS you define these values as *input values* for the element. When you define an element, you can define up to 15 input values for it. You decide which values you want to record and what limits, or validation, to apply to those values.

Input values can be numbers, text, dates, times, hours, or monetary values. You also decide whether each input is required or optional when an entry of the element is made for an employee.

Processing Input Values

Input values are so called because they are the inputs to calculations performed by Oracle Payroll. In a payroll run, formulas process the input values and other database information to produce *run results*.

For example, if your enterprise makes overtime payments, you might write a formula to calculate the payment amounts for each assignment from inputs of the overtime rate and the hours worked for the period. The payroll run then processes each assignment and produces the overtime payment amounts as run results.

Run results are used for other purposes besides summing the amount of employee pay. In the overtime example, the run result information can also be used for costing purposes and to track the actual hours of overtime worked.

Table 12 – 3 shows the input values, with some representative entries, for the element NI Car Primary. This is a recurring Information element, predefined in Oracle Payroll, which you enter for employees with company cars. The run results of the processed element feed a balance that accumulates the employer’s Class 1A contributions to company car benefit.
The Pay Value

Oracle Payroll makes special use of the pay value to represent the result of processing an element for employee pay. The pay value is the amount paid to the employee from that element after payroll processing. You must define a pay value as one of the inputs for the element if you want Oracle Payroll to process an element for pay. You can have only one pay value for each element and it must have the name 'Pay Value'.

You can enter a pay value directly as an input to the element. When you do so, no formula will fire during the payroll run to calculate any direct result for the element. Instead, the pay value you enter becomes the run result.

Validating Input Values

When you define inputs for an element, you also define the validation for each input value. The validation you define controls the values a user can enter. The options are to:

- provide a default value
- provide a minimum and maximum value range
- provide a fixed value
- provide a lookup list of valid values
- validate the input value using a formula

Using the formula option you can model complex business rules for validating entries. For example, for a bonus payment you might want

<table>
<thead>
<tr>
<th>Input Value Name</th>
<th>Type</th>
<th>Entry</th>
<th>Validation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pay Value</td>
<td>Money</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Price</td>
<td>Money</td>
<td>12000.00</td>
<td>Min. – Max.</td>
</tr>
<tr>
<td>Registration Date</td>
<td>Date</td>
<td>24–JUN–1994</td>
<td></td>
</tr>
<tr>
<td>Registration Number</td>
<td>Character</td>
<td>L 123 ZYX</td>
<td></td>
</tr>
<tr>
<td>Mileage Band</td>
<td>Character</td>
<td>2501–17999</td>
<td>Lookup (GB_MILEAGE)</td>
</tr>
<tr>
<td>Fuel Scale</td>
<td>Money</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Payment</td>
<td>Money</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 12 – 3 Input Values for NI Car Primary Element
to set a maximum bonus value that depends on length of service and current salary.

With Oracle’s formula writing tool, Oracle FastFormula, you can include conditional logic to validate input values using different criteria for different employees.

See Also

Defining an Element’s Input Values: page 12 – 8
Using Oracle FastFormula for Payroll Calculations: (Oracle FastFormula User’s Guide)
Using Oracle FastFormula for Validation: (Oracle FastFormula User’s Guide)
Element Eligibility Rules

Employees can be eligible for compensation elements in a number of different ways. For example:

- You may have a union group, with negotiated rates of pay. All members of the union are entitled to a fixed rate of pay dependent on their assigned grade and step.
- You might also have groups of salaried employees where you negotiate the level of salary with each employee personally. The salary value might be based on a combination of performance, personal, or market factors that are regularly reviewed with the employee.

In both cases you are dealing with a similar type of compensation, but the rules that govern actual values, as well as eligibility and review, are different. You define these rules in Oracle HRMS using element links.

Element Links

An eligibility rule for an element is defined as a link between the element and the components of the employee assignment. Each link defines a group of employees who are eligible to receive the element.

For example, you might want to give a production bonus only to those employees who work full time in Production and are on the weekly payroll. To do this you would define a link between the element ‘Production Bonus’ and the combination of the ‘Production’ organization, the ‘Full–Time’ employment category and the ‘Weekly’ payroll.

While this link is effective, you cannot pay the bonus to anyone who is not eligible. Similarly, element linking on deductions ensures that you do not take deductions from employees not liable for them.

An employee is eligible for an element when his or her assignment exactly matches the link definition. You can link an element to the following components of an employee assignment:

- Organization
- Job
- Position
- Grade
- Location
- Payroll
• Group Segments
• Employment Category
• Salary Basis

Adjusting Element Values for Different Groups

For each eligibility group, you can also define different default values. For example, you might want to pay a bonus to most employees, with a default value of 2 percent. However, you might want to exclude the Sales department from the bonus, because they are paid on a commission basis, while for everyone in the HR department you might want to default 3 percent.

To do this you would define the bonus element with a default input value of 2 percent. You would then link this to each department in turn, except the Sales department. Employees in Sales would not be eligible for the bonus. When you link the bonus to the HR department, you would change the default to 3 percent.

Multiple Rules of Eligibility

You can define more than one link for each element but there must be no overlap between the eligibility criteria for the links. For example, you could create one link to the combination of grade ‘A’ and the job ‘Accountant’. However, you could not create one link to grade ‘A’ and a second link to the job ‘Accountant’. This would imply that an accountant on grade A is eligible for the same element twice.

Oracle HRMS does not permit you to define links that would make an employee eligible for an element more than once.

Element Qualifying Conditions

An employee is eligible for an element if his or her assignment matches the eligibility criteria on the link. However, an employee might be eligible for an element and yet not receive it because he or she does not meet other qualifying conditions.

Two common qualifying conditions are a minimum age or a minimum period of service in the current assignment. You can define these conditions when you define the element. You can enter or adjust these conditions when you define the element links so that you have different qualifying conditions for different groups of assignments.
These qualifying conditions are checked automatically when you try to enter an element for an employee.

**Using Standard Links for Automatic Element Entry**

If you want all employees who meet the eligibility criteria and qualifying conditions to receive a recurring element automatically, you can define *Standard* links to the element. You can create a standard link if:

- the element is recurring, and
- multiple entries are *not* allowed for the element

If there are no qualifying conditions, the start date of the automatic entry is the date the assignment becomes eligible for the element. For example, this might be the employee’s hire date, or the date of a promotion or transfer.

If you entered qualifying conditions for the element, the start date of the automatic entry reflects the date on which the employee meets the qualifying conditions. For example, if a new hire is entitled to a company car after six months, an element entry is automatically created when the employee is entered on the system, and the start date of the entry is six months after the hire date.

If the employee’s date of birth is altered on the system, this may change the date on which he or she qualifies for the element. In this case, the start date of the element entry changes automatically.

**Manual Element Entries**

You may have other qualifying criteria that are performance or assessment based. Perhaps employees must pass a certain test or achieve a certain volume of sales before they qualify for the receipt of the element. For this type of element (and for all nonrecurring elements), you cannot define a *Standard* link. You must manually enter the element for those employees who should receive it. You can make entries individually or in a batch.
Costing Compensation and Benefits

Using Oracle HRMS, you can record cost information at a number of different levels. These cover the definitions of your organizations, compensations and benefits, individual employee assignments and the specific elements that make up their remuneration package.

When you define the element link you can define how the element values are costed for the group of assignments defined by the link criteria. For example, you may want to cost the same element to different codes for different payrolls.

You can enter Costing information at the element link level if you have set up a segment of the Cost Allocation flexfield with the qualifier Element set to Yes. If you set the qualifier Balancing to Yes, you can do double entry accounting.

The values you enter at the level of the element link apply, by default, to all entries of the element for all assignments matching the link. However, you can set up cost allocation so that users can override the account codes for one assignment, or for a single entry, if required. For example, with timecard entries you may want to record different cost centers for different hours worked. In this case you would want to enter the cost center information when you enter the timecard element.

You enable this by setting up a Cost Center segment with the qualifier Element Entry set to Yes.

See Also

Setting Up the Cost Allocation Key Flexfield: page 6 – 3
Controlling Element Processing in Payroll Runs

In any payroll run, an assignment is processed only if it meets the following conditions:

- it is included in the assignment set selected for the run
- its status, such as Active Assignment or Suspend Assignment, is associated with a payroll system status of Process

You can define your own assignment statuses and associate with each a payroll system status of Process or Do Not Process.

Using formulas, you can vary the processing performed for each status associated with Process. For each element you can either associate a different formula with each assignment status, or you can use the same formula but associate different results with each status. Formula results include direct run results, messages, and updates to other element entries for the assignment.

A further way to control the processing of an assignment is to associate a skip rule formula with an element. The skip rule formula defines when the run should process the element and when it should skip it. The formula can check balances, other element entries for the assignment, the assignment status, or any other information held as a database item to determine whether the element should be processed.

See Also

Assignment Statuses: page 8 – 5
Associating Processing Rules with Elements: page 12 – 12
Writing Formulas for Element Skip Rules: (Oracle FastFormula User’s Guide)
Setting Up Compensation and Benefits for Payroll Processing

To set up compensation and benefits:

1. Using Oracle FastFormula, write the formulas for the element skip rules and element processing rules you require to calculate element results and other processing outcomes in payroll runs.

2. Define elements to represent your compensation and benefit types. For each element, define the input values a user enters when giving the element to an employee.

3. Link each element to your enterprise work structures to define one or more groups of employees who are eligible to receive it. Employees are eligible for an element only if they are assigned to the work structures that are linked to the element.

4. Specify how the element should be costed for each eligibility group.

5. Associate formula result rules with your element processing rules. These specify how payroll processing outcomes take effect.

   See: Associating Processing Rules With Elements: page 12 – 32

6. Make an entry of the element for each employee who should receive it. Depending on how you define and link the element, the entry may be done automatically or manually.
Defining an Element (Payroll Users)

Use the Element window to create element types for earnings, deductions and benefit types.

At set up you can define the date an element is valid from. Similarly, you can also set an end date. The element cannot be linked or entered until the start date and will not be processed after the end date.

Attention: This topic explains how to define elements using a Payroll responsibility, that is, a responsibility with the HR User Type profile option set to Payroll User or HR with Payroll User. If you are an HR User, you cannot see certain fields in the Element window for entering information about how the element is to be processed.

See: Defining an Element (HR Users), Oracle Human Resources User's Guide

Prerequisites

- Decide how you want to validate the values users enter when they give an element to an employee.
  
  If you want to restrict their entries to a list of valid values, use the QuickCode Types window to define a new lookup. Then enter your valid values for this lookup in the QuickCodes window.
  
  If you want to validate values using a formula, write your formula first using the Formulas window.

- Create skip rule formulas if you want to control processing frequency for recurring elements.
  
  See Writing Formulas for Element Skip Rules: (Oracle FastFormula User’s Guide)

- Define secondary classifications if you want to create balance feeds for the element to user defined balances.
  
  See: Defining Secondary Element Classifications: page 12 – 8
To enter dates, names and a classification for the element:

1. Set your effective date early enough to handle any historical element entries you want to make.
2. Enter a unique name, reporting name, and description for the element. The reporting name is a short identifier for reports and pay advices.
3. Select a primary classification.
   If you are defining a salary element for Salary Administration, you must select the classification Earnings.

Processing Information

To enter processing information for the element:

1. Select either Recurring or Nonrecurring as the processing type.
2. Select a termination rule. This determines how entries of the element are processed after termination of the employee. There are three choices:
   - Select Actual Termination if you want recurring entries to close down on the date the employee leaves. For a nonrecurring element, select Actual Termination if you want the entries to close down at the end of the pay period in which the employee
leaves, or on the date the assignment ends (the final process date) if this is earlier.

- Select Final Close if you want the entries to stay open beyond the employee’s leaving date so that you can continue to pay the employee.

- Select Last Standard Process for all recurring and nonrecurring element if you want their entries to close down on the Last Standard Process date or on the date the assignment ends (the final process date) if this is earlier. The Last Standard Process date defaults to the last day of the pay period in which the employee is terminated, but you can set it to a later period.

3. You can check any of the remaining check boxes in the Processing region.

**Multiple Entries Allowed:** Check this to be able to give an employee more than one entry of the element at the same time.

**Additional Entry Allowed:** Check this to be able to make occasional one–off entries of a recurring element.

See: Element Processing Option Examples: page 12 – 27

**Closed for Entry:** Check this to prevent any new entries being made for the element without affecting existing entries. For example, a long service payment element, is not available to newly qualifying employees but continues to exist for the employees already receiving it.

**Attention:** Use this feature with caution. When you perform certain important tasks in Oracle HRMS, the system may automatically create or delete element entries. These tasks include hiring and terminating people, and updating assignments. Therefore, if you check Closed for Entry on an element, this might prevent users terminating employees and updating assignments. If there are standard links for the element, it will also prevent users hiring people who are eligible for the element.

**Process in Run:** Check this if you want the element to process in payroll runs.

**Indirect Results:** Check this if you want the element only to accept entries from indirect formula results. Leave the check box unchecked if you want to accept entries both from indirect formula results and from manual entries in the Element Entries window.

**Adjustment Only:** Check this to use the element only for creating balance adjustments.

**Third Party Payments:** Check this to use the element only for creating third party payments.
4. If you want to determine the order in which the element processes within its classification range, you can overwrite the default priority number in the Priority field. Lower numbers process before higher ones.

If the order of processing within the element classification is not important, you can accept the default priority number, which is the midpoint of the range.

5. To determine how often an element should be processed, select a skip rule in the Skip Rule field.

Currency

The default currency for element entry values in payroll processing is the base currency defined for the Business Group. You can select a different currency for the element if required.

To select currencies for element entries and processing:

1. If you want to make element entries in a currency other than the base currency, select it in the Input field.

2. For Information type elements, you can select a different output currency because these elements do not feed the Payments balance. When you do this, Oracle Payroll converts the entry values to the output currency before they are processed in the payroll run.

For other elements, the output currency is determined by your legislation and you cannot change it.

Note: In the Define Exchange Rates window, you should define the exchange rate between the new input and output currencies, or between the new currency and the base currency, before you run any payrolls.

Qualifying Conditions

To define qualifying conditions for receiving the element:

1. If there is a minimum age for employees to receive the element, enter it in the Age field.

2. If there is a minimum length of service employees must work before receiving the element, enter a number in the Length of Service field and select a unit of measure (such as months or years) in the Units field.

3. If you want the element to be entered automatically for all employees who are eligible, check the Standard check box.
You cannot check Standard if the element is nonrecurring or if Multiple Entries are allowed.

**Note:** The qualifying conditions and Standard check box provide defaults for the element. You can override them for particular groups of assignments when you define the element’s links.

4. Save the element definition.

**Further Details**

**To define further details of the element:**

1. You can enter the Further Information field if you use Oracle SSP/SMP.

2. To define input values for the element, choose the Input Values button.
   
   See: Defining an Element’s Input Values: page 12 – 28

3. To create balance feeds for the element individually, choose the Balance Feeds button.
   
   See: Creating Balance Feeds for Individual Elements: page 12 – 30

4. To select or remove secondary element classifications for the element, choose the Balance Feed Control button.
   
   See: Creating Classes of Balance Feeds: page 12 – 31

**See Also**

Defining and Linking a Salary Element: page 15 – 5
Element Processing Option Examples

The options you choose in the Processing Region of the Element window determine the type of entries that can be made for the element and when they can be made.

Multiple Entries

Suppose you define a nonrecurring element for entering the overtime hours worked by monthly–paid employees. If you enter the hours on a weekly basis, you might need to give an employee five entries of the overtime element in each pay period. You need to enable more than one entry of the element in each pay period by checking the Multiple Entries Allowed check box.

Additional Entries

Suppose you define a recurring bus allowance element to be paid every week to employees working at a particular location. You give these employees a normal recurring entry of the element so that they receive the allowance automatically each week.

However, you also want to give the allowance to other employees temporarily working at the same location. You need to check the Additional Entries Allowed check box so that you can give these employees a one–off (nonrecurring) entry of the element.

Notice that for an element defined in this way, an assignment could have:

- a normal recurring entry only
- an additional entry for one pay period only
- a normal recurring entry and an additional entry

The assignment could have several normal recurring entries of the element (if you also checked the Multiple Entries Allowed check box). However, it can only have one additional entry in a pay period.
Defining an Element’s Input Values

To define input values:

1. Set your effective date early enough to handle any historical element entries you want to make.
2. Enter or query the element in the Element window and choose the Input Values button.
3. Enter the name of the first input value. Remember that if you want to define a pay value, you must name it Pay Value.
4. Select the unit type of your input value (money, hours, character, date, number, or time). A Pay Value must have the unit type Money if the element is in a payments type classification.
5. You can use the Sequence field to change the order in which the input values appear in the Element Entries window.
6. Check the Required check box if all entries of the element must have a value for this input.
7. Check the User Enterable check box if users can enter a value for this input. Uncheck it if you want to ensure that the default value is entered for all employees.
8. Check the Database Item check box if the value can be used as a Database Item in formulas or QuickPaint inquiries.
   Database Items are simple identifiers that the system uses to find specific items of information in the human resources database.

Default Values

To enter a default for an input value:

1. Enter the value in the Default field.
2. If you want existing entries to be updated whenever the default is changed, check the Hot Default check box. The input value must be required if you want to use this option.

A hot default appears in the Element Entries window in quotation marks. If the user overrides the default, subsequent changes to the default will not affect the entry.

Validation

- To enter validation for an input value:
  1. Do one of the following:
     - Enter maximum and minimum values for the input.
     - Select a QuickCode Type to act as a lookup supplying a list of valid values.
     - Select a formula to validate entries for this input value. Formulas can return messages to users about the success or failure of the validation.
  2. Select Warning or Error to determine whether the system warns users that an entry is invalid or prevents them from saving an invalid entry. You cannot select a value if you chose a Lookup because a user cannot enter an invalid value for an input value validated by lookup.
Creating Balance Feeds for Individual Elements

In the Balance Feeds window, you can select balances to be fed by the input values of an element. Balances are either fed by whole classifications of elements or by individual elements, but not by both. Therefore, in this window you cannot select balances that are fed by classifications. You can query a balance in the Balance window and choose the Classifications button to view the list of classifications that feed it.

You can use an element to feed as many balances as you require.

Prerequisite

- Define an input value for the element of the same unit of measure as the balance you want to feed. Money units must be the same currency.

To create balance feeds for one element:

1. Set your effective date to when you want the balance feed to start.
2. Enter or query the element in the Element window and choose the Balance Feeds button.
3. In the Balance Feeds window, select the input value that you want to feed the balance with.

   The list displays all the input values defined for the element. These input values may have different units of measure. When you select an input value its unit of measure displays in the Units field. If you want to feed a balance with the element’s direct run result, select Pay Value.

4. Select the balance you want the input value to feed.

   The list restricts your choice to balances having the same unit of measure as the input value you selected.

5. Select Add or Subtract for the balance feed.
Creating Classes of Balance Feeds

In the Balance Feed Control window, you can classify an element using secondary classifications. These determine the balances that the element feeds. You can query a balance in the Balance window and choose the Classifications button to view the list of classifications that feed it.

Prerequisites

- Define any new secondary classifications you require in the Element Classifications window.
  
  See: Defining Secondary Element Classifications: page 12 – 8

To select or remove secondary element classifications:

1. Set your effective date to when you want the element to begin feeding the balances that the secondary classifications feed.

2. Enter or query the element in the Element window and choose the Balance Feed Control button.

3. In the Balance Feed Control window, delete any default secondary classifications you do not require for the element. When this window opens, it displays any default secondary classifications for the element’s primary classification. Unless they are predefined, you can delete any of these classifications, and you can change their effective start dates.

4. Select any non-default secondary classifications you require.
Element processing rules control the conditions under which elements process. As a minimum, you create a standard rule, which associates a payroll formula with the element. You can also create other rules associating different formulas or formula results with the element. The payroll run selects the rule to use when processing an assignment based on the status of the assignment. For example, you could associate the element Salary with the rules Standard Salary, Disability Pay and Sabbatical Pay.

You associate formula result rules and processing rules with elements in the Formula Results window.

Prerequisite

- Write or check the formulas you want to associate with the element in the Formula window. You can write several formulas for the same element and associate each with a different processing rule.

See: Using the Formula Window (Oracle FastFormula User’s Guide)

To associate processing rules and formula results with elements:

1. Set your effective date as you require.
2. Select the element for which you want to enter a processing rule and formula results.
The element’s description and classification automatically display.

3. Select the standard processing rule and formula for the element.

   **Note:** If you select a formula with inputs that do not match the
element, you will receive a warning message, but you can still save
your rule as you are able to update the formula any time before
running the payroll.

4. If you want the processing of this element to vary by assignment
status, select assignment statuses and formulas in the Processing
Rules block.

5. Save your entries.

6. For each processing rule, select one or more formula result names
from the list of results specified when the formula was written.

7. Select the formula result type appropriate for the result you have
specified. There are five possible types:

   **Direct result:** This is the element’s run result. There can be only
   one direct result per formula.

   **Indirect result:** This result passes as an element entry to the
   nonrecurring element you name in Step 8. A formula can have any
   number of indirect results. Each nonrecurring element must have a
   processing priority causing it to process after the element whose
   formula produces the result.

   **Message:** These are messages the formula issues under certain
   conditions. For example, a formula can check a loan repayment
   balance and, if the balance is zero, issue the message “Loan is
   repaid.” You read formula messages on the message listing
   reports.

   **Stop:** This formula result stops the entry of the element you name
   in Step 8 from processing. This element must be a recurring entry
   type with multiple entries not allowed.

   **Update recurring entry:** This result updates the element entry for
   the element you name in Step 8. This element must be a recurring
   entry type with multiple entries not allowed. However, you can
   pass a recurring element’s results to itself even if multiple entries
   are allowed for this element.

8. If you select indirect result, stop, or update recurring entry as the
formula result type, select the name of the element to which you
want to pass the formula result. This element must have a
processing priority causing it to process after the element whose
formula produces the result.
9. If you select indirect result or update recurring entry as the formula result type, select the input value name to which you want to pass the formula result.

10. If you select Message as the formula result type, select a message severity level. There are three choices:

   **Fatal**: When a message with this severity results from your formula, the run rolls back all processing for the employee assignment.

   **Warning**: A message with this level of severity does not affect payroll processing but warns the user of a possible problem.

   **Information**: A message with this level of severity simply gives information.

**Correcting and Updating Processing Rules**

When you add a formula result it takes on the effective end date of its processing rule. Any date effective changes you make to existing processing rules can affect formula results as follows:

- **Update**: If you update a processing rule or give it an effective end date, all the rule’s currently effective and future–dated formula results automatically get identical end dates.

- **Correction**: If you correct a processing rule, all its currently effective and future–dated formula results remain unchanged.

- **Future delete**: If you delete all future changes scheduled for a processing rule, this also deletes any future changes scheduled for the rule’s formula results.

**See Also**

Assignment Statuses: page 8 – 5

Defining Element Links

Use the Element Link window to define groups of assignments that are eligible for an element.

Prerequisites

- In Oracle Payroll, you can distribute direct costs (such as an employer’s contribution to a pension plan) over other elements (such as employee’s pensionable earning elements). If you want costs to be distributed, define a distribution set in the Element and Distribution Set window. This set contains the elements over which you plan to allocate the costs.

See: Defining an Element or Distribution Set: page 20 – 6

To define an element link:

1. Set your effective date to the date you want the eligibility criteria to come into effect.
2. In the Element Name field, select the Element for which you are defining a link.
3. Check the Standard check box if you want all employees who are made eligible by the link to receive the element automatically. You can only create a standard link if:
   - the element is recurring, and
   - multiple entries are not allowed by the element definition
4. In the Eligibility Criteria region, select the assignment components that form the basis of your eligibility rule. If you want to link to all employees, do not enter any eligibility criteria.

You can link to all payrolls or to a specific payroll. Do one of the following:

- Enter the name of a specific payroll if you want only employees on that payroll to be eligible for the element. Do not check the Link to all Payrolls check box.
- Leave the Payroll field blank and check the Link to all Payrolls check box if you want employees assigned to any payroll to be eligible. This rule excludes employees who are not assigned to a payroll.
- Leave both fields blank if assignment to a payroll is irrelevant to eligibility for the element.

Costing

To enter costing information for the link:

1. In the Costing alternative region, select the Costable Type. Notice that some element classifications are predefined as Not Costed and you cannot override this.

   - If you do not want to allocate costs for the element, select Not Costed.
   - If you want all entries of the element to be allocated to the same account, select Fixed Costed. This prevents users overriding the account code at the assignment and element entry levels.
   - If you want users to have the flexibility to override the account code at these lower levels, select Costed.
   - If you want to distribute overhead costs over other elements, select Distributed. Then select a Distribution Set.

2. For deductions elements:

   - Enter the account code you want to credit in the Costing field.
   - Enter the account code you want to debit in the Balancing field.

   For elements in all other classifications:

   - Enter the account code you want to debit in the Costing field.
   - Enter the account code you want to credit in the Balancing field.

   Depending on your set up of the Cost Allocation flexfield, the Balancing field may not be enabled.
3. Check the Transfer to GL check box if you want Oracle HRMS to transfer cost totals to the general ledger on completion of each payroll run.

Qualifying Conditions

► To enter qualifying conditions for the link:
  ■ In the Qualifying Conditions alternative region, you can add or change age or length of service conditions for this particular eligibility group.

  The system checks these conditions when you make an entry of the element. If the employee does not meet the qualifying conditions, you receive a warning.

Input Values

► To adjust input values for this eligibility group:
  ■ Save your link definition and choose the Input Values button.

Adjusting Input Values for an Eligibility Group

In the Link Input Values window, you can adjust the Default, Maximum, and Minimum for each input value. Logically, the new values should be within the range you defined for the element itself. However, this is not enforced.

You can also choose which input values are costed by checking the Costed check box.
Element Link Details Report

This report allows you to check the eligibility criteria that have been defined for an element. You can restrict the information in the report by certain assignment components, by element or element classification, by element processing type, and by link type and status.

You run reports from the Submit Requests window.

► To run the Element Link Details report:

1. In the Name field, select Element Link Details Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Select the classification of elements you want to report on. Optionally select an element processing type (recurring or nonrecurring) or an element to further restrict the report.
5. If you want to restrict the links listed in the report to standard links only, select Yes in the Standard Link field. Select No to restrict the report to non–standard links. Leave blank to report on both types of link.
6. You can select a link status to restrict the report to links that are either Active or Inactive at your effective date.
7. Do one of the following:
   • Select No in the All Payrolls field and select a payroll in the Payroll field to report on links to this payroll only.
   • Select Yes in the All Payrolls field and leave the Payroll field blank to report on links to all payrolls.
   • Select No in the All Payrolls field and leave the Payroll field blank, to report on all links irrespective of their payroll criteria.
8. You can also select a job or organization to report on links to these assignment components only.
9. Choose the Submit button.
Customizing the Element Entries Window

As part of the setup of compensation and benefits, you need to plan how users will make element entries. For example, you will want to consider how you will use the MIX facility and which users have access to the Element Entries window.

You can create customized versions of the Element Entries window. A customized version might restrict the elements a user can enter. This enhances speed, usability, and security for specific data entry scenarios.

For example, one version could be restricted to the element name 'Timesheet' and accessed from a menu entry labelled 'Timesheet Entries'.

Element entry can be restricted by:

- Element Set (that is, a group of elements that you define)
- Element Type (that is, recurring or nonrecurring)
- Element Classification (such as, Earnings, or Direct Payment)

See Also

Restricting the Data Displayed in a Window: page 20 – 3
Tracking Compensation and Benefit Changes

It is inevitable that your business rules for compensation and benefits will change over time. Element definitions, link definitions, and element entries are all datetracked. This lets you track the changes to your compensation and benefit policies without losing any of your historical employee information. The history of your definitions remains in place for validation and reporting, and for future calculations of back pay.

Maintaining Elements

After you have defined and used an element, you can make the following changes:

- Change a required input value to be not required
- Alter the sequence in which input values appear in the Element Entries window
- Change the input value validation rules for minimum, maximum, lookup, or formula
- Change your specification of which input values create Database Items. Note, however, you cannot remove Database Items if they are used in any formulas or QuickPaint reports.

You cannot remove existing input values nor add new ones if you have created any entries for the element.

Maintaining Links

Link rules always control the entry of element values at the time of entry. Changes to link rules affect existing entries in different ways, depending on your use of Standard links and Hot Defaults. After you have used an element you can make the following changes to the link rules:

- Change the input value defaults and validation.
  - These changes affect all new entries. Changes to hot defaults affect existing entries. Changes to validation also affect existing entries when you update the entry.
- Date–effectively end all of the rules that apply to an element and define a new set of rules, which are effective from a later date. For example, suppose you have defined eligibility for a company car based on grade. Following a change of policy you must now define eligibility based on job.
− You will not be allowed to end the link if any nonrecurring entries exist at the date you want to end the rule. You must delete existing entries before you end the link.
− You can end the link if recurring entries exist. Any existing entries will be ended, automatically, when you end the link.

- Change the qualifying conditions of age and length of service that employees must meet to be eligible for the element.

Policy Development

With DateTrack you can also make future-dated changes to your information safe in the knowledge that these changes will not become effective in the system until the correct date.

In this way you can use your compensation and benefit information to plan changes ahead of time; analyze the impact of these changes; adjust these changes and generally smooth out the workload that is often associated with major changes in compensation and benefits policy.

See Also

Managing Change Over Time: page 1 – 11
Entering Compensation and Benefits

An employee must have an entry for an element to receive that element as a component of his or her compensation and benefits package. You can start, update and stop element entries for individual employees in a number of different ways:

- You can define standard element links so that eligible employees receive an entry automatically.
- You can use MIX (Mass Information Exchange) to enter a batch of element entries, using defaults for fast entry.
- You can make manual entries of most elements for an individual assignment in the Element Entries window. However, there are two exceptions. You enter salaries in the Salary Administration window, and you enter absences in the Absence Detail window.

Processing Element Entries

If you also implement Oracle Payroll, you can process these entries in a payroll run. The payroll process is the means by which you calculate actual earnings and deductions for each employee in each pay period.

Oracle Human Resources and Oracle Payroll fully share the information you set up for compensation and benefits. You use the same elements, the same rules to determine eligibility, and the same entries to show personal levels of compensation and benefits.

If you decide not to implement Oracle Payroll you can still use your HR compensation and benefit information for transfer to your own payroll system.

See Also

Entering Absences: page 10 – 13
Entering Salaries and Salary Changes: page 14 – 9
MIX For Batch Entry: page 12 – 50
Automatic or Manual Element Entry

If an element is defined as recurring with standard links, the system makes an entry automatically for all eligible assignments.

**Suggestion:** If you are defining elements for information only, aim to define recurring elements with standard links and default values. This reduces your manual data input requirements to a minimum.

If an element is nonrecurring, or if you have enabled multiple entries for a recurring element, you cannot define standard links. This means you must make a manual entry of the element. You can make entries individually or in a batch, for fast data entry.

Manual Entries for Recurring Elements

You can start entries for a recurring element at any point in time. Use DateTrack to set the Effective Start Date of an entry, to update values, and to maintain history for the entry.

Values you enter for a recurring element remain effective for all subsequent processing periods until you change the element entry. A recurring element entry ends if the employee ceases to be eligible for the element, for example after a change of work assignment.

Manual Entries for Nonrecurring Elements

When you define an element as nonrecurring you are saying that an entry made for this element is effective for only the current pay period. To make the entry, you set your effective date to *any* date in the appropriate pay period.

Any changes you make to individual entries are always corrections. There can be no history of element entries within a payroll period. However, the entries for each period (if any) are stored as history for an employee.

**Note:** Effective Start and End Dates for a nonrecurring entry are the dates of the pay period. As a result, employees must be assigned to a payroll before they can have nonrecurring element entries.
## Entering Elements

You enter compensation and benefits for employee assignments in the Element Entries window. If the employee is assigned to a salary basis, you enter his or her salary in the Salary Administration window.

You can use the Element Entries window to make entries or to inquire on existing entries. Use the Period field, Classification field, and Processing Types option buttons to restrict the entries you see when making inquiries.

The Processed check box displays whether Oracle Payroll has processed the entry in the current pay period.

---

### To enter an element for an employee assignment:

1. Change your effective date if necessary to:
   - the correct start date for a recurring element entry
   - any date in the correct pay period for a nonrecurring element entry

   If the pay period is closed at your effective date, you cannot enter any nonrecurring elements that process in a payroll run. If a current or future pay period is closed, you cannot enter any recurring elements that process in a payroll run.

2. If you want to reduce the list of elements to choose from, select a Classification or a Processing Type, or both, in the first region.

3. In the Element Name field, select an element.
The system checks whether the employee meets the element’s qualifying conditions. If the employee is either not old enough or has not served for the required qualifying period, it displays a warning message.

**Note:** Entries for elements defined with a standard link appear automatically.

4. If the Costing field is enterable, you can enter a cost code, for example to indicate to which cost center the assignment’s time should be charged.

5. You can enter a reason for the element entry you have made or updated. To add new reasons to the list, enter values for the QuickCode Type ELE_ENTRY_REASON.

6. You can check the Override check box to create an entry that overrides all other entries of this element in the current period. You cannot create an override entry if one already exists, or if any of the entries of this element have been adjusted.

7. If you want to create a one–off entry of a recurring element, check the Additional check box.

An Additional entry is valid only for the current pay period, shown in the Effective Dates fields.

You can only check Additional if:

- the element definition allows additional entries, and
- an additional entry does not already exist for the assignment in this period, and
- the employee is assigned to a payroll
- there is a payroll period defined at your effective date

8. Choose the Entry Values button to open the Entry Values window.

9. Enter values in the Entry Values fields. Notice that:

- Entry to some fields may not be permitted.
- Some fields may be required.
- Some fields may have a list of values; others may be validated as you leave the field. You will receive a message if your entry is not a valid value.
- Some fields may contain default values. If the default value is in quotation marks, it is a “hot default”.

**Attention:** You should consider carefully before overriding a hot default. If you override it, then any subsequent changes to the
default value on the element or element link definition will not affect the element entry. However, you can clear your entry if you want the default value to come back into effect.

10. Save your work.

Adjusting a Pay Value

Oracle Payroll users can adjust the Pay Value of any normal recurring payroll element entry. When you open the Entry Values window for an entry of this kind, you will see a Show Adjustment check box in the lower left corner of the window.

You cannot adjust an entry that has been overridden.

**Note:** You do not see this check box until you have saved the entry.

**To adjust a Pay Value:**

1. Check the Show Adjustment check box.

2. In the Adjustment pop list, select Add, Subtract, or Replace. You can only select Add or Subtract if the Pay Value is numeric.

3. Enter the value to add to, subtract from, or replace the existing Pay Value entry.
Making Third Party Payments

Oracle Payroll enables you to make both single and recurring deductions from employee salary for third party payments, and to specify either corporate bodies or individuals as payees. The deductions you can make include:

- court orders and arrestments of earnings
- GAYE deductions for charity
- deductions of union dues

How you pay third parties is determined by whether the Third Party Payment check box is checked when defining the deduction element. If this check box is unchecked, you must pay third parties outside Oracle Payroll through Accounts Payable. If it is checked, you can pay third parties through Oracle Payroll, using a third party payment method that you have defined.

Table 12 – 4 shows how this has been set up for predefined third party deductions elements. Court Orders can be deducted and paid entirely through Oracle Payroll. GAYE deductions can be made through Oracle Payroll but must be paid outside the system.

<table>
<thead>
<tr>
<th>Element Name</th>
<th>Classification</th>
<th>Third Party Box Checked</th>
</tr>
</thead>
<tbody>
<tr>
<td>Court Order</td>
<td>Court Orders</td>
<td>Yes</td>
</tr>
<tr>
<td>Court Order Non Priority</td>
<td>Court Orders</td>
<td>Yes</td>
</tr>
<tr>
<td>EAS Scotland</td>
<td>Court Orders</td>
<td>Yes</td>
</tr>
<tr>
<td>CMA Scotland</td>
<td>Court Orders</td>
<td>Yes</td>
</tr>
<tr>
<td>CAO Scotland</td>
<td>Court Orders</td>
<td>Yes</td>
</tr>
<tr>
<td>GAYE</td>
<td>Pre Tax Deductions</td>
<td>No</td>
</tr>
</tbody>
</table>

Table 12 – 4 Predefined Elements for Third Party Payments (Page 1 of 1)

See Also

Entering Court Order Elements: page 16 – 11
Entering Elements for Scottish Arrestments: page 16 – 14
Setting Up Deductions

To set up deductions for third party payments:

1. Define or select the deductions element.
   Deductions elements for court orders, arrestments and GAYE are predefined. There are no predefined elements for union dues.
   Deductions elements you define for union dues should have the classification Voluntary Deductions and the element type Recurring. Check the Third Party Payments check box for these elements if you want to make payments as well as deductions through Oracle Payroll.
   See:
   Defining an Element (Payroll Users): page 12 – 22
   Oracle Payroll and Court Orders/Arrestments: page 16 – 9

2. Link the element to the assignment payroll.
   See: Defining Element Links: page 12 – 35

3. Create one or more organizational payment methods for third party payments.
   See: Defining Payment Methods for the Enterprise: page 5 – 3

4. Enter these payment methods as valid payment methods on your payrolls.
   See: Defining a Payroll: page 5 – 5
Making Deductions

The sequence for making third party deductions and payments through Oracle Payroll is as follows.

1. **To make third party deductions from individual assignments:**
   1. Create the organization or person to receive the third party payment.
      
      You create payee organizations in the Organization window, selecting the Payee Organization classification. You create individual payees as contacts of the person making the deduction. In the Contacts window, check the Payments Recipient check box when you create the payee.
      
      See:
      
      Creating an Organization: page 2 – 10
      Entering Next of Kin and Other Contacts: page 9 – 13
   2. In the Personal Payment Method window, select a third party payment method for the assignment. In the Payee region, select the payee you have created.
      
      See: Entering Payment Methods for an Employee Assignment: page 11 – 19
   3. Create an element entry for the deduction.
      
      In the Entry Values window, you enter details of payment, payee and payment method. Required entry information varies according to the kind of deduction you are making.
      
      See:
      
      Entering Court Order Elements: page 16 – 11
      Entering Elements for Scottish Arrestments: page 16 – 14

Making Payments

After payroll processing takes place, the pay value of the deductions element is paid according to the third party payments method you have defined.

See: Defining Payment Methods for the Enterprise: page 5 – 3
MIX for Batch Entry

Use the Batch Header and Batch Lines windows of MIX’s BEE (Batch Element Entry) facility for rapid entry of batches of information held as element entries. This information might include timecard data, compensation information, and vacation entitlements, for example.

You can enter information in a batch for as many elements and assignments as you require. You can enter defaults for any value to speed up data entry, and you can change the defaults as you work through a batch. You choose which element input values to display in the Batch Lines window.

Validation of Batch Entries

To validate a batch after saving it, you run the BEE validation process from the Batch Header window. This process checks the header and each line of the batch. For example, it checks that each assignment number exists in the database, and that you have specified values for all required input values.

You can add your own validation procedures to the standard process. For example, you can set up control types, such as record counts, and write a validation procedure to check that the batch matches the control totals you enter for each type. You can also add any business validation you require, for example to check that amounts entered for a bonus do not exceed a maximum, or that an assignment’s paid time off entitlement is sufficient to cover time taken.

When the batch is ready for transfer to the database, you run the BEE transfer process from the Batch Header window. This process first performs the same checks as the validation process. If it finds no errors, it transfers the element entries from the temporary tables to the Entries table in Oracle HRMS.

You can choose whether the transfer process automatically purges the entries from the temporary tables after transfer. You can also run a separate purge process.

Batch Statuses

The Batch Status depends on the status of the batch header, all the batch lines, and any control totals specified for the batch. On the Batch Header window, you can see the following status values:

Valid

All of the lines, control totals, and header are valid.
### Creating and Updating Batches of Element Entries

You can enter batches of element entries in the Batch Header and Batch Lines windows.

#### Prerequisites

- You can create additional validation procedures for checking the batch header and lines, and for validating the batch against control totals.
- If you want to use control totals to validate the batch, enter values for the QuickCode Type CONTROL_TYPE.

#### Entering a Batch Header

The header identifies the batch and determines what happens if any of the batch lines duplicate existing element entries.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transferred</td>
<td>All of the lines, control totals, and header have been transferred.</td>
</tr>
<tr>
<td>Unprocessed</td>
<td>At least one line, control total, or the header is unprocessed.</td>
</tr>
<tr>
<td>Error</td>
<td>At least one line, control total, or the header is in error.</td>
</tr>
<tr>
<td>Status Mismatch</td>
<td>The combination of statuses in the header, lines, and batch is not consistent. For example, it is inconsistent for some, but not all, of the lines to have the status Transferred.</td>
</tr>
</tbody>
</table>

**Note:** A status mismatch is not possible if you always use the Batch Header and Batch Lines windows to enter and maintain a batch.
To enter a batch header and control totals:

1. Set your effective date to the date when you want the entries to take effect.

2. Enter a name for the batch, and enter a reference number and the source of the batch, if you require these for your own reference.

3. Select what action the process should take if one of the batch lines matches an existing element entry for an assignment at the effective date.

   - Create New Entry – The process creates a new entry if multiple entries of the element are allowed by the element definition. If multiple entries are not allowed, the process sets the status of the batch line to Error.
   - Reject Entry – The process sets the status of the batch line to Error.
   - Change Existing Entry – The process corrects or updates the existing entry. If there is more than one existing entry, the process sets the status of the batch line to Error.

   The Undefined option is display–only (for batches created using SQL*Plus or a similar tool).

4. If you selected Change Existing Entry, select the type of date effective change to be made to recurring entries:

   - Update – The process changes the existing entry from the effective date, but preserves the previous information. If there are future–dated changes to the existing entry, the process inserts the change before the next scheduled change.
• Correct – The process corrects the existing entry from its start date through to its end date. Any future-dated changes are unaffected.

• Override – The process changes the existing entry from the effective date, but preserves the previous information. If there are future-dated changes to the existing entry, the process replaces all future-dated changes with the batch line.

  Notice that if you select this option, you cannot check the Reject if Future Changes check box.

The Undefined option is display-only (for batches created using SQL*Plus or a similar tool).

5. If you want to reject batch lines that match entries that start in the future or for which future changes are scheduled, check the Reject if Future Changes check box.

  Notice that if you check this box, you cannot select the Override option.

6. If you want the batch to be purged from the temporary tables after successful transfer to Oracle HRMS, check the Purge After Transfer check box.

7. If you have set up control types to validate the batch before transfer, choose the Totals button. Select a batch control type and enter the total for the batch. You can enter as many types and totals as you require.

**Entering Batch Lines**

A batch line is one element entry for an assignment.

Use the Create Batch Lines window to create identical lines for all assignments identified by an assignment set. This is a quick way to create many lines for an element. If the input values need to vary between assignments, you can leave these blank and add them later using the Batch Lines window.

In the Batch Lines window, you can enter new lines for individual assignments, and you can view and edit lines created automatically for an assignment set. You can speed up entry of new lines by entering default input values

  **Note:** A batch can contain lines for as many elements as you require. Lines within a batch can have different effective dates.

To navigate to these windows, first create and save a batch header in the Batch Header window. Then choose the Create Lines button (for
the Create Batch Lines window) or the Lines button (for the Batch Lines window).

► **To enter batch lines for an assignment set:**

1. Select the assignment set and payroll which identify the employees you want to create lines for.
2. Select the element for the batch lines and enter input values as appropriate.
3. Change the effective date if required.
4. Choose the Process button to submit a concurrent process called Create Batches. Confirm that you want the system to create the lines.

   The Batch Lines window now closes, taking you back to the Batch Header window.

5. Choose the Create Lines button again if you want to add lines for another element. Requery your batch and choose the Lines button if you want to view and edit the lines created by the process.

► **To enter batch lines manually:**

1. Choose the Lines button.
2. Select the element for which you want to make entries.
3. To enter default values to speed up the data entry, choose the Defaults button. The Defaults window displays the input values for the selected element.

4. Enter default values in any of the fields in the Defaults window. These defaults apply to all new entries in the batch, but not to any entries you have already made. You can change the defaults at any time during your data entry.

5. Uncheck the Display check box for any field that you do not want to display in the Lines window. You might want to hide any fields for which the default is correct for every entry.

6. In the Lines window, enter the data required for the batch. Lists of values are available on some fields, but no validation is enforced during data entry.

   You can override the Effective Date for any line. This is the effective start date for a new entry or the effective date of an update.

7. Save your entries. If you want to make entries for another element, select the element, enter new defaults, enter the lines, then save again.

Retrieving Existing Batch Lines

Use the Batch Lines window to view existing batch lines.

**To retrieve existing batch lines:**

1. Do one of the following:
   - Select the element in the Element field.
   - Check the Unknown Elements check box if you are querying batch lines entered for an invalid element (or no element) by SQL*Plus or another tool.

2. Choose the Find button.

Updating a Batch

You can update a batch at any time before you transfer it. If you make any changes to a batch with the status Validated or Error, the batch status changes to Unprocessed.
Validating a BEE Batch

You can validate a batch with the status Unprocessed, Error, or Valid. The validation process tests each batch line against certain predefined rules about element entries, and also against your own rules if you have created additional validation procedures.

To validate a batch:

1. Query the batch in the Batch Header window, and choose the Process button.
2. Select Validate, and choose Start. The system displays the concurrent request ID so that you can query it on the Requests window.
3. When the concurrent request is completed, query the batch in the Batch Header window.
   If the Batch Status is Valid, the validation was successful. If the Batch Status is Error, at least one line, control total, or the header is in error.
4. To view the status of individual lines in the batch, choose the Lines button. In the Batch Lines window, select an element and choose Find.
5. If you entered control totals for the batch, choose the Totals button on the Batch Header window to view the status for each control type.
6. To view messages for the whole batch, or all lines, or control totals, choose the Messages button. Use the option group at the top of the Messages window to control which messages are displayed.

Transferring a BEE Batch

A batch exists in the temporary BEE tables only until you run the transfer process to create element entries in the Oracle HRMS Entries table.

To transfer a batch:

1. Query the batch in the Batch Header window, and choose the Process button.
2. Select Transfer, and choose Start. The system displays the concurrent request ID so that you can query it on the Requests window.
3. When the concurrent request is completed, query the batch in the Batch Header window.

   If the Batch Status is Transferred, there were no errors in the batch and the process has created the element entries. The process may have issued messages associated with the batch header, lines, or control totals.

   If the Batch Status is Error, the process has set the status of at least one line, or control total to Error. Check the status fields in the Batch Lines window and the Control Totals window, and review the messages issued by the process.

---

**Purging a Batch From the BEE Tables**

If the Purge After Transfer check box on the Batch Header window is checked when you run the transfer process, the batch is deleted from the MIX tables automatically after the transfer. If the box is not checked, you can purge the batch by running a separate process.

You can purge a batch with any status.

► **To purge a batch:**

1. Query the batch in the Batch Header window, and choose the Process button.

2. Select Purge, and choose Start. The system displays the concurrent request ID so that you can query it on the Requests window.

   When the concurrent request is completed, the batch is purged.

---

**Rolling Back a MIX Process**

You can roll back a MIX process if you want to completely remove it after it successfully completes. You have a choice of deleting the batch header as well or of keeping the header after the rollback.

The process interlock rule (which prevents you rolling back a payroll process if any further processing has taken place) does not apply to MIX Rollback. You can still perform the rollback even if run results from payroll processing exist for any of the lines.

You run the MIX Rollback process from the Submit Requests window.

► **To roll back a MIX process:**

1. Select the batch header name of the process you want to roll back.
2. Enter Yes to cancel the rollback process if the system detects run results for any of the batch lines. Enter No if you want the system to complete the rollback even though run results exist.

3. Enter Yes to keep the batch after the rollback. Enter No to delete the batch after the rollback.
Inquiring on Compensation and Benefit Entries

Three windows are provided for making inquiries:

- In the Element Entries window, you can view the entries for one employee assignment in any one pay period.
- In the List Employees By Element window, you can view a list of the employee assignments receiving a compensation element in any period of time you choose. You can also see the last entry value for each assignment.
- In the View Element Entry History for Employee window, you can view the history of entries for one or more elements for an employee.

If your system administrator has customized these windows, you may be restricted to viewing elements of a certain processing type or classification.
Listing Employees by Element

In the List Employees By Element window you can view a list of the employee assignments receiving a compensation element in any period of time you choose.

To view a list of employees receiving an element:

1. Select an element.
2. Select Current Employees, Ex–employees, or both.
3. You can also enter a date range. Both date fields default to your effective date.
4. You can enter additional query criteria in the second region.
5. Run the query.

The window displays all entries of the element for employees of the type you selected in the chosen time period.

Note: This window does not display datetracked updates to recurring element entries. You only see the latest value (within your chosen time period) of each element entry. The date of the last datetracked update may vary from employee to employee.
Viewing Element Entry History

In the View Element Entry History for Employee window you can view, for a single employee assignment, a history of entries for:

- all recurring elements, all nonrecurring elements, or both
- elements from a selected classification

To view element entry history for an employee:

1. Enter your selection criteria. You can:
   - Select a classification.
   - Select a processing type.
   - Enter a date range. The end date defaults to your effective date.
2. Place your cursor in the Element Name field and run the query.
   The window displays all entries of the types of element you selected within the time period, including datetracked updates to entries. New entries are shown in bold to contrast with datetracked updates, which are listed under the initial entry.
3. Select an entry and choose the Entry Values button to view the entry values.

Element Result Listing

This report sums all the run results processed for a particular element over a defined period, and displays them by individual assignment. In
addition, it lists the run results of each employee’s last assignment process for input values you select.

You run the report in the Submit Requests window.

**To run the Element Result Listing:**

1. In the Name field, select the report name.
2. In the Parameters window, select the name of either the consolidation set or payroll for which you want to see information.
3. Select the element and date range for which you want to see information.
4. You can further restrict information you see by selecting an organization.
5. Select up to three input values for which you want to see run results of each employee’s last assignment process. These input values appear on the report in the order in which you select them.
6. Select additional sort parameters for assignment information if you require them. The default is payroll, which is always the first parameter. You can also select from organization, employee name and assignment number.
7. Choose the Submit button.

**See Also**

Viewing Employee Run Result History: page 17 – 59
Balances play an important role in Oracle Payroll functions. This chapter gives information on predefined balances in Oracle Payroll. It also explains how you can create and adjust user balances, and how you can control balance feeds and dimensions.
Balances in Oracle Payroll

Balances show the positive or negative accumulation of particular values over periods of time. They are generated by payroll runs and hold pay values or other related values such as time periods and numbers of employees. A Holiday balance, for example, could show the amount of leave already taken by an employee against an annual entitlement element to date. The Taxable Pay balance is one that reflects both positive and negative accumulations of different taxable values over a fixed period of time.

Balances may have restrictions limiting the values that feed them under certain conditions. This can include legislative requirements. For example, if an employee transfers to a payroll reported under a different Tax District Reference Number, the Taxable Pay to Date balance must start again. If the employee transfers to another payroll reported under the same Tax District Reference Number, the Taxable Pay to Date balance continues to accumulate as before.

Startup and User Defined Balances

Oracle Payroll balances are in two categories:

- **Startup** balances, which are put in place by localization teams.
- **User defined** balances that you define in the Balance window to meet your particular additional requirements.

Startup balances are mainly legislative, that is, they reflect the tax legislation of the country where your enterprise is located. They accumulate over standard periods of time such as a payroll period, a quarter, or a year.

See Also

Classifications and Balance Feeds: page 12 – 4

Viewing and Creating Balance Feeds

To enter values to a balance you have to define its balance feeds. These feeds are the input values of the elements feeding the balance, either as additions or subtractions. If an element has input values of different units of measure, only the ones of the same unit of measure as the balance are used as its feeds.

You can define balance feeds for particular elements and particular input values, and you can also define them for whole classifications of
elements. When you specify that a balance is to be fed by a particular classification, all elements that belong to that classification, including any that you create subsequently, automatically feed that balance. As with individual feeds, the balance can only be fed by input values of the same unit of measure as the balance. In the case of Earnings elements, the balance is fed by the sum of these elements’ pay values.

Creating Feeds Using Element Classifications

Using element classifications means you can create balance feeds for whole categories of elements. For example, if you specify that a balance is to be fed by the Earnings classification, then all elements you define with Earnings as their primary classification feed this balance automatically.

Creating balance feeds using primary classifications tells the system that all elements of the classification must feed the balance. You cannot remove these balance feeds once created.

You can also create balance feeds using secondary element classifications. This allows you to choose which elements from the primary classification should be in the secondary classification and, therefore, feed the balance. You have date effective control over the start and end dates of each element in a secondary classification.

Creating Individual Balance Feeds

You can create balance feeds from individual elements for balances that are not already fed by element classifications. There is no limit on how many balances an element can feed. For example, an element may feed one or more balances by virtue of its primary or secondary classification, and one or more further balances by virtue of its individually created balance feeds. The same balance can be fed by more than one element classification or, alternatively, by more than one individually created balance feed.

Note: Oracle Payroll does not allow you to mix balance feeds created by element classifications with feeds created manually.

You can create balance feeds for element classifications in either of the following windows:

- the Balance Feeds window of the Element form
- the Balance Feeds window of Balance form

The window to use depends on whether you want to create feeds from more than one element to a single balance, or feeds from one element to
more than one balance. Table 13 – 1 sets out the options and indicates which window to use for your purpose.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Form to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balance feeds from one element to more than one balance.</td>
<td>Element</td>
</tr>
<tr>
<td>Balance feeds from more than one element to one balance.</td>
<td>Balance</td>
</tr>
<tr>
<td>Balance feed from one element to one balance.</td>
<td>Balance or Element</td>
</tr>
</tbody>
</table>

*Table 13 – 1 Creating Individual Balance Feeds*

**Balance Feed Examples**

Below are examples of balance feeds to some of Oracle Payroll’s predefined balances.

**Automatic feed**

The Gross Pay balance must be fed by all the payments elements. To ensure that this takes place automatically, Oracle Payroll has linked the primary classification of these elements to this balance.

**Discretionary feed**

The Taxable Pay balance may be fed by the same elements as Gross Pay and, in addition, is reduced by the Pre–Tax elements. Oracle Payroll links the secondary classification ‘Taxable Earnings’ to the Taxable Pay balance, so that you can decide which Earnings elements feed taxable pay. You do this by classifying these elements in the Taxable Earnings secondary classification.

**Individual feed**

The PAYE balance, which is fed only by the element PAYE, is an example of a balance with an individual feed from one element.

**See Also**

Defining Secondary Element Classifications: page 12 – 8
Creating Classes of Balance Feeds: page 12 – 31
Balance Dimensions

Balance dimensions indicate the time span over which balances accumulate. They specify to the system how long to sum a balance and this information can be accessed by formulas and reports. Most balance dimensions apply to assignment level balances. Standard dimensions implement simple rules such as:

- sum this balance since start of year
- sum this balance since start of period

Statutory dimensions implement legislative rules such as:

- sum this balance since the start of the statutory year
- sum this balance since a transfer from a different tax reference

When you are working in the Balance window, all balance dimensions are predefined. You can select any number of them for your own user balances. Additionally, you can create user-defined balance dimensions from the Submit Requests window. User-defined balance dimensions can then be associated with any predefined or user-defined balance.

UK Payroll Dimensions:

**Standard Dimensions**

You are likely to combine these with many of your balances to sum balance feeds for an assignment.

- **_ASG_RUN** during one payroll run
- **_ASG CALENDAR QTD** since start of calendar year, reset every three months
- **_ASG CALENDAR YTD** since start of calendar year, reset every year
- **_ASG QTD** since start of tax year, reset every three months
- **_ASG YTD** since the start of payroll processing year
- **_ASG PROC_PTD** for payroll processing period
- **_ASG_ITD** since the start of assignment

**Statutory Dimensions – Single Assignments**

These statutory dimensions are normally used for summing balance feeds for single assignments to predefined balances.
since the start of the statutory period; used in NI and PAYE formulas

**Note:** The statutory period is the same as the processing period but includes results from previous payrolls if the assignment has transferred.

**_ASG_TRANSFER_PTD_** since the latest of start date of the processing year or start date of the employee on that payroll

**_ASG_TD_YTD_** since the latest of the start of a directorship or the start of the processing year; used in NI formulas for directors

**_ASG_STAT_YTD_** since the start of the statutory period; used in NI and PAYE formulas

**_ASG_TD_ITD_** since the start of calendar year or since a transfer from a different tax scheme; used in PAYE formula and EOY reporting

**_ASG_PROC_YTD_** since the latest of start of tax year; used in NI Class 1a calculation and reporting

**_ASG_TD_ITD_** since start of assignment or since transfer from a different tax scheme; used in PAYE formula

**Statutory Dimensions – Multiple Assignments**

These statutory dimensions are usually associated with predefined balances for summing balance feeds for an employee’s multiple assignments when those assignments are in the same tax scheme, that is, report under the same tax reference.

**_PER_TD_YTD_** since the latest of start date of the processing year or start date of the employee on that payroll

**_PER_TD_DIR_YTD_** since the latest of the start of a directorship or the start of the processing year; used in NI formulas for directors

**_PER_NI_PTD_** since the inception of that element entry

**Payments Dimension**

This is a special dimension which aggregates results from payroll runs that have been picked up in a particular pre-payments run.

**_PAYMENTS_** for a set of payroll runs

**Court Order Dimensions**

The element dimensions associated with court orders aggregate results for a particular element entry for single assignments. These dimensions are not available for selection from the Balance form.

**_ELEMENT_ITD_** since the start of the processing period

**_ELEMENT_PTD_** since the inception of that element entry
Create Balance Dimension Process

Use this process to create balance dimensions which you can afterwards associate with any balance on the system, user or predefined, using the Balance window.

You run this process from the Submit Requests window.

To create a balance dimension:

1. In the Name field, select Create Balance Dimension.
2. In the Parameters window, enter a name for the dimension in the Balance Suffix field.
3. Select a balance level for the dimension. Currently you can only create an assignment level dimension.
4. Enter a start date for the dimension in the format DD–MM. As an example, 1 March is represented as 01–03.
5. Select a frequency for the dimension from the list of supported period types. The frequency you select governs the number of times the balance is reset to 0 in one year.
6. Choose the Submit button.
Defining User Balances

Defining a balance includes defining its feeds and dimensions. When you select feeds for the balance you have to choose between specifying element input values directly and selecting element classifications to determine the feeds. You cannot choose both methods together.

You define balances in the Balance window.

Prerequisites

- In the Element window, define any elements whose input values or run results you need to feed your balances.

To define a user balance:

1. Do one of the following:
   - Enter a unique name and a reporting name for balances you want to define. If you do not provide a reporting name the first seven characters only of the balance name appear on reports.
   - Query any user balances you want to change.

   Note: Do not select the Use for Remuneration check box. This displays which predefined balance is the Remuneration balance. Only one balance within a legislation can have this value. For the UK Payroll this is Total Pay, the balance used to sum payments for assignment remuneration.

2. Enter the unit of measure for the balance. The choices are days, hours (listed in different formats), integer, money and number. If you select money as the unit you must also select a currency. The default is GBP (pounds sterling).

3. Do one of the following:
In the Balance Feeds window:

- Set your effective date to the start date for the balance feeds.
- Select one or more elements to feed the balance. Only those elements whose input values have the same unit of measure as the balance are listed. You can select as many elements from the list as you require.

  When you select an element its classification is displayed. You can select elements with different classifications.

- Select the input value name for the element.

  For most payroll balances the input value name will be Pay Value. When there is a different unit of measure – for example, Number – you may have to choose between differently named instances of the same input value.

- Select Add or Subtract for the balance feed.

In the Balance Classifications window:
• Select one or more element classifications whose elements you want to feed this balance automatically.

The list includes all the primary and secondary element classifications that are valid for this balance. Select as many classifications as you require and select Add or Subtract for each.

**Note:** You cannot select more than one classification per balance from any set of associated primary and secondary classifications. For example, the primary classification Court Orders has a predefined secondary classification, Attachable Court Orders. You can select only one of these two classifications (the primary or the secondary) to control balance feeds for one particular balance.

4. In the Balance Dimensions window, select the dimensions you require.

You can remove any dimension you have created for your own user-defined balances. You can also add and remove further dimensions to ones that have been predefined for startup balances. You cannot remove predefined dimensions.

5. In the Initial Balance Feed window you can see details of the element and input value used for the Initial Balance feed. This feed is defined by implementation consultants prior to performing an initial balance upload at implementation time.
Making Balance Adjustments

Oracle Payroll balances do not normally need direct adjustment by users. The most frequent cause of an incorrect balance – when you have paid the wrong amount to an employee – is remedied by carrying out a QuickPay run for the employee. How far you can manually adjust other balances depends on whether the balance is a predefined startup balance or is user-defined.

You can freely adjust all user balances. However, the only predefined balances that you can adjust are those which are not “above” other balances in the balance hierarchy. You can adjust a pretax deduction balance but not the Total Deductions balance. This is to protect the integrity of predefined balances, by preventing users from adjusting high level balances in isolation. To ensure balance integrity, whenever you adjust a low level predefined balance, Oracle Payroll automatically adjusts all related higher level balances as well.

Adjusting a Balance

Balance adjustments can be made to any user balance and to assignment level predefined balances. You can make adjustments to balances of any unit type, and when you adjust a balance there is no requirement for you to carry out further processing actions. However, Oracle Payroll processes the results of money balance adjustments in such a way that you can easily pay the value of an adjustment to an employee if you require.

When you save your adjustment, it processes like a payroll run with just one entry, and the value you enter becomes a processed run result.
When you select a consolidation set for the adjustment, the system labels the run result for prepayments processing, in the same way that it labels the results of payroll runs and QuickPay runs.

You adjust balances in the Balance Adjustment window.

**To adjust a balance:**

1. Query the assignment for which you want to adjust the balance.

2. In the Adjust Balance window, set the effective date to when you want to adjust the balance.
   
   The window displays your current effective date. If the assignment is to a payroll, it also displays the corresponding payroll processing period.

3. Select the element whose pay or input values you want to change, and update the entry values as you require.

4. Select a consolidation set to control further post-run processing.
   
   The default consolidation set displays automatically but you can select another set. This is a required field even for balance adjustments that do not require further post-run processing.

5. Save your entry.

   Oracle Payroll applies the adjustment by creating a processed run item equivalent to the adjustment value you entered. The option buttons display the progress of the adjustment’s processing.

   **Note:** If the transaction finally shows Error, check that the units of measure for the entry values are correct. If they are, consult your system administrator.
Uploading Initial Balances

Setting initial values for balances is an essential task for new customers migrating from other systems.

Such balances typically consist of both legislative and customer defined balances, for example, the amount of PAYE deducted for each employee during the tax year, or the number of holidays taken by each employee during the calendar year.

The correct initial setting of these balances is essential for subsequent processing to be valid.

Initial Balance Upload Process

The Initial Balance Upload process allows the specification and loading of initial balances into the system. System implementers use this process once only, on migration. After that, balance maintenance is carried out automatically by Oracle Payroll.

You run this process from the Submit Requests window.

Prerequisites

- Define a balance element, and its input values, to feed each balance
- Set up initial balance values in the tables

PAY_BALANCE_BATCH_HEADERS
PAY_BALANCE_BATCH_LINES

For more information, see the technical essay:
Initial Balance Loading for Oracle Payroll, Oracle HRMS UK Implementation Guide

To load initial balances into Oracle Payroll:

1. Run one or more of the four modes as appropriate:
   - validate: checks the details in the batch to be uploaded
   - transfer: creates the balances in the batch
   - undo transfer: reverses the effects of a transfer
   - purge: removes the batch from the batch tables
2. Select the batch to be processed.
3. Choose the Submit button.
4. Continue to run the process for as many modes as you require.
This chapter explains how to set up your system for salary administration and budgeting. It also explains how to enter and approve salary proposals for individual employees, and how to review salaries for groups of employees.
Salary Administration and Performance Reviews

In Oracle HRMS you use salary administration to:

• enter salary amounts or wage rates for newly hired employees.
• enter and approve proposals for salary or wage increases (or decreases) for current employees. You can associate a salary change with the result of a performance review.

To administer salaries for employees, you first assign them to a salary basis. This determines the duration for which their salaries are quoted, such as hourly or monthly. Then for new employees, you enter starting salary amounts, which receive approval automatically.

For current employees, you enter proposed salary changes, expressed either as a new amount or a change amount or percentage. If necessary, you can break down a salary change into two or more components, to reflect different reasons for the change. For example, you might define components for Cost of Living and Merit. You can approve each component of the proposal separately. When all components are approved, you can approve the proposal as a whole. Proposals do not take effect until they receive approval.

Optionally, you can select a performance review to associate with a salary change. When you set up salary administration, you can enter grade rate ranges against which the system validates salary proposals.

Salaries Determined by Grade

If your employees’ salaries are entirely determined by their grade, you may not need to use Salary Administration. For these employees you define a grade rate or pay scale rate and enter values for each grade. Then you can assign employees to grades, and place them on the appropriate point of their grade scale. If you use Oracle Payroll, you can write a salary formula that uses the grade rate or pay scale rate to calculate each employee’s salary pay value.

See Also

Grade Relationships to Compensation and Benefits: page 4 – 6
Reviewing Current Salaries

Before entering salary proposals, you can review the current salaries of comparable groups of employees. There are a number of ways to do this:

- Query a list of assignments in the Salary Management folder to view their current salaries and any existing salary proposals. You can view up to ten salary components (such as Cost of Living, Location Adjustment, or Promotion) for each proposal.
  
  See: Using the Salary Management Folder: page 14 – 13

- Query lists of assignments receiving a particular salary element on the List Employees by Element window. This shows the latest approved salary for each assignment in the date range you select.

- Run the Salary Review Report to view current and previous salaries for all employees, or for employees assigned to a selected organization, job, position, and/or grade.
  

- Query a list of assignments in the Assignments folder then view the salary history for each assignment in the list, individually, using the Salary History window. This window displays the dates, reasons, and amounts of each approved salary change, and of any new salary proposal.
  
  See: Viewing Salary History: page 14 – 16

- If you use grade rates, you can view the salaries of all employees on a certain grade receiving a particular salary element, using the View Employee Grade Comparatio window. This window also displays each employee’s salary as a percentage of the midpoint defined for the grade.
  
  See: Viewing Grade Comparatios: page 4 – 10

- If you use pay scale rates for salaries, you can report on the salaries of all employees or a group of employees using the Employee Increment Results report.
  
  See: Employee Increment Results Report: page 4 – 19
Setting Up Salary Administration

Before entering salaries for new hires and salary proposals for current employees using salary administration, complete the following setup steps.

To set up salary administration:

1. Create a salary element for each group of employees whose salaries are quoted on the same basis (such as annually or hourly).
2. Link the salary elements to components of employee assignments, using the Element Link window.
3. Define a salary basis for each salary element.
4. Review the seeded salary components, which are defined as values for the QuickCode Type PROPOSAL_REASON. If necessary, create your own salary components.
   
   Note: If you want your new components to be displayed in the Salary Management folder, you must also change a view.

   See: Changing Salary Components: page 14 – 8
5. If you want to record performance ratings such as Outstanding, Superior and Average, enter them in the QuickCodes window for the QuickCode Type PERFORMANCE_RATING.
6. Add the function Salary Administration: Approve to the menu of responsibilities that should be able to approve salary proposals. Without this function, users can enter salary proposals but they cannot approve them.
7. Assign employees to a salary basis using the Salary Information region of the Assignment window. Also assign employees to a grade, if you have associated a grade rate with the salary basis.

Validating Salary Entries

There are two ways to validate salary entries:

- You can *warn* users when they enter a salary proposal that is outside a valid range defined for an employee’s grade. This approach uses grade rate ranges.
- You can *prevent* users from approving a salary that is outside a valid range, or that fails validation performed by a formula. Notice that this validation is not performed until you try to approve a salary proposal. This approach uses element input value validation.
To validate salaries against grade rate ranges:
1. Create a salary grade rate and enter minimum, maximum, and midpoint values for each grade.
2. When you define the salary basis, select your salary grade rate.
3. Assign your employees to grades.

To validate salaries using input value validation:
1. If you want to validate salaries using a formula, create your formula in the Write Formulas window.
2. When you define an input value for the salary element, you can select a formula to perform validation, or you can enter minimum and maximum valid values.
3. If you want to vary the validation for different groups of employees, you can enter validation criteria in the Link Input Values window.

See Also

Entering a New Assignment: page 11 – 8
Using Oracle FastFormula for Validation: (Oracle FastFormula User’s Guide

Defining and Linking a Salary Element

You define a salary element in the Element window.

To define a salary element:
1. Set your effective date to a day on or before the start of the first payroll period for which you want to enter salaries.
2. Enter a name for the element, and select the classification Earnings.
3. Select the Type Recurring.
4. Do not check the Standard check box.
5. Save the element, then choose the Input Values button.
6. In the Input Values window, create one input value to hold the salary value. This is normally the Pay Value. If you want to associate this element with more than one salary basis, create one input value for each salary basis.
Suggestion: If the salary basis is different from the payroll periods of the employees who will receive this element, make this clear in the input value name. For example, if the salary basis is Annual, you could name the input value Annual Salary.

7. You can enter validation criteria for the input value, such as a Minimum and Maximum value, or a formula to perform the validation. Select Error in the Warning or Error field.

Note: If you select Warning, users do not see the warning in the Salary Administration window

8. Save your work.

To link the salary element:

1. Set your effective date to a day on or before the start of the first payroll period for which you want to enter salaries.
2. In the Element Link window, select your new salary element.
3. Do not check the Standard check box.
4. Select eligibility criteria for this element. If you want to make the element available to all employees, do not select any criteria.
5. Save the link.
6. If you want to enter different validation criteria for different eligibility groups, you can change the Min and Max valid values in the Link Input Values window.

See Also

Defining an Element (Payroll Users): page 12 – 22
Defining Element Links: page 12 – 35

Defining Salary Bases

The salary basis establishes the duration for which a salary is quoted, for example, hourly, monthly or annually. Notice that an employee’s salary basis is not necessarily the same as the pay periods of his or her payroll. For example, an employee with an hourly pay rate has the salary basis Hourly Salary, but can have an assignment to a weekly payroll.

You can associate an element with one salary basis. When you associate an element with a salary basis, you cannot create or maintain entries for the element on the Element Entries window. You must use the Salary Administration window to enter and maintain employee salaries.
You define a salary basis in the Salary Basis window.

To define a salary basis:

1. Enter a name and select a basis.
2. Select the name of the salary element and input value associated with this salary basis.
3. Optionally, select a grade rate to associate with the salary basis.

   Oracle HRMS uses the grade rate to validate your salary proposals. You receive a warning if the salary you enter for an employee is not within the grade rate range defined for the employee’s grade.

   In doing this check, the system takes account of the hours in the employee’s standard work week. It compares the hours on the employee’s assignment with those entered for his or her organization.

   If the employee works fewer than the standard hours per week for the organization, the system prorates the permissible minimum and maximum grade rate values before validating the salary.

4. If you selected a grade rate, select the Basis (Hourly, Monthly, Annual, or Period) for the rate. For example, if your grade rate specifies the valid *monthly* salary ranges for each grade, select Monthly Salary in the Grade Rate Basis field.

5. If either the Basis or the Grade Rate Basis is Hourly Salary (but not both), you must enter a value in the Annualized Hours field. This records the number of working hours in a year (and hence in a month). The system uses this figure to convert salary entries and grade rate values to the same basis when it validates a new salary entry.
Changing Salary Components

Salary changes can be broken down into two or more components, to reflect different reasons for the change. You can approve each component of the proposal separately.

Ten salary components are predefined, as shown in Table 14 – 1. You can create as many additional components as you require. However, only ten components can be displayed in the Salary Management folder. If you want your new components to be displayed in the folder instead of the default components, you must update a view.

This task is for system administrators.

<table>
<thead>
<tr>
<th>Predefined Salary Component</th>
<th>QuickCode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost of Living</td>
<td>COL</td>
</tr>
<tr>
<td>Job Evaluation</td>
<td>JOEV</td>
</tr>
<tr>
<td>Location Adjustment</td>
<td>LOAD</td>
</tr>
<tr>
<td>Market Adjustment</td>
<td>MKAD</td>
</tr>
<tr>
<td>New Hire</td>
<td>NEWH</td>
</tr>
<tr>
<td>Performance</td>
<td>PERF</td>
</tr>
<tr>
<td>Periodic Review</td>
<td>PERE</td>
</tr>
<tr>
<td>Progression</td>
<td>PROG</td>
</tr>
<tr>
<td>Promotion</td>
<td>PROM</td>
</tr>
<tr>
<td>Transfer Adjustment</td>
<td>TRAD</td>
</tr>
</tbody>
</table>

Table 14 – 1  Predefined Salary Components

To create new salary components to display in the folder:

1. Query the QuickCode Type PROPOSAL_REASON in the QuickCodes window and add a new code for each new component.
2. In a text editor, open the View file peupl01v.sql.
3. Go to the component reason list and replace the default QuickCodes with the new codes you have created.

Note: There are two places in the file where you need to change these codes.
4. Go into SQL*Plus as hr user and run the edited script.

5. Change the column names in the Salary Management folder by choosing Change Prompts from the Folder menu.

**Entering Salaries and Salary Changes**

Use the Salary Administration window to enter a salary amount for a new employee, to propose a salary change for a current employee, or to approve a salary proposal.

Use the Salary Management folder to approve multiple salary proposals or to download salary information to a spreadsheet. In the spreadsheet you can enter new proposals, edit existing proposals, and approve salary components. Then you can upload your changes to the database.

If you want to hold multiple reasons for a salary change, you can break down a proposal into two or more components. Each component represents a different reason for changing the salary. You can define as many reasons as you require using the QuickCode Type PROPOSAL_REASON. Examples might be Merit Award and Cost of Living.

From the Salary Administration window, you can open the Performance window. You can associate a salary proposal with a performance review in two ways:

- You can simply enter the date of the review and a performance rating in the Performance window.
- If you use the Employee Review window to schedule and record performance reviews, you can select a review by type in the Performance window.

To review the history of an employee’s salary and performance reviews, use the Salary History window.
Using the Salary Administration Window

Use the Salary Administration window to enter a salary amount for a new employee, to propose a salary change for a current employee, or to approve a salary proposal.

![Salary Administration Window](image)

Entering an Approved New Salary

Use the procedure below to enter:

- a starting salary amount for a newly hired employee, or
- a salary amount for a current employee assigned to a new salary basis. This could be, for example, an employee moving from an hourly wage to a monthly salary.

Notice that you cannot enter multiple components of a starting salary for a newly hired employee or one assigned to a new salary basis.

**To enter a salary for a new employee, or one assigned to a new salary basis:**

1. Enter the start date for the salary. For a new hire, this is usually the hire date.
2. Enter the amount of the salary in the New Amount field.
3. You can select a reason.
4. Save the new salary. Its approval is automatic.

**Entering a Salary Proposal**

You can propose a salary change for someone at any time. If you entered intervals for regular salary reviews in the Salary Information region of the Assignment window, Oracle HRMS uses this information to display the date of the next scheduled salary review. However, you can override this date, provided that the date you enter is after the date of the last approved salary.

If there is an unapproved salary proposal recorded for the assignment, you must approve or delete this proposal before you can enter a new proposal.

You can enter a salary proposal as a new amount, a single change amount or percentage, or multiple change amounts or percentages (reflecting different reasons, such as a merit award and a cost of living component).

**To propose a salary change:**

1. In the Salary region, enter the date when the new salary should come into effect.

2. If you want to hold multiple reasons for a salary change, check the Use Multiple Components check box.

3. Do one of the following:
   
   - If you did not check the Use Multiple Components box, enter the salary change in the Salary region. You can enter a new salary amount, or the amount or percentage of the proposed change.
   
   - If you did check the Use Multiple Components box, use the Components region. Select the reason for each component of the proposal and the amount or percentage of each proposed change.
     
     Notice that each percentage is applied to the last approved salary. For example, if the last approved salary is 3000 and there are two components of 10% and 5%, the new amount is 3000 + 300 + 150.

   To effect a salary decrease, enter a negative number in the Change Amount or Change Percent field.

4. You can select a reason for the overall salary change.

5. If you entered a time period for regular salary reviews in the Salary Information region of the Assignment window, the date of the next review appears automatically. You can change this date.
6. To associate the salary change with a performance review, choose the Performance button. Enter the date of the review and select a performance rating. In the Interview region, you can select a review that was recorded in the Employee Review window.

7. If you entered a time period for regular performance reviews in the Salary Information region of the Assignment window, the date of the next review appears automatically. You can change this date.

8. Save your proposal.

Approving a Salary Change

A salary proposal does not go into effect until it receives approval. If you have recorded multiple components of a salary proposal, you can approve each component independently. However, none of them goes into effect until you approve the overall proposal.

When you approve a salary, Oracle HRMS creates or updates a salary element entry for the assignment. You can view this entry in the Element Entries window, but you cannot change it there.

Note: You may not be able to approve salaries. This is controlled by a menu function set up by your system administrator.

To approve a salary change:

- Query the proposal, check the Approved box, and save. If some individual components were not already approved, you are warned and they are automatically approved if you continue.
Using the Salary Management Folder

Using the Salary Management Folder, you can select sets of assignments for which you want to enter or approve salary proposals. For each assignment, the folder can display the current approved salary and proposed new salary, including up to ten salary components.

Using Application Data Export (ADE), you can download this information from the folder to a spreadsheet. Here you can manipulate the data to create new salary proposals or to modify existing proposals. You can then upload your revised salary information to the database. If your responsibility permits, you can approve all or selected proposals in the folder.

Manipulating Salary Information in a Spreadsheet

You can use a spreadsheet application to enter or update salary proposals for groups of employees. The changes you make in the spreadsheet are checked when you upload them to the database. To minimize errors, follow these rules:

• Do not enter components for a first salary (for example, for a new hire). Enter a proposed amount and change date only.
• Enter changes for the full salary or for components but not for both.
• If you enter components, make sure you enter a value (Y or N) in the Approved field for each component.
- Do not alter a Change Date that was downloaded from the database.
- Do not enter information in the grey fields (except for Change Date).
- Note that the Change Amount is given precedence over the Change Percentage. If you enter inconsistent values, the upload process records the new change amount and adjusts the percentage to match. If you want to record a percentage change, clear the amount field.
- If you want to delete a component, clear both the change amount and percentage fields for that component.

To manipulate salary proposals in a spreadsheet:

1. In the Salary Management folder, query the assignments you want to process.
2. Click on the ADE icon on the Oracle HRMS tool bar.
3. In the ADE Fetch Data window, select the style Salary Proposals and select the action Spreadsheet. Choose Start.
   This launches your spreadsheet application and iconizes ADE.
4. Edit the data in the spreadsheet, following the rules outlined above.
   Save the spreadsheet with a new name (to prevent it being overwritten the next time ADE is run).
5. Exit your spreadsheet application.
6. In ADE, choose the Upload button.
   Note: If the Upload button is not available, ask your system administrator to create the function HR_HRIO_ENABLE_UPLOAD and add it to your menu.
7. Choose Load and select the spreadsheet that you saved.
   You can review your changes in the built-in ADE spreadsheet. The Status column shows which rows have been updated.
8. Choose Upload.
   The updated information is uploaded to the database. The Status column records any errors encountered during the upload.
9. To view your new proposals in the Salary Management folder, requery the data.

Approving Multiple Salary Proposals

If the Approve button is displayed in the Salary Management folder, you can select multiple assignments in the folder and approve them.
Note: If the Approve button is not displayed, you cannot approve salaries. This is controlled by a menu function set up by your system administrator.

When you approve a salary, Oracle HRMS creates or updates a salary element entry for the assignment. You can view this entry in the Element Entries window, but you cannot change it there.

To approve multiple salary proposals:
1. In the Salary Management folder, query the assignments you want to process.
2. Select the assignments you want to approve and choose the Approve button. To select multiple assignments, hold down the CTRL key and click on the assignment records you want to select.

Correcting a Salary Entry

You enter and approve salary proposals in the Salary Administration window. You can also correct salary entries in this window.

To correct a salary proposal:
- Enter the correct value in the New Amount field.

To correct an approved salary:
1. Delete the salary record and enter a new one.
2. If you discover an error in a proposal approved in the past, after which more recent approved proposals are on record, you must delete and reenter every proposal from the one last approved back through the incorrect one.
3. When you delete an approved proposal that the payroll run has processed, you receive a warning message. You can continue to delete the record, but you must of course correct the processing.
Viewing Salary History

Oracle HRMS maintains a complete history of approved salary changes for an employee, along with associated performance reviews. In the Salary History window, you can view the dates, reasons, and amounts of each approved salary change, and of any new salary proposal.

The Salary History window contains a folder. You can enter a query in the folder to reduce the list of salary changes displayed. You can remove, rearrange, add, or resize fields in the folder if you have access to the folder menu.

The **Change** field shows the amount of the salary change, and the **Actual** field shows the new salary effective from the **Change Date**. The **Hourly, Monthly, Annual**, and **Payroll** fields show the salary prorated to these periods. The **Mid, Minimum, and Maximum** fields show values from the grade rate for the employee’s grade. The **Comparatio** field shows the salary as a percentage of the midpoint defined for the grade rate.
Salary Review Report

Use this report to see current and past salaries, and salary proposals, for some or all of your employees. You can restrict the employees to those assigned to a selected organization, job, position, or grade. You can also restrict the report to showing only employees receiving the maximum salary for their grade (defined by the grade rate). You can use the report to show all salaries (approved and proposed) or to show unapproved salary proposals only.

You run reports from the Submit Requests window.

To run the Salary Review Report:

1. In the Name field, select Salary Review Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Optionally select an organization, job, position, and/or grade to restrict the scope of the report to employees assigned to these components.
5. If you want to restrict the report to showing salary proposals, select Yes in the Unapproved Proposals Only field.
6. If you want to restrict the report to showing employees receiving the maximum salary for their grade (defined by the grade rate), or a higher salary, select Yes in the Grade Rate Maximum Only field.
7. Choose the Submit button.
Salary Budgeting

Using Oracle Human Resources, you can set up human resource budgets for headcounts and full time equivalents at various levels of the organization.

See: Human Resource Budgets (Oracle Human Resources User’s Guide)

Most enterprises need to add salary estimates to these headcount budgets to provide salary budgets. Oracle Human Resources provides you with the key information you require to define your salary budgets:

- headcount or FTE budget for a defined period of time
- valid grades for jobs and positions
- grade rates or pay scale rates to show salary values

However, the detailed process of salary budgeting varies from one enterprise to another according to the enterprise size, type, and culture. This topic looks at three types of enterprise to suggest different ways in which you could use the information held in Oracle Human Resources to derive your salary budgets.

Note: The calculation of actual salary values happens during the payroll run. To help you compare planned versus actual spending, Oracle Payroll provides the following information:
- actual pay values for each assignment in the payroll run
- balances to show to date totals
- costs accumulated to the cost centers and project codes you set up in the Cost Allocation Flexfield

Budgeting Approach in a Government Agency

A typical government agency has a rule–based structure based on organizations, positions, and grading structures. In this type of enterprise, salary budgets are usually set for each position, then rolled up to the organization level.

Starting from the position definition, you can extract the list of valid grades and the grade rate values for each of these grades. If you use grade scales, you can use the midpoint value from the range defined for each grade.

To calculate the salary budget for each position, you multiply the position headcount by one of the values for the grade. Typically you would use the value for the middle grade. However, you might choose the lowest grade if you are making entry–level assignments to new positions.
When you have established the relationship between these various items in the database, you can automate the budgeting through the creation of a standard reporting view, using SQL*Plus.

**Budgeting Approach in a Centralized Management Company**

The company with a centralized management structure has a more flexible approach to roles, frequently using jobs rather than positions. There is more emphasis on recruiting the ‘right people’ and on individual responsibility and initiative. Reward systems are usually performance related.

Salary budgets are typically set for each organization, based on a headcount budget for jobs and organizations. The budget for each organization is calculated from the midpoint grade rate value for the valid grades for each job multiplied by the planned headcount for each organization and job combination.

**Budgeting Approach in a Devolved Management Company**

In this type of enterprise, local managers are expected to decide on the composition of their own workforce in response to market requirements, and to set their staff’s compensation levels, within an overall budget. Control is exercised through the allocation of a budget, but administration of the budget is left to the discretion of the local manager.

Current expenditure in each organization is used as the starting point for budgeting. This cost is projected on the basis of plans for expansion or reduction, with some inflationary factor added.

One approach to budgeting in this environment is to download current salary values from Oracle Human Resources to a spreadsheet. You can use Oracle Glue to create an interface from Oracle Human Resources to your spreadsheet system. The spreadsheet facilities are well suited to the application of various percentages to try out salary and headcount change proposals.
This chapter explains how Oracle Payroll can be used to meet the statutory requirement to deduct Income Tax and National Insurance contributions from employee earnings.
PAYE: Legislative Details

PAYE is the system used to collect income tax from all taxable income paid to employees under Schedule E.

The amount of PAYE calculated depends on earnings subject to tax, including taxable benefits. Taxable pay can be reduced by employee payments made to authorized company pension schemes, or by employee donations to charities, to an agreed maximum. For more information on the definitions of earnings subject to tax, see The Employer's Guide to PAYE.

Tax Codes

The Tax Office with which your enterprise is registered administers the tax records of your employees. This office issues a tax code for each employee which determines how the tax is to be collected, and whether the basis for calculation is to be cumulative or non-cumulative.

Valid tax codes are as follows:

**Suffix codes – numbers followed by a letter**

The number, when multiplied by ten and nine added, represents the total tax free pay available in the year. The letter denotes what type of allowance is applicable:

- **L** – personal Allowance
- **H** – personal allowance and married couple allowance
- **P** – personal allowance for those aged 65 – 74
- **T** – all other cases

**Prefix codes – K followed by a number**

The number, when multiplied by ten and nine added, represents the additional taxable pay for the year.

- **K** – additional taxable pay
Special codes

- D0 – taxed at higher than basic rate
- NT – no tax payable
- BR – taxed at basic rate
- NI – exempt from PAYE but not NIC, for example, students working during the vacation

Tax Calendar

The tax year starts on 6 April one year and ends on 5 April the following year. Each tax year may be referred to as a combination of the two partial calendar years, for example, 95/96.

The calendar can be based either on a weekly frequency or on a calendar month frequency.

The first tax week, known as Week 1, runs from April 6 –12. Week 2 runs from April 13 –19, and so on through the year.

As the year is not perfectly divisible by 7, an extra week is necessary. For non–leap years Week 53 is April 5, and for leap years Week 53 is April 4 –5.

Monthly calendars also start from 6 April. Month 1 is from April 6 – May 5, and so on through the year.

Key dates

- 6 April – start of year
- 19 May – last date for sending year end returns
- 6 July – last date for sending P9Ds and P11Ds
- 5 April – end of tax year

Payment date

The tax period to use for calculating PAYE is the period in which the payment date falls. For example, the weekly payment date April 14 is in Week 2, and the monthly payment date April 5 is in Month 12.
Method

Tax tables are provided in either printed or computer version, and sometimes there is a small difference on the amount of tax calculated. Both are correct.

Oracle Payroll calculates PAYE using the formula issued by the Inland Revenue to computer users. This formula is incorporated in the startup data for the product.

Identifying Your Tax Scheme

Your local Tax District has a three figure tax district reference number, and each PAYE scheme administered by your enterprise has an individual employer’s reference number. This is normally a letter followed by up to seven alphanumeric characters.

See Also

NIC: Legislative Details: page 15 – 17
Oracle Payroll and PAYE

Oracle Payroll provides as startup data all the elements, balances and other components you need to correctly administer PAYE. It also provides legislative upgrades to keep your payroll processing up to date with current legislation.

If you include employees in more than one payroll run each processing period, Oracle Payroll’s calculations for tax deductions take into account the sums already deducted in that period.

The system provides balances for Taxable Pay and PAYE, both of which include dimensions that correctly sum up all the necessary run results. The PAYE balance is fed only by the amount of PAYE paid. The run results passed to the Taxable Pay balance, however, are identified by balance feeds that you define.

If you have payrolls that are reported under different tax reference numbers, you may sometimes have the requirement to transfer employees between these payrolls. In such cases, both the tax balances will restart from zero, and you should issue P45s for the employees concerned.

Note: If you transfer employees between payrolls having the same tax reference number, the balances continue to accumulate as before.

See:
Entering Employee PAYE and NI Details: page 15 – 27
Viewing and Creating Balance Feeds: page 13 – 2

Implementing Startup Data

Table 15 – 1 shows the tax deduction elements defined by Oracle Payroll for PAYE administration and supplied as part of startup data.

<table>
<thead>
<tr>
<th>Element Name</th>
<th>Processing Type</th>
<th>Classification</th>
<th>Processing Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAYE Details</td>
<td>Recurring</td>
<td>PAYE</td>
<td>5001</td>
</tr>
<tr>
<td>PAYE</td>
<td>Nonrecurring</td>
<td>PAYE</td>
<td>5002</td>
</tr>
<tr>
<td>PAYE Refunds</td>
<td>Nonrecurring</td>
<td>Information</td>
<td>5003</td>
</tr>
</tbody>
</table>

Table 15 – 1 Tax Deduction Elements

You must link these elements to the appropriate payrolls before they can be given to employees and included in payroll runs. If you have set up segments of the Cost Allocation key flexfield to receive entries at
the element level, you should enter these account codes in the Element Link window when you link the PAYE elements to your payrolls.

The recurring element PAYE can process after termination to allow for payments to employees who have left, but who may still be entitled to receive late payments.

See Also

Business Groups: Entering Tax Details: page 2 – 18
Defining an Element (Payroll Users): page 12 – 22
Defining Element Links: page 12 – 35

Start of Year Process

This process is normally used at the start of the tax year to update tax information held for each employee. The process performs the following actions:

- **Tax Basis**: Updates all employees on a Non–Cumulative basis to Cumulative.
- **Previous Taxable Pay and Previous Tax Paid**: Clears the values entered for employees for whom a P45 or a P6 was received in the previous tax year.
- **Tax Code**: Performs blanket changes on employees’ tax codes where the employer has been issued with a P9X tax document to make changes.

The Inland Revenue P9 document details changes in an employee’s Tax Code and Tax Basis. The document can be supplied on paper or on magnetic tape, and the process accepts data from tape.

The P9X document issued at the start of each tax year gives the employer the authority to increase or decrease Tax Codes in bulk. The process performs these blanket changes.

Running the Process

The Start of Year process runs in one of three modes:

- **Start of Year**: The process performs all the actions above.
- **Mid Year Tax Code Uplift**: The process performs the blanket tax code changes only.
- **Tax Code Uplift from Tape:** The process transfers the P9 details from the interface table to your database.

**Prerequisites**

To run in the Start of Year or Mid Year Tax Code Uplift mode:

- Enter values in the predefined user table TAX_CODE_UPLIFT_VALUE for the UPLIFT_VALUE column:
  - Enter the tax code suffix in the Exact field, and the tax code value in the Value field.

To run in the Tax Code Uplift from Tape mode:

- Load data from the Inland Revenue P9 tape into the PAY_GB_TAX_CODE_INTERFACE table. Table 15–2 gives details of the table structure.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Format</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISTRICT_NUMBER</td>
<td>NUMBER(3)</td>
<td>Yes</td>
</tr>
<tr>
<td>EMPLOYER_REFERENCE</td>
<td>VARCHAR2(10)</td>
<td>Yes</td>
</tr>
<tr>
<td>NATIONAL_INSURANCE_NUMBER</td>
<td>VARCHAR2(10)</td>
<td>Yes</td>
</tr>
<tr>
<td>TAX_CODE</td>
<td>VARCHAR2(5)</td>
<td>Yes</td>
</tr>
<tr>
<td>NON_CUMULATIVE_FLAG</td>
<td>VARCHAR2(1)</td>
<td>No</td>
</tr>
<tr>
<td>EMPLOYEE_NAME</td>
<td>VARCHAR2(28)</td>
<td>No</td>
</tr>
<tr>
<td>WORKS_NUMBER</td>
<td>VARCHAR2(20)</td>
<td>No</td>
</tr>
<tr>
<td>PROCESSED_FLAG</td>
<td>VARCHAR2(1)</td>
<td>No</td>
</tr>
</tbody>
</table>

*Table 15–2 The PAY_GB_TAX_CODE_INTERFACE Table*

All the above columns, apart from PROCESSED_FLAG, are populated from the tape. The PROCESSED_FLAG column is reserved for Start Of Year process use and should be set to NULL on insert.

You must populate this table with the data from the P9 tape and clear down the table after the Start Of Year process has been run.

You run the process from the Submit Requests window.

See: User Defined Tables: page 20–9

**To run the Start of Year process:**

1. In the Name field, select Start of Year.
2. In the Parameters window, select the mode.
3. Select the date. The default is the start of the current tax year.
4. Select a payroll if required.
   By default, all payrolls are processed, but you can restrict to a particular payroll.

On completion, the process produces a report listing the records processed, details of all changes made, and all records rejected by the process, together with reasons.

### Start of Year Resume

This process enables Start of Year processing to resume after a deliberate stoppage in mid-run. You can stop a process while it is running either by requesting its cancellation or by terminating the concurrent manager.

The Start of Year process records the processing of each record as it completes. When processing resumes, the system does not need to reprocess previously completed records. It continues only with the records that were previously unprocessed. This applies both to Start of Year Resume and to automatic restarts following a concurrent manager failure.

You run the Start of Year Resume process from the Submit Requests window.

**To run the Start of Year Resume process:**

- Select the name of the process and choose the Submit button. There are no parameters.

On completion, the process produces a report listing the following:
  - all records processed
  - details of all changes made
  - details of all records rejected, with reasons for the rejections

### Start of Year: Unprocessed P9 Records Report

Submit this report only after running the Start of Year process in the Tax Code Uplift From Tape mode.
The report lists valid records on the Inland Revenue P9 tape that do not fully match the records in the main database. No reasons are listed in the report, but each unmatched record is caused by data that appears in the interface table and not in your database.

You run the report from the Submit Requests window.

► **To run the report:**

- Select the name of the report and choose the Submit button. There are no parameters.
End of Year Process

The End of Year process produces the statutory End of Year return to the Inland Revenue for employees in your enterprise. The process comprises a set of five separate concurrent processes, each with a different concurrent request id. The five processes are as follows:

- End of Year Process – the controlling program
- Year End Multiple Assignments Report
- Year End P35 Listing
- Magnetic Report
- Year End P60 Report

The process runs in two modes, Full End of Year and P35 Listing.

Full End of Year

When you select full EOY mode, the system submits all the above five processes, and produces the following output:

- Full details of PAYE, NI, SSP and SMP for all employees. This is written to a .mf file for production of a magnetic tape that you submit to the Department of Social Security.
- P60 reports for each employee.
- A P35 listing which summarizes totals on the full return.
- A Multiple Assignments report showing details of all multiple assignments in the return where earnings are aggregated into one assignment.
- The log file for the magnetic tape report shows raw formatting details of the tape file and details of all Department of Social Security Type 1 and Type 2 errors.

Note: Type 1 and Type 2 errors are defined in the Magnetic Tape & Data Cartridge Technical Specification Part 2 CA51 (MM3) issued by the Department of Social Security.

When you select full EOY mode with the P60 Alignment field set to Yes, the system submits the first four processes listed above together with two Year End P60 Report processes. One of these displays the alignment and the other contains the P60 detail.

P35 Listing

When you select P35 Listing mode, the system submits the first three processes listed above, leaving out the Magnetic Report and the Year
End P60 Report. You can run the P35 listing by itself at any time to use as a record, or to check against payment figures through the year. When you run the process in this mode the log file for the process also shows format details and lists Type 1 and Type 2 errors.

**Running the Process**

You run the process from the Submit Requests window.

**To run the End of Year process:**

1. In the Name field, select End of Year.
2. In the Parameters window, enter the end year for which you are running the process. For example, enter 1996 for the year 1995–96.
3. Select the EOY mode you want to run – full EOY or P35 listing. The default is Full.
4. Select the tax district reference number for your payrolls. Only payrolls in the tax district are included in the return. Leave blank for all payrolls to be included.
5. Select the DSS permit number. Only payrolls connected to the selected number are included in the return. Leave blank for all payrolls with a permit number to be included.
6. Use the Sort Order fields to customize sort details for your P60s. Of the seven sort fields, only the last is obligatory. In this field you select Assignment Number or Last Name to sort by. You can enter higher priority sort criteria in the other fields by selecting values you previously defined in the People Group flexfield. These could include location details, work or pension group details, or any other people–based values you define.
   See: Setting Up the People Group Flexfield: page 5 – 10
7. Enter Yes in the Alignment field if you want to run the Alignment report before printing off P60s.
8. Select Yes in the NI Y Balances field to include NI car benefit details in the return. If you are submitting these details by the Alternative Payment method and not through Oracle Payroll, select No.
Accuracy Requirements

The employer has to submit a declaration and a certificate on the documentation submitted to the Inland Revenue each year. The deadline is May 19 following the end of year, with penalties for lateness and for incorrectly completing the return.

Printing Details for the EOY Process

The P60 process generates P60 reports using Oracle Reports. To print the report, you define a SRW driver file for your particular printer and P60 stationery.

You can find a sample SRW driver file, paygbp60.prt, in the $PAY_TOP/srw directory. This file is designed for standard P60 continuous stationery for the DEC LN03 printer, and all other printers that understand the same control characters as the LN03.

Further information about customizing or registering your printer driver definitions and print options is given in the Oracle Applications System Administrator’s Guide.

Checking the Status of the Different Processes

When you check the status of the End of Year process, you should also check the status of the other related concurrent processes. Each process produces a log file and an output file, and these are written to the $APPLCSF/$APPLLOG and $APPLCSF/$APPLOUT directories respectively. Further details of these directories are given in the Oracle Applications System Administrator’s Guide.

Linking the P35 Listing to the Magnetic Tape

The P35 Listing contains the concurrent request id of the Magnetic Report file in the report header. This appears on the first page of the report and must be used to tie the two outputs together.

File Name Format

The Magnetic Report, P60 and P35 listing output files can be found in $APPLCSF/$APPLOUT and have the following file name formats:

- o<request id>.mf for the Magnetic Report
- o<request id>.out for the P60 Report (alignment and detail)
- o<request id>.out for the P35 Listing
Writing the EOY Magnetic Report to Tape

The following example is an illustration of how the Magnetic Report could be written to tape using UNIX commands. However, the writing of reports to tapes is operating system and machine specific. You should ask your system administrator for details of writing the Magnetic Report file to tape for your particular system and machine.

To write a magnetic report to tape using UNIX commands:

1. Place the tape in the device.
2. Rewind the tape. Type:
   ```
   mt -f /dev/rst0 rewind
   ```
   – where /dev/rst0 is the magnetic device with rewind.
3. Write a tape marker. Type:
   ```
   mt -f /dev/rst8 eof
   ```
   – where /dev/rst8 is the magnetic device without rewind.
4. Write the Magnetic Report file to tape. Type:
   ```
   dd if=<magnetic report file> of=/dev/rst8 ibs=360 obs=3600 cbs=360
   ```

To check the result:

1. Rewind the tape. Type:
   ```
   mt -f /dev/rst0 rewind
   ```
2. Skip past the tape header. Type:
   ```
   mt -f /dev/rst8 fsf 1
   ```
3. Read the file from tape, renaming the file. Type:
   ```
   dd of=/tmp/<renamed file> if=/dev/rst8 ibs=3600 obs=360
   ```
4. Check the original file and the renamed file for differences. Type:
   ```
   wc <magnetic report file> /tmp/<renamed file>
   ```
In Oracle Payroll, P45 forms are printed for all terminated employees through the P45 Report. You run this standard report from the Submit Requests window.

▶ **To issue a P45 form for a leaver:**

1. In the Name field select the report name.
2. In the Parameters field you can set two optional parameters:
   - you can restrict the process by payroll
   - you can restrict the process by start and end date
3. Choose the Submit button

If no parameters are set, the report picks up every employee with a status of Terminate who has not yet had a P45 issued. The process prints off the P45 information on continuous stationery for issue to the tax office and leaver.

**Using the P45 Window**

Sometimes you need to send tax returns to different tax offices for an employee working at different sites. In this case you may need to issue
a P45 to the second tax office. You may also want to issue a P45 manually to a leaver.

In both these cases you use the P45 window, which you access from the Assignment window. The window displays Part 1 of the P45 form showing the leaver’s pay and employment details.

► **To manually issue a P45 form for a leaver:**
1. Complete the form manually from the details in the window.
2. Choose the Manual Issue button.

In the Statutory Details window, Oracle Payroll records that you have issued the P45. The system prevents you from running the report again for this assignment.

► **To issue a P45 form for a current employee:**
1. Choose the Mark for Print button.
2. In the Submit Requests window:
   - Run the P45 Alignment report to check the printing alignment of the report. This is optional.
   - Run the P45 report. You can restrict the process by specifying a payroll and/or a time period.

In the Statutory Details window, Oracle Payroll records that you have printed off the P45 for the employee. This does not prevent you from issuing the report again.

**Printing Details**

The P45 process generates P45 reports using Oracle Reports. To print the report, you define an SRW driver file for your particular printer and P45 stationery.

You can find a sample SRW driver file, paybgp45.prt, in the $PAY_TOP/srw directory. This file is designed for standard P45 continuous stationery for the DEC LN03 printer, and for all other printers that understand the same control characters as the LN03.

For more details regarding customizing or registering your printer driver definitions and print options, please refer to the *Oracle Applications System Administrator’s Guide*. 
P45 Alignment Report

This is a printer alignment report for your sample P45.
You run the P45 Alignment report from the Submit Requests window.

To run the P45 Alignment report:

1. In the Name field, select the report name.
2. Choose the Submit button.
Nic: Legislative Details

Primary Class 1 National Insurance contributions are payable by every employee, on earnings subject to NIC, unless exempted because of age or employment contract. Secondary Class 1 National Insurance contributions are payable by the employer. National Insurance is administered by the Department of Social Security, but payments are collected on its behalf by the Inland Revenue through the PAYE system.

If your enterprise runs an occupational pension scheme, employees in the scheme may contract out of the State scheme, SERPS. In this case both the employee and employer pay less National Insurance contributions.

Calculating the Amounts Payable

The amount of NIC payable by employees depends on the following factors:

- NI category
- earnings subject to NIC
- age
- pension arrangements
- earnings period
- method of calculation
- number of occurrences of the earnings period
- arrears

NI Category Codes

The most commonly used category codes are: A, B, C, D, E, F, G, S, X and Y. These are used in the following way:

Standard Rate Contributions:

These are made by employees between the ages of 16 and the state pension age.

A not contracted out
D contracted out
F contracted out for members of COMP schemes
Reduced Rate Contributions
These are made by married women and widows who have a valid Certificate of Election.
B not contracted out
E contracted out
G contracted out for members of COMP schemes

Employer Only Contributions:
These are in three categories:
Contributions for employees over state pension age who have a valid Certificate of Age Exemption, and employees with more than one job who have a valid CA2700 and are in ‘not contracted out’ employment.
C not contracted out
Contributions for employees with more than one job who have a valid CA2700 and are in contracted out employment.
C contracted out
Contributions for contracted out employees who are members of COMP schemes, who have more than one job and who hold valid CA2700s.
S contracted out

Category X and Category Y:
Category X is used to indicate that no contributions are being made. Category Y indicates Class 1a contributions (for NIC payable on company cars).

Earnings subject to NIC
Earnings that are subject to NIC may be different from gross pay or taxable pay figures. They normally include all money payments to the employee and exclude any benefits paid to third parties on the employee’s behalf.

Each tax year the Lower Earnings Limit (LEL) and the Upper Earnings Limit (UEL) are announced. LEL is the minimum amount of earnings on which NIC may be paid for the current year, and UEL is the maximum amount of earnings that the employee’s contribution of Class 1 can be based on. If the employee’s earnings are less than the LEL figure, no NIC is deducted.
There is no UEL for the employer’s secondary contributions. In addition, since the tax year 1991/1992 the employer has a liability to pay Class 1A contributions on the taxable benefit of a company car.
Age

There is no liability for either primary or secondary contributions if the employee is under the age of 16 years.

There is no primary contribution when the employee is above the state pensionable age.

Pension Arrangements

Employees who are members of occupational pension schemes are contracted out of the State Earnings Related Pension Scheme (SERPS). Their NIC is reduced by the amount that would have been paid into SERPS.

Earnings Period

There are four basic earnings period types for NIC:

- Daily
- Weekly
- Calendar Monthly
- Annual

Weekly and Calendar Monthly are for employees on weekly or monthly payrolls. Annual is for directors or office holders. Daily is used for periods of more than seven days that do not fall into weekly or monthly categories.

You can make more than one regular payment to an employee within the earnings period. For example, employees with a week’s salary retained by the employer on a ‘week in hand’ basis, can receive two payments in their final week.

Method of Calculation

There are two methods of calculation:

- using the National Insurance tables issued by the DSS
- exact percentage method

Oracle Payroll uses the exact percentage method. Both methods make use of rates and bands which may be changed annually.

Number of Occurrences of the Earnings Period

NIC is calculated at the time of payment, but if you have to pay an employee for more than one period at the same time, you calculate NIC on the earnings for each period separately.
For example, it proves impossible to pay a new starter in the period of starting so she receives a double payment in the next period. You calculate this employee’s NIC separately for each period: it should not be aggregated in the second period.

**Arrears**

If a wrong category code is used for an employee, too much or too little NIC may be deducted. You can correct this as follows:

- If the employee has been overcharged, the balances maintained for year end reporting against each category code need to be corrected, and the excess deduction refunded.

- If the employee has been undercharged, the balances maintained for year end reporting also need to be corrected, and the balance of secondary contributions owing must be paid to the Inland Revenue with the next payment.

However the arrears of the primary contributions may only be recovered by doubling the actual primary contribution in subsequent periods. For example, if the arrears are £20.20 and the normal period NIC contribution is £15.20, you can double the contribution to £30.40, reducing the arrears to £5. The subsequent period’s normal calculation is £14.80, which you can increase to £19.80, recovering the remaining arrears. Arrears in one tax year cannot be recovered from the employee in subsequent years.

See: Correcting NIC Balance Information: page 15 – 34

NIC Holiday: page 15 – 32
Oracle Payroll and NIC

Oracle Payroll provides as startup data all the elements, balances and other components you need to correctly administer NIC. It also provides legislative upgrades to keep your payroll processing up to date with current legislation. It uses the exact percentage method to calculate NIC.

The system provides the balance NIable Pay, which includes the dimensions to correctly sum up all element feeds during the correct tax period dates. These element feeds come from the elements you define as balance feeds for this balance.

The amount of NIable Pay used for the NIC calculation depends on the LEL and UEL amounts. This is recorded in another balance linked to the category code, such as NI A Able.

You can include employees in more than one payroll run each processing period. Oracle Payroll’s calculations for this are based on total NIable earnings for the period, reduced by any NIC already paid in the period.

NI Elements Supplied as Startup Data

Table 15 – 3 shows the National Insurance elements supplied as part of startup data.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Classification</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>NI Arrears</td>
<td>Non–Recurring</td>
<td>NI</td>
<td>5004</td>
</tr>
<tr>
<td>NI</td>
<td>Recurring</td>
<td>Information</td>
<td>5005</td>
</tr>
<tr>
<td>NI G</td>
<td>Non–Recurring</td>
<td>NI</td>
<td>5011</td>
</tr>
<tr>
<td>NI E</td>
<td>Non–Recurring</td>
<td>NI</td>
<td>5012</td>
</tr>
<tr>
<td>NI B</td>
<td>Non–Recurring</td>
<td>NI</td>
<td>5013</td>
</tr>
<tr>
<td>NI F</td>
<td>Non–Recurring</td>
<td>NI</td>
<td>5014</td>
</tr>
<tr>
<td>NI D</td>
<td>Non–Recurring</td>
<td>NI</td>
<td>5015</td>
</tr>
<tr>
<td>NI A</td>
<td>Non–Recurring</td>
<td>NI</td>
<td>5016</td>
</tr>
<tr>
<td>NI S</td>
<td>Non–Recurring</td>
<td>NI</td>
<td>5017</td>
</tr>
<tr>
<td>NI C</td>
<td>Non–Recurring</td>
<td>NI</td>
<td>5018</td>
</tr>
<tr>
<td>NI Employee Arrears</td>
<td>Non–Recurring</td>
<td>NI</td>
<td>5120</td>
</tr>
</tbody>
</table>

Table 15 – 3 National Insurance Elements
<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Classification</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>NI Employer</td>
<td>Non-Recurring</td>
<td>Employer Charges</td>
<td>5120</td>
</tr>
<tr>
<td>NI Employer Arrears</td>
<td>Non-Recurring</td>
<td>Employer Charges</td>
<td>5122</td>
</tr>
</tbody>
</table>

Table 15 – 3 National Insurance Elements

Notes

- You have to link the National Insurance elements to the appropriate payrolls before you enter them for employees and include them in payroll runs. If you have set up segments of the Cost Allocation key flexfield to receive entries at the element level, you should enter these account codes in the Element Link window when linking these elements to your payrolls.
- The category code elements have been defined to maintain the necessary balances for Year End reporting. Because you may occasionally need to correct these balances, the category code elements have *not* been defined to receive indirect results only.

See Also

NIC: Legislative Details: page 15 – 17
Defining Element Links: page 12 – 35
Correcting NI Category Code Entries: page 15 – 34
Calculating NIC for Multiple Assignments

Some employees in your enterprise may hold two or more paid jobs at the same time. In Oracle Payroll, such employees are given multiple assignments, that is, two or more assignments with payroll components.

To calculate NIC on multiple assignments, the general rule is to add all the employee’s earnings together and calculate NIC on the total. If, however, the employee has a number of single assignments to payrolls in different PAYE schemes, you calculate each assignment’s NIC separately.

Oracle Payroll enables you to process NIC correctly in both situations. For employees with single assignments in separate PAYE schemes, the system calculates NIC for each assignment independently. For those with multiple assignments in one scheme it calculates NIC by aggregating the earnings under each tax reference.

See Also

Using Multiple Assignments: page 11 – 5

Setting Up Multiple Assignment Processing

Oracle Payroll supplies the nonrecurring element NI Person and the formula NI_PERSON to handle aggregated NIC calculations. The formula takes into account the priority of the different NI categories and the current rates of LEL and UEL. You do not link the element as it is defined for indirect results only.

When you enter on the system that an employee has multiple assignments, the NI_PERSON formula runs every time payroll processing takes place for this person’s assignments. The system then aggregates earnings for all assignments with the same tax reference. You enter tax reference information when you define payrolls.

See: Defining a Payroll: page 5 – 5

You set up multiple assignment processing for an employee in the Person window.

To set up multiple assignment processing:

- Check the NI Multiple Assignments box in the Employment region.
  The NI_PERSON formula will now calculate NIC across all payroll assignments for this employee and aggregate them by tax reference over each statutory period.
The formula also generates a message that you can view with the run results from the Payroll Processes window. The message displays:

- total earnings subject to NI
- earnings for each category
- period type used
- employer rate used

**Note:** As the formula calculation is performed on all the NI categories that relate to the employee, the result often feeds more than one category’s balances. The Balance window in Assignment Process Results shows the balances that have been updated in this way during the run.

---

**Prioritizing Assignment Processing**

When you aggregate the earnings calculations of multiple assignments, you have to give processing priority to each assignment in the following order:

1. Appropriate Personal Pension assignments
2. contracted out assignments
3. non–contracted out assignments

If there are two or more assignments in the same category, you should give priority to the one with the shortest processing period. However, the DSS can reverse this rule in particular cases if it accepts that most of the employee’s earnings come from the assignment with the longer period.

Total earnings can vary according to how many weekly payments fall within the monthly period. For more details and examples of multiple employments calculations, refer to the Department of Social Security’s National Insurance Contributions Manual for Employers for the current year.

You prioritize assignment processing for each assignment in the Statutory Details window.

**To prioritize assignment processing:**

- In the NI region, select the Priority Period Type you require.
  
  If you do not enter the Period Type the formula defaults to the period of the payroll.
Note: The assignment process errors if the assignment’s period type is not specified and the formula detects that the assignments being calculated in association are for more than one period type.

Balance Dimension Information

Oracle Payroll uses the balance dimension _PER_NI_PTD to calculate earnings and deductions for the statutory period being processed. From the assignment’s priority period type and the regular payment date of the run being processed, it derives the start of the statutory period and sums the run results since that date.

This dimension is given to all the main NI balances. These include:

- NI D Able
- NI D CO
- NI D CO Able
- NI D Employee
- NI D Employer

In addition, the NI_PERSON formula uses a function to calculate the earnings subject to NIC for each category since the start of the statutory period.

For end of year reporting the dimension _ASG_TD_YTD is used, and the balances from all the assignments for the Person aggregated and returned against a single assignment.

Planning Runs for Multiple Assignments

When multiple assignments are processed at different intervals, such as weekly and monthly, you have to submit each assignment in the correct sequence. The submission sequence for each run must be in the same order as its effective run date sequence. If you submit runs out of sequence the system enforces the Time Period Dependent rule, which prevents the creation of an assignment process for an employee who has future actions existing.

Example

An employee has assignments to both a weekly and a monthly payroll. Table 15 – 4 shows the sequence of this employee’s payroll runs for one particular month.
All these runs have been submitted in the correct sequence. However, if you submitted the Month 1 run in Table 15 – 4 on 20 April, the Week 3 run would now come between the submission date and effective date of the Month 1 run. The rule would then exclude the employee’s assignment from the Week 3 run.

**Suggestion:** Two reports, Payroll Statutory Calendar and Assignments Unavailable for Processing, give useful information for planning multiple assignment submissions and for checking whether individual assignments will not be processed on specified dates.

### Multiple Assignments Report

This report lists employees who have been marked for multiple assignment processing, and indicates where Priority Processing Type is not set and cannot be defaulted.

You run the Multiple Assignments Report from the Submit Requests window.

**To run the Multiple Assignments Report:**

1. In the Name field, select the report name.
2. Enter an effective date for the report. The default is the session date.
3. Choose the Submit button.

<table>
<thead>
<tr>
<th>Effective Date of Run</th>
<th>Submitted On</th>
</tr>
</thead>
<tbody>
<tr>
<td>10–April, Week 1</td>
<td>7 April</td>
</tr>
<tr>
<td>17 April, Week 2</td>
<td>14 April</td>
</tr>
<tr>
<td>24 April, Week 3</td>
<td>21 April</td>
</tr>
<tr>
<td>30 April, Month 1</td>
<td>22 April</td>
</tr>
<tr>
<td>1 May, Week 4</td>
<td>28 April</td>
</tr>
</tbody>
</table>

Table 15 – 4 Planning Runs for Multiple Assignments (Page 1 of 1)
Entrering Employee PAYE and NI Details

The Statutory Details window lets you enter and view an employee’s PAYE and NI information on one screen. Check box information displayed at the top of the window shows whether the employee

- has had a P45 issued
- is a director
- is a pensioner
- has multiple assignments

Prerequisites

- Link the PAYE Details element to your payrolls. You can enter defaults for the input values so that no assignment is processed without a valid code being present.

  See: Defining Element Links: page 12 – 35

To enter tax details for an employee:

1. Query the employee assignment and choose the Tax Information button.

  Information displayed at the top of the Statutory Details window includes the following:
• whether the person is a director
• whether he or she falls within the scope of the P11D form for expenses and benefits
• whether the person is a leaver for whom a P45 has been issued
• whether the person is a current employee for whom a P45 has been printed off and submitted to a different tax office.

2. Change your effective date if required.

   **Note:** The Statutory Details window is now datetracked.

3. Enter the employee’s tax code.

   When you enter the tax code a validation formula is run to ensure that it is in the correct format.

   **Note:** At the start of a new tax year there may be a statutory requirement to either uplift or reduce particular suffix codes because of budgetary changes.

4. Enter Cumulative or Non Cumulative as the employee’s tax basis.

   At the start of a new tax year all tax codes except D0 that have a tax basis of N should be changed to C.

5. Record new employees’ previous taxable pay and tax paid with previous employers in the current tax year.

   **Note:** If you subsequently receive a P6 with different figures, enter the new figures. These are included in the PAYE calculation for cumulative based employees and reported separately on the End of Year Reports. They are not included in Taxable Pay or the PAYE balances.

6. If any tax is refundable, select the refundable category from the list. There are four choices:

   **Yes:** Make the refund.
   **Starter:** The refund, which is greater than the allowed maximum for a new starter, is withheld pending authorization.
   **Trade Dispute:** The refund is withheld as the employee is currently involved in a trade dispute.
   **Starter/Trade Dispute:** The employee has one refund withheld for starter reasons and another withheld for trade dispute reasons.

   **Note:** The categories Starter and Starter/Trade Dispute are no longer applicable after 6 April 1996. If you select them after this date they have no effect on the system.
Entering NI Details

To enter NI details for an employee:

1. Query the employee assignment and choose the Tax Information button.
2. Change your effective date if required.
   Note: The Statutory Details window is now datetracked.
3. Select the NI category for the employee.
4. In the Certificate field, select the method of authentication for the employee’s category if applicable.
5. Where applicable, enter the renewal date for the certificate.
6. Select the employee’s pension type. Oracle Payroll validates the type you select as different rates of National Insurance apply to different types.
7. Select a process type for the category of employee. Oracle Payroll automatically performs the correct NI calculation for whatever process type you select. There are eleven choices, as follows:
   - **Deceased:** When making the final payment to a deceased employee, no NI contributions are due.
   - **Director:** For an employee who is also a Director or Office Holder, NIC must be calculated on an annual frequency, irrespective of the frequency of the payroll the Director is assigned to.
   - **Director Pro Rate:** If the employee is appointed a Director partway through the year, the calculation frequency is based on the annual bands prorated by the remaining weeks in the year. However, if the Director resigns partway through the year, the annual frequency remains.
   - **Irregular Periods:** If the employee works for more than seven days in a frequency that does not fall into one of the basic tax frequencies, NIC is calculated on a daily basis.
   - **Left Irregular:** If the employee has left but a late payment is due, for example, a back dated salary award, use the Weekly tax basis. Do not use the Contracted Out codes for longer than six weeks after the employee leaves.
   - **Left Last Year Irregular Payments:** This is the same as Left Irregular but only Not Contracted codes can be used.
   - **Left Last Year Regular Payments:** This is the same as Left Regular except that only Not Contracted codes can be used in a new tax year.
Left Regular: This is used when the employee has left but is receiving regular payments, for example, a commission. In such cases the normal frequency continues to be used, but after six weeks, any Contracted Out codes revert to the Not Contracted Out equivalent.

Multiple Periods: This is used when more than one normal payment is being made in a single processing period. NIC can be calculated on each normal payment in isolation.

Normal: This is the category for all those not in one of the other ten special categories. Most employees in your enterprise will be in this category.

Pensioner Director: If the NIable Pay was earned before the director became a pensioner, he or she must still pay NIC.

8. In the Period field:
   • enter a number of days if you selected Irregular Periods as the process type
   • enter a number of periods if you selected Multiple Periods as the process type

9. Select a period type if you need to prioritize multiple assignment processing according to period type. Otherwise, leave this field blank.

10. In the SCON field, enter the employee’s Scheme Contracted Out number if he or she is in a Contracted Out Money Purchase pension scheme (COMP). Valid values for this field can be set by users for the QuickCode GB_SCON.
**Tax Payments Listing**

This report shows details of employees’ PAYE and National Insurance deductions. You run the report in the Submit Requests window.

**To run the Tax Payments Listing:**

1. In the Name field, select the report name.
2. In the Parameters window, select a payroll and payroll period for which you want to see the information.
3. If you want to see information just for a consolidation set, select the name of the set.
4. You can see the information listed either by employee name or assignment number. Select one of these to sort by.
5. Choose the Submit button.
NIC Holiday

The NIC holiday scheme is part of the ‘Back to Work Incentives’ legislation announced in the 1994 Budget. Under its terms, employers can reclaim NIC charges for up to a year for qualifying employees.

To qualify, employees must have been out of work for at least two years before starting work on or after 6 April 1996. Employers calculate and record NIC as normal, then deduct the amounts they are claiming back from their monthly payments to the Inland Revenue.

All amounts claimed are returned against category letter P at the end of the year. Employers can choose to claim at the not contracted out rate even when an employee is contracted out.

Two important conditions apply to employer claims:

- Employees must complete a 13 week qualifying period. If this period is not fully served, any amounts already reclaimed by the employer must be reimbursed to the Revenue in the following month’s payment.
- Employers can only claim for earnings actually paid within the period of entitlement to the NIC holiday. Earnings payments made by the employer after the period of entitlement is over cannot be claimed back, even if the money was earned wholly or partially before the period ended.

Oracle Payroll and NIC Holiday

Oracle Payroll provides the following features to enable you to calculate NIC Holiday:

- There is a predefined Employer Charge element, NIC Holiday. The result returned by this element is a negative value.
- The element feeds the NIC Holiday balance which accumulates the value for NI category letter P at the end of the year.
- When the element is first processed, the system automatically calculates the full amount reclaimable up to that point, whether this is within the first 13 week period or afterwards.
- When the employer reclaims payments during the first 13 weeks and the employee does not complete the qualifying period, the system recovers the amounts claimed.

Note: If the employee leaves before completing the qualifying period and you complete his or her processing before entering
the termination, you have to adjust the NIC Holiday balance manually.

- The element entry for NIC Holiday ends automatically when you reach the end of the NIC Holiday period. A message also displays.

  **Note:** The system only calculates a value in the last payroll period that the NIC holiday covers if the regular payment date of the period is earlier than, or equal to, the input value’s End Date.

### Setting Up the NIC Holiday Element

**To set up the NIC Holiday element:**

1. Link the element to the appropriate payrolls.
2. Enter the element for the employee.
3. Enter information in the Entry Values window, as follows:
   - Select Yes or No in the Standard Rate field. The default is Yes. Set the field to No if you want to reclaim at the not contracted out rate for employees who are contracted out.
   - Enter the end date that is quoted on the documentation you receive for the employee.
Correcting NI Category Code Entries

If an employee is allocated a wrong NI category code this could result in the employee assignment receiving a wrong entry of one of the NI category code elements. You can correct this by taking the following steps:

• enter the correct NI category code element for future deductions
• correct the amounts wrongly deducted through the previous category code element
• refund any overpayment of NIC by the employee as a result of the error, or
• record any underpayment that results as arrears for recovery through the system

You make these corrections in the Element Entries window for individual assignments by entering positive or negative amounts directly onto the relevant NI category code elements.

Prerequisites

☑ You must know the correct amounts to deduct from each assignment for the NI category code element that should have been allocated.

☑ You must know the correct amount to enter for the element NI Employer.

To enter the correct NI category code element:

1. Set your effective date to when you want the element entries to take effect. The date you set must be for an unprocessed pay period.
2. In the Element Name field, select the element for the NI Category that the employee should have had deductions made against.
3. Choose the Entry Values button.
4. Enter the correct entry values for the element. The amounts you enter should be the total values that would have accumulated had the correct category been used. The Pay Value must hold the amount of NI that should have been deducted.
5. Close the Entry Values window.

To reverse the values previously entered in error:

1. In the Element Name field, select the element for the NI Category that was entered wrongly for the employee.
2. Choose the Entry Values button.
3. Enter negative amounts for the relevant input values for the element to clear the values that have accumulated in error.

To correct the values entered for the NI Employer element:
1. In the Element Name field, select the element NI Employer.
   Note: If the requirement is to cost this as a separate item, select the element NI Employer Arrears instead.
2. Choose the Entry Values button.
3. In the Pay Value field, enter the difference between the total amount as held and the total amount that should have been calculated.
   This entry corrects the value held for NI Employer.

To create an NI Arrears entry for employee undercharges:
   If the net difference between the old and new pay values indicates too much was deducted, the refund will be made to the employee when the element entries are processed. If the net difference indicates too little was deducted, follow this procedure.
1. In the Element Name field, select the element NI Arrears.
2. Choose the Entry Values button.
3. Enter in the Pay Value field the amount of the undercharge for NI. The value must be entered as a negative amount, for example, –105.
   This entry will ensure that arrears are recovered over successive periods if necessary, in line with current legislation.
   Note: Any arrears outstanding at the end of the tax year will not be carried forward.
4. Close the Entry Values window, and save your work.

See Also

Entering Elements: page 12 – 44
Overriding NI System Calculations

If necessary, you can override the system calculation for NI for individual employee assignments in the Element Entries window.

To create an override for NI:

1. Set your effective date to the payroll period in which you want to make the override.
2. Create a new entry and select the nonrecurring element for the correct NI Category.
3. Choose the Entry Values button.
4. Enter the amounts that you want the system to use in the appropriate entry values.
5. Close the Entry Values window.
6. Check the Override check box.

Note: When the NI element is processed, it still creates a nonrecurring entry for the appropriate category, but the run results for this entry show what the system actually calculated. The entry will be marked Overridden.

7. If necessary, repeat the above procedure for the element NI Employer.
NIC for Company Directors

Special rules apply to the calculation of NIC for directors. A person is classified as a company director if he or she is appointed under Sections 291–294 of the Companies Act 1985. Directors’ earnings are chargeable to Schedule E (PAYE) income tax.

Most directors receive annual fees and bonuses. To calculate their contributions on a normal pay period basis would mean they only had to pay NIC up to the weekly or monthly Upper Earnings Limit. National Insurance for directors is therefore calculated on an annual, cumulative basis, like PAYE.

The main differences in the calculation of directors’ NIC are as follows:

- the use of an annual, or prorated, earnings period
- calculation on the director’s cumulative earnings
- deduction of the difference between NIC paid and NIC due

Oracle Payroll uses the exact percentage method of calculation to administer company directors’ NIC. The procedure takes into account changes in circumstances and recalculates the annual liability for each category each time.

For employees who become directors, NIC balances are maintained showing the director’s figures in addition to the reporting balances that show contributions as an employee and as a director. The director or employer can choose to pay on account.

Implementing Startup Data

You must link the recurring element NI Directors on Account if you want to use the ‘on account’ functionality. Oracle Payroll also supplies the nonrecurring element NI Director, which you do not need to link because it is defined for indirect results only. When the NI formula sends an indirect result to this element, the NI Director formula processes.

Balances

The special balance dimension _PER_TD_DIR_YTD is used to determine the amount of NI contributions paid as a director.

This dimension goes back to the latest of:

- appointment as a director
- tax year start
- transfer from a payroll that is reported to a different tax district reference number at end of year
Figure 15 – 1 shows the differences in balance dimensions when a director is appointed in mid-year:

**Figure 15 – 1 Balance Dimensions for Directors**

- _PER_TD_DIR_YTD_ goes back to 1 July, the start of the period in which the director was appointed
- _PER_TD_YTD_ goes back to the start of the year

This dimension is defined against the main NI balances:
- NI D Able
- NI D CO
- NI D CO Able
- NI D Employee
- NI D Employer

In addition, the NI_DIRECTOR formula uses a function to calculate the earnings subject to National Insurance for each category since the director was appointed.

- For end of year reporting the standard dimension _PER_TD_YTD_ is used. This includes results before and after the appointment as a director.

**Formulas**

The NI Director’s formula is triggered when the NI formula, processed for all employees from the NI element, detects that director’s processing has been requested. An indirect result is output to the NI Director nonrecurring element, and this processes the NI_DIRECTOR formula itself.

The formula takes into account the priority of the different NI categories. For example, when a director joins the company pension...
scheme, he or she changes category. All the director’s earnings at
category D are calculated first, and, if these reach the upper earnings
limit, no employee contribution is due on Category A. Oracle Payroll
makes an adjustment for Category A contributions at the same time as
the Category D deduction is made.

The priority order is:

G
E
B
F
A with APP
D
A (no APP)
S
C with Company Pension
C (no pension)

See Also

Balance Dimensions: page 13 – 5
Updating an Employee to Director

You enter director information in the Person window and in the Statutory Details window.

To update an employee to director:

1. Set your effective date to the day of the employee’s appointment as a director.
   
   This date is used to calculate what earnings were made after the appointment, and the number of weeks to pro rate the NI thresholds by.

2. Query the employee in the Person window and choose the Employment Information region.

3. Check the Director check box, and save your work.

4. In the Statutory Details window for the employee assignment, select the appropriate director category in the Process Type field.

   There are three choices:
   - Director
   - Director Pro Rate
   - Pensioner Director

   The calculation for Director and Pensioner Director is based on an annual period. The calculation for Director Pro Rate is based on the number of weeks left in the year after the appointment as director.

   Note: If you want to appoint a director who is not subject to the Special Rules NI calculation, check the Director check box only, as in Step 3 above. Leave the Process Type field in the Statutory Details window blank.

To make a retrospective change to a director’s NI:

- If you learn that an employee has been appointed director after you have paid him or her for that month, date effectively update the employee to director as of the appointment date.

   In the run following, Oracle Payroll will calculate the NIC on a pro rata basis and adjust the previous period’s figures.

See Also

Entering a New Person: page 9 – 5
Updating a Director’s Employment Status

It is important to accurately record changes to a director’s NI category and pension arrangements as this means a change to his or her employment status. You record these changes in the Statutory Details window for the employee assignment.

To update a director’s NI category and pension arrangements:

1. Set your effective date to the date of the changes to the director’s employment status.
   
   It is important to enter your changes on the correct date. Earnings before the change will be calculated on the previous circumstances.

2. Change the director’s category if the director has lost the right to a reduced rate NIC.

3. Change the director’s pension and category if the director does one of the following:
   • leaves the company’s contracted–out pension scheme
   • joins the company’s contracted–out pension scheme
   • joins or leaves an appropriate pension scheme

4. If the director reaches pensionable age, change his or her category and change the process type to Pensioner Director.

When a Director Resigns

If a director resigns and continues to be employed by the company during the same tax year, his or her earnings period for NI does not change. NIC continues to be calculated cumulatively for the ex–director using the annual earnings period.

Paying Directors’ NIC On Account

As NIC for directors is calculated on an annual earnings period, the company and director may find that contributions are not payable for the initial pay periods until the LEL is reached. At this point contributions increase substantially. For this reason NIC can be paid on account from the start of the directorship.

With the director’s permission, NIC can be paid before earnings reach the LEL. For the director this is paid at the initial rate applicable up to the LEL, and for the employer, at the lowest not contracted–out rate.
You arrange to pay a director’s NIC on account in the Element Entries window.

**Prerequisites**
- Link the predefined element NI Director on Account in the Element Link window.

**To enable a director to pay NIC on account:**
1. Set your effective date to when the director should begin paying NIC on account.
2. Enter the element NI Director on Account.
3. In the Entry Values window, set the input value Primary to Yes.

---

**Paying Employers’ NIC On Account**

Employers can elect to even out payments of NIC by paying a higher band percentage if the director’s earnings are expected to rise over the year. The maximum increase allowed is 10% of earnings.

You arrange to pay employers NIC on account for a director in the Element Entries window.

**Prerequisites**
- Link the predefined element NI Director on Account in the Element Link window.

**To enable payment of employers’ NIC on account:**
1. Set your effective date to when you want to begin paying employers’ NIC on account.
2. Do one of the following:
   - If the director already has an entry of the element NI Director on Account, select the element and choose the Entry Values button.
   - If the director does not have an entry of the element NI Director on Account, select this element in the Element Name field and choose the Entry Values button.
3. In the Secondary field, set the contracted in rate you want to use. Set this rate in decimals. For example, you would enter 10% as .1.

**Note:** If the director is contracted out, Oracle Payroll derives the equivalent contracted out rate for the calculation. These rates are
validated against the user table NI_ERS_WEEKLY column C_ERS_RATE_CI.
Viewing Processing Results for a Director

The Tax Payments Listing displays balances for all categories the director has been on from the start of the year.

The Pay Advice Report displays the following information with the run results for the current period’s processing:

- total earnings subject to NI
- earnings for each category
- number of weeks if prorated
- whether deductions made ‘on account’
- employer rate used

**Note:** The calculation is done on all categories the director has been on. The results may therefore be output to more than one category’s balances.

To view the balances that have been updated in the run, select the run in the Employee Assignment Processes window and choose the Balances button.

See Also

Viewing Assignment Process Results: page 17 – 55
NI Class 1A Contributions

Class 1A contributions relate to the employer’s NIC payable on company cars, and on fuel made available for private use. The NIC category code for these contributions is Y.

Contributions are collected at the highest rate of employer contribution (10.2% in the tax year 1995/96) when employees earn more than £8,500 annually, or are directors or office holders.

The amount to be paid in any current year is summed in the NI Y year dimension balance for that year, and is paid to the Inland Revenue in the June following the tax year end. It is then reported on in the Year End reports at the end of that tax year. For example, contributions for the tax year 1993–94 are summed for the year in April 1995, paid in June 1995 and reported on in April 1996.

The Alternative Payment Method (APM) for Class 1A avoids the necessity of having to record payments in the Year End reports. The employer pays directly to the Contributions Agency.

Since 6 April 1994, Class 1A NIC has been assessed using the same formula for ascertaining car benefit and the fuel scale charges as published for PAYE P11d purposes.

**Note:** Fuel scale assessment is based on the PAYE ‘all or nothing’ principle. If the employee uses just one gallon of fuel for private use, NIC becomes payable. The scale relates directly to the fuel scale rate of the car.
Predefined Elements for Class 1A Administration

The predefined elements for Class 1A administration that are supplied as startup data are listed in Table 15 – 5.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Classification</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>NI Car Primary</td>
<td>Recurring</td>
<td>Information</td>
<td>500</td>
</tr>
<tr>
<td>NI Car Secondary</td>
<td>Recurring</td>
<td>Information</td>
<td>500</td>
</tr>
<tr>
<td>NI Y</td>
<td>Nonrecurring</td>
<td>Employer Charges</td>
<td>3500</td>
</tr>
<tr>
<td>NI Y Last Year</td>
<td>Nonrecurring</td>
<td>Employer Charges</td>
<td>3500</td>
</tr>
<tr>
<td>NI Car Payment</td>
<td>Nonrecurring</td>
<td>Voluntary Deduction</td>
<td>6500</td>
</tr>
<tr>
<td>NI Car Payment Secondary</td>
<td>Nonrecurring</td>
<td>Voluntary Deduction</td>
<td>6500</td>
</tr>
</tbody>
</table>

Table 15 – 5 Predefined Class 1A Elements

NI Car Primary and NI Car Secondary

These elements both represent NI Class 1A. NI Car Primary is entered for employees with one company car, while employees allocated a second company car receive an entry of NI Car Secondary as well.

When an employee is allocated two company cars, you have to decide at the outset which is primary and which is secondary. Current legislation defines the primary car as the one which does the greater daily average business mileage.

Run items for both elements feed the NI Y balance. There are two specific features to these elements:

- Both elements process after termination to allow for late changes to be made to input values.
- The formulas for each element recalculate for the whole of the current year during payroll runs, thereby maintaining the latest calculated values for the NI Y balance at all times.

Note: Because the formulas have been defined to access only the entry values from the normal entry forms, you cannot override the system calculation for NI Car Primary or NI Car Secondary.
NI Y
The element NI Y allows you to enter an opening balance for NI Y in the current year when transferring to Oracle Payroll from another payroll application. The value you enter for this element is ignored during formula recalculations of NI Y but is included in the Year to Date balance.

**Note:** Because NI Y has an Employer Charges classification, remember to enter the correct costing data.

NI Y Last Year
The element NI Y Last Year allows you to enter a reporting value for NI Y for the previous year when transferring to Oracle Payroll from another payroll application. This is because the NI Y balance is not available for entry.

**Note:** If you have entered an opening balance via NI Y adjustment it is your responsibility to ensure that the total balance is correct.

NI Car Payment and NI Car Payment Secondary
These elements accept as indirect results the actual amount of an employee’s contribution towards the private use of the car, if an amount has been entered onto NI Class 1A.

In addition to these predefined elements, there is a report listing the NI Y amounts due from employees.

---

**Formulas for Calculating NI Class 1A Contributions**

The formula linked to NI Car Primary is NICAR_PRIMARY. The formula linked to NI Car Secondary is NICAR_SECONDARY.

For the year 1995–96 the following legislative global values apply to both formulas:

- Car benefit is 35% of the price.
- The maximum price for car benefit calculations is £80,000.
- The highest level of employer’s NIC is 10.2%.

A business mileage of between 2,500 and 17,999 reduces the car benefit of NI Car Primary by one third. It does not reduce the car benefit of NI Car Secondary. A business mileage of 18,000 or more reduces the car benefit of NI Car Primary by two thirds, and the car benefit of NI Car Secondary by one third.
Cars that are four or more years old by the end of the tax year have the car benefit, after adjustment for mileage, reduced by one third.

Payment for private use further reduces car benefit on a pound for pound basis down to, but not beyond, zero.

Fuel scale value is then added to the car benefit.

In both formulas this sum is multiplied by the highest level of employer NIC percentage, divided by 365 to obtain the daily rate, and multiplied by the number of days of availability. This is calculated as the days between:

- the START DATE, which is the later of:
  - start of tax year
  - start date of entry values
- the END DATE, which is the earliest of:
  - end of tax year
  - end date of entry values
  - termination date, if set

If there are any updated or corrected input values, the formula recalculates the result, which becomes the difference between the current Class 1A_ASG_STAT_YTD balance and the amount from the appropriate formula.

Within the formulas there is a call to the function CLASS1A_YTD. This sums across all the element entries for the year rather than looking at the current entry.

See Also

GB Functions: (Oracle FastFormula User’s Guide)

**NI Class 1A Contribution Balances**

The NI Car Primary and NI Car Secondary balances are used by their respective formulas to calculate the amount of Class 1A NIC as follows:

- the system calculates the total amount owing from the beginning of the tax year to the end of the current pay period
- it then subtracts from this figure the Statutory Year to Date balance paid
The NI Y balance with the dimension _ASG_STAT_YTD is used for reporting on. The amount paid for each employee is reported against the category code Y in the Year End reports.

**Note:** If your enterprise has just implemented Oracle Payroll this year, you may have used the balance NI Y Last Year to store your NI Y liability for last year from your previous payroll application. If so, the End of Year process selects that balance if a value does not exist in NI Y for that year.
Entering NI Car Elements for Employees

You must enter the NI Car Primary element for employees who hold a company car. You must also enter the NI Car Secondary element if you have allocated a second car to the employee. Enter these elements in the Element Entries window.

Prerequisite

- Link the elements to payrolls before giving them to an employee and including them in payroll runs. The link default on NI Car Primary and NI Car Secondary is discretionary, enabling you to input correct values for each employee.

See: Defining Element Links: page 12–35

To enter a NI Car Primary or NI Car Secondary element for an employee assignment:

1. Set your effective date to the day you want to enter the element, and query the employee assignment.
2. In the Element Entries window, select the NI Car Primary or NI Car Secondary element.
3. Enter cost codes and a reason for the entry if these fields are set up on your system. Choose the Entry Values button.
4. In the Entry Values window, enter the price of the car to the nearest pound.
   The value you enter is based on the list price of the new car plus delivery charges and VAT. Add the cost of any accessories over £100 if fitted after 31 July 1993, and deduct any employee capital contribution up to £5,000.
5. Enter the car’s registration date in the format DD–MON–YYYY.
6. For reporting purposes, you can enter the car’s registration number. This is optional.
7. Select the mileage band for the car based on the expected level of business mileage for the current tax year. Any business mileage already done in a car allocated to an employee partway through a year can be included in the calculation. There are three categories:
   - Under 2,501
   - 2,501–17,999
   - Over 17,999
8. Select the fuel type, either Petrol or Diesel, or leave the field blank.
9. If you enter a fuel type, enter a value in the Engine cc field for fuel scale charge purposes. Leaving this field blank after entering a fuel type causes the formula to use the lowest charge for the type selected.

10. Enter a value in the Fuel Scale field if you want to override the value derived from the entered fuel type and engine size.
    
    **Note:** If you want to record fuel type and engine size details for the car but do not want a fuel scale charge to be included in the calculation of NI Class 1A, enter a fuel scale value of 0.00.

11. If the employee contributes to the use of the car for private mileage, enter the annual amount in the Payment field. The amount you enter is automatically passed by the formula to the element NI Car Payment for the deduction to be made.

---

**Updating NI Car Element Entries**

If the employee changes to a vehicle of different value or alters the level of his or her payment contribution during the year, the NI Car formula uses the updated values to prorate new amounts. The year for Class 1A purposes consists of 365 days running from 6 April to 5 April following.

In particular cases you may need to take action in the Element Entries window, as follows:

- **To update records when the employee no longer has use of the car:**
  - Choose Delete Record from the Edit Menu to delete the element entry and choose the End Date option at the prompt. This stops further processing of the element.
  - If the car is no longer available partway through a pay period, update the price to 0.00 on the effective date and put an end date to the element after the last processing date in that period.

- **To update records when the car is off the road for repairs:**
  - Update the price to 0.00 on the effective date and update it to the original value when the car becomes available again.
  - **Note:** A car must be off the road for essential repairs for more than thirty days before you can change the details.

- **To make changes to primary and secondary cars (1):**
  - If an employee with one company car (Car A) is allocated a second car (Car B) and you need to make the second car the primary car:
Update the NI Car Primary entry from Car A to Car B, and make a new entry of NI Car Secondary for Car A.

To make changes to primary and secondary cars (2):

If an employee has a primary car (Car C) and a secondary car (Car D) and the primary car becomes unavailable, the secondary car then becomes the new primary car. To do this:

Update the NI Car Primary entry from Car C to Car D and put an end date on the NI Car Secondary entry or update its price to 0.00.

Viewing NI Class 1A Contribution Run Results

When the payroll run is complete you can view the results in the Employee Assignment Processes window.

To view class 1A contribution run results:

Select the payroll run and choose the Run Results button or the Balances button to view information for the NI car elements as follows:

- **NI Car Primary and NI Car Secondary**: You can see the run results for these elements. As they are Information elements, they have no effect on net or payment balances.
- **NI Y**: You can see the run result for this element. As it is an Employer Charge element it has no affect on net or payment balances.
- **NI Car Payment**: You can see the run result for this element if the employee makes a contribution towards the private use of the car.
- **NI Y balance**: You can see this balance showing the YTD dimension of Class 1A liability to date.

**Note**: If this balance differs from the sum of the NI Car Primary and NI Car Secondary ASG_STAT_YTD dimensions, this is because a direct entry via NI Y has been made.

See Also

Viewing Assignment Process Results: page 17 – 55
NI Car Detail Report

This report lists employees by payroll who have entries of the element NI Car Primary and NI Car Secondary, and shows the NI Y amounts due from each. The Grand Total amount should equal the NI Y payment amount from each payroll.

You run this report in the Submit Requests window.

To run the NI Car Detail report:

1. In the Name field, select the report name. Then select the Parameters field to open the Parameters window.
2. Enter the start and end dates of the report.
   By default, these are the start and end dates of the current tax year.
3. Select the payroll for which you want to see information. If you do not select a payroll, the report displays payments information for all the employees in your enterprise receiving a company car benefit.
4. You can select the order in which details are shown on the report. The default order is by employee name. Alternatively, you can select by employee number or National Insurance number.
5. Choose the Submit button.
Court Orders and Arrestments

This chapter describes the court orders and arrestments in operation in the United Kingdom, and explains how to administer them for your employees.
Court Orders and Arrestments Legislation

Court orders for the attachments of earnings are served by courts on employers requiring them to deduct sums from the earnings of employees who have incurred court debts or fines. The employer has to administer the collection of the debt and ensure that it is passed to the court, Agency or local authority issuing the order.

An Attachment of Earnings order is made under the Attachment of Earnings Act 1971. The procedure used under this legislation is largely followed in other similar legislation covering the collection of debts under Community Charge, Council Tax and Child Support Act legislation. Attachment of Earnings orders are given different terminology in Scotland and are administered under the Debtors (Scotland) Act 1987. Table 16 – 1 lists the principal UK legislation and names of orders.

Northern Ireland legislation, not listed in Table 16 – 1, administers the same orders as under the Attachment of Earnings Act and the Child Support Act, but there is no liability in Northern Ireland for Council Tax or Community Tax.

<table>
<thead>
<tr>
<th>Legislation</th>
<th>Name of Order</th>
<th>Acronym</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment of Earnings Act, 1971</td>
<td>Attachment of Earnings</td>
<td>AEO</td>
</tr>
<tr>
<td>Debtors (Scotland) Act, 1987</td>
<td>Earnings Arrestment</td>
<td>EAS</td>
</tr>
<tr>
<td></td>
<td>Current Maintenance Arrestment</td>
<td>CMA</td>
</tr>
<tr>
<td></td>
<td>Conjoined Arrestment</td>
<td>CAO</td>
</tr>
<tr>
<td>Community Charges (Administration and Enforcement) Regulations, 1989</td>
<td>Community Charge Attachment of Earnings</td>
<td>CCAEO</td>
</tr>
<tr>
<td>Child Support Act, 1991</td>
<td>Deduction from Earnings</td>
<td>DEO</td>
</tr>
<tr>
<td>Council Tax (Administration and Enforcement) Regulations, 1992</td>
<td>Council Tax Attachment of Earnings</td>
<td>CTO</td>
</tr>
</tbody>
</table>

Table 16 – 1 Principal Court Order Legislation

Court order legislation is complex. Full details for administering the system are set out in the Employers Handbook on Attachment Orders available on request from the Lord Chancellor’s Department, Debt and Enforcement Branch, 105 Victoria Street, London SW1E 6QT.
Attachment of Earnings Orders

The procedure for administering an AEO applies broadly to the other categories of court orders.

The following terms are used in the order:

- **Attachable earnings**: This is the part of the employee’s earnings to which an attachment order applies.
- **Protected earnings**: These are the earnings the employee must be left to live on after all deductions, including the earnings attachment deductions, have been made.
- **Normal deduction**: This is the amount that is normally deducted from the employee each pay period under the terms of the order.

Attachable earnings include:
- salary, overtime and bonuses
- SSP and pensions, less PAYE
- National Insurance and pension scheme contributions, including AVCs

Non-attachable earnings include the following:
- SMP
- refunds of expenses
- pay advances
- sums paid by government departments in Northern Ireland or foreign countries
- pay or allowances paid to the employee as a member of Her Majesty’s forces
- pensions or allowances paid under social security legislation
- disability allowances and pensions
- the GMP elements of pensions

An AEO states to the employer the amount to be deducted and the amount of the protected earnings, based on the employee’s normal payment frequency.

On receipt of an AEO the employer is required to deduct the specified amount from the employee’s attachable earnings and to forward the amounts deducted to the issuing court, until one of the following takes place:

- instructions are received to cease the order
• the employee leaves
• the amount of the debt, if known, has been repaid

**Multiple payments in a period**

• Supplementary payments in a period may be used to make up any shortfall between the expected deduction for the period and the actual period–to–date deduction.

• If the employee receives holiday pay in advance, the amount of the deduction should be multiplied by the number of holiday pay periods, provided the protected earnings for these periods remain covered.

**Priority and Non–Priority Orders**

All AEOs are designated priority or non–priority, and the order’s category can determine the way it is processed. Priority orders have processing priority over non–priority ones. All priority AEOs issued against an employee are to be processed first and in date order. After these, non priority AEOs are to be processed, again in date order.

**Priority AEOs**

For these, the attachable earnings are reduced by the protected earnings, and if the remainder is sufficient, the full deduction is taken. If not, the remainder is deducted, and the shortfall is added to an arrears balance for recovery in subsequent runs if possible.

If there are insufficient attachable earnings to cover the protected earnings, then the shortfall is added to an arrears balance. In addition, the full deduction amount is added to an arrears balance. Both will be recovered in subsequent runs if possible.

**Example**

An employee whose net earnings are £190 per week incurs a debt of £180. The Court sets protected earnings at £130 and orders the debt to be paid at the rate of £20 per week for nine weeks.

In the second week the employee’s net earnings drop to £100. This is £30 less than his protected earnings entitlement, and the employer makes no deduction from the employee’s pay. Instead, the employer sets the employee’s Protected Salary Arrears balance to £30, and his Deductions Arrears balance to £20.

In the third week the employee’s net earnings return to £190. His protected salary is now £160 (130 + 30), and he owes £40 deductions. The employer deducts £30 (the maximum possible for the period),
resets the Deductions Arrears balance to £10 and the Protected Salary Arrears balance to zero.

The employee’s earnings remain at £190 in the fourth week, and the employer is now able to deduct £30 to bring the employee’s current repayments up to date. The Deductions Arrears balance is reset to zero.

Non Priority AEOs
These are processed in the same way as Priority AEOs except that there is no arrears balance for deductions. If, after allowing for protected earnings, the employee has insufficient attachable earnings in any pay period from which to make either a normal or partial deduction, the amount outstanding is not carried forward against future earnings. However, the full debt remains to be paid over a longer time scale.

Community Charge Attachment of Earnings Orders
CCAEOs are issued by local authorities. The legislation concerning the method of recovery was amended on 1 April 1992.
The normal deduction is determined by reference to bands of attachable earnings and is either a fixed amount if the order was issued before 1 April 1992, or a percentage of attachable earnings if issued after that date.

Attachable Earnings
Authorized pension contributions should not be deducted for orders issued before 1 April 1992.

Multiple payments in a period
For orders made before 1 April 1992 holiday pay paid in advance is deemed as all attachable in one period. For orders made after that date the amount to be deducted is based on the current period’s earnings and then the holiday period’s earnings. Supplementary payments in the same period have a deduction rate of 20% applied.

Council Tax Attachment of Earnings Orders
CTOs are used for the recovery of Council Tax using the same procedures as those used for CCAEOs issued after 1 April 1992.

Multiple payments in a period
The amount to be deducted is based on the current period’s earnings and then the holiday period’s earnings. Supplementary payments in the same period have a deduction rate of 20% applied.
Deduction from Earnings Orders

DEOs are used for the collection of child support maintenance payments under the authority of the Child Support Agency. These orders are administered in the same way as AEOs.
Scottish Arrestments

Scottish court orders are called arrestments, and there are three kinds: Earnings Arrestments, Current Maintenance Arrestments and Conjoined Arrestment Orders. Oracle Payroll provides elements for all these arrestments.

Earnings Arrestments

The amount to be recovered each processing period is based on bands of attachable earnings and a fixed amount. Only one EAS can be in operation for an employee at any one time. If you receive a second EAS for the employee, you must return it to the issuing authority, and give details of the existing order.

Multiple Payments in a Period

All earnings in a period whether or not they contain holiday pay paid in advance are attachable. Supplementary payments have a deduction rate of 20% applied.

Current Maintenance Arrestments

CMAs are used to collect maintenance. The employer is informed of the daily amount of deduction, the daily protected earnings applicable under the order, and an indication of the employee’s entitlement to have deductions reduced by the equivalent of UK basic rate income tax. The employer is required to divide the amount of attachable earnings by the number of calendar days since the last normal payment, and then use that daily figure to calculate the amount of deduction.

Only one CMA can be in operation for an employee at any one time. If you receive a second CMA for an employee, you must return it to the issuing authority, and inform them of the details of the existing order. Note, however, that a single CMA may coexist with a single EAS for the same employee. The EAS must be processed first, being of higher priority.

Multiple Payments in a Period

Supplementary payments in a period may be used to make up any shortfall between the expected deduction for the period and the actual period–to–date deduction.

Conjoined Arrestment Orders

CAOs are issued where more than one EAS and/or more than one CMA are to be operated. These orders are administered in the same
manner as EASes, except that deductions for CAOs are payable to the Sheriff Court instead of the named creditor. Only one CAO at a time can be in operation for an employee, and while it is in operation no single EAS or CMA may be administered.

Supplementary payments are treated as their single order equivalents.

**Processing Priority for Court Orders**

When deductions are taken from employees for more than one court order at a time, the order of processing must be as follows:

1. For orders issued before 1 April 1993:
   - If a Priority AEO or a Non Priority AEO is in operation then any later dated CCAEO can be administered.
   - If a CCEAO is in operation then no further CCAEOs can be administered until the first has cleared.

2. For orders issued after 31 March 1993, the following should be administered in order of receipt date:
   - AEO
   - DEO
   - CCAEO
   - CTO
   
   Non Priority AEOs are administered after the above orders and, if more than one is received, in order of receipt date.

3. In Scotland the order is either
   - DEO
   - CAO
   
   or
   - DEO
   - EAS
   - CMA
Oracle Payroll and Court Orders/Arrestments

Oracle Payroll provides all the elements, balances and formulas necessary for you to correctly administer court orders and arrestments in the United Kingdom.

<table>
<thead>
<tr>
<th>Element</th>
<th>Used For</th>
<th>Balance Feeds</th>
</tr>
</thead>
<tbody>
<tr>
<td>Court Order</td>
<td>CTO, AEO, CCAEO, CCAEO_PRE_APRIL, DEO</td>
<td>Court Order_ELEMENT_ITD, Court Order_ELEMENT_PTD</td>
</tr>
<tr>
<td>Court Order Arrears</td>
<td>Holds deduction arrears and protected pay arrears for Priority AEOs and DEOs. You do not make entries of this element for employees. It is used in the payroll run.</td>
<td>Court Order Arrears Deduction_ELEMENT_ITD, Court Order Arrears Protected Pay_ELEMENT_ITD</td>
</tr>
<tr>
<td>Court Order Non Priority</td>
<td>Non priority AEO</td>
<td>Court Order Non Priority_ELEMENT_ITD, Court Order Non Priority_ELEMENT_PTD</td>
</tr>
<tr>
<td>EAS Scotland</td>
<td>Earnings Arrestments issued in Scotland</td>
<td>EAS Scotland_ASG_ITD</td>
</tr>
<tr>
<td>EAS Scotland Payments</td>
<td>Holds the payment for Earnings Arrestments. You may use it for EAS balance adjustments, for example, after the EAS has been closed or replaced by a CAO.</td>
<td>EAS Scotland Payments_ASG_ITD</td>
</tr>
<tr>
<td>CMA Scotland</td>
<td>Current Maintenance Arrestments issued in Scotland</td>
<td>CMA Scotland_ASG_PROC_PTD</td>
</tr>
<tr>
<td>CAO Scotland</td>
<td>Conjoined Arrestments issued in Scotland</td>
<td>CAO Scotland_ASG_PROC_PTD</td>
</tr>
<tr>
<td>CAO Scotland Payments</td>
<td>Holds the CMA and EAS components of the CAO payment. You may use it for EAS balance adjustments, for example, after the CAO has been closed.</td>
<td>CAO Scotland Payments EAS_ASG_ITD, CAO Scotland Payments CMA_ASG_PROC_PTD</td>
</tr>
<tr>
<td>Fee</td>
<td>All court orders</td>
<td>Fee_ELEMENT_PTD</td>
</tr>
</tbody>
</table>

See Also

Non–Third Party Payment Court Orders: page 16 – 10
Non–Third Party Payment Court Orders

Users who do not want to make court order payments through Oracle Payroll can use nonpayment versions of the court order elements. These elements have the prefix NTPP (non–third party payment).

For these elements, the system keeps full track of debts and payments, but you make payment through some external means such as Accounts Payable. The list of NTPP elements is as follows:

- Court Order NTPP
- Court Order Non Priority NTPP
- CAO Scotland NTPP
- CMA Scotland NTPP
- EAS Scotland NTPP
Setting Court Order and Arrestment Balances

The amount of court order debt paid at any time is held in an Inception-to-Date (ITD) balance. For those elements that can have multiple occurrences, this balance exists at element level, reflecting the need to keep track of how much has been paid for each separate occurrence. Otherwise the balance exists at assignment level.

The amount of the debt still outstanding is the difference between the amount in the ITD balance dimension and the Initial Debt input value.

For assignment level ITD balance dimensions, care must be taken, once the total debt has been repaid and the element has been given an end date for processing, that the balance is cleared back to 0.00. If this is not done and a new element entry is given to the employee for the same court order type element, the formula finds the ‘old’ balance and the element is not processed correctly.

The attachable pay balances have their RUN and PERIOD balance referenced within the formulas because of the possibility of there being more than one run in a period.

See Also

Balance Dimensions: page 13 – 5

Entering Court Order Elements

The elements Court Order and Court Order Non Priority are used for United Kingdom court orders, excluding Scotland. Court Order Non Priority is used only for entering non-priority AEOs. Court Order is used for entering priority AEOs and other court orders.

You enter these elements for an employee assignment in the Element Entries window.

You can run the Element Result Listing report from the Submit Requests window to see all the run results processed for a court order element over a period of time you select.

How Oracle Payroll Manages Deductions

For AEO and DEO type debt repayment orders:

You enter the initial debt. The system then manages the deductions automatically and ends the process when the debt is cleared. If you do
not enter a value for the debt the system continues to process the
deductions each pay period as ongoing maintenance payments.

**For CTO, CCAEO and CCAEO_PRE_APRIL type orders:**
Oracle Payroll calculates each deduction from the initial debt and from
pay band tables. The system adjusts deductions to the level of net pay
in each period, taking any net pay variations into account. The system
stops the element entry automatically when the total debt has been
repaid. Each time the element is processed a payroll message is issued
giving deduction details, and these are notified to the employee
through his or her pay advice.

**Prerequisites**
- Link the elements Court Order and Court Order Non Priority to
  your payrolls. You can use the link to define defaults for the
  administration fees you want to apply.
- You can use the link to define defaults for the administration fees
  you wish to apply to all court orders, subject to the legislative
  maximum amounts.
- Enter any Costing key flexfield segment values requiring input at
  element level onto the element when linking the court order
  elements to each payroll.
- Set up third party payee and payment method details.

  See:

**To enter a priority AEO, CTO, CCAEO or DEO for an employee:**
1. Set your effective date to the day you received the order, and query
   the employee assignment.
2. In the Element Entries window, select the Court Order element.
3. Enter cost codes and a reason for the entry if these fields are set up
   on your system. Choose the Entry Values button.
4. In the Entry Values window, select the type of order.
5. Do one of the following:
   - For AEO and DEO type orders, in the Order Amount field enter
     the normal deduction for the order. Then enter the protected
     pay amount. You can also enter an initial debt amount for AEOs
     and DEOs when they are debt repayment orders.
     Oracle Payroll maintains deduction arrears and protected pay
     arrears for priority orders by returning indirect results to the
     Court Order Arrears element during the payroll run.
For CTO and CCAEO type orders, in the Initial Debt field enter the total debt to be paid.

6. Enter the employer’s administration fee for the order. The maximum fee is £1.00. This is chargeable once each pay period that a court order is processed.

7. Enter a Reference, such as the Case Number, to help you identify this order in messages and reports.

8. In the Issued By field, enter the name of the issuing authority.

9. In the Payee Details field, select the details of the person or organization to whom the order is payable.

10. If required, enter the sub-priority number for the entry in the unlabeled field next to the Processing Priority field. If you make more than one entry of a court order element for the same employee, the sub-priority number enables you to determine the order of processing for the different entries.

To enter a non priority AEO for an employee:

- In the Element Entries window, select the element Court Order Non Priority, then follow the same procedure as for entering a priority AEO. There is no Type field in the Entry Values window as there is only one type of non priority order.

See Also

Non–Third Party Payment Court Orders: page 16 – 10
Element Result Listing Report: page 12 – 61
Entering Elements for Scottish Arrestments

You enter Scottish arrestments elements for employee assignments in the Element Entries window. The following legislative restrictions apply to these entries:

- You may not give an employee more than one EAS Scotland entry or more than one CMA Scotland entry at a time. You may, however, give the employee one EAS Scotland and one CMA Scotland entry at the same time.
- While a CAO Scotland element is in operation for an employee, you may not give the employee an EAS Scotland, a CMA Scotland, or another CAO Scotland element entry.

Prerequisites

- Link the elements EAS Scotland, EAS Scotland Payments, CMA Scotland, CAO Scotland and CAO Scotland Payments to your payrolls.
- You can use the link to define defaults for the administration fees you wish to apply to all court orders, subject to the legislative maximum amounts.
- Enter any Costing key flexfield segment values requiring input at element level onto the element when linking the arrestment elements to each payroll.
- Set up the third party payee and payment method details.

To enter an EAS, CMA or CAO for an employee:

1. Set your effective date to the day you received the order.
2. In the Element Entries window, select the EAS Scotland, CMA Scotland or CAO Scotland element.
3. Enter cost codes and a reason for the entry if these fields are set up on your system. Choose the Entry Values button.
4. Carry out one of the following sets of tasks:

   For EAS:
   - Select Single for the order type.
   - Enter the initial debt, that is, the total debt to be paid.

   For CMA:
   - Enter the daily debt to be paid.
• Enter the amount of the old daily debt if you have to enter a different rate of daily debt partway through a period. In this case the amount you entered for the daily debt becomes the amount for the second part of the period. Leave the Old Daily Debt field blank if the daily debt amount applies throughout the period.

• If applicable, enter the date at which the old daily debt ends. If you leave the Old Daily Debt field blank leave the Old Debt End Date blank as well.

• Enter the daily protected pay amount.

• Select Yes in the Tax Relief field if UK tax equivalent relief applies to this order. If not, select No.

For CAO:

• Where applicable, make entries for EAS as described above.

• Where applicable, make entries for CMA as described above.

5. Enter the amount of any administration fee you are charging as an employer.

The maximum fee is 50 pence. This is chargeable once each pay period that a court order is processed.

6. Enter a reference, such as the case number, to help you identify this order in messages and reports.

7. Enter the name of the issuing authority in the Issued By field.

8. Enter the details of the person or organization to whom the order is payable in the Payee Details field.

Caution: A CAO is sometimes issued to supersede an EAS currently in operation for an employee. When this happens, ensure that the CAO Scotland Payments EAS_ASG_ITD balance dimension is adjusted to the value for the amount already deducted under the original order, that is, the value of EAS Scotland Payments_ASG_ITD. If this is not done, you could deduct more from the employee than is necessary.
Closing Scottish Arrestments

There are different procedures for closing different arrestments.

Earnings Arrestments

EAS Scotland element entries stop automatically when the total deductions equal the initial debt. In addition, you can manually stop these elements before the debt has been fully paid. It is mandatory to stop a current EAS if a CAO is made against the same employee.

Caution: When an EAS Scotland entry is stopped, either manually or automatically, you should adjust to 0 the EAS Scotland Payments_ASG_ITD balance dimension for the employee assignment. If this is not done, any subsequent EAS Scotland element for the same employee will appear to be partly or fully paid.

To manually close an EAS Scotland element entry:
1. Set your effective date to the day the order is to end.
2. In the Element Entries window, select the EAS Scotland element.
3. Choose Edit – Delete Record to delete the element entry. Choose the End Date option at the prompt.
4. Save your work.
5. Set your effective date to the day after the element has ended.
6. In the Employee Assignment Processes window, select the appropriate payroll process entry and choose the Balances button to query the EAS Scotland Payments_ASG_ITD balance dimension.
7. In the Adjust Balance window, adjust to 0 the EAS Scotland Payments_ASG_ITD balance dimension by applying an appropriate contra-entry; e.g. if the value of EAS Scotland Payments_ASG_ITD is 123.59, apply a contra-entry of –123.59.

Current Maintenance Arrestments

CMA Scotland element entries are not stopped automatically. Two manual procedures are available for closing them: closure on the last day of the pay period, and closure partway through a period. No balance adjustments are required with CMA closures.

To manually close a CMA Scotland element entry on the last day of a pay period:

Follow the procedure for manually closing an EAS Scotland element entry, steps 1–4. In the Element Entries window, select the CMA Scotland element.
To manually close a CMA Scotland element entry partway through a pay period:
1. Set your effective date to the day after the order is to end.
2. In the Element Entries window, select the CMA Scotland element, and choose the Entry Values button.
3. In the Entry Values window, enter a daily debt value of 0. Choose the Update button when prompted.
4. Enter the original Daily Debt value in the Old Daily Debt field.
5. In the Old Debt End Date field, enter the date the CMA is to end.
6. Close the Entry Values window.

The CMA Scotland element processes finally in the payroll run for the period in which you enter the Old Debt End Date, and is then automatically stopped.

Note: This method may also be used to alter the Daily Debt to some other nonzero rate if required. In this case the element will not be automatically stopped.

Conjoined Arrestments

CAO Scotland element entries cannot be automatically stopped. Three manual procedures are available for closing different combinations of conjoined arrestments.

To manually close a CAO Scotland element comprising a CMA portion only:
1. In the Element Entries window, select the CAO Scotland element, and follow the procedure for closing a CMA Scotland element entry, above.
2. Set your effective date to the last day of the payroll period for which you have entered the CMA Old Debt End Date.
3. In the Element Entries window, select the CAO Scotland element.
4. Choose Edit – Delete Record to delete the element entry. Choose the End Date option at the prompt.

To manually close a CAO Scotland element comprising an EAS portion only:
1. In the Element Entries window, select the CAO Scotland element, and follow the procedure for closing an EAS Scotland element entry, above, steps 1–5.
2. In the Employee Assignment Processes window, select the appropriate payroll process entry (i.e. the last for the element) and choose the Balances button to query the CAO Scotland Payments EAS_ASG_ITD balance dimension.

3. In the Adjust Balance window, adjust to 0 the CAO Scotland Payments_EAS_ASG_ITD balance dimension by applying an appropriate contra-entry; e.g. if the value of CAO Scotland Payments EAS_ASG_ITD is 123.59, apply a contra-entry of −123.59.

**To manually close a CAO Scotland element comprising an EAS and a CMA portion:**

1. Follow the closure procedure for a CMA-only CAO, above.

2. Follow the balance clearing procedure for an EAS-only CAO, above.
   
   If the CAO is to end on the last day of a pay period, it may be manually stopped without the need to make any date–effective changes, but you must still clear the CAO Scotland Payments EAS_ASG_ITD.

3. Reset to 0 the CAO Scotland Payments EAS_ASG_ITD balance dimension for the employee assignment once the entry has been stopped and the payroll run has taken place.
   
   If this is not done, any subsequent CAO Scotland element for the same employee that has an EAS portion will appear to have already partly or even fully paid the EAS portion.

**Note:** You may use the method described above to alter the CMA Daily Debt to some other value, or to adjust the EAS Initial Debt. If you alter the EAS Initial Debt, however, you must also enter old and new CMA Daily Debt values, even if the daily debt is not actually changing. Furthermore, if you are **reducing** the EAS Initial Debt, you must ensure that the CAO Scotland Payments_EAS_ASG_ITD balance dimension value is not larger than the new EAS initial debt. If it is, a balance adjustment will be required to set the ITD balance to the new EAS Initial Debt input value.
Viewing Court Order and Arrestment Run Results

After payroll processing is complete, you can view the results of court order and arrestment calculations in the Employee Assignment Processes window.

To view the results of court order and arrestment processing:

- In the Employee Assignment Processes window, select the process whose results you want to see, and choose the Run Results button to open the Run Results window.
The Payroll Run and Other Processes

This chapter explains how to carry out the following payroll tasks:

- selecting employee assignments for payroll runs
- starting payroll runs
- retrying, rolling back and reversing payroll runs
- starting QuickPay runs
- running other payroll processes
- viewing payroll and assignment process results
- submitting payroll reports
The Payroll Run

Although you can make individual payments through QuickPay, the payroll run is the regular way your enterprise processes employee pay. You can select from a range of employee assignments to process, as follows:

• a single payroll
• a set of employee assignments within a payroll

As well as selecting the range of assignments to process in this way, you can also restrict which elements are to be processed for each run.

Assignment Sets

Occasions when you need to use assignment sets for the payroll run include the following:

• You need to process the night shift earlier than the rest of the payroll as they must receive their pay advices the night before the rest.
• You need to process a correction run, as entries were not received in time for the normal run and the overtime must be paid this period.
• You want to process an additional run for a long service award which the enterprise is presenting as a cheque to each qualifying employee.

To fulfil these requirements you can select from a range of assignments as follows:

• include all assignments
• include or exclude individually identified assignments
• include or exclude certain groups of assignments, by using a formula

See Also

Creating an Assignment Set: page 18 – 15
Element and Distribution Sets

In the normal run you would want to include all elements, but for the long service award bonus in the above example you would want to include only the bonus element and the statutory elements. You first calculate gross pay for ascertaining the gross amount to transfer into the payroll account. Then you complete the gross to net calculation.

You can select element sets as follows:
- include all elements
- include or exclude individually identified elements
- include or exclude classifications of elements.

The statutory elements have all been defined by Oracle Payroll to be processed for every payroll run in which they have been included. The deductions are recalculated using the period totals, the amount already paid in previous runs is deducted, leaving the remainder as the deduction for the new payroll run.

See Also

Defining an Element or Distribution Set: page 19 – 6

Defining Exchange Rates

You define and update exchange rates in the Exchange Rates window.

You need to define the rates between different currencies for payroll runs in the following circumstances:
• When the input currency you define for the element in the Element window is different from your Business Group’s base currency.

• When the output currency you define for the element (possible for Information element types only) is different from your Business Group’s base currency.

• When you create any balance or process whose input value is in a different currency to its output value.

Whenever possible you should enter exchange rates that are current on the day of the payroll run, as rates can fluctuate on a daily basis.

To define exchange rates for different input or output currencies in payroll runs:

1. Change your effective date if you have to define the rate for a day different to your current date.

2. Query the name of the payroll for which you are defining exchange rates.

   The payroll’s processing period type displays in the next field.

3. Select the input and output currencies for which you want to define exchange rates.

4. Enter the exchange rate expressed as a decimal. This is always the value of the output currency divided by the input currency. For example, if the input value is 2.50 and the output value is 1.00, the rate is 0.4.

   Note: The entry block for exchange rates is multi-row. You can define as many exchange rates for each payroll as your balances and processes require.
Starting a Payroll Run

You start off payroll runs in the Submit Requests window.

**Prerequisites**

- If you need to define the rates between different currencies for the payroll run, define them in the Exchange Rates window.
- Define a consolidation set for the run.

**To run a payroll:**

1. In the Name field, select Payroll Run. Then enter the Parameters field to open the Parameters window.
2. In the Parameters window, select the payroll.
   
   The default consolidation set name for the payroll and current payroll period display.
3. Select a new consolidation set for the run if required.
   
   Use the consolidation set to control post–run processing of the results.
4. Select the payroll period for the run.
5. Select an element set and assignment set if required.
6. Choose the Submit button.

**See Also**

Payroll Message Report: page 17 – 6

Viewing Payroll Run Messages: page 17 – 58

Running Oracle Applications Reports and Programs, *Oracle Applications User’s Guide*
Payroll Message Report

This report lists messages produced during payroll runs. You can list the information either by payrolls or by payroll processes.

You run the report in the Submit Requests window.

▶ To run the Payroll Message Report:

1. In the Name field, select the report name. Then enter the Parameters field to open the Parameters window.
2. Select the name of the payroll for which you want to see messages. This is the only required field. If you leave the next three fields blank the system brings back all messages for all processes connected to this payroll in all periods.
3. Select a payroll period for which to view messages. This restricts payroll messages to the period you select.
4. Select a payroll process type. This restricts payroll messages to the payroll process type you select. All messages for all runs of this process during the period selected are returned.
5. Select a payroll process. This restricts payroll messages to one instance of the payroll process type selected. If you leave the Process Type field blank you can choose one instance of any payroll process for the period selected.
6. Select a message severity level for the messages in the report, or leave the field blank to see messages of all levels of severity.
7. Select assignment number or employee name as sort criteria for the report. The default is employee name.
8. Choose the Submit button.

Viewing Payroll Run Messages: page 17 – 58
Gross to Net Report

This report shows details of total earnings and deductions summarized for a specified payroll and payroll period. You may also limit the report's information by consolidation set.

The report shows three totals (Net Payment, Total Payment, Total Cost) derived from four balance totals:

- Gross pay
- Total deductions
- Total direct payments
- Total employer charges

These balance totals are broken down, first by element classification totals, then by element type totals within each classification.

You run the report in the Submit Requests window.

To run the Gross to Net Report:

1. In the Name field, select the report name. Then enter the Parameters field to open the Parameters window.
2. Select the payroll and payroll period for which you want to see the information.
3. If you want to restrict the information by consolidation set, select the name of the set.
4. Choose the Submit button.

Payments Summary Report

This report shows payments totalled by payment method type and organizational payment method for a specified payroll and payroll period. Account details for each organizational payment method are also listed.

You run the report in the Submit Requests window.

To run the Payments Summary Report:

1. In the Name field, select the report name. Then enter the Parameters field to open the Parameters window.
2. Select the payroll and payroll period for which you want to see the information.
3. If you want to restrict the information by consolidation set, select the name of the set.
4. Choose the Submit button.

Payroll Statutory Calendar Report

This report enables you to plan the payroll run submission timetable for multiple assignments, and to monitor payroll processing.

The report displays two kinds of payroll information, as follows:

- It shows the statutory week and month for each payroll run, and the time periods defined for all payrolls sequenced by their regular payment date.
- For completed payroll runs, it shows totals for the following:
  - numbers of live assignments
  - numbers of assignments completed in the run
  - numbers pre-paid
  - numbers paid within each payroll processing period

**Suggestion:** Run the report with the Assignments Unavailable for Processing report to identify any employees who have future assignment processes.

**To run the Payroll Statutory Calendar report:**

1. From the Submit Request window select the report name.
2. In the Parameters window, enter a range of dates. The report selects periods which have a Regular Payment Date within that range.
3. Choose the Submit button.

See Also

Planning Runs for Multiple Payroll Assignments: page 15 – 25
Multiple Assignments Report: page 15 – 26

Assignments Unavailable for Processing Report

This report lists the assignments that will not be processed by a payroll run on a specified date. It shows the reason for the exclusion which can be one of the following:
• A previous process for this employee is incomplete or in error.  
  – Action: complete or roll back the prior action.
• There is a future process for this employee.  
  – Action: roll back the future process.
• The assignment has a payroll status of ‘Do not process’.  
  – Action: change the employee status.

You run the report from the Submit Requests window.

► To run the Assignments Unavailable for Processing report:
  1. In the Name field, select the report name.
  2. In the Parameters field, select the payroll for the assignments.
  3. Select the effective date you want to check against. The default is  
     the regular payment date of the current period of the selected  
     payroll. For payroll run processes this date will be the effective  
     date of the runs for the period.
  4. Choose the Submit button.

See Also

Planning Runs for Multiple Assignments: page 15 – 25
Multiple Assignments Report: page 15 – 26
Correcting Run Results: Retries

Retrying Employee Assignments

You use retries for correcting mistakes shortly after a payroll run finishes. For example, you receive late entries of hours worked for some employees after a run starts, and you must enter these late details for some assignments.

Provided there has been no post–run processing for these assignments, you can mark them for retry, then run the Retry process. This process leaves the marked assignments in place but removes their run results.

After you have corrected the element entry information for the marked employees, you submit another payroll run for the process Retry Payroll Process. The new run processes only those employees marked for retry.

When you mark employee Assignments for retry, the run’s status is Incomplete. This protects you from forgetting to correct and rerun an assignment marked for retry.

Automatic Retries

Any assignments having a status of Error after a payroll run are automatically retried when you run the payroll again. Users do not have to mark these assignments for retry and cannot unmark them. The recommended procedure for dealing with retries, therefore, is as follows:

- Run the payroll and examine the results.
- Check any assignments with a status of Error and make the necessary changes to them so that they can process correctly.
- Check the other assignments. Mark for retry any that require changes and make the necessary changes.
- Run the payroll again. It will now process only the assignments having a status of Error after the first run, together with those you have manually marked for retry.

Retries and Post–run Processing

You cannot run the payroll retry process if you have already started off another post–run process, such as Pre–payments. In such a case, to start the payroll run retry process you must first mark the other process itself for retry. This deletes all element entries for the process and enables you to run the retry of the payroll.

The payroll run’s status remains at Incomplete as long as some employees remain marked for retry.
Retrying Runs

In another situation, you may realize after a run that results for a sizeable number of employees may be incorrect. This could happen, for example, when you neglected to modify a formula for an earnings or deduction before starting the run.

In this case you can make the necessary changes and retry the entire run. The new run ignores employees whose processing is unaffected by the corrections you have made. It reprocesses only those whose original results are incorrect in view of the corrections entered.

Marking and Retrying Payroll Runs and Other Processes

► To mark a small payroll process for retry:
- In the Payroll Processes window, select the process to retry and check the Retry box. This effectively marks every employee assignment included in the process for reprocessing when you retry it.

► To mark a large payroll process for retry:
1. In the Submit Requests window, select Mark Payroll Run for Retry in the Name field if you are retrying a payroll run. Otherwise select Mark Process for Retry. These processes have the same parameters, Payroll Process and Assignment Set.
2. Select the process you are marking for retry.
3. Leave the Assignment Set field blank.
4. Choose Submit.

► To mark an individual employee assignment for retry:
- In the Assignment Processes window, select the assignment to retry and check the Retry box. Then when you retry the process, only these assignments are reprocessed. This is a convenient approach when only a few assignments require reprocessing.

► To mark a group of employee assignments for retry:
1. Place the group of employee assignments in an assignment set.
2. In the Submit Requests window, select Mark Payroll Run for Retry in the Name field if you are retrying a payroll run. Otherwise
To retry a payroll run or other payroll process:

1. Mark the entire process, individual employee assignments, or a group (assignment set) of assignments for retry, using one of the procedures given above.

2. In the Submit Requests window, select Retry Payroll Run in the Name field to retry a run. Otherwise select Retry Payroll Process to retry another process.

   If the Parameters box does not automatically appear, click in the Parameters field.

3. In the Payroll Process field of the Parameters box, select the process to retry.

4. Choose Submit.

Correcting Run Results: Reversals

You can retry an employee or a run only when no post-run processing has occurred. You use reversals when you need to correct run results after post-run actions have already occurred.

In other words, reversals are useful when you need to correct run results some time after the run has occurred.
When you reverse a run, Oracle Payroll creates negative figures to cancel out all positive run results, and it creates positive figures to cancel out all negative run results. Both the original results and the reversal results remain on the database. This also includes information about payroll costs. Oracle Payroll automatically adjusts all necessary balances and preserves an audit trail.

You reverse pay runs in the Reverse Payroll Run window for the employee assignment.

**To reverse a payroll run or QuickPay for an assignment:**

1. Select the run you want to reverse.
   All the payroll runs for the assignment are displayed when you open the window.
2. Select the Reverse check box for the run you want to reverse.
   The consolidation set for the run automatically displays as the consolidation set for the reversal.
3. Select a different consolidation set if you want to process the reversal in a different set to the original run set.

**Restarting Earnings or Deductions after Reversals**

You may reverse a run for a past period during or after which stop dates exist for earnings or deductions. When this happens, Oracle Payroll issues a warning. This tells you to check whether you should restart any of the stopped earnings or deductions.

For example, the reversal may have cancelled out a deduction that was an employee’s final payment toward an outstanding loan. In this case, the warning alerts you to the need to restart the deduction.

**Reprocessing Nonrecurring and Additional Entries after Reversals**

Reversals of payroll runs with nonrecurring and additional element entries provide an exception to the ‘once only’ rule for processing nonrecurring elements.

Normally, nonrecurring element entries can be given only once to an employee. Additional entries for recurring elements can be given only once in each pay period.

The effect of this rule on payroll run reversals is that nonrecurring and additional entries do not get reprocessed in subsequent runs following a reversal. As a consequence, the results of subsequent runs will not be identical to the original run results.
To prevent this, Oracle Payroll allows nonrecurring and additional entries to be reactivated and reprocessed in subsequent runs following payroll run reversals. This makes it possible for the run results of subsequent runs to be identical to the original results.

⚠️ **Warning:** This exception to the normal rule has an important consequence for rolling back payroll run reversals. If you roll back a reversal historically, that is after a subsequent payroll run has taken place, nonrecurring and additional entries will be given twice. To prevent this happening, rollbacks of payroll run reversals are interlocked by future payroll runs. This means you can only roll back a reversal before any subsequent payroll run takes place.

---

**Removing Runs: Rollbacks**

Run rollbacks are useful when you have no need to keep any record that a run occurred. When you roll the run back, the process removes all the assignments and the run results. You cannot roll back payroll processing for individuals or payrolls for which post-run processing has occurred.

You can roll back a run for an employee when, for example, you should never have processed the employee in the run. A rollback completely removes an employee from a run, as if the processing had never occurred.

**Uses of Rollbacks**

Suppose that just after a payroll run, you receive notification that three employees have been transferred to a different payroll. This means you should not have processed them in the run just completed.

In this case you can roll back the processing for the three individuals. This action completely removes them from the run.

If the whole set of employees a run processes is the wrong set, you can roll back the entire run.

Rollbacks can also be useful if you want to do a run for testing purposes only, examine the results, and then remove all traces of it.

---

**Rolling Back Payroll Runs and Other Processes**

Use the Payroll Processes window to roll back a process for a few individuals. Roll back processes for many employees from the Submit
Requests window. To roll back a subset of employee assignments included in a process, place them in an assignment set.

► To roll back a process from the Payroll Processes window:
  - In this window, select the process record. Select Delete Record from the Edit menu.

► To roll back a process from the Submit Requests window:
  1. In the Name field, do one of the following:
     - Select Rollback to roll back all processes except a payroll run.
     - Select Rollback Run to roll back a payroll run.
  2. If the Parameters box does not appear, click in the Parameters field.
  3. Select the process to roll back. The list for Rollback displays processing dates with the corresponding process types, payrolls, and consolidation sets. The list for Rollback Run displays process run dates with the corresponding period dates and payrolls.
  4. To roll back processing for an assignment set, select the set name.
  5. Choose Submit.

Indirect Employee Assignment Process Rollback

Use the Assignment Processes window.

► To roll back an assignment process:
  - Select the record for the assignment process. Choose Delete Record from the Edit menu.
Retrying and Rolling Back Other Processes

Retries and rollbacks can apply to other processes besides the payroll run. Table 17 – 1 summarizes the rules applying to retries and rollbacks of these other processes.

<table>
<thead>
<tr>
<th>Process Type</th>
<th>PP Retry</th>
<th>PP Rollback</th>
<th>AP Retry</th>
<th>AP Rollback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payroll Run</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>QuickPay</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>QuickPay Pre–Payments</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Reversal</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Balance Adjustment</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Pre–Payments</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ext/Manual Payments</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>BACS</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Cheque Writer</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Cash</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Costing</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Transfer to GL</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

Table 17 – 1   Retries and Rollbacks of Other Processes

PP       Payroll Process
AP       Assignment Process
Post–Run Processes

The payroll run is the central payroll process.

When a payroll run has successfully completed, you run further processes to produce actual payments and generate costing information. These post–run processes include:

- Preparing the distribution of net pay in accordance with the employee’s personal payment methods, (the Pre-payments process)
- Printing and distributing pay advices
- Producing and transmitting BACS data
- Printing and signing cheques
- Ordering money from the bank and setting up pay packets
- Producing costing information
- Making payments to third parties
- Transferring payroll costs to the general ledger

See Also

End of Year Process: page 15 – 10
Start of Year Process: page 15 – 6

Consolidation Sets

Consolidation sets are the means by which you label payroll runs for further processing. This enables you to process the results from more than one payroll in a single action. You need only produce one BACS tape, one set of reports and one set of costing for the whole set.

Consolidation sets also facilitate the selective post–run processing of different payrolls. For example, after processing three payrolls in one consolidation set, you may want to select just one for immediate post–run processing. To do this, transfer the one you want to process to a new consolidation set.

You can follow this procedure when scheduling additional runs. These are the runs you make in addition to your regular payroll runs; for
example, to pay leavers. You can decide whether to consolidate an additional run with the regular run or switch it to a special set.

Consolidation sets are also used to label assignment sets when you use these for payroll processing. The same choices apply to assignment sets as to payrolls. You can accept the default consolidation set or select a new one when you set the run parameters in the Submit Requests window. You can also change the consolidation set after the run in the Update Payroll Run window.

Note: Because consolidation sets provide essential labelling for payroll runs, you must always select a consolidation set even to process one payroll or one assignment set.

Defining Consolidation Sets

You define consolidation sets in the Consolidation Sets window.

To define or delete a consolidation set:
- Enter the name of a new consolidation set or query an existing set.
  To delete a consolidation set, select the record and then choose Edit, Delete Record.
  You can only delete a consolidation set if it is not the default set for a payroll and if it is not associated with any payroll processes.

Changing Consolidation Sets

When a payroll run has processed, you may want to change its consolidation set if, for example, you want to carry out post-run processing for it separately from the other payrolls in the original set.
You may also want to retry a payroll while continuing with pre-payments for other payrolls whose status is Complete. This too would require a change of consolidation set for the first payroll.

You change consolidation sets for payrolls in the Update Payroll Run window.

**Note:** Changes you make in this window are for the selected payroll process only. Default consolidation set and pay advice information continue to apply to subsequent runs.

**To change the consolidation set for a payroll:**

1. Query the payroll whose consolidation set you want to change.

   Payroll run information for the payroll displays in reverse order from the last completed run. The Set region displays whether the run was for an element set and/or assignment set.

   **Note:** You can update consolidation set and pay advice information in this window regardless of the status displayed for the payroll run.

2. Enter a new consolidation set.

3. Update pay advice date and message information if required.

   The pay advice date and message fields are for information only.
Pre-Payments Process

Oracle Payroll allows you to define any number of payment methods, and you can distribute employee pay over more than one method using either a percentage or monetary split.

You can override the Pre-Payments process. You could do this, for example, if after running the normal payroll run and making payments via BACS, you then have to run supplementary payments for some employees and pay them by cheque. The Pre-Payments process, having distributed the regular payments over the payment methods entered, allocates the supplementary payments to the override method.

You run this process from the Submit Requests window.

To run the Pre-Payments process:

1. In the Name field, select Pre-Payments.
2. In the Parameters window, select the name of the payroll or consolidation set to run the process for. When you select a payroll, its default consolidation set displays.
3. Enter the start and end dates of the time span for the pre-payments processing to cover.
4. If required, enter an override payment method. The method you select overrides all other payment methods for this processing.

See Also

Defining Payment Methods for the Enterprise: page 5 – 3
Pay Advice Report

This report generates pay advices for all employees for a specified payroll and period. This is a sample report which you can customize. You run it after completing the Pre-payments process for a payroll.

Run the report from the Submit Requests window. To check printing alignment, run the Pay Advice Alignment report first.

To run the Pay Advice report:

1. In the Name field, select the report name. Then enter the Parameters field to open the Parameters window.
2. Select the payroll for which you want to generate pay advices.
3. Enter the period for which you want to generate pay advices and the date on which you want to generate them.
4. Do one of the following:
   - If you want to generate pay advices for all employee assignments, leave the Assignment Number field blank.
   - If you want to generate a single pay advice for an employee assignment, enter the employee assignment number.
5. Choose the Submit button.

Note: You can also view this report from the Assignment Process Results window, where you select an individual assignment and the process you want to view the report for.

See: Viewing Employee Pay Details: page 17 – 58

Printing Details

The Pay Advice process generates pay advice reports using Oracle Reports. To print the report, you define a SRW driver file for your particular printer and pay advice stationery.

You can find a sample SRW driver file, paygbsoe.prt, in the $PAY_TOP/srw directory. This file is designed for the sample pay advice stationery provided with Oracle Payroll. The driver file is designed for the DEC LN03 printer, and all other printers that understand the same control characters as the LN03.

For more details regarding customizing or registering your printer driver definitions and print options, please refer to the Oracle Applications System Administrator’s Guide.
Pay Advice Alignment Report

This is a printer alignment report for your sample pay advice.

You run the Pay Advice Alignment report from the Submit Requests window.

To run the Pay Advice Alignment report:
1. In the Name field, select the report name.
2. Choose the Submit button.
The Cheque Writer process determines the generation of cheques for a specified payroll and consolidation set over a specified time period.

The process enables you to generate contiguous serial numbers for cheque printing, and you can use this feature to account for cheque stationery used during the cheque printing process. If you do this, you also need to take into account the cheques you use to carry out the alignment of your printer.

A sample cheque report is supplied with the Cheque Writer process. You can customize this report, or add your own cheque style to meet your enterprise requirements.

You run this process from the Submit Requests window.

To run the Cheque Writer process:

1. In the Name field, select Cheque Writer.
2. In the Parameters window, select the name of the payroll or consolidation set to run the process for. When you select a payroll, its default consolidation set displays.
3. Enter the start and end dates for the process.
4. Enter your cheque payment method.
5. Enter the sort sequence for the cheques. This defaults to Organization, then to Person.
6. Enter your cheque style. If you enter Default, this selects the sample cheque report, PAYRPCHQ.
7. Enter the first cheque number of your cheque sequence in the Start Cheque field. If required, you can enter the last cheque number in the End Cheque Number field.
8. Choose the Submit button.

Adding Your Own Cheque Report

You can add your own cheque report to the Cheque Writer process by generating it and placing it in the $PAY_TOP/srw directory.

To select your report in the Cheque Writer Parameters window, you first need to add the cheque report details to the HR_LOOKUPS table. The sample report supplied has the following definition in this table:
Column Name | Value
---|---
APPLICATION_ID | 800
LOOKUP_TYPE | GB_CHEQUE_REPORT
LOOKUP_CODE | PAYRPCHQ
MEANING | Default
ENABLED_FLAG | Y

**Printing Details**

The sample cheque report, PAYRPCHQ, is generated using Oracle Reports. To print the report, define a SRW driver file for your particular printer and pay advice stationery.

For more details regarding customizing or registering your printer driver definitions and print options, please refer to the *Oracle Applications System Administrator’s Guide*.

**See Also**

*Defining Payment Methods for the Enterprise: page 5 – 3*
The Void Cheque Payments process voids cheques you have issued using Oracle Cheque Writer. You may want to do this if there is a printing error or if the cheques you print are afterwards lost. The process cancels the cheques issued, records that there was an issue, and enables you to give a reason for cancelling.

Void Cheque Payments is a payroll process and for every cheque that is voided Oracle Payroll creates a corresponding assignment process.

You run the Void Cheque Payments process from the Submit Requests window.

**To run the Void Cheque Payments process:**
1. In the Name field, select Void Payments.
2. In the Parameters window, select the payment run for Cheque Writer that you want to void.
3. Enter the date on which you want to void the cheque or cheques. The default is your system date.
4. Enter, optionally, a reason for voiding the cheque issue.
5. Enter start and end numbers of the cheque sequence you are voiding. For single cheques, enter the cheque number in both fields.

The Void Payments Report shows details of cancelled cheque payments.

You run this report in the Submit Requests window.

**To run the Void Payments report:**
1. In the Name field, select Void Payments Report
2. In the Parameters window, enter a start date and an end date for the report.
3. Select a payroll and/or consolidation set if you want to restrict your information by these parameters. If you leave these fields blank the report will return information on all payrolls for the period chosen.
4. Choose the Submit button.
BACS Process

BACS is the UK system for the direct deposit of employee pay. To make deposits through BACS, you must provide details of the source and destination banks, and of the amount to be transferred to each employee.

Oracle Payroll supports BACS magnetic tape submission in four formats:

- single file single day
- single file multi-day
- multi-file single day
- multi-file multi-day

**Single day formats:** These are for payments made on a single processing day.

**Multi-day formats:** These are for payments made on different processing days. Multi-day processing allows you to make payments to assignments on different days because of different dates of birth, for example.

**Single file formats:** These are for individual enterprises.

**Multi-file formats:** These are for payroll bureaus or enterprises that accept BACS files from other institutions as well as their own.

Setting Up BACS

The following step applies to all formats:

**To enter user number and bureau number:**

- In the Organizational Payment Method window, enter your BACS user number to make a single file submission. Enter your BACS user number and bureau number to make a multi-file submission.

  See: Defining Payment Methods for the Enterprise: page 5 – 3

The following steps apply to **multi-day** formats only:

**To link and enter the BACS Entry Date element:**

1. In the Element Link window, link the BACS Entry Date element to each payroll in the process.

2. In the Element Entries window for each assignment, enter the BACS Entry Date element. In the Entry Values window, enter the
first date on which payment is to be made for the assignment.
Payment will be made on the same day in subsequent pay periods.
If you leave the default date (which appears as 01–01–0001) the
default payment date for the payroll is given to the assignment.

3. Check that the BACS payment rule has been set for each payroll in
the process.

See: Defining a Payroll: page 5 – 5

Running the Process

You run the BACS process from the Submit Requests window.

To create a BACS file:

1. Select the BACS process.

2. In the Parameters window, select the payroll and consolidation set
for which you are creating BACS output.

   Consolidation set is mandatory. Leave the Payroll Name field blank
   if you want to output payments from all payrolls in the
   consolidation set.

3. Enter a start date to restrict the BACS payments to unpaid
   pre-payments from that date. If you do not enter a start date the
   process includes all unpaid pre-prepayment runs.

4. Enter the end date of the BACS process.

5. Select a payment method or leave blank for all.

6. In the Process Date field enter the processing date for the BACS file.
   This is the day before payment is made to the employee accounts
   and must be a banking day. If not a banking day, enter the date of
   the last banking day before payment day.

   Note: Although you should enter a date in this field for all formats,
   it is not a critical date for multi-day processing.

7. Select a sort sequence for the BACS listing. You can sort by one of
   the following:
   • assignment
   • employee name
   • the combination of employee name within bank sort code

8. Enter a submission number. This corresponds to the label you stick
   on the tape.
9. Enter the expiration date of the tape. This is the date after which the tape will not be processed.

10. In the Audit Sample Freq. field enter a number if you want to enable the BACS audit facility. After processing the tape, BACS prints a listing of every nth transaction, n being the number you enter, to a maximum sampling of 1 in 50.

11. In the Report Type field, select the file and day format you require for the process.

Creating a BACS Tape

You create BACS tapes in your operating system after first running the BACS process in Oracle Payroll.

The BACS process produces an output file conforming to the format specified in the BACS User Manual for 1/2 inch magnetic tapes. You can locate this file in the $APPLCSF/$APPLOUT directory. The file name is in the format p<request_id>.mf. The request id is the one allocated to you by Oracle Payroll for your BACS process. The file name could be, for example:

```
p02331.mf
```

▶ To create a BACS tape:

1. Load a half inch magnetic tape with write access.
2. Go to your Out directory.
3. Run the PYUMWT routine from the command line, specifying the BACS file name and the magnetic device name as parameters. For example:
   ```
   PYUMWT p02331 /dev/rmt8
   ``
   **Note:** Do not add the extension .mf to the file name in the command.
4. Unload the tape, write protect it, label it and send it to BACS.

Viewing the BACS File

A listing file is produced by the BACS process simultaneously with the magnetic tape file. The name of the listing file includes the extension a01, for example, p02331.a01. This is a text file that can be viewed or printed.

See Also

Defining Payment Methods for the Enterprise: page 5 – 3
Cash Process

Oracle Payroll enables you to choose Cash as a payment method and to record cash payments to employee assignments. Oracle Payroll automatically analyses cash payments into the largest denomination notes and coins as part of the Pre–Payments process.

You run the Cash process from the Submit Requests window.

To record cash payments to employee assignments:
1. In the Name field, select Cash.
2. In the Parameters window, select the name of the payroll or consolidation set to run the process for. When you select a payroll, its default consolidation set displays.
3. Enter a start date from which to restrict making cash payments. Leave this field blank to include all unpaid cash payments.
4. Enter the end date of the Cash process.
5. Select your cash payment method.
6. Choose the Submit button.

Assigning Monetary Units to a Currency

Monetary units are the denominations of a currency’s coins and paper money expressed as multiples or decimals of the standard currency unit. Oracle Payroll uses these monetary units for cash analysis rules if you make cash payments.
The monetary units for your own currency are already seeded. If you want to define monetary units for other currencies, enter their details in the Assign Monetary Units to a Currency window.

**To assign monetary units to a foreign currency:**

1. Select the name of the currency. Further details of the currency display.
2. Enter the name of each banknote denomination and coin that you want to include in your cash analysis rules.
3. Enter the value of the standard currency unit as 1, and enter the values of all other units as multiples or decimals of this figure.

**See Also**

Defining Payment Methods for the Enterprise: page 5 – 3
Costing Process

The Costing process generates journal entries for your ledgers and costing information relating to labor costs. You can enter start and end dates of the period over which you want to cost payroll runs in order to cost all your runs in one process. Alternatively, you may want to produce a costing run for each payroll run.

You run the Costing process from the Submit Requests window. You should run Costing before the Transfer to GL process.

► To run the Costing process:

1. In the Name field, select Costing.
2. In the Parameters window, select the name of the payroll or consolidation set to run the process for. When you select a payroll, its default consolidation set displays.
3. Enter the start and end dates of the time span for the Costing process to cover.
4. Choose the Submit button.

See Also

Costing in Oracle HRMS: page 6 – 2
Cost Breakdown Report

There are two versions of the Cost Breakdown report:

- The Cost Breakdown Report for Costing Run shows summarized costing totals for a specified costing process.
- The Cost Breakdown Report for Date Range shows summarized costing totals for a particular consolidation set or payroll over a specified interval.

Both versions show the distribution of payroll calculation results plus corresponding General Ledger and labor cost details.

You run both versions in the Submit Requests window.

To run the Report for a Costing Run:

1. In the Name field, select the report name. Then enter the Parameters field to open the Parameters window.
2. Enter the costing process for which you want to generate the report.
3. Choose the Submit button.

To run the Report for a Date Range:

1. In the Name field, select the report name. Then enter the Parameters field to open the Parameters window.
2. Enter the start and end dates for which you want to generate the report.
3. Select the name of either the payroll or the consolidation set for which you want to see information.
4. Choose the Submit button.

Transfer to GL Process

If your installation includes Oracle General ledger, you can run the transfer to GL process to transfer the results of the Costing process for a payroll to the Accounting flexfield of Oracle General Ledger.

You run the Transfer to GL process from the Submit Requests window.

Prerequisites

- Map segments of the Cost Allocation key flexfield to segments of the Accounting flexfield.
Run the Costing process.

See: Costing Process: page 17 – 31

To run the Transfer to GL process:

1. In the Name field, select Transfer to GL.
2. In the Parameters window, select the payroll or consolidation set for which you are running the process. When you select a payroll, its default consolidation set displays.
3. Enter the start and end dates of the period for which you want to transfer Costing process results.
4. Choose the Submit button.

See Also

Costing in Oracle HRMS: page 6 – 2
RetroPay Process

Overview

You run the RetroPay process when items affecting pay have to be altered retrospectively, leading to backpay adjustments. You may have to make such adjustments when, for example, pay awards are backdated, or when you receive late notification of changes to element entries that should have changed in the past. Such changes may affect groups of employees or individuals.

The RetroPay process reruns the payroll calculations for all the periods affected by the retroactive change. This payroll processing is held in memory only and the results are not saved to the database. Instead, the system calculates the difference between the original results and the results using the new information.

This recalculation feeds into a pay balance that you choose. If the changes affect multiple elements or rate values, you may want to recalculate Gross Pay YTD. Alternatively, you may want to recalculate the balance for a single element, for example, Regular Salary YTD. Another option is to define a new balance and to recalculate for a specific set of elements that feed that new balance.

The balance difference creates entry values for a RetroPay element that you define and link to the recalculated assignments. These assignments receive the benefit of the backpay adjustment through this element when it processes in the current pay period.

Note: The only permanent result of the process is to create entry values in the RetroPay elements. No changes are made to your audited payroll data, and the only difference that remains is between these processed run results and the backdated entry value adjustments for the assignments. This is reconciled when the payroll run processes the RetroPay elements.

Setting Up RetroPay

To set up the RetroPay process:

1. In the Assignment Set window, define the set of employee assignments for which you want to make the payments or reductions.
   See: Creating an Assignment Set: page 18 – 15

2. In the Element Entries window, make the necessary date effective updates to element entry values for each employee assignment in the set.
3. Make other changes if necessary to salary information or to other database values relevant to the backdated changes.

4. In the Element window, define the RetroPay elements you require to receive entries of the retroactive adjustments. Your definition must include the following:
   - an appropriate element classification such as Earnings or Voluntary Deduction (not Information)
   - the processing type Nonrecurring
   - the rule Multiple Entries Allowed
   - input values with these names:
     - Pay value
     - Start date
     - End date

See: Defining an Element (Payroll Users): page 12 – 22

5. In the Element Link window, link the element to each employee assignment in the set.

See: Defining Element Links: page 12 – 35

6. Create a RetroPay set.

Creating a RetroPay Set

To create a RetroPay set:

1. In the RetroPay Set window, enter a name and a description for the RetroPay set you are creating. Save this information before moving to the next block.
2. Select the balance in which the RetroPay process will create new values. For example, this could be Gross Pay to Date. You can select more than one balance.

**Note:** If you plan to run the process over several past payroll periods, check that you are not going to go through an end of year or similar period where balance totals are reset to zero. If necessary, adjust the balance dimension span to ITD.

3. Select the RetroPay element you have defined to receive the values of the updated balance.

4. Select an input value for the element. Normally this will be Pay Value.

**Running the RetroPay Process**

You run the process in the Submit Requests window.

**To run the RetroPay process:**

1. In the Name field, select RetroPay

2. In the Parameters window, select the assignment set and RetroPay set for which you are running the process. Enter the start date and end date for which you want the payroll processes to be recalculated. The default end date is the current date. The RetroPay element will be entered in the payroll period this date falls in.

3. Choose the Submit button.

Oracle Payroll now rolls back and reprocesses all the payrolls for the assignment set from the date you specified. The system compares the old balance values with the new ones and creates entry values for the RetroPay elements based on the difference.

These entries are processed for the assignments in the payroll run for your current period.
Advance Pay Process

The Advance Pay process enables you to pay employees in advance for holidays or other events. The process performs payroll runs for the periods to be advanced, using all date effective information in place, and stores the final net figure as the amount to be advanced.

An employee can receive advance pay up to two pay periods before the advance pay period. This is the period of the holiday or event for which the advance payment is being made. More accurately, it is the total number of payroll periods covering the event. Regular payroll processing continues for the employee during the advance pay period. The amount advanced is progressively recovered in each regular payroll run, and the following actions are also carried out as appropriate:

- If further payments become due to the employee during the advance pay period, these can be paid using the employee’s normal payment method. Alternatively, the net payment can be deferred and paid to the employee in the period following the advance pay period.

- If the employee’s entitlement during the advance pay period becomes less than the sum advanced, thereby creating an overpayment, the amount owing is recovered automatically in the pay period following the advance pay period.

You can make advance payments for any pay period types, but the most likely ones are weekly or biweekly. You set the maximum number of periods that can be advanced when you define the payroll.
Advance Pay Setup Information

Advance Pay Elements

The elements created by the system for Advance Pay are set out in Table 17 – 2.

<table>
<thead>
<tr>
<th>Name</th>
<th>Classification</th>
<th>Process in Run</th>
<th>Priority</th>
<th>Input Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advance Period</td>
<td>Information</td>
<td>No</td>
<td>8000</td>
<td>Start Date, End Date</td>
</tr>
<tr>
<td>Advance Cleanup</td>
<td>Direct Payment</td>
<td>Yes</td>
<td>9996</td>
<td>Amount Value</td>
</tr>
<tr>
<td>Advance Recovery</td>
<td>Direct Payment</td>
<td>Yes</td>
<td>9997</td>
<td>Deduction Value</td>
</tr>
<tr>
<td>Advance Payment</td>
<td>Direct Payment</td>
<td>Yes</td>
<td>9998</td>
<td>Pay Value</td>
</tr>
<tr>
<td>Advance Indicator</td>
<td>Information</td>
<td>Yes</td>
<td>9999</td>
<td>Advance Defer</td>
</tr>
<tr>
<td>Deferred Payments</td>
<td>Direct Payment</td>
<td>Yes</td>
<td>9999</td>
<td>Pay Value</td>
</tr>
</tbody>
</table>

Table 17 – 2 Advance Pay Elements

Notes on the Table

1. The termination rule for all Advance Pay elements is Last Standard Process.
2. You can query Advance Pay elements in the Element Entries window, but you cannot make entries for them.
3. It is possible to delete Advance Pay entries in the Element Entries window, but if you do this, a message displays stating that your action may invalidate Advance Pay processing for the assignment.
4. If an employee is paid an advance but leaves before the end of the advance pay period, you must delete some of the entries for the Advance Pay elements in order to terminate the employee. In this case you would have to check the outstanding balance and use your own pay element, if necessary, to make a recovery.
Creating Entries for Advance Pay Elements

Advance Pay creates two sets of element entries for both individual assignments and batch assignments, as follows:

- **Advance Period**: An entry for this element is placed in the pay period in which the advance is paid. The input values show the start and end dates of the advance pay period.

- **Advance Indicator**: Entries of this element are placed in each payroll period of the advance pay period. The input values Advance and Defer each hold Yes or No.

Set Up Examples

Table 17 – 3 shows examples of how the Advance Pay elements are placed in an arrears and non-arrears payroll when the employee is paid an advance for one period. In both examples, the payment date for the advance is 12–APR–1997.

<table>
<thead>
<tr>
<th>Pay Element Name</th>
<th>Non–Arrears Payroll</th>
<th>Arrears Payroll</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Advance Indicator</strong></td>
<td>The element is placed in the period 13–APR–1997 to 19–APR–1997, and will show a Yes flag against the Advance input value. The flag against the Defer input value will be either Yes or No depending on whether you choose to defer payments. The element will not appear in the period 20–APR–1997 to 26–APR–1997.</td>
<td>The element is placed in the period 13–APR–1997 to 19–APR–1997, and will show a No flag against the Advance input value. The flag against the Defer input value will be either Yes or No depending on whether you choose to defer payments. The element will also appear in the period 20–APR–1997 to 26–APR–1997, and will show a Yes flag against the Advance input value. The flag against the Defer input value will now show No.</td>
</tr>
</tbody>
</table>

Table 17 – 3  Advance Pay Elements in Arrears and Non–Arrears Payrolls

Arrears Payrolls

If you have a payroll where employee pay is based on entries for hours worked in the previous period, you may want to identify this as an arrears payroll.
For an arrears payroll the pay period (or periods) for which advances are calculated is offset by one period from the original dates entered.

**Example:** An employee is paid one pay period in advance for a week’s holiday. The advance is paid in Week 5, together with the hours the employee worked in Week 4. The holiday is during Week 6.

In this example, the advance will be calculated for Week 7 and paid in Week 5. Date effective entries will have to be made in Week 7 to make up for the fact that no hours worked will be due then. The hours the employee works in Week 5 can be paid as normal in Week 6 or deferred until Week 7.
Advance Pay Run Information

How the Process Works at Element Entry Level

The Advance Pay process runs for specific payrolls. It processes all assignments within the payroll with entries for the Advance Period element in the period specified.

The process performs payroll runs in memory. It stores the net figure for all periods having an entry for the Advance Indicator element with the Advance input value set to Yes.

Entries for the element Advance Recovery are placed in each period with an Advance Indicator element holding the Advance input value set to Yes. This value will be the net pay for the period originally calculated by the Advance Pay process.

The process creates an entry for the element Advance Payment in the period in which the Advance Period entry is found. The amount for the entry is the total net figure for all periods for which an advance is calculated.

An entry for the element Advance Cleanup is created in the period immediately following those in which recovery is due to be made.

The process uses all date effective information currently in place at the time it is run.

For non–arrears payrolls, the process calculates the current period as well as the advance periods. PAYE is calculated using the basis effective for each period. To ensure accurate results, you should run the process only when all data for the current period is in place.

For arrears payrolls, the process only performs runs in memory for periods containing an entry for the element Advance Indicator with the Advance input value set to Yes. The current period and offset period are not calculated. PAYE is always calculated on a non–cumulative basis. Entries must be in place before the process is run. For this reason, no timecard entries will be due in the periods for which the advance is calculated.

Using Create Batch Lines

The Create Batch Lines window enables you to create batch lines with the same details for all assignments identified by an assignment set. You can make use of this MIX feature when you generate payments that only occur during an Advance Pay period.

For example, you could create an assignment set in which one of the criteria is a check for the value Y in the database item
ADVANCE_INDICATOR_ADVANCE_ENTRY_VALUE. You would use this assignment set to define the parameters of Create Batch Lines.

If the criteria are met (indicating the employee to be currently in a period in which the recovery of an advance is due), any required pay element can then be paid. An element paying Holiday Pay is one example of how this might be used in situations where normal hours would not have been worked because the employee is on leave.
Prerequisites for Setting Up Advance Pay

The following prerequisites apply to setting up Advance Pay both for individual assignments and batch assignments.

- Make sure that your enterprise has procedures in place for making legal deductions from employees to recover advances of pay.
- Set the maximum number of pay periods for which employees can receive an Advance Pay payment. Do this by entering a number between 1 and 52 in the segment Maximum Holiday Period Advance in the Statutory Information flexfield on the Payroll window.
- Link the six Advance Pay elements to the appropriate payrolls.
- If you make a pay advance to an assignment on an arrears payroll, check the Arrears Payroll check box in the Payroll window. When prompted for Correction or Update on a previously defined payroll, choose Correction.

See Also

Defining a Payroll: page 5 – 5
Defining Element Links: page 12 – 35
Setting Up Advance Pay for Individual Assignments

You set up Advance Pay for individual assignments in the Advance Pay window.

**Note:** Check first that you have completed the prerequisite tasks.

**To set up advance pay for single assignments:**

1. Select the assignment to receive the payment and navigate to the Advance Pay window.
   
   The arrears check box appears checked if the assignment is linked to an arrears payroll.

2. In the From field, select the start date of the holiday or other event for which you are making the advance payment. Oracle Payroll replaces the date you enter by the first date of the pay period in which it falls.
   
   At the same time the Payment Date field displays the date for making the advance payment to the employee. This date defaults to the last day of the pay period immediately preceding the start of the advance pay period. You can manually alter this date to the last day of the preceding pay period if you require.

3. Do one of the following:
   
   - In the Periods field, enter the number of pay periods covering the advance pay period.
   
   - In the To field, select the end date of the advance. The system automatically replaces the date you enter by the last date of the pay period in which it falls.

4. Check the Defer check box if you want any net payment amounts to be deferred to the pay period following the recovery of the advance.
If you do not check Defer, such payments will be made in the pay period they are earned according to the normal payment method for the assignment.

5. Save the entries you have made.

The Advance region now displays the period for which the Advance Payment element is entered for the assignment. For arrears payrolls this is one period later than the event period. For other payrolls this period is the same as the event period.

After the Advance Pay Process Runs

The following additional information displays when the Advance Pay process successfully completes.

- The Processed check box appears checked.
- The amount of the advance is displayed. The amount outstanding remains at zero until the first payroll run of the advance pay period completes. This information is datetracked, and by moving down with your cursor you can see any future events. To see historical information you must change the effective date.
- If the Defer check box is checked, the Deferred Payments region shows the period for which payments to the assignment are deferred. This information is also datetracked and you can see current and future information as above.
Setting Up Advance Pay for Batch Assignments

You set up Advance Pay for batch assignments by the Advance Pay Batch Setup process. This creates MIX batches for the elements Advance Period and Advance Indicator. A separate batch is created for each element and pay period.

You run the process from the Submit Requests window.

**Note:** Check first that you have completed the prerequisite tasks.

**Further Prerequisites for Batch Setup**

- Check that the assignments for which you want to set up Advance Pay are in a suitable assignment set for this process.

  As both Payroll and Assignment Set are required parameters, the assignments for which you are running the process should, for convenience, be in the same assignment set and payroll. If you select a mixed assignment set, with assignments from different payrolls, Advance Pay Batch Setup will process only those assignments that are in the payroll selected for the process.

- To run the process for a whole payroll, create an assignment set which is equal to or larger than the payroll. ‘Larger than’ could mean equal to the organization, for example.
To set up advance pay for batch assignments:

1. In the Name field select Advance Pay Batch Setup. Then enter the parameters field to open the Parameters window.

2. Select the payroll for which you want to run the process, then the advance start period, then the advance end period. These are the first and last pay periods of the advance pay period.

   The advance end period list displays the maximum number of pay periods that can be advanced for the payroll you select.

3. Select Yes or No to flag whether you want to defer any net payments that accrue during the advance pay period.

4. Select the assignment set for which you want to run the process.

5. Select the payment date for the advance. This date defaults to the last day of the pay period immediately preceding the start of the advance pay period. You can move this date back by one pay period if required.

6. Select Yes for MIX transfer if you want the batches that the process creates to be transferred to the database automatically. Select No if you want to transfer the batches manually.

7. Enter a unique header name for your batch process. This name is used as a base header name for each MIX batch created. For each batch, the system appends an underscore and an incrementing number, for example, _1, _2.

   This is a mandatory field whether you select Yes or No in the MIX Transfer field.

8. Save your entries.

Transferring MIX Batches Manually

If you transfer MIX batches yourself (see Step 6 above), you can make edits to the element entries in the Batch Lines window. If you make an automatic transfer, you can view the entries but cannot change them.

To initiate MIX transfers manually:

- Initiate the transfer of the element entries to the Oracle HRMS Entries table in the Batch Header window.

See: Transferring a BEE Batch : page 12 – 56

Further MIX Processing

Once batches have been transferred, you can purge them from the system using the Batch Header window.
If you create and transfer incorrect batches, you can remove them using the MIX Rollback process. All the batches in the process must be rolled back. They can be identified by the base name.

See:

Purging a Batch from the MIX Tables: page 12 – 57
Rolling Back a MIX Process: page 12 – 57
Running Advance Pay

To run Advance Pay, you should first run the Advance Pay Listing report to ascertain whether any assignments have entries of the Advance Period element for the current pay period. If they do, you run the Advance Pay process to calculate values prior to the payroll run for that period.

Advance Pay Listing

This report gives information about the advance pay periods for employees due to receive advance pay. The report can be used to detect whether there are assignments with Advance Pay entries during a particular payroll period.

The report lists the following information:

- Name and assignment number of employees with an entry for the Advance Period element in the date range covered by the report
- For each assignment, the dates held on the Advance Period element entry
- Yes/No to show whether the Advance Pay process has already been run for the assignment
- Summary listing, by payroll, of the number of employees with entries, and the number that have been processed

You run this report in the Submit Requests window.

To run the Advance Pay Listing:

1. In the Name field select Advance Pay. Then enter the parameters field to open the Parameters window.
2. In the Summary Version field select No for the full version of the listing, or Yes for the summary version only.
3. Enter a date range for the period in which you want to see information.
4. You can restrict the information to a particular payroll by entering the payroll name. If you leave the Payroll field blank, the report shows information for the whole Business Group.
5. Choose the Submit button.

Running the Advance Pay Process

For each selected assignment, the Advance Pay process calculates the amount of the advance to be paid and creates a nonrecurring element
This entry is processed as a post-tax allowance by the standard payroll run in the payment period for the advance.

**Note:** The process does not generate entries where the amount calculated is zero or negative. Messages are generated for all assignments where this is the case. You can view these in the Payroll Message Report.

You run the process from the Submit Requests window.

**To run the Advance Pay process:**

1. In the Name field select Advance Pay. Then enter the parameters field to open the Parameters window.
2. Select the payroll for whose assignments you are running the process.
3. Enter the effective date of the process. This should be the date on which you intend to pay the advance.
4. Select an element set if you want to exclude items from the calculation. For example, you may want to exclude some pay elements, such as expenses, from the Advance Pay run.
5. Choose the Submit button.
Viewing Process Information

Most of the payroll processes in Oracle Payroll produce results that you can view.

Table 17–4 lists these processes and indicates whether each one is restricted or unrestricted. Restricted processes apply only to a particular, specified payroll. Unrestricted processes apply to more than one payroll. You can view both types of process in the Payroll Processes window, and you can mark them for retry or rollback.

<table>
<thead>
<tr>
<th>Process Name</th>
<th>Restricted or Unrestricted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balance Adjustment</td>
<td>Restricted</td>
</tr>
<tr>
<td>Cash</td>
<td>Unrestricted</td>
</tr>
<tr>
<td>Costing</td>
<td>Unrestricted</td>
</tr>
<tr>
<td>External/Manual Payments</td>
<td>Restricted</td>
</tr>
<tr>
<td>Magnetic Transfer</td>
<td>Unrestricted</td>
</tr>
<tr>
<td>Non–tracked Action</td>
<td>Unrestricted</td>
</tr>
<tr>
<td>Payroll Run</td>
<td>Restricted</td>
</tr>
<tr>
<td>Pre–payments</td>
<td>Restricted</td>
</tr>
<tr>
<td>QuickPay</td>
<td>Restricted</td>
</tr>
<tr>
<td>QuickPay Pre–payments</td>
<td>Restricted</td>
</tr>
<tr>
<td>RetroPay</td>
<td>Restricted</td>
</tr>
<tr>
<td>Reversal</td>
<td>Restricted</td>
</tr>
<tr>
<td>Transfer to General Ledger</td>
<td>Unrestricted</td>
</tr>
</tbody>
</table>

Table 17–4  Payroll Processes

Assignment Processes

Every payroll process consists of one or more assignment processes. An assignment process is of the same type as its parent payroll process, but relates to a single employee assignment only. The number of assignments processed within one payroll process may vary from several thousand for a payroll run to just one for a QuickPay run or balance adjustment.

You view assignment processes in the Employee Assignment Processes window.
Viewing Payroll Process Results

Use the Payroll Processes window to view, retry and roll back payroll processes.

To view, retry or roll back payroll processes:

1. Select the name and period dates of the payroll you want to view results for.
   If you leave the Period To field blank, the end date in the Period From field becomes the end date for the query. If you run the query directly without entering payroll or period details, the window displays all payroll process results for all payrolls in the Business Group.

2. Choose Find.
   The window displays details of all payroll processes for the payroll and period selected. See below for further display details.

3. To mark a payroll process for retrial, select the Retry check box for the record. You can then run the Retry process from the Submit Requests window.

4. To roll back a payroll process, select the record and choose the Delete Record icon. This deletes the process from the database and returns all values to their former state.

   Note: Use the Payroll Processes window to roll back small processes only. It is better to roll back large processes such as payroll runs from the Submit Requests window. This runs the
process under concurrent manager control, freeing you to carry out other tasks during processing and handling the process more quickly. You can also run processes for assignment sets in Submit Requests.

5. To see further information about the assignments making up the payroll process, select the record and choose from the buttons at the bottom of the window. Valid choices are enabled for the records you select.

- **Assignment Process:** Lists details of the assignment processes making up the payroll process.
- **Message:** Displays any system messages relating to the payroll process.
- **Process Information:** Summarizes processing status information for the assignment processes.
- **Concurrent Manager:** Enables you to query details of the run to view log file details.
- **Costing Breakdown:** Summarizes costing process information as follows:
  - costings that were correctly costed (Normal Number)
  - costings posted to the suspense account

**Note:** Costings can be posted to the suspense account if costing codes are wrong or, for example, values missing for distributed costing. Such costings still have a status of Complete. For costing processes to be given a status of Error there must be a serious breakdown at system or process level.

**Further Display Details**

Details displayed in the Payroll Processes window include the following:

- **Period:** The period the payroll process was for. This field remains blank if no payroll was selected in the previous zone and the process is unrestricted.
- **Name:** The payroll process name is a composite of its major identifying details. These vary with the payroll process type, as shown in Table 17 – 5
<table>
<thead>
<tr>
<th>Payroll Process</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run</td>
<td>Run Number, Employee Set, Element Set</td>
</tr>
<tr>
<td>Costing</td>
<td>Consolidation Set</td>
</tr>
<tr>
<td>Pre-payments</td>
<td>Consolidation Set</td>
</tr>
<tr>
<td>Magnetic Transfer</td>
<td>Consolidation Set</td>
</tr>
<tr>
<td>Transfer to General Ledger</td>
<td>Consolidation Set</td>
</tr>
<tr>
<td>Cash</td>
<td>Consolidation Set</td>
</tr>
<tr>
<td>QuickPay Pre-payments</td>
<td>Run Number, Employee Name</td>
</tr>
<tr>
<td>Purge</td>
<td>None</td>
</tr>
<tr>
<td>Non-Tracking Process</td>
<td>None</td>
</tr>
<tr>
<td>QuickPay</td>
<td>Run Number, Employee Name</td>
</tr>
<tr>
<td>External Manual Payment</td>
<td>Employee Name</td>
</tr>
<tr>
<td>Reversal</td>
<td>Employee Name</td>
</tr>
<tr>
<td>Balance Adjustment</td>
<td>Employee Name, Element Type</td>
</tr>
</tbody>
</table>

Table 17 – 5 Payroll Process Name Details

- **Payroll:** This remains blank if the payroll process is unrestricted.
- **Status:** There are four process status categories: Incomplete, Complete, Error, Processing.

A status displays for both restricted and unrestricted payroll processes. When you specify a particular payroll, only the assignment processes associated with that payroll affect the status displayed in this field, even for unrestricted payroll processes.

For example, Payroll A has fifteen completed Costing processes, while Payroll B has nineteen complete and one incomplete. In this example, Payroll A will display Complete and Payroll B Incomplete. If you do not select a payroll, the system returns both payrolls when you choose Find and the Status field also displays Incomplete.

**See Also**

Correcting Run Results: Retries: page 17 – 10
Removing Runs: Rollbacks: page 17 – 14
Viewing Assignment Process Results

You can view assignment process results either in the Employee Assignment Processes window or in the Assignment Processes window. You can mark for retry or roll back these processes from either window.

The difference between the windows is in what they select. The Employee Assignment Processes window displays assignment processes for a particular assignment, while the Assignment Processes window displays assignment processes for a particular payroll process.

Viewing Assignment Process Results for an Assignment

You view these results in the Employee Assignment Processes window.

To view assignment process results for an assignment:

1. Select the employee’s name or assignment number.
   The employee’s payroll displays automatically. If the employee has an assignment to more than one payroll, select the one you want.
2. Select the period dates of the payroll you want to view results for.
   If you leave the Period To field blank, the end date in the Period From field becomes the end date for the query.
3. Choose the Find button.
The window displays details of all the assignment processes for the employee assignment and period selected.

- **Number**: This is the assignment process ID.
- **Applied To**: For reversals, external/manual payments and pre-payments, this field displays the assignment process ID of the parent process.

### Viewing Assignment Process Results for a Payroll Process

You view these results in the Assignment Processes window.

**To view assignment process results for a payroll process:**

1. In the Payroll Process window select a payroll and a range of dates.
   - If you leave the Period To field blank, the end date in the Period From field becomes the end date for the query.
2. Choose the Find button.
   - The window displays details of all the payroll processes for the payroll and period selected.
3. Select a payroll process and choose the Assignment Process button.
   - All the assignment processes for the selected payroll process now display.

### Rolling Back or Retrying Assignment Processes

Use either the Employee Assignment Processes window or the Assignment Processes window to roll back assignment processes or mark them for retry.

**Prerequisite**

- If you retry an assignment process you must first include it in an assignment set.

See: Creating an Assignment Set: page 18 – 15

**To Retry an Assignment Process:**

1. Select the assignment process you want to retry and check the Retry box. This marks the process for retry.
2. Run the Retry process in the Submit Requests window.
   - In the Parameters field, select the assignment process you are retrying, and the assignment set to which it belongs.
To Roll Back an Assignment Process:

- Select the assignment process and choose Edit – Delete Record.
  This deletes the process from the database and returns all values to
  their former state.

See Removing Runs: Rollbacks: page 17 – 14

Viewing Further Information about Assignment Processes

You can view further information about assignment processes either in
the Employee Assignment Processes window or in the Assignment
Processes window.

- To see further information about an assignment process, select the
  process and choose from the buttons at the bottom of the window.
  Valid choices are enabled for each record you select.
  - **Message**: Displays any system messages relating to the
    assignment process.
  - **Run Results**: Displays run results for payroll runs and QuickPay
    runs.
  - **Balances**: Displays balance information for payroll runs and
    QuickPay runs.
  - **Payment Methods**: Displays payment method information for the
    Pre-payments process.
  - **Costing**: Displays details of the Costing process.
  - **Balance Adj**: Displays details of the Balance Adjustment process.
  - **Payment**: Displays payment details for the BACS, Cheque Writer
    or Cash process.
  - **SOE Report**: Displays tax and NI information for the
    Pre-payments process.

See Also

- Viewing NI Class 1A Contribution Run Results: page 15 – 52
- Viewing Court Order Run Results: page 16 – 19
Viewing Payroll Run Messages

You can view run messages for payroll processes in the Payroll Processes window, and messages for assignment processes in the Assignment Processes window.

To view messages for payroll and assignment processes:

1. In the Payroll Processes window, query the payroll and period for which you want to see process information.
2. Place your cursor on each record in turn.
   Where system messages exist, the status bar at the bottom of the window will inform you.
3. Choose the Message button to view the messages.
4. To see assignment process messages, select a payroll process and choose the Assignment Process button.
5. In the Assignment Processes window, place your cursor on each record in turn.
   If any assignment level messages occur, the status bar displays a message.
6. Choose the Message button to view the messages.

Payroll Message Report: page 17 – 6

Viewing Employee Pay Details

The Pay Advice Report window displays payment results for an employee assignment in standard pay advice form. The window also shows the employee’s address, current pre-payments details and a list of run messages, if any, from the payroll run.

If you access this window from the Assignment Process Results window you can select the particular process you want to view the report for. You can also select a payroll run without a pre-payments process.

See Also

Pay Advice Report: page 17 – 21
Viewing Employee Run Result History

In this window you can view, for a single employee, a history of run results by element.

To view a history of run results for an employee:

1. Select the name or the assignment number of the employee and the name of the element for which you want to see run results.
2. Select the range of payroll periods over which you want to see the information.
3. Choose Find.
   The window displays information on each completed run for the criteria you have selected.
   • Run – This is the run type (Payroll or QuickPay).
   • Number – This is the assignment action id corresponding to the run.
4. Select an entry and choose the Entry Values button if you want to view entry value details.

Element Result Listing: page 12 – 61
Reports on Payroll Processes

Oracle Payroll provides the following standard payroll reports. You run these reports from the Submit Requests window.

Assignments Unavailable for Processing: page 17 – 8
Cost Breakdown Report for Costing Run: page 17 – 32
Cost Breakdown Report for Date Range: page 17 – 32
Element Result Listing: page 12 – 61
Gross to Net Summary Report: page 17 – 7
Multiple Assignments Report: page 15 – 26
NI Car Detail Report: page 15 – 53
P45 Report: page 15 – 14
Pay Advice Report: page 17 – 21
Payroll Message Report: page 17 – 6
Payroll Statutory Calendar Report: page 17 – 8
Start of Year: Records Unprocessed Report: page 15 – 8
Tax Payments Listing: page 15 – 31
Void Payments Report: page 17 – 25

Report Sets

You can run all the processes and reports for a payroll one after the other in a required sequence by defining a report set for them. To do this ask your System Administrator to define the set and sequence in the Request Set window.

You run report sets from the Submit Requests window. First select Set in the Type field.

See Also

Predefined and User Defined Reports: page 18 – 5
Submitting a Request
(Oracle Applications User’s Guide)
Running QuickPay

QuickPay enables you to carry out payroll processing for individual employees. You can use QuickPay to pay employees who are leaving and who require payment by cash or cheque. If an employee asks you what his or her net pay will be this month, you can run QuickPay to find the answer, then roll it back to remove all results from the database.

You navigate to the QuickPay window from an employee assignment.

To define and execute a QuickPay run for an employee assignment:

1. Set your effective date to the date for which you want to make the QuickPay payment.

   The Payroll Period displays for the date selected, and the Date Paid and Date Earned for this period also display. Date Paid is the regular payment date which, under UK legislation, is the last day of each payroll period. You can update the Date Paid field, but only to another period’s regular payment date.

   Note: If you select an effective date for which there is no valid payroll period, all three fields remain blank. You cannot select an effective date earlier than the start date of the parent record – the employee assignment.

2. Select a consolidation set.

   The default is the consolidation set for the assignment’s payroll.

   Note: The Number field remains blank and the status field remains set to Unprocessed until the QuickPay run process is completed.
3. Enter a pay advice date and message if required. These fields are for information only.

4. Save your QuickPay definition.

   **Note:** All assignment processes for the assignment’s payroll must have a status of Complete for you to save the definition. If not, you see an assignment interlock failure message. Check the status of the assignment processes in the Assignment Processes window, and delete, roll back or rerun any non-Complete processes.

   If the QuickPay Run itself displays In Error or Marked for Retry, choose the Retry Run button to run the process again.

5. Choose the Element Selection button if you want to check or verify element entries for the QuickPay run. All the elements for the assignment which exist as of Date Earned are listed in the Element Selection window. Select or clear the Include in Run check box for elements you want to include or exclude from the run.

6. You can choose the Entry Values button to view entry values for each element.

   **Note:** You cannot create, update or delete entries or entry values in the Element Selection and Entry Values windows. You can only select or clear the Include check box for entries.

7. Choose the Start Run button to run the QuickPay process.

   You run QuickPay from the QuickPay window, not from the Submit Requests window. You can view the status of the run in the View Requests window. If necessary, you can then mark it for retry or roll it back either from the QuickPay window or the Payroll Processes window.

   When the run is processed, the Status and Number fields in the QuickPay Run block display values for the run as follows:

   - **Number:** Numbering is consecutive, starting from 1, for each QuickPay run in a payroll period. There is a separate series for each separate payroll. The numbering restarts from 1 for each successive period.
   
   - **Status:** Values displayed for processed QuickPay runs are Complete, In Error, Mark for Retry. You cannot enter or update values directly in this field. Choose the Retry Run button to rerun the QuickPay process for runs with the status In Error or Marked for Retry.

**Troubleshooting: Concurrent Manager**

Once you initiate the QuickPay process, the screen freezes, and you cannot delete or update the QuickPay definition until the process completes.
If there is a processing problem you will see one of two error messages informing you that:

- the process has not started, or
- the process has started but has not finished

These messages could be displayed either because the concurrent manager has not been started, or because there are other requests of a high priority. You may need to consult your system administrator to start your request or change its priority.

You may also need to consult your system administrator if you do not receive an error message but the request seems to be taking a long time to run.

For more information on concurrent manager issues for QuickPay, system administrators should consult the technical essay Payroll Action Parameters in the Oracle HRMS UK Implementation Guide.

See Also

Correcting Run Results: Retries: page 17 – 10
Correcting Run Results: Reversals: page 17 – 12

Running Post–Run Processes for QuickPay

Once the QuickPay run has a status of Complete, you have a choice of options for post–run processing. The first option is to include the QuickPay in the batch pre–payments processing for the assignment’s payroll. The second option is to start the pre–payments from the QuickPay window, if necessary overriding the default payment method.

You would choose the first option if, for example, you have a new employee who joins after the payroll run for the current period has taken place. Instead of rolling back the whole payroll and resubmitting it with the new employee added, you run QuickPay instead for the new employee, including him or her in the consolidation set for batch pre–payments.

You would choose the second option if, for example, an employee is leaving and is waiting to be paid by cash or cheque.

To run pre–payments and other processes from the QuickPay window:

1. Choose the Start Pre–payments button. If required, you can override the default payment method for the assignment. You have
a choice of Cash or Cheque for pre-payments run from the QuickPay window.

The status for the completed process displays in the Status field in the QuickPay Pre-payment block.

2. When a status of Complete displays, do one of the following:
   • Choose the External Payment button to make payment by cash or cheque from the External/Manual Payments window.
   • Leave the payment to be made by a batch cash or Cheque Writer process for the consolidation set.

Note: If you have already included the QuickPay run in the default consolidation set for the assignment payroll, it can take part in the batch pre-payment process for the payroll without further action on your part.

**Entering External/Manual Payment Details**

Use the External/Manual Payments window to record cash or cheque payments to employees from external sources or petty cash. The window enables you to record details of each payment.

You often make such payments following QuickPay runs, and you can navigate to the External/Manual Payments window either from the Assignment window or the QuickPay window.

► **To make a manual payment by cash or cheque to an employee:**

1. Run a query in the Payment Method field to see a list of any unpaid cash or cheque payments for the current assignment.
   
The window displays each pre-payments source type (either Pre-payments or QuickPay Pre-payments) and its effective date.
Note: If you enter the External/Manual Payments window from the QuickPay window you can query unpaid payment methods associated with the current QuickPay pre-payment only. The Effective Date and Type fields do not display as the source type is always QuickPay, and the date is the same as the date of the QuickPay run.

2. Select the Pay check box for the payment methods you are now going to pay manually. Enter the value of the payment and, if you are paying by cheque, the cheque number.

3. Save your entry.

See Also

Entering a New Assignment: page 11 – 8
This chapter introduces the inquiry and reporting tools you can use with Oracle HRMS. It summarizes the reports and inquiry windows that are supplied with Oracle Human Resources and Oracle Payroll. It also explains how you can create and run your own QuickPaint reports for fast online reporting on people and assignments.
Overview of Inquiry and Reporting Tools

Oracle HRMS provides a range of inquiry and reporting mechanisms to meet the needs of different users:

- inquiry windows (including folders)
- predefined reports that can be scheduled and grouped for periodic processing
- DateTrack History, to view the changes to datetracked information over time
- QuickPaint, to create your own online inquiries and reports about people and assignments

In addition, you can use Oracle Reports or other tools to write your own reports. You can register these with the system so that they can be run in the same way as the predefined reports.

You can extract mail merge information from the human resource database to send to your word processing system. For example, you might want to produce standard letters for applicants as part of your recruitment process.

It is also possible to download information from the human resource database to other tools for reporting or editing. For example, you can use Oracle Application Data Export (ADE) to download information to a spreadsheet.

See Also

Viewing DateTracked Information and History: page 1 – 15
Inquiry Windows and Folders

Oracle HRMS includes some inquiry windows to meet the most common online reporting requirements. In these windows, you typically enter selection criteria in the first block then choose the Find button to view a list of people, assignments, or other entities that match your criteria. Some of these windows use folders to display the information retrieved by your criteria.

Folders are online views that you can customize. By default, the folder block in an inquiry window displays all records matching your inquiry and all fields available within the folder. However, you can create your own folders to display a subset of these records and fields. You can also choose the field labels, their size and order, and the sort sequence of the retrieved records.

For example, in the Assignment Folder window, you could create a folder called Sales Employees by Grade. This folder has the query criteria Organization = ‘Sales’, and it is sorted by grade.

You can define public folders, which all users can view, as well as private folders for your own use.

<table>
<thead>
<tr>
<th>Inquiry Window</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignments Folder</td>
<td>Lists of assignments in a folder</td>
</tr>
<tr>
<td>Employee Assignment Processes (Oracle Payroll)</td>
<td>All the assignment processes for one employee assignment, which you can view, retry or roll back, with further information on run messages, run results, balances, payment details and costing</td>
</tr>
<tr>
<td>Payroll Processes (Oracle Payroll)</td>
<td>All the payroll processes for one payroll for a specified period, which you can view, retry or roll back, with further details on assignment processes, run messages and costing</td>
</tr>
<tr>
<td>People Folder</td>
<td>Lists of people in a folder</td>
</tr>
<tr>
<td>Salary Management Folder</td>
<td>List of assignments with their current approved salary and proposed new salary</td>
</tr>
<tr>
<td>Position Occupancy Folder</td>
<td>Lists of people who have held a selected position, or are applying for it, and the dates of their occupancy</td>
</tr>
<tr>
<td>List Assignments</td>
<td>Assignments that match the assignment components you specify for current applicants, employees, or both</td>
</tr>
<tr>
<td>List People by Assignment</td>
<td>People whose assignments match the assignment components you specify for current or former applicants, employees, or both</td>
</tr>
</tbody>
</table>

Table 18 – 1 Inquiry Windows in Oracle HRMS
<table>
<thead>
<tr>
<th>Inquiry Window</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Employees by Organization</td>
<td>All employees assigned to one organization and, optionally, to all organizations below it in a specified hierarchy</td>
</tr>
<tr>
<td>Assignment History</td>
<td>The dates of assignments and periods of service for an employee who has had more than one assignment. NOTE: use DateTrack History on the Assignment window to see historical changes to one assignment</td>
</tr>
<tr>
<td>List Employees by Position</td>
<td>All employees assigned to a specified position or organization and job</td>
</tr>
<tr>
<td>List Employees by Position Hierarchy</td>
<td>Current holders of positions at and below a specified position in a position hierarchy</td>
</tr>
<tr>
<td>View Employee Grade Comparatio</td>
<td>The amount employees receive for a specified element as a percentage of the mid–value of their grade rate range</td>
</tr>
<tr>
<td>List Employees by Absence Type</td>
<td>All absences of a particular absence type or category within, optionally, a specified time period</td>
</tr>
<tr>
<td>View Employee Absence History</td>
<td>Periods of absence for a specified employee</td>
</tr>
<tr>
<td>List People by Special Information</td>
<td>All people for whom you have entered details about a specified special information type</td>
</tr>
<tr>
<td>List Employees by Element</td>
<td>All employee assignments receiving a specified compensation element within a given time period</td>
</tr>
<tr>
<td>View Element Entry History for Employee</td>
<td>The history of entries of one or more elements for an employee assignment</td>
</tr>
<tr>
<td>List Position Budget Variance</td>
<td>Variances between the number of actual position holders and the values entered in a specified budget for positions below a chosen position in a hierarchy</td>
</tr>
<tr>
<td>List Budget Variance by Organization</td>
<td>Variances between the number of actual position holders and the values entered in a specified budget for all positions in organizations at and below a chosen organization in a hierarchy</td>
</tr>
<tr>
<td>View Vacancies</td>
<td>Vacancies matching assignment components and other criteria you select</td>
</tr>
</tbody>
</table>

Table 18 – 1 Inquiry Windows in Oracle HRMS
Predefined and User Defined Reports

There are a number of predefined reports that you can use immediately without any further set up (see Table 18 – 2). They have a predefined format but you can choose which records to view by entering a set of parameters when you submit the report.

These reports run in batch mode: you submit them for processing in the Submit Requests window and can view their progress using the View Requests window. The requests are handled by a concurrent manager so you can continue working online while your request is processed.

You can schedule the reports to run regularly and you can group them with other reports and processes to run as a set. You can also control access to the reports and control their printing. For example, the system administrator might want to ensure that users in one location always print their reports on a local printer.

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absences</td>
<td>Absence details for an employee or organization, for some or all absence types</td>
</tr>
<tr>
<td>Assignment Status</td>
<td>All employees, applicants, or both assigned to selected work structures</td>
</tr>
<tr>
<td>Assignments Unavailable for Processing (Oracle Payroll)</td>
<td>Assignments that will not be processed by particular payroll runs, and reasons for their exclusion</td>
</tr>
<tr>
<td>Costing Breakdown Report for Costing Run (Oracle Payroll)</td>
<td>Summarized totals of payroll calculations for a specified costing process</td>
</tr>
<tr>
<td>Costing Breakdown Report for Date Range (Oracle Payroll)</td>
<td>Summarized totals of payroll calculations for a consolidation set or payroll over a specified period</td>
</tr>
<tr>
<td>Current and Projected Progression Point Values</td>
<td>The expected results of running the Increment Progression Points process, that is, the projected point and value changes for a group of employees</td>
</tr>
<tr>
<td>Element Link Details</td>
<td>The eligibility criteria for an element or a group of elements</td>
</tr>
<tr>
<td>Element Result Listing (Oracle Payroll)</td>
<td>Run results processed for a particular element over a defined period, and run results for selected input values of each employee’s last assignment process</td>
</tr>
<tr>
<td>Employee Increment Results</td>
<td>The actual results of running the Increment Progression Points process, that is, progression point and value changes for a group of employees</td>
</tr>
</tbody>
</table>

Table 18 – 2 Standard Reports in Oracle HRMS
<table>
<thead>
<tr>
<th>Report Name</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Organization Movements</td>
<td>New hires, terminations, transfers in and transfer out of a selected organization, or organization hierarchy</td>
</tr>
<tr>
<td>Employee Payroll Movements</td>
<td>New hires, terminations, transfers in and transfer out of a selected payroll</td>
</tr>
<tr>
<td>Employee Summary</td>
<td>Addresses, contacts, period of service, assignments, special information, personal payment methods, and element entries for a selected employee</td>
</tr>
<tr>
<td>Full Applicant Details</td>
<td>Applications and applicant interviews for one applicant</td>
</tr>
<tr>
<td>Full Assignment Details</td>
<td>Assignment information including periods of service, payment methods, and element entries for one employee</td>
</tr>
<tr>
<td>Full Personal Details Report Set</td>
<td>Person details, applicant details, assignment details, and work details for one employee</td>
</tr>
<tr>
<td>Full Person Details</td>
<td>Addresses and information entered in the Person window, such as name, date of birth, nationality, and work telephone number for one employee</td>
</tr>
<tr>
<td>Full Work Details</td>
<td>Miscellaneous work information, including special information, absences, recruitment activities, and contacts for one employee</td>
</tr>
<tr>
<td>Gross to Net (Oracle Payroll)</td>
<td>Details of total earnings and deductions summarized for a specified payroll and payroll period</td>
</tr>
<tr>
<td>Job and Position Skills Matching</td>
<td>Lists of employees, applicants, or both that meet some or all skill requirements of a job or position</td>
</tr>
<tr>
<td>NI Car Detail (Oracle Payroll)</td>
<td>All the NI Y amounts due from employees on a given payroll who have a company car benefit</td>
</tr>
<tr>
<td>Organization Hierarchy</td>
<td>The organizations (and optionally their managers) below a selected organization in a particular hierarchy</td>
</tr>
<tr>
<td>P45 (Oracle Payroll)</td>
<td>P45 details for terminated employees, for issue to the tax office and the leaver; P45 details for current employees for issue to different tax offices</td>
</tr>
<tr>
<td>P45 Alignment (Oracle Payroll)</td>
<td>Draft printer alignment for your P45 reports</td>
</tr>
<tr>
<td>Pay Advice (Oracle Payroll)</td>
<td>Pay advice details in a customizable format, either for single assignments or for all assignments on a payroll, after Pre-payments is complete for the payroll</td>
</tr>
<tr>
<td>Pay Advice Alignment (Oracle Payroll)</td>
<td>Draft printer alignment for your sample pay advice</td>
</tr>
</tbody>
</table>

Table 18 – 2 Standard Reports in Oracle HRMS
<table>
<thead>
<tr>
<th>Report Name</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payments Summary (Oracle Payroll)</td>
<td>Payments totalled by payment method type and organizational payment method, with payment bank account details</td>
</tr>
<tr>
<td>Payroll Statutory Calendar (Oracle Payroll)</td>
<td>The sequence of regular payment dates for each payroll, and the numbers of assignments completed, pre-paid and paid within a run</td>
</tr>
<tr>
<td>Position Hierarchy</td>
<td>The positions (and optionally their holders) below a selected position in a particular hierarchy</td>
</tr>
<tr>
<td>Requisition Summary</td>
<td>Applicants and their interview schedules for a selection of vacancies</td>
</tr>
<tr>
<td>Salary Review</td>
<td>Current, past, and proposed salaries for a selected list of employees</td>
</tr>
<tr>
<td>Staffing Budget Details</td>
<td>Actual staffing level with budgeted levels over a specified period</td>
</tr>
<tr>
<td>Start of Year: Unmatched P9 Records (Oracle Payroll)</td>
<td>Valid records on the Inland Revenue P9 tape that do not fully match your database records after running the Start of Year process</td>
</tr>
<tr>
<td>Tax Payments Listing (Oracle Payroll)</td>
<td>Details of employees’ PAYE and National Insurance deductions</td>
</tr>
<tr>
<td>Terminations</td>
<td>The number of employees from selected organizations leaving your enterprise within a particular period, and the reasons for leaving</td>
</tr>
</tbody>
</table>

Table 18 – 2 Standard Reports in Oracle HRMS

You can create your own reports using Oracle Reports or SQL*Plus or another tool of your choice. You can register them with Application Object Library. This means you can run them from the standard Submit Requests window, and you can schedule them in report sets with other reports and processes.

See Also

Assignment Status Report: page 11 – 29
Employee Summary Report: page 11 – 30
Employee Movements Report: page 11 – 30
Terminations Report: page 11 – 16
Employee Increment Results Report: page 4 – 19
Current and Projected Progression Point Values Report: page 4 – 19
Organisation Hierarchy Report: page 2 – 29
Position Hierarchy Report: page 3 – 25
Salary Review Report: page 14 – 17
Reviewing Element Links: page 12 – 38
Submitting a Request
(Oracle Applications User’s Guide)

Oracle Application Object Library Reference Manual
QuickPaint

QuickPaint is a powerful and flexible tool to design reports about assignments in the format you require. You can include the following sorts of information in a QuickPaint report:

- Personal information
- Contact information
- Assignment information
- Application information
- Compensation and benefit information
- Descriptive Flexfield information

Once you have designed a QuickPaint report, you and other users can run the report online for any assignment or set of assignments. You can view the results online or print them.
Defining QuickPaint Reports

You can design QuickPaint reports in the Define QuickPaint Report window.

In the Report Definition area, you can enter free text to introduce the report and to label the information that the report extracts from the database. You can also select database items, which are tags representing the information to be extracted from the database. When you run the report, the database item names are replaced by the appropriate data for the assignment or set of assignments for which the report is run.

You must be careful how you position the database items so that QuickPaint interprets them correctly and formats the report in the layout you require.

To define a QuickPaint Report:

1. Enter a name, and optionally a description, of the report.
   The Protected field is display only; some reports provided by localization teams are protected against edits.

2. In the Report Definition area, enter free text exactly as you want it to appear on the report.
3. To select database items, choose the Show Items button and run a query to display a list of database items, then select and copy items to the Report Definition area.

Notice that the database item name must begin with an ampersand (&). Names without an ampersand are treated as free text.

4. Save the report definition.

Positioning Items

If you want to add free text immediately after a database item, you must separate it from the database item with at least one space. Otherwise QuickPaint reads the database item as free text.

Both free text and database items appear in the report results on the line on which you painted them in the Report Definition area. They also generally appear in the column in which you painted them. However, it might be that the data replacing a database item name is long enough to push later items on the same line to the right.

For example, if you paint database items and free text like this:

```
&ASG_JOB       in &ASG_ORG
```

the report results print like this:

```
Technician     in Biochemistry
Scientific Officer in Biochemistry
```

Notice that, in the second result, the free text ’in’ is pushed to the right and one space is entered before it.

If you know the number of the column in which you want text or a database item to appear, you can enter it like this:

```
&ASG_JOB       &32in &ASG_ORG
```

However, the text ’in’ will still be pushed to the right if the preceding database item (&ASG_JOB) extends beyond column 32. If you would prefer the preceding database item to be truncated, paint the line as follows:

```
&ASG_JOB       &&32in &ASG_ORG
```

The report results will look like this:

```
Technician     in Biochemistry
Scientific Off in Biochemistry
```
If you want one space between two database items or between a
database item and text, then paint them separated by a single space.
The single space is always preserved. For example, this definition:

```
&EMP_FIRST_NAME &EMP_LAST_NAME
```

gives the following report results:

Alice Hollister
Ray Garcia

### Adding Conditions or Calculations to QuickPaint Reports

When you save a report definition, QuickPaint generates a formula to
extract the information required by the report. You can view this
formula in the Formulas window. To query the formula, enter the
name of your QuickPaint report preceded by the prefix QP_.

Formulas generated from QuickPaint definitions do not contain
conditional logic or mathematical computations. If you need these
features, query the formula in the Formulas window and copy it. Edit
the copy to add the logic you require.

**Attention:** You should not edit the original QuickPaint
formula. Always edit a copy. Any edits of the original formula
are overwritten if you change the report definition in the
QuickPaint Report window.

### See Also

- Static Database Items: page B – 2
- Dynamic Database Items: page B – 19
- Using Oracle FastFormula to Define QuickPaint Reports: *(Oracle
  FastFormula User’s Guide)*
Running QuickPaint Reports

You run QuickPaint reports from the Run QuickPaint Report window. You can run a report for one assignment or for a group of assignments.

Prerequisites

- To run a QuickPaint report for a group of assignments, you must first define an assignment set.

To run a report for one assignment:

1. Select the type Assignment.
2. In the Assignment region, select the assignment for which you want to run the report.
3. In the Report field, select the report you want to run.
4. Choose the Run Report button.
   The message line tells you when the report is complete.
5. Choose the View Report button to see the report results.

When you run a QuickPaint report, the system runs the formula associated with the report. The first time you run a report, the
system may take several seconds to identify all of the related data and bring it back to the screen. All subsequent inquiries for other employees or applicants will run very quickly.

To run a report for an assignment set:

1. Select the type Assignment Set.
2. In the Assignment Set region, select the assignment set for which you want to run the report.
3. In the Report field, select the report you want to run.
4. Choose the Run Report button.
   The message line tells you when the report is complete.
5. Choose the View Report button to see the report results.

Customizing the Run QuickPaint Reports Window

Using the standard QuickPaint Report window, you can run the report for an assignment or an assignment set. The assignments can be held by current employees or applicants.

Your system administrator can create customized versions of this window to restrict the reports you can run and the people you can report on. A customized version might be subject to one or more of the following restrictions:

• report on one person type only (employees OR applicants)
• run one report only
• report on single assignments only, or report on assignment sets only

If the window is subject to the third type of restriction, it will look different to the standard version since it will contain either the assignment region or the assignment set region, but not both.

See Also

Restricting the Data Displayed in a Window: page 19 – 3
Creating an Assignment Set

There are two uses of assignment sets in Oracle HRMS:

- You can run a QuickPaint report for a set of assignments, rather than individual assignments.

- In Oracle Payroll, you can process subsets of the employees assigned to a payroll. Normally you initiate payroll runs and other post-run processes for one or more payrolls at a time. However, if you need to process smaller groups within a single payroll, you define an assignment set.

There are three ways to define the set:

- You can enter selection criteria, which the system generates into a formula. When you use the assignment set, Oracle FastFormula runs the formula to find the assignments that match the criteria. It checks all the assignments in the Business Group or, if you select a payroll when you define the set, all the assignments to that payroll. When you define the set you can also include or exclude individual assignments to modify the set created by the formula.

- You can select individually all the assignments you want to include in the set.

- You can start from a full set of all the employees in the Business Group or all the employees assigned to a selected payroll. Then you can exclude individual assignments from the set.

Use the Assignment Set window to define your set.

To define an assignment set using criteria for a formula:

1. Enter a unique name for the set.
2. Do one of the following:
   - If you are defining an assignment set for payroll processing, you must select a payroll. You cannot process an assignment set drawn from more than one payroll.
• If you are defining an assignment set for other purposes, selecting a payroll is optional. If you select a payroll, the formula generated from your selection criteria will select assignments from this payroll only. If you do not select a payroll, the formula will select assignments from the whole Business Group.

3. Save the new set and choose the Criteria button.

4. In the Assignment Criteria window, enter one criterion in each row, and join the criteria with AND or OR in the Condition field. Field details are as follows:

   **No.**: The sequence number of each condition in your rule. If you use sequence numbers that are multiples of 10, it will be easier to insert new conditions later.

   **Condition**: Leave the first row blank. Enter AND or OR for second and subsequent rows.

   **Database Item**: Select database items as variables for your definition. All database items are prefixed by an ampersand [&].

   **Operator**: Select operators to determine relationships between database items or values. The list of operators is shown in Table 18–4.

   **Value/Database Item**: Select database items for the second variable. Alternatively, you can enter a fixed value of the same type as the database item. Enter text values in single quotes.

   As an example, here is a definition for an assignment set of employees with salaries between 16,000 and 24,000:

<table>
<thead>
<tr>
<th>No.</th>
<th>Condition</th>
<th>Database Item</th>
<th>Operator</th>
<th>Value/Database Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td></td>
<td>&amp;SALARY_PAY_VALUE_ENTRY_VALUE</td>
<td>&gt;=</td>
<td>16000</td>
</tr>
<tr>
<td>20</td>
<td>AND</td>
<td>&amp;SALARY_PAY_VALUE_ENTRY_VALUE</td>
<td>&lt;=</td>
<td>24000</td>
</tr>
</tbody>
</table>

   **Table 18–3 Assignment Set Criteria**

5. Save your criteria and choose the Generate button to generate the formula.

   You can view and edit the formula in the Formula window. Its name is the same as the assignment set name. See: Using Oracle FastFormula to Define Assignment Sets: (Oracle FastFormula User’s Guide)

6. If you want to include or exclude individual assignments from the set defined by your criteria, choose the Amendment button. Select the assignments you want to include or exclude from the set.
Note: The list of assignments you see in this window is either all the assignments in the Business Group or, if you selected a payroll, all the assignments to that payroll. It does not show the assignments matching your criteria since these are identified dynamically each time the formula runs.

7. Save the set.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Symbols</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equals</td>
<td>=</td>
<td>The condition is true if both expressions have exactly the same value. For text, the case of the expression must be the same. So, for example, ‘Smith’ is not equal to ‘SMITH’.</td>
</tr>
<tr>
<td>Not Equal</td>
<td>!=</td>
<td>The condition is true if the result of the first expression does NOT have the same value as the result of the second expression.</td>
</tr>
<tr>
<td>Greater than</td>
<td>&gt;</td>
<td>The condition is true if the first expression is alphabetically after, or has a numerically greater value, or a later date than the second expression.</td>
</tr>
<tr>
<td>Less than</td>
<td>&lt;</td>
<td>The condition is true if the first expression is alphabetically before, or has a numerically smaller value, or an earlier date than the second expression.</td>
</tr>
<tr>
<td>Greater than or equal to</td>
<td>&gt;=</td>
<td>The condition is true if either the greater than OR the equal to operator returns a true result.</td>
</tr>
<tr>
<td>Less than or equal to</td>
<td>&lt;=</td>
<td>The condition is true if either the less than OR the equal to operator returns a true result.</td>
</tr>
</tbody>
</table>

Table 18 – 4 Values in Operator Field

To define a set by including or excluding assignments:

1. Enter a unique name for the set.
2. If you are defining a set for payroll processing, select a Payroll.
3. Save the new set.
4. Choose the Amendment button.
5. Do one of the following:
   - If you want to create a small set of assignments, select Include in the Inc/Exc field and select all the assignments for the set.
   - If you want to start from the full set of assignments for the payroll or Business Group, select Exclude in the Inc/Exc field and select assignments to remove from the set.
Attention: Do not create a mixture of Include and Exclude rows if you have not entered criteria and generated a formula.

6. Save your set.
Custom Reports

The Custom Reports function provides a generic reporting capability that makes use of a single report to print out a custom definition. This report is called PERGENRP.

The report is registered as a concurrent process and prints, in landscape format, the contents of the temporary table PER GENERIC OUTPUT REPORT.

This table contains the individual components of a custom report and is populated by the PL/SQL package PERGENRP.pkb, stored in $PER_TOP/admin/sql. This package is executed when you select the Generate Report button on the Custom Reports window.

To submit a Custom Report:

1. Navigate to the Custom Reports window.
2. Select the report by name.
3. Enter any parameters for this report.
4. Choose the Generate Report button

Attention: Parameter values are not validated until you choose the Generate Report button.

Creating New Report Formats

A special feature of Custom Reports is that you do not need to create multiple reports. You modify the generic package (PERGENRP.pkb) and report to provide additional formats and parameters.
Three sample report formats are provided, each with a different set of parameters:

- **PERCS001 – Custom Report 1**
  
  There is one parameter: Vacancy. The format in PERGENRP is *Full Name of Applicant* and *Gender*.

- **PERCS002 – Custom Report 2**
  Parameters are Vacancy and Gender. The format in PERGENRP is *Full Name of Applicant* in uppercase.

- **PERCS003 – Custom Report 3**
  Parameters are Vacancy, Gender and Marital Status. The format in PERGENRP is *Full Name of Applicant, Gender* and then *Full Name* in uppercase.

You can edit the generic package to change:

- Report Title Page
- Header
- Footer
- Body Text

After you have modified the package, you need to register a new custom report, with the parameter set for that report. This is a task for the System Administrator.

**To register a new Custom Report with parameters:**

1. Navigate to the Concurrent Programs window.
2. Enter the name of the Custom Report as the Program.
3. Enter a short name for the Custom Report.

**Attention:** You must start the short name with PERCS. This will limit the list of values available to users in the Custom Report window.
As part of your implementation plan, you identify who will use Oracle HRMS, what information they require, and how they will use it. You can group together users with similar requirements and give them the same view of the system. For each group, you can:

- set up menus using structures and names that make sense to the users
- link windows into flows that the users follow to complete a task
- restrict the data they can view and edit in certain windows, so they only see what they need to see

These customizations provide security for your data and an efficient interface designed for your users’ needs.

In addition to these customizations for groups of users, you can customize windows for all users by adding data fields to hold additional information required by your enterprise.
Adding New Fields to Windows

The predefined fields in Oracle HRMS windows are designed to meet your core information requirements. However, like all enterprises, you may have special requirements that are best met by fields that you design yourself. Oracle HRMS provides a flexible mechanism called descriptive flexfields to enable you to add fields to windows.

Figure 19 – 1 illustrates the distinctive appearance of descriptive flexfields. When users click in a flexfield that you have set up, a window opens, displaying up to 20 segments that you have defined.

Figure 19 – 1

Defining Segments

For each segment, you can define its prompt, the type of data it can contain, and the values a user can enter. You can provide a list or range of valid values. You also control the size and display characteristics of each segment and the order in which the segments appear.

You can define two types of descriptive flexfield segments:

- Global segments, which always appear in the flexfield window
- Context sensitive segments, which appear only when a defined context exists. You can prompt the user to provide the context, or you can provide the context automatically from a reference field in the same zone.

For example, a segment to hold details of an employee’s disability might display only when the Disabled field contains the value Yes.

Attention: Some descriptive flexfields appear in more than one window. For example, the Additional Evaluation Details flexfield appears in the Job Evaluation window and the Position Evaluation window.

Check all of the windows that use a descriptive flexfield before you define any of the segments. This is especially important if you intend to make the flexfield context sensitive to another field. You must ensure that the reference field is present in all of the windows that use the flexfield.

See Also

List of Descriptive Flexfields: page B – 6

Oracle Applications Flexfields Guide
Restricting the Data Displayed in a Window

Many of the standard Oracle HRMS forms are multipurpose. For example, in the Person form, you can enter or view details of employees, applicants, contacts, or other person types that you have defined. In the Element Entries form, you can make entries for all the elements you have defined.

You may prefer to have multiple versions of these forms, each version being used for just one purpose. This approach restricts the list of values on certain fields and therefore provides for faster data entry. It also allows you to limit access to certain types of information.

For example, you might create a customized version of the View Element Entry History for Employee form that does not display the earnings elements representing salary, bonus, and commission. Most users' menus would only give them access to this customized version of the form. For the small group of people authorized to view salary, bonus, and commission figures, your system administrator can define a menu function to allow access to the uncustomized form.

Table 19 – 1 lists the forms you can customize and the criteria you can use to restrict access to information.

<table>
<thead>
<tr>
<th>Form</th>
<th>Restrict By</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Balance (Oracle Payroll form)</td>
<td>Element Set</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Element Processing Type</td>
<td>Recurring, Nonrecurring</td>
</tr>
<tr>
<td>Assignment Folder</td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td>Define User Values</td>
<td>Table Name</td>
<td>User defined</td>
</tr>
<tr>
<td>Element Entries</td>
<td>Element Set</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Element Processing Type</td>
<td>Recurring, Nonrecurring</td>
</tr>
<tr>
<td></td>
<td>Entry Type</td>
<td>Override</td>
</tr>
<tr>
<td>Event Bookings</td>
<td>Employee or Applicant</td>
<td>Employee, Applicant</td>
</tr>
<tr>
<td>List Employees by Element</td>
<td>Element Set</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Element Processing Type</td>
<td>Recurring, Nonrecurring</td>
</tr>
</tbody>
</table>

Table 19 – 1 List of Customizable Forms
<table>
<thead>
<tr>
<th>Form</th>
<th>Restrict By</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>List People by Special Information</td>
<td>Employee or Applicant</td>
<td>Employee, Applicant</td>
</tr>
<tr>
<td></td>
<td>Special Information Type</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td>Organization</td>
<td>Organization Classification</td>
<td>List of Organization Classifications</td>
</tr>
<tr>
<td>Payroll and Assignment Processes</td>
<td>Action Type</td>
<td>List of Action Types (e.g. Run, Pre-payments, Reversal)</td>
</tr>
<tr>
<td>(Oracle Payroll form)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>People Folder</td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td>People (PERWSEPI), People and Assignment</td>
<td>Person Function</td>
<td>Enter Employee, Enter Applicant, Hire people already on system</td>
</tr>
<tr>
<td>(PERWSHRG)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td>Position Occupancy Folder</td>
<td>Employee or Applicant</td>
<td>Employee, Applicant</td>
</tr>
<tr>
<td>Run QuickPaint Report</td>
<td>QuickPaint Inquiry</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Assignments</td>
<td>Assignment Sets, Assignments</td>
</tr>
<tr>
<td>Special Information</td>
<td>Special Information Type</td>
<td>User defined</td>
</tr>
<tr>
<td>View Element Entry History for Employee</td>
<td>Element Set</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Element Processing Type</td>
<td>Recurring, Nonrecurring</td>
</tr>
</tbody>
</table>

Table 19 – 1 List of Customizable Forms
Types of Data Restrictions

You can restrict the information that appears in a customized form by the following sorts of criteria:

- element type (recurring or nonrecurring)
- element set (user defined)
- person function (enter employee, enter applicant, hire someone on system)
- person type (user defined)
- special information type (user defined)
- organization classification
- employee or applicant
- QuickPaint Report (user defined)

If you want to restrict the data by a user defined information type, you must create it first:

- To restrict by element set, create the set in the Element and Distribution Set window.
- To restrict by QuickPaint Report, create the report in the Define QuickPaint Report window.
  See: Defining QuickPaint Reports: page 18 – 10
- To restrict by Special Information Type, define your information type as an instance of the Personal Analysis key flexfield.
- To restrict by person types, define your user person types in the Person Types window.
  See: Defining Person Types: page 8 – 3
Defining an Element or Distribution Set

In the Element and Distribution Set window, you can select element classifications or individual elements to define a set. There are three types of set:

- **Customization set:** You can use a Customization set to restrict the elements that can be entered or viewed on a customized version of the Element Entries window.
- **Run set:** Oracle Payroll users can use a Run set to specify the elements to be processed in a payroll run.
- **Distribution set:** Oracle Payroll users can use a Distribution set to define the elements over which the costs of other elements are to be distributed.

**To define an element or distribution set:**

1. Enter a unique name for the set and select the Type: Distribution, Run, or Customization. Save your new set.
2. If you want to include all elements in a classification, choose the Classification Rules button.
   - In the Classification Rules window, select one or more classifications to include. Save the set and close this window.
   - The elements in the classifications you choose are now listed in the Elements region.
3. If you want to exclude individual elements, place your cursor in the element’s row and choose the Exclude Element button.
3. If you want to include particular elements from other classifications, choose the Include Element button.

   - In the Elements window, select the element you want to include and choose the OK button.

   **Note:** After you include a particular element, you cannot go to the Classification Rules window and include the classification to which this element belongs.

4. Save your set.

5. If you want to see a list of the individual elements you have included or excluded from the set, choose the Element Rules button. The Element Rules window is view-only.
Defining Customized Forms

You can define customized versions of certain forms in the Form Customization window.

See: Table 19–1 List of Customizable Forms: page 19–4

Note: If you want to restrict access to query–only for a form, you do not need to create a customized version. Instead you create a new form function, setting the QUERY_ONLY parameter to YES.

See: Setting Up Query–only Access to Forms: page 19–21

To define a customized version of a form:

1. Select the name of the standard form in the Form to be customized field. All GUI Smart Client form names are prefixed by F4.
2. Enter the name of your new version in the Name field. This name is used when defining menus but it is not seen by users.
3. Select Enabled if you want the restrictions to come into effect. If you do not select this option, the customized version of the form behaves the same way as the standard version.
4. Enter the titles to appear in the new version of the form:
   • In the Standard Title field, enter the window title to be seen by users who can use the form for data entry and editing.
• In the Query Title field, enter the window title to be seen by users who have view-only access to the form.

5. Save your new version.

6. In the Restrictions block, select the Type and Value of the restriction you want to define. The types and values available depend on the form you are customizing.

Adding the Customized Form to a Menu or Task Flow

If you want to add the customized form to a task flow, you must create a Task Flow Node for it.

If the customized form is called directly from the Navigator window, your System Administrator must define a menu function to call the form with the customization. The System Administrator can add this function to any menu.

Note: If you want to use a customized version of the People form, People Folder, or Assignment Folder to start a task flow, you should define a new customized task flow node and then define a menu function to call the task flow.

See Also

Calling Customized Forms and Task Flows from Menus: page 19 – 22
Linking Windows in Task Flows

To complete many tasks, users need to use more than one window. For example, to hire a new employee, users typically go from the Person window, to the Address window, to the Special Information window, to the Assignment window, and so on.

You can link these windows together in a task flow so that the user can choose a button to bring up each window in turn without returning to the menu. The first window in the task flow defines the context of the subsequent windows. For example, if the task flow begins with the People window, all subsequent information is entered for the person you enter or query in the People window.

You can include customized forms in task flows. For example, you might create a customized version of the People window that handles applicants only. Then you could use this customization in a recruitment task flow.

Oracle HRMS supplies a predefined task flow that includes all the windows that you can use in task flows. It is designed as a simple structure to use during implementation, not as a recommended structure for users.
Windows You Can Use in Task Flows

You can create your own task flows using the windows listed in Table 19 – 2, or customized versions of them. Some of these windows require the context of an assignment. This means that either the Assignment window or the Assignments Folder window or the Application window (for applicant assignments) must appear above them in the task flow.

All task flows must begin with one of the following forms:

- People and Assignment (PERWSHRG)
- People (PERWSEPI)
- People Folder (PERWSFPE)
- Assignments Folder (PERWSFAS)
- Job (PERWSDJT)
- Position (PERWSDPO)

**Attention:** Using the combined People and Assignment form (PERWSHRG), rather than the separate forms (PERWSEPI and PERWSEMA), the Assignment window opens more quickly from the People window. We therefore recommend that you use the combined form in any taskflow that requires both windows. The seeded taskflows use the combined form.

<table>
<thead>
<tr>
<th>Window</th>
<th>Context Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absence Detail</td>
<td>Person (employee)</td>
</tr>
<tr>
<td>Address</td>
<td>Person</td>
</tr>
<tr>
<td>Window</td>
<td>Context Required</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Adjust Balances (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Applicant Interview</td>
<td>Assignment (applicant)</td>
</tr>
<tr>
<td>Application</td>
<td>Person (applicant)</td>
</tr>
<tr>
<td>Assignment</td>
<td>Person (employee)</td>
</tr>
<tr>
<td>Assignment Budget Values</td>
<td>Assignment</td>
</tr>
<tr>
<td>Assignments Folder</td>
<td>None</td>
</tr>
<tr>
<td>Book Events</td>
<td>Person (employee or applicant)</td>
</tr>
<tr>
<td>Competence Profile</td>
<td>Person</td>
</tr>
<tr>
<td>Contact</td>
<td>Person</td>
</tr>
<tr>
<td>Costing</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Element Entries</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Employee Review</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>External/Manual Payments (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Grade Step Placement</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>P45 (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>People Folder</td>
<td>None</td>
</tr>
<tr>
<td>People</td>
<td>None</td>
</tr>
<tr>
<td>Personal Payment Method</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Phone Numbers</td>
<td>Person</td>
</tr>
<tr>
<td>Picture</td>
<td>Person</td>
</tr>
<tr>
<td>Position</td>
<td>None</td>
</tr>
<tr>
<td>Position Occupancy</td>
<td>Position</td>
</tr>
<tr>
<td>Qualifications</td>
<td>Person</td>
</tr>
<tr>
<td>QuickPay (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Reverse Payroll Run (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Salary Administration</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Salary History</td>
<td>Assignment (employee)</td>
</tr>
</tbody>
</table>

Table 19 – 2 Windows You Can Use in Task Flows
<table>
<thead>
<tr>
<th>Window</th>
<th>Context Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schools and Colleges (Establishment Attandances)</td>
<td>Person</td>
</tr>
<tr>
<td>Secondary Statuses</td>
<td>Assignment</td>
</tr>
<tr>
<td>SOE Report (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Special Information</td>
<td>Person</td>
</tr>
<tr>
<td>Statutory Details (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Terminate</td>
<td>Person (employee)</td>
</tr>
<tr>
<td>Terminate Applicant</td>
<td>Person (applicant)</td>
</tr>
<tr>
<td>View Element Entry History</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Work Choices (Job or Position)</td>
<td>Job or Position</td>
</tr>
<tr>
<td>Work Choices (Person)</td>
<td>Person</td>
</tr>
</tbody>
</table>

Table 19 – 2 Windows You Can Use in Task Flows
Defining Task Flow Nodes

Each form in a task flow is a node. There are predefined nodes for every form that you can include in a task flow. However, if you create a customization of one of these forms, you must create a node for the customization before you can include it in a task flow.

You create nodes in the Define Task Flow Nodes window.

To create a task flow node:

1. Enter a name for the node. You select this name when you create a task flow containing the node. It is not visible to users.

2. Select the form that you customized. Leave the Block field blank.

3. Select the customization that you created.

4. Save the new node.
Defining Task Flows

You define task flows in the Define Task Flow window. If there is a similar existing task flow, you can copy it to form the basis of your new flow.

Including the Assignment Window in Taskflows

Using the combined People and Assignment form (PERWSHRG), rather than the separate forms (PERWSEPI and PERWSEMA), means the Assignment window opens more quickly from the People window.

Attention: We therefore recommend that you use the combined form in any taskflow that requires both windows. The seeded taskflows use the combined form.

When users move down a task flow from the combined form, the Assignment window remains visible in the background. They can return to the Assignment window by closing their current window. Therefore you should not define a button to call the Assignment window.

However, if you are defining a task flow to the Assignment window from any window except the People window, you should use the Assignment form (PERWSEMA). In this case you may wish to add an Assignment button to any forms below the Assignment window in the taskflow. This allows users to return to the Assignment window without going back to the top window.

Prerequisites

- First create nodes for any form customizations you want to include in the task flow.
To define a task flow:

1. Enter a name for the task flow and save it.
2. In the Node block, select the name of the node that you want to be the first form in the task flow.
3. For this node, select the Top Node check box.
4. Create a new record in the Node block and select another node. You must create all the nodes for the task flow before you can begin entering the navigation paths between them.
5. In the Navigation Options region, for each node, select the other nodes to which you can navigate.
6. Enter a sequence number to determine the order in which the navigation options appear as buttons (from left to right) along the base of the window or as options in a navigation list.
7. Select the Button check box for the navigation options that should appear as buttons. There is a limit on the number of buttons that can appear on each form. This number varies from form to form. The other options are displayed in a navigation list when the user chooses a button labelled Others. Or, if there is only one other option, this form displays when the user chooses a button labelled Next.
8. There is a default label that appears on buttons or in the navigation list for every form. You can override this with your own label.
If the label in the Define Taskflow window appears blue, this is the default value. It is a dynamic default: if the seeded value changes (for example, as the result of an upgrade), the label will be updated automatically in all task flows where it has not been overridden.

If the label appears black, the default value has been overridden. To re-inherit the default label, clear the field.

9. To define an access key (or keyboard shortcut) for a navigation option, precede the appropriate letter in the label with an ampersand (&). For example, to use ALT+P (in the Microsoft Windows environment) as the access key for the Picture window, enter the label &Picture.

Note: Do not use the following letters since they are used on the Oracle Applications menu: A, E, F, G, H, Q, S, W.

There is no validation to prevent the same letter being used more than once for a group of buttons.

10. Save the task flow.

➤ To copy an existing task flow:
   1. Query the existing flow and choose the Copy To button.
   2. Enter the name of the new task flow and choose OK.
   3. Query your new task flow and edit it as required.

See Also

Calling Customized Forms and Task Flows from Menus: page 19 – 22
Setting Up Navigation Menus

Users access standard windows, customized windows, and the first window in a task flow through the menu structure displayed in the Navigator window. Each responsibility is associated with a single menu structure. Using Function Security System Administrators can further restrict access to individual menu options.

By defining menus with function security for groups of users, you can:

- limit the range of information users can access for the applicant and employee records available to them
- improve users’ efficiency in using the system by reducing menu choices
- restrict users to query-only access to some or all windows

Each responsibility you define must be linked to one root menu, which is the list of menu options displayed when the Navigator window first opens.
The Default Menu Structure

The AutoInstall program creates a default menu structure for your HRMS product. This menu structure lets you access all of the windows for your system. Normally, only a System Administrator has access to the full default menu structure.

Using function security you can use this default menu for any number of responsibilities and restrict access to the default menu options. You can also define any number of new functions and menus to restrict the access of other users. To view the hierarchy of menus you have defined, you can run the Menu Structures Report.

The supplied menus give you access to all of the available submenus. However, a number of seeded functions are not enabled on these menus. You need to add them for the responsibilities that should have access to these functions:

- **HR View Medical**
  This function causes the Medical Information alternative region to display in the People window.

- **HR View Background**
  This function causes the Background Information alternative region to display in the People window.

- **HR View Rehire**
  This function causes the Rehire Information alternative region to display in the People window.

- **Salary Administration: Approve**
  This function enables the user to approve salary proposals in the Salary Administration window and the Salary Management folder.

Suggestions for Structuring Menus

Menus can be structured in different ways:

- following a sequence of tasks, such as:
  1. Define a Requisition and Vacancy
  2. Define a Recruitment Activity
  3. Enter Applicant Information
- by type, such as inquiry windows, in which case the grouping is important but the sequence is not
When you define a new menu you should start by drawing it out on paper. This will help you to decide the best structure and the best prompts and descriptions. Work from the lowest level of sub-menu to the highest and define the root menu as the last step in the sequence.

You can define as many sub-menus as you require under each menu option. We recommend that you restrict the number of menu levels to three because a menu structure with more levels is cumbersome to use.

Opening Multiple Forms

In most Oracle Applications, you can open multiple forms from the Navigator window without closing the form you already have open.

Attention: You must disable this feature on a menu structure that accesses Oracle HRMS task flows. To prevent the confusion of working with multiple effective dates, you should also disable this feature if your menu structure accesses Oracle HRMS datetracked forms.

To disable the Multiple Open Form feature:

1. Add a Function type menu entry to the top-level menu referenced by your new responsibility.
2. Select the function whose User Function Name and Function Name are:
   - Disable Multiform, Multisession
   - FND_FNDSCSGN_DISABLE_MULTIFORM
3. Save your changes.

See Also

Default Navigation Menus for Payroll Responsibility: page A – 9

Menus
Oracle Applications System Administrator’s Guide

Menu Report
Oracle Applications System Administrator’s Guide
Setting Up Query–only Access to Forms

You can restrict access to query–only for all HR and Payroll forms on a menu by setting the user profile option HR:Query Only Mode to Yes. You can set this profile for individual responsibilities or users, or at the site or application level.

If you want to give query–only access to some forms and full access to other forms, set the HR:Query Only Mode profile to No and use the parameter QUERY_ONLY=YES at form function level to restrict access to individual forms.

**Note:** You can set the parameter QUERY_ONLY=YES for a form function that also launches a task flow. In this case, specify two parameters in the Form Function window:

QUERY_ONLY=YES
WORKFLOW_NAME="taskflow name"

The entire task flow will be query–only, not just the first form.

► **To restrict access to query–only mode for an individual form:**

1. In the Form Functions window, select the form and specify the parameter QUERY_ONLY=YES. If you want to specify other parameters for this form function, separate them with a space.

2. Enter a user function name to identify your new function, and save it.

3. In the Menus window, select your new function instead of the supplied form function.
For certain options you must define menu functions that include a parameter in the Parameters field of the Form Functions window, as follows:

- If the menu entry calls a customized form, use the following parameter:
  \[ \text{HR}_{-}\text{CUSTOMIZATION} = "customization\ name" \]

- If the menu entry calls the first form in a task flow, use the following parameter:
  \[ \text{WORKFLOW}\_\text{NAME} = "task\ flow\ name" \]

- If the menu entry calls a form in query–only mode, use the following parameter:
  \[ \text{QUERY}\_\text{ONLY}=\text{YES} \]

- If the menu entry calls the Define Rate form (PAYWSGEV), use the following parameter:
  \[ \text{FORM}\_\text{MODE} = "grade" \text{ (for the Grade Rate window)} \]
  \[ \text{FORM}\_\text{MODE} = "spine" \text{ (for the Scale Rate window)} \]

- If the menu entry calls the Payroll and Assignment Processes form (PAYWSACT – used in Oracle Payroll), use the following parameter:
  \[ \text{FORM}\_\text{MODE} = "assignment" \text{ (for the Assignment Processes window)} \]
  \[ \text{FORM}\_\text{MODE} = "payroll" \text{ (for the Payroll Processes window)} \]

If you need to specify more than one parameter for a form function, separate the parameters with a space.
QuickCodes and User Tables

QuickCodes provide lists of valid values on certain fields throughout the system. For many types of code you can add your own values and change the values that are predefined. You can also set up your own types of QuickCode.

You can set up user tables to provide matrixes of valid values that vary according to a factor such as age, or job, or number of years service. You can access these values from formulas, or your own forms or reports, using a supplied function.

This chapter explains how to set up QuickCode Types and how to add values to predefined QuickCodes. It lists the predefined QuickCodes to which you can add values. It also explains how to set up user tables and enter values for the rows and columns you define.
QuickCodes

Providing lists of valid values for certain items of information has two key advantages:

- It ensures that all users use the same terminology, which makes it easier to inquire and report on the information.
- It speeds up data entry because you can enter just enough to identify the value, and the system completes the entry.

In Oracle HRMS, a list of values is called a QuickCode Type. Each value comprises a code and a meaning. For example:

<table>
<thead>
<tr>
<th>QuickCode Type</th>
<th>Code</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>YES_NO</td>
<td>Y</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>No</td>
</tr>
</tbody>
</table>

The codes are used internally; users do not see them. There is a maximum of 250 QuickCodes for each QuickCode Type.

Predefined QuickCode Types

A number of QuickCode Types are included in Oracle HRMS. Some contain codes as startup data. You can never delete these codes, but you can change their meaning. For some QuickCode Types, you can also disable the codes that are supplied. Your ability to disable codes and add new codes is determined by the access level of the QuickCode Type:

- User: You can add codes and you can disable supplied codes.
- Extensible: You can add new codes, but you cannot disable supplied codes because the system uses them.
- System: You can neither add codes nor disable supplied codes. You can only change the meaning or description of supplied codes.

Table 20 – 1 lists the predefined QuickCode Types with an access level of User or Extensible.

You can also create your own QuickCode Types in the QuickCode Type window. These all have an access level of User.
Adding QuickCode Values

To add, disable, or change the meaning of a QuickCode, use the QuickCodes window.

To add QuickCodes:

1. Query the QuickCode Type to which you want add a value.
   You cannot add values if the Access Level is System.
2. Enter a code and meaning. Optionally, enter a start and end date.
   If you do not enter a start date, the new QuickCode is valid immediately. If you do not enter an end date, the new QuickCode is valid indefinitely.
Removing QuickCode Values

You cannot delete QuickCodes after saving them, but you can stop them appearing in lists of values.

► To remove a user defined QuickCode:

- In the QuickCodes window, do one of the following:
  - Disable the code by unchecking the Enabled check box if you want to prevent users selecting this value on any date.
  - Enter an end date if you want to prevent users selecting this value after a certain date.
  - Change the meaning and description to create a replacement QuickCode.

If you disable the QuickCode or set an end date, users cannot select this value when they create new records. However, they can continue to see the value when they query records that contain it.

If you add, disable, or change the meaning of a QuickCode, users must log out and log back in again for your changes to take effect.
Defining QuickCode Types

You can create your own QuickCode Types to provide lists of values, for example to validate element entries.

Define the new type in the QuickCode Types window, then query it in the QuickCodes window to define the values that appear in lists.

To define a new QuickCode Type:
1. Enter the name and meaning of your new type.
2. Save your work.
3. Optionally, choose the Usages button and select other Oracle Applications in which you want to use this new QuickCode Type.
## User and Extensible QuickCodes

<table>
<thead>
<tr>
<th>Field</th>
<th>QuickCodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category (absence)</td>
<td>ABSENCE_CATEGORY</td>
</tr>
<tr>
<td>Reason (for absence)</td>
<td>ABSENCE_REASON</td>
</tr>
<tr>
<td>Account Type (for bank details)</td>
<td>ACC_TYPE</td>
</tr>
<tr>
<td>Address Type</td>
<td>ADDRESS_TYPE</td>
</tr>
<tr>
<td>Reason (for application assignment status)</td>
<td>APL_ASSIGN_REASON</td>
</tr>
<tr>
<td>Type (event type for applicant)</td>
<td>APL_EVENT_TYPE</td>
</tr>
<tr>
<td>Type (interview type for applicant)</td>
<td>APL_INTERVIEW_TYPE</td>
</tr>
<tr>
<td>Reason (for secondary assignment status)</td>
<td>APL_SEC.Assign_REASON</td>
</tr>
<tr>
<td>Appraisal and Assessment Status (Appraisal and Assessment on the Web)</td>
<td>APPRAISAL_ASSESSMENT_STATUS</td>
</tr>
<tr>
<td>Appraisal and Assessment Type (Appraisal and Assessment on the Web)</td>
<td>APPRAISAL_TYPE</td>
</tr>
<tr>
<td>State (Australian addresses)</td>
<td>AU_STATE</td>
</tr>
<tr>
<td>Blood Type</td>
<td>BLOOD_TYPE</td>
</tr>
<tr>
<td>Measurement Type (for budget)</td>
<td>BUDGET_MEASUREMENT_TYPE</td>
</tr>
<tr>
<td>Cash Analysis (for a cash payment)</td>
<td>CASH_ANALYSIS</td>
</tr>
<tr>
<td>Census Metropolitan Area (Canada)</td>
<td>CA_CMA</td>
</tr>
<tr>
<td>Province (Canadian addresses)</td>
<td>CA_PROVINCE</td>
</tr>
<tr>
<td>Method</td>
<td>CERTIFICATION_METHOD</td>
</tr>
<tr>
<td>User friendly names for cheque–ordering SQL statement</td>
<td>CHEQUE_PROCEDURE</td>
</tr>
<tr>
<td>User friendly names for cheque–writing SRW2 reports.</td>
<td>CHEQUE_REPORT</td>
</tr>
<tr>
<td>Primary Evaluation Method</td>
<td>COMPETENCE_EVAL_TYPE</td>
</tr>
<tr>
<td>Competence Type</td>
<td>COMPETENCE_TYPE</td>
</tr>
<tr>
<td>Type (relationship of one person to another)</td>
<td>CONTACT</td>
</tr>
<tr>
<td>Type (of MIX batch control total)</td>
<td>CONTROL_TYPE</td>
</tr>
</tbody>
</table>

Table 20 – 1 User and Extensible QuickCodes
<table>
<thead>
<tr>
<th>Field</th>
<th>QuickCodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason (for element entry)</td>
<td>ELE_ENTRY_REASON</td>
</tr>
<tr>
<td>Reason (for employee assignment)</td>
<td>EMP.Assign_REASON</td>
</tr>
<tr>
<td>Employment Category</td>
<td>EMP_CAT</td>
</tr>
<tr>
<td>Reason (for secondary assignment status)</td>
<td>EMP_SEC.Assign_REASON</td>
</tr>
<tr>
<td>Ethnic Origin</td>
<td>ETH_TYPE</td>
</tr>
<tr>
<td>System (job or position evaluation system)</td>
<td>EVAL_SYSTEM</td>
</tr>
<tr>
<td>Measurement In (type for EVAL SYSTEM)</td>
<td>EVAL_SYSTEM_MEAS</td>
</tr>
<tr>
<td>Type (of formula)</td>
<td>FORMULA_TYPE</td>
</tr>
<tr>
<td>Authority (for PAYE details)</td>
<td>GB_AUTHORITY</td>
</tr>
<tr>
<td>Bank Name</td>
<td>GB_BANKS</td>
</tr>
<tr>
<td>Certificate (for element NI)</td>
<td>GB_CERTIFICATE</td>
</tr>
<tr>
<td>Cheque Style</td>
<td>GB_CHEQUE_REPORT</td>
</tr>
<tr>
<td>County (UK addresses)</td>
<td>GB_COUNTY</td>
</tr>
<tr>
<td>Pension</td>
<td>GB_PENSION</td>
</tr>
<tr>
<td>Sequence (for the BACS process)</td>
<td>GB_SORT_SEQUENCE</td>
</tr>
<tr>
<td>Reason (for leaving)</td>
<td>LEAV_REAS</td>
</tr>
<tr>
<td>Marital Status</td>
<td>MAR_STATUS</td>
</tr>
<tr>
<td>Nationality</td>
<td>NATIONALITY</td>
</tr>
<tr>
<td>Name (of organization classification)</td>
<td>ORG_CLASS</td>
</tr>
<tr>
<td>Organization Type</td>
<td>ORG_TYPE</td>
</tr>
<tr>
<td>Category</td>
<td>PER_CATEGORIES</td>
</tr>
<tr>
<td>FTE Capacity</td>
<td>PER_FTE_CAPACITY</td>
</tr>
<tr>
<td>Minimum Service</td>
<td>PER.LENGTHS_OF_SERVICE</td>
</tr>
</tbody>
</table>

*Table 20 – 1 User and Extensible QuickCodes*
<table>
<thead>
<tr>
<th>Field</th>
<th>QuickCodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relocation</td>
<td>PER_RELOCATION_PREFERENCES</td>
</tr>
<tr>
<td>Status</td>
<td>PER_SUBJECT_STATUSES</td>
</tr>
<tr>
<td>Subject</td>
<td>PER_SUBJECTS</td>
</tr>
<tr>
<td>Work Duration</td>
<td>PER_TIME_SCALES</td>
</tr>
<tr>
<td>Tuition Method</td>
<td>PER_TUITION_METHODS</td>
</tr>
<tr>
<td>Work Hours</td>
<td>PER_WORK_HOURS</td>
</tr>
<tr>
<td>Work Schedule</td>
<td>PER_WORK_SCHEDULE</td>
</tr>
<tr>
<td>Rating</td>
<td>PERFORMANCE_RATING</td>
</tr>
<tr>
<td>Type</td>
<td>PHONE_TYPE</td>
</tr>
<tr>
<td>Reason (for grade step placement)</td>
<td>PLACEMENT_REASON</td>
</tr>
<tr>
<td>Status (for salary proposal)</td>
<td>POSITION_STATUS</td>
</tr>
<tr>
<td>Source of Proficiency Rating</td>
<td>PROFICIENCY_SOURCE</td>
</tr>
<tr>
<td>Reason (for salary proposal)</td>
<td>PROPOSAL_REASON</td>
</tr>
<tr>
<td>Units (qualifying units for probation period)</td>
<td>QUALIFYING_UNITS</td>
</tr>
<tr>
<td>Prefix</td>
<td>TITLE</td>
</tr>
<tr>
<td>Status (of a vacancy)</td>
<td>VACANCY_STATUS</td>
</tr>
<tr>
<td>Availability Schedule</td>
<td>WORK_SCHEDULE</td>
</tr>
</tbody>
</table>

Table 20 – 1 User and Extensible QuickCodes
User–defined Tables

You may need to set up your own tables in your Oracle HRMS system, to hold data such as wage codes, shift differentials, or the amounts of certain deductions. You can set up all the tables you require using the Table Structure window. Using Oracle FastFormula, you can write simple formulas for validating entries made in table columns.

Notice that the Oracle HRMS user–defined tables are different from the database tables of the Oracle Relational Database Management System. When you set up a user table, you define the rows as well as the columns, like a matrix. For example, you could set up a table showing bonus amounts (the column) against years of service (the rows).

Your Oracle HRMS startup data includes some predefined user tables. These are maintained by your Oracle localization team.

Entering and Accessing Table Values

To enter values in tables, you use the Table Values window. Table entries and rows are both datetracked, so you can delete existing entries or rows, and add new ones, as of an effective date.

Oracle HRMS provides the GET_TABLE_VALUE function to access table values. You can yourself write formulas that include calls to this function, perhaps for QuickPaint inquiries. Also, it is easy for MIS personnel to write PL/SQL statements that call this function, to include in the code for a form or report process, for example.

See Also

Functions: (Oracle FastFormula User’s Guide)
Setting Up User Tables

You set up user tables in the Table Structure window.

**Prerequisites**

- Plan what your table rows and columns will contain, and whether you will use formulas to validate table column entries.
- If you plan to use formulas to validate entries into the table columns, write these formulas and enter them in your database.


To set up the structure of a table:

1. Set your effective date to the date from which you want the table’s row labels to take effect.
2. Enter the table name.
3. For the table’s match type, select Match or Range. Select Match if each row is for one item, such as one job or one code. Select Range if each row is for a range of numeric values, such as an age range or a pay range.
4. If the match type is Match, select Date, Number or Text as the Key Units of Measure, depending on whether entries in the rows are dates (DD–MON–YYYY), numbers, or alphanumeric text.
   - If the table’s match type is Range, the Key Units of Measure automatically becomes Number.
5. Enter the row label as the Row Title.
   - For example, if the table rows refer to rate codes, an appropriate row title would be Rate Code. If the rows refer to age ranges, you might use the title Age Range.
6. Save your work, and choose the Columns button to go to the Columns window.

To enter column labels:

1. Enter labels for the table columns in the Name field. To add a new column to a table that already exists, place the cursor on the name of the column after which you want to enter the new column name, and choose Insert Record from the Edit menu to obtain a clear field.

2. If you are using formula validation for a column’s entries, select the name of the validation formula for the column.

3. Save your work and close the window. In the Table Structure window, choose the Rows button to go to the Rows window.
To enter row labels:

1. If the match type of the table is Match, enter the label for each table row in the fields under the heading Exact. If the match type of the table is Range, enter numbers representing the lower and upper boundary of each row’s range.

2. In the Sequence fields, you can optionally enter a number for each row label to determine the order in which it appears on a list in the Table Values window. Logical sequencing of row labels helps users enter table values rapidly and accurately.

3. When you are finished, save your work and close the window. Your table is now set up and ready to receive entries into its columns.
Entering Table Values

If you have set up user-defined tables, you can enter and maintain values in the Table Values window.

**Note:** The system administrator can create customized versions of the Table Values window so that you use each version for one user table only.

**Prerequisite**

- Before you can enter values into a table’s columns, the table with its columns and rows must be completely set up.

To enter values into table columns:

1. Set your effective date to the date from which you want the entries to take effect.
2. Query the table name.
3. With the cursor in the Column Name field, use the up and down arrows to locate the name of the column in which you want to make entries.
4. In the Values region, select each row for which you want to make an entry. You select rows in the Exact field or the Lower Bound field, depending on the match type of the table.
5. For each row, make the appropriate entry in the Value field.
6. Save your work.
Oracle Payroll can be integrated with a number of Oracle and third party products. This chapter explains how to set up Oracle Payroll to integrate with the following products.

- Oracle Human Resources
- spreadsheets

It also explains how to attach text, images, OLE objects, and Web pages to individual records.
Using Oracle Human Resources with Oracle Payroll

Oracle Human Resources and Oracle Payroll are available for purchase together as the components of a closely integrated human resources management system. This system combines Oracle Human Resources and Oracle Payroll windows under a single menu structure, sharing windows and underlying tables wherever possible to eliminate redundant data entry, maintenance and storage.

For Oracle Human Resources or Oracle Payroll, you enter and maintain the same fundamental human resource information about your structure and operations, your employees and their assignments, and employee compensation and benefits. You then add the specialized information you need specifically for human resources or payroll management and administration.

Shared Information in Oracle HRMS

The common core of fundamental information used by both human resources and payroll managers and staff includes:

- **Your operational basics:**
  - payrolls with their calendars and pay periods
  - the currencies and methods of payment you use

- **Your organizational structure:**
  - internal organizations, such as companies, divisions, departments, work groups, or production team
  - external organizations of key importance to you, such as employment agencies, tax authorities, or union headquarters
  - organization location information, including addresses and telephone numbers
  - hierarchies showing the relationships between your organizations
  - any grade and grade scale structures you use

- **Your employees’ essential personal information,** such as:
  - name and address
  - marital status
  - birth date
  - nationality
- ethnic origin

- **Your employees’ current work statuses**, such as:
  - active assignment
  - on maternity leave
  - terminated

- **Your employees’ assignments to:**
  - internal organizations
  - grades, or grades and grade steps
  - groups having a compensation-related factor in common, such as membership in an insurance or pension plan or participation in an employee stock purchase plan
  - jobs, or jobs and positions
  - payrolls

- **Elements of your employees’ pay and benefits:**
  - earnings such as salary, wages, commissions, bonuses, allowances
  - employer charges such as employer contributions to legislatively-mandated or private insurance or pension plans
  - deductions such as contributions for union dues or employee stock purchase plans
  - nonpayment benefits such as vacation time or a company car

---

**Shared Windows in Oracle HRMS**

While many of the windows in your system relate exclusively to the human resources or payroll function, some include information relevant to both functions. These latter windows are *shared* windows.

Shared windows can include some information fields relevant to both human resources and payroll users, and other fields for information specific to either human resources or payroll users but not both.

**Using Shared Windows**

You can control the use of fields on shared windows by the value your system administrator gives to each user or responsibility for the HR:User Type profile option. The three valid values are:
• HR with Payroll User
• HR User
• Payroll User

Users with an *HR User* profile are restricted in their use of fields on certain windows. In particular:

• they do not see certain fields on the Element window, which are only required if you are processing elements

• they cannot assign employees to a payroll if both Oracle Payroll and Oracle Human Resources are installed

• they do not see the Statutory Information field in the Payroll window

• they cannot adjust element entry Pay Values
Using Oracle HRMS with Spreadsheets

Spreadsheets are commonly used in many enterprises to provide managers and other users with a powerful modelling and analysis tool. Often it is the ability to represent complex numeric data in a simple graphical format that makes them so popular.

You can use Oracle Application Data Export (ADE) to download information from the HRMS database to a spreadsheet for analysis and manipulation. For example, you can download data on current and proposed salaries for a group of employees. You can adjust the salary proposals in the spreadsheet, or enter new ones, and upload the revised data to the database. The ADE upload process reports any errors and ensures that only valid data is saved in the database.

To download information from a form to a spreadsheet using ADE, your system administrator needs to create a style in ADE. The style defines the form it is used for, the responsibilities that can use it, and the columns (or fields) to be downloaded. You determine which records are downloaded by running a query in the form before launching ADE.

A style for downloading salary proposals is predefined.

See Also

Using the Salary Management Folder: page 14 – 13

*Application Data Export User’s Guide* page

*Application Data Export Online Help*
Using Attachments

You can attach short comments, word processed documents, images, video, OLE objects, or Web pages to many records in Oracle HRMS. For example, you could attach a resume to an applicant record and a position description to a position record.

Each record can have one or more attachments, and you can copy attachments from one record to another. You can store the attachments in the database or in your file system.

You view or add new attachments by clicking the Attachments icon. By default, clicking the attachments icon displays a Comments window where you can enter text up to 2000 characters. This is the Comments facility available in earlier releases of Oracle HRMS. If you want to replace this facility with the ability to attach multiple items, ask your system administrator to set your user profile option HR:Use Standard Attachments to Yes.

The HRMS entities that support attachments are as follows:

- Absence
- Absence Type
- Address
- Application
- Assignment
- Balance (Oracle Payroll)
- Batch Header
- Booking
- Budgets
- Budget Version
- Calendar
- Career Path
- Consolidation Set (Oracle Payroll)
- Contact Relationship
- Customization
- Element
- Element Entry
- Element Link
- Element Set
- Event
- Grade
- Grade Rate
- Job
- Job Evaluation
- Job Requirement
- Letter Type
- Monetary Unit (Oracle Payroll)
- Organization
- Organization Payment Method
- Organization Hierarchy
- Pay Scale
- Payroll Process (Oracle Payroll)
- Period of Service
- Person
- Person Analysis/Special Information
- Personal Payment Method
- Position
- Position Hierarchy
- Recruitment Activity
- Requisition
- Salary Basis
- Salary Proposal
- Salary Proposal Component
- Secondary Assignment Status
- Special Information Type
- Status Processing Rules (Oracle Payroll)
- Vacancy
- Valid Grade

See Also

Working With Attachments
*Oracle Applications User's Guide*
Setting User Profile Options: page 22 – 4
The HRMS system administrator looks after the day to day administration of the system. This chapter summarises the tasks performed by the system administrator and explains how to:

- set user profiles to redefine aspects of your users’ work environment
- enable the currencies used in your Business Group
The Role of the System Administrator

The system administrator takes responsibility for the day to day administration of one or more Oracle Applications.

Many jobs are more efficiently performed by one designated person. For example, the system administrator defines printers, and balances the system’s processing workload between online data entry and background processing, such as report generation.

A database management system can be conceptually divided into two parts: user applications and their underlying data structures. This division lends itself to two job categories: database administrator (DBA), and system administrator.

- An Oracle Applications System Administrator administers the user interface or applications side of the database management system.
- An Oracle Database Administrator or DBA administers the data the various applications enter, update, delete, and use for company business.

Ideally the system administrator should be someone from within the user group who knows how the system has been defined and can act as the first level of support for the application users. The system administrator role is clearly defined with a specific set of practical tasks to be carried out.

The HRMS System Administrator

For Oracle HRMS these practical tasks normally include:

- customizing the application, including setting up Key and Descriptive Flexfields. See:
  User Definable Key Flexfields: page B – 2
  User Definable Descriptive Flexfields: page B – 5
- imposing limits on what users can access through menus, security profiles, and responsibilities
  See: Setting up Security in Oracle HRMS: page  23 – 10
- defining audit requirements
  See: Setting Up AuditTrail: page  24 – 2
- setting up user profiles
  See: Setting User Profile Options: page  22 – 4
• defining the formats for displaying currency amounts
  See: Enabling Currencies: page 22 – 7

• setting up and maintaining QuickCode types and values

• installing printers and managing concurrent processing
  See: Oracle Applications System Administrator’s Guide
Setting User Profile Options

A user profile is a set of changeable options that affect the way your application runs. The system administrator can set user profiles at different levels:

- **Site level**: These settings apply to all users at an installation site.
- **Application level**: These settings apply to all users of any responsibility associated with the application.
- **Responsibility level**: These settings apply to all users currently signed on under the responsibility.
- **User level**: These settings apply to an individual user, identified by their application username.

Values set at a higher level cascade as defaults to the lower levels. Values set at a lower level override any default from a higher level.

**Figure 22 – 1**
Levels for Setting User Profile Options

**Suggestion**: Set site–level options first to ensure that all options have a default. If a profile option does not have a default value, it might cause errors when you use windows, run reports, or run concurrent requests.

You use the System Profile Values window to set profile options at each level for your user community. If you change a user profile option value, your change takes effect as soon as your users log on again or change responsibilities.
Application users can use the Personal Profile Values window to set their own profile options at the user level. Not all profile options are visible to users, and some profile options, while visible, cannot be updated by end users. Any changes a user makes to his or her personal profile options take effect immediately.

List of User Profile Options

There are a number of User Profile Options that are of specific importance to HRMS system administrators. These are listed in Table 22–1 and Table 22–2. The only one of these options that a user can change is DateTrack:Reminder.

<table>
<thead>
<tr>
<th>HR Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR:Business Group</td>
<td>Business Group that is linked to the security profile for a responsibility. This option is used online to control access to records that are not related to organization, position, or payroll.</td>
</tr>
<tr>
<td></td>
<td>This option is seeded at Site level with the start-up Business Group. It is view only. Values are derived from the HR:Security Profile user profile option.</td>
</tr>
<tr>
<td>HR:Security Profile</td>
<td>Restricts access to the organizations, positions, and payrolls defined in the security profile. This option is seeded at Site level with the view–all security profile created for the Startup Business Group.</td>
</tr>
<tr>
<td>HR:User Type</td>
<td>Limits field access on windows shared between Oracle Human Resources and Oracle Payroll. If you do not use Oracle Payroll, it must be set to HR User for all responsibilities.</td>
</tr>
<tr>
<td></td>
<td>If you do use Oracle Payroll, you can give each Responsibility one of the following user types, depending on the work role of the holders of the responsibility: HR User, HR with Payroll User, Payroll User</td>
</tr>
<tr>
<td>HR:Query Only Mode</td>
<td>Restricts access to view–only for all HR and Payroll forms on a menu.</td>
</tr>
<tr>
<td>HR:Use Standard Attachments</td>
<td>Disables the facility to attach short text comments to records. Enables the attachment of multiple items of various types including OLE objects, Web pages, images, and word processed documents.</td>
</tr>
</tbody>
</table>

Table 22–1 HR User Profile Options
DateTrack Option | Purpose
---|---
**DateTrack:Date Security** | Controls the way users can change their effective date:  
*All* (users can change to any date),  
*Past* (users can change to dates in the past only),  
*Present* (users cannot change their effective date),  
*Future* (users can change to dates in the future only)

**DateTrack:Reminder** | Determines whether the Decision window appears when a datetracked window opens:  
*Always* (the window always appears),  
*Never* (the window never appears),  
*Not Today* (the window appears only if the effective date is not the system date)

Table 22 – 2 DateTrack User Profile Options

See Also

*Oracle Applications System Administrator’s Guide*
Enabling Currencies

Oracle HRMS allows you to use multiple currencies for entering information about employee compensation and benefits. You can also record your payment methods to employees in different currencies.

For example, if you have employees living and working temporarily in other countries, you might want to record specific earnings or deductions for these employees in local currencies. You might also want to pay these employees a fixed amount into a bank account in their home currency. The remainder you would pay in a local currency.

Your startup data includes the definitions of all world currencies. These definitions are shared by all Oracle Applications and are controlled by the system administrator responsibility. You enable those currencies you want to use in the Currencies window.

**Note:** You must enable at least one currency as the default currency for all information related to money in your system. This default is known as the *Base Currency* for your Business Group.

▶ **To enable a currency:**

- Query the currency you want to enable and check the Enabled check box. Save your choice to enable the currency.

You can never delete a currency, but you can disable it.

▶ **To disable a currency:**

- Uncheck Enabled, or enter an End Date for the currency.
Employees’ personal and pay–related information is highly sensitive. You must be able to reliably secure this information from unauthorized access by users of your Oracle Applications.

Oracle HRMS gives you a flexible approach to controlling access to records, windows, and functions. This means you can suit each employee’s level of access to his or her work responsibilities. You can partition data by organization, position, or payroll.

Management of security is normally part of the system administrator’s role. This chapter explains how to secure information in Oracle HRMS.
Security in Oracle HRMS

You can control users’ access to human resources information by record, window, and function.

You can restrict access to records of applicants and employees assigned to certain work structures. For example, you can give department managers access only to the records of the employees in their own department.

Further, within a given department, you can control access to records of employees at or above a certain level. For example, you can give a department’s administrator access to all department employee records except those of the manager and assistant manager. You do this by defining security profiles.

You can use the same security profiles to restrict the records accessed by a reporting user, who runs reports against the system but does not have online access through the Oracle HRMS forms.

You can also restrict access to certain information types. For example, you can create customized versions of some windows to restrict access to certain elements and person types.

Another important area of security is control over information change. For each group of employees sharing a responsibility, you can set up a menu controlling the windows to which they have access. If it is important to know who makes changes to information in certain windows, you can enable full data auditing for these windows.

You can specify which processes and reports a user can use by setting up security groups.

Access Control through User Responsibilities

You control access to Oracle HRMS through responsibilities that you create and assign to users of the system. Users can sign on to Oracle HRMS only through the responsibilities you give them. So their responsibilities control what they can see and do in the system.

A responsibility always includes a security profile and a menu structure. It may also include a security group. Optionally, you can restrict access to specific sub–menus or functions in your chosen menu.

- Security profiles determine the organizations, positions and payrolls whose applicant and employee records responsibility holders can access.
- Menu structures and functions control:
- the particular *windows* a responsibility holder can access
- whether he or she can perform *data entry, change or deletion* on these windows

You can produce customized versions of some Oracle HRMS windows. Each customized version allows access to a subset of certain types of information, such as person types, special information types, or elements. You define additional menu functions to call customized windows or task flows, and then you add these functions to a menu structure, which is linked to a responsibility.

- Security groups determine the group of *processes and reports* a responsibility holder can initiate. A security group is an optional component of a responsibility. If holders of a responsibility should not initiate any reports or processes, you do not include a security group in the responsibility.

For each responsibility, you must also define two user profile options:

- HR:Security Profile
- HR:User Type
Single and Multiple Responsibilities

You can develop as many different responsibilities as your enterprise requires. Typically, most employees need one responsibility only. However you can assign multiple responsibilities to users who need to:

- access applicant and employee records from two or more security profiles.
- use more than one menu structure to view or make changes to the records they can access.
- use more than one Oracle Application. For example, some people may use windows in both Oracle HRMS and Oracle General Ledger.
- access records for more than one Business Group. For example, an enterprise with international operations may have a US-based Business Group and a UK-based Business Group. A few of your employees might need access to both.

See Also

Setting User Profile Options: page 22 – 4

Security Profiles

The security profile attached to a responsibility determines which applicant and employee records are available to holders of that responsibility. You associate a security profile with work structures. The records of employees and applicants assigned to these work structures are then accessible to holders of the responsibility.

The work structures you can name in security profiles are:

- internal organizations and organization hierarchies. Organizations include structures like departments, sections, groups and teams. Each security profile allows access to one Business Group only.
- positions and position hierarchies. Positions are jobs performed within specified organizations, such as:
  - Clerk, Accounting Section (organization is Accounting Section and job is clerk)
  - Quality Control Technician (organization is Quality Control Group and job is technician)
- payrolls, such as Weekly Payroll, Monthly Payroll, or Sales Payroll.
Organizations and Organization Hierarchy

To set up a security profile that permits access to employee records of certain organizations only, you make use of organization hierarchies. You can build any number of additional hierarchies to meet your security requirements.

For example, suppose you build this Sales Organization hierarchy:

![Sales Organization Hierarchy Diagram]

You can create a security profile that permits access to employee records throughout the sales organization. This profile references the Sales Organization hierarchy. It names the Sales Department as the highest organization in the hierarchy through which profile holders have access to employee records.

Next, you want the directors of the two sales regions to have access to all employee records in their region only. You create Eastern and Western Sales Director security profiles. These profiles also reference the Sales hierarchy. But, they name the Eastern and Western Regions, respectively, as the top organizations for these profiles’ access to employee records.

When you name an organization as the top organization, you specify whether it is inclusive or not. You must include the top organization if...
you want holders of the profile to access records of people assigned to the top organization.

**Positions and Position Hierarchies**

After establishing limits on record access using organization hierarchies, you can further restrict access by means of position hierarchies.

Suppose, for example, within the Sales Department, you want to give the Sales Research Director access to her subordinates’ records only. You can start by building the following Sales Positions Hierarchy:

![Sales Positions Hierarchy Diagram](image)

Now you create the Sales Research Director security profile. This profile references the Sales Positions hierarchy and names the Sales Research Director as the top position for access to employee records.
Security Profile: SALES RESEARCH DIRECTOR
Organization Hierarchy: Sales Organization
Top Organization: Sales Department
Position Hierarchy: Sales Positions
Top Position: Sales Research Director
Include Top Position: Yes

When you give the Sales Research Director a responsibility including this security profile, she can access the records of her subordinates. But, she cannot access records of:

- the VP or Associate VP of Sales
- the Regional Sales Director
- the Regional Sales Director’s subordinates.

As with organization hierarchies, you can specify that profiles do not include access to the top position.

Payrolls

The third way to restrict access to employee records is by payroll. For example, you can give payroll staff who work on the Sales payroll access to records of employees on this payroll only.

Controlling security by payroll assignment limits the employee records users can see and update on employee-related windows, such as those for employee information, and element entry.

Of course, if an employee assignment does not include a payroll, payroll security cannot apply to this assignment. Payroll security never applies to applicant records since applicants are not assigned to payrolls.

The windows for compensation definition are unrelated to any particular employee records or payroll assignments. Therefore limiting access by payroll does not affect users’ access to these windows.

See Also

Database Access Without Online Access

You may need to set up access restrictions for employees who never use Oracle HRMS windows and do not change database information, but do access the database. These individuals are reporting users. A reporting user can use Oracle reporting tools to access database information for reports. A reporting user can report on, or query, the information in the HRMS database, but cannot insert, update, or delete that information.

You can make any of your security profiles available not only for regular Oracle HRMS users, but also for reporting users. The security profile restricts a reporting user’s access to employee records in exactly the same way as it limits regular users’ access.

Menu Structures

Each responsibility includes a security profile to restrict users’ access to employee records. It also includes a menu structure to restrict the windows users can access, and what they can do on these windows.

By using different menu structures and functions for groups of users, you can:

- limit the range of information users can access for the applicant and employee records available to them
- improve users’ efficiency in using the system by reducing menu choices

Menu functions can include:

- standard windows, displayed in edit or view-only mode
- customized windows, on which you have restricted the range of data that can be displayed
- the first window in task flows that link a number of windows that are used in sequence to complete a task

The AutoInstall program creates the default menu structure for your Oracle HRMS product. You can run a report to produce a listing of this structure.

The default menu structure lets you access all of the windows for your system. Normally, only a System Administrator has access to the full default menus. You can define any number of new functions and menus to restrict the access of other users.
See Also

Setting Up Navigation Menus: page 19 – 18

Security Groups

When you build a responsibility for employees who must initiate reports or processes, you can attach a security group to the responsibility. The security group lists a group of processes and reports its holders can run. Holders of responsibilities with no security groups cannot run any processes or reports.

The seeded groups US/UK HRMS Reports and Processes give access to all predefined reports and processes.
Setting Up Security in Oracle HRMS

Figure 23–4 depicts the relationship between the security items you define when you set up security for Oracle HRMS.

The key definition is the responsibility, which allows access to the records specified by the security profile, using the windows specified by the menu structure, and the reports and processes specified by the report security group.

At most, one responsibility can see all records for one Business Group. When you create a new Business Group, a view–all security profile is automatically created. It provides access to all employee records, and all applicant records in the Business Group. The system administrator creates a responsibility that includes this view–all security profile, then assigns this responsibility to the users who are setting up the system. They in turn can set up security profiles for other users.

Figure 23–4
Security Definitions
To set up a new responsibility for Oracle HRMS:

2. Set up any new functions or menus required for the responsibility.
   For menu functions calling customized forms or task flows, you must enter a parameter in the Parameter field of the Form Functions window.
   See: Setting Up Navigation Menus: page 19 – 18
3. Define the new responsibility.
4. Create usernames and passwords related to the new responsibility.
   A username can be related to more than one responsibility.
5. Set the HR User Profile Options for the new responsibility. The options you must set are:
   - HR:Security Profile
   - HR:User Type
   You can set other User Profile Options.
6. Run the HRMS security processes
   See: Running the HRMS Security Processes: page 23 – 15

Security for Reporting Users

Reporting users do not have online access to the database through Oracle HRMS forms. They use Oracle reporting tools to prepare reports on the information to which their security profiles grant access.

All secure users connect to the APPS ORACLE ID. This is created when the system is installed. However, for reporting users, you should create one or more new reporting user ORACLE IDs and associate each with a restricted security profile.

The first step in this procedure is the job of the ORACLE database administrator. The other steps are normally done by the system administrator.

To set up a new reporting user:

1. Create a new reporting user ORACLE ID.
2. Register the new ORACLE ID with Application Object Library.
3. Using a view–all responsibility, define a security profile in the Security Profile window for the new ORACLE ID.
4. Run the HRMS security processes
   See: Running the HRMS Security Processes: page 23 – 15
Defining Security Profiles

Using a view–all responsibility, you can define security profiles in the Security Profile window.

**Prerequisites**

- If you want to associate a reporting user with the new security profile, the ORACLE database administrator must create a new reporting user ORACLE ID. The system administrator must register the new ORACLE IDs with the Application Object Library.

**To define a security profile:**

1. Enter a name for the security profile and select a Business Group. This does not need to be the Business Group you are logged on to.

2. If you want reporting users to be able to use this security profile, select the Reporting User name for the ID set up by the database administrator.

3. Uncheck the View All Employees and View All Applicants check boxes if you want to restrict access to these person types by organizations, positions, or payrolls.

4. To restrict access by organization, uncheck the View All Organizations check box. Select an organization hierarchy, and a top organization. Check the Include Top Organization check box if you want to allow access to this organization.
5. To restrict access by position, uncheck the View All Positions check box. Select a position hierarchy, and a top position. Check the Include Top Position check box if you want to allow access to this position.

6. In the Payroll Security alternative region:
   • To give access to many payrolls, check the View All Payrolls check box, and uncheck the Include check box. Select the payrolls you want to exclude.
   • To give access to a small number of payrolls, uncheck the View All Payrolls check box, and check the Include check box. Select the payrolls to include.

7. Save your work.
Running the HRMS Security Processes

There are three HRMS security processes:

- Run the Grant Permissions To Roles process when you install Oracle HRMS, or when you upgrade the system.
- Run the Generate Secure User process when you create a new security profile that references a reporting user.
- Run the Security List Maintenance process every night.

You run these processes using a system administrator responsibility from the Submit Requests window.

Grant Permissions To Roles Process (ROLEGEN)

All reporting users in Oracle HRMS share access to a set of synonyms for tables. The synonyms are created by the Autoinstall process. You must run the Grant Permissions To Roles process to create the public grants to make those synonyms usable.

Run this process when you install Oracle HRMS, or when you upgrade the system. You must run this process before you run the Generate Secure User Process for the first time.

The process grants SELECT permissions to the role "hr_reporting_user". Permissions are not granted on the secured tables, but only on the secure views of those tables. All permissions previously granted to the role are revoked.

Generate Secure User Process (SECGEN)

This process grants permissions to new reporting users. It grants the "hr_reporting_user" role to the REPORTING_ORACLE_USERNAME specified in the security profile.

Run this process when you have created a new security profile that references a reporting user. In the Submit Requests window, select the name of the new security profile. This is the only parameter to the process.

Security List Maintenance Process (LISTGEN)

This process maintains the lists of organizations, positions, payrolls, employees and applicants that security profile holders can access. You should schedule it to run every night to take account of changes made during the day. If a disruption, such as a power cut, occurs while the
process is running, you can manually restart it from the Submit Requests window.

There is one required parameter for this process: Effective Date, which should normally be set to SYSDATE. You can also enter a security profile name to generate list entries for that security profile only.

**Attention:** LISTGEN should normally run when there are no users logged on to Oracle HRMS. Users attached while LISTGEN is running may experience unexpected results; for example, additional employees may become visible or previously visible employees may disappear from view.
AuditTrail provides a flexible approach to tracking the changes to your data. You can choose which data to audit and how long to keep the audit data. You can use the supplied audit report or design your own.

This chapter explains how to set up AuditTrail and how to report on audit data.
AuditTrail

AuditTrail lets you keep a history of changes to your important data: what changed, who changed it, and when. With AuditTrail, you can easily determine how any data row or element obtained its current value. You can track information on most types of fields, including character, number and date fields.

You enable auditing for audit groups. These are groups of tables and columns you want to audit, where you do not necessarily need to include all the columns in a given table. You typically group together those tables that belong to the same business process, such as employee compensation tables.

During implementation you need to decide:

• which tables and columns you want to audit
• how you plan to report on the audit data
• how long you want to keep the audit data active

Setting Up AuditTrail

Setting up AuditTrail is normally a task for the system administrator.

The first four steps must be done to enable auditing of any Oracle Applications table. They are explained in more detail in the Oracle Applications System Administrator’s Guide. The fifth step is required only for tables in the HR account.

> To set up AuditTrail:

1. Have your database administrator grant SELECT privileges on SYS.DBA_TABLES to the APPLSYS account. Normally this step would already have been done as part of your installation or upgrade.

2. Select the tables you want to audit in the Audit Groups window, and select which columns in these tables you want to audit in the Audit Tables window.

   Note: You cannot audit LONG, RAW, or LONG RAW columns.

3. Select the registered ORACLE IDs you want to audit in the Audit Installations window.

4. Run the Audit Trail Update Tables process. You do this in the Submit Requests window for a System Administrator responsibility. This process:
• creates database triggers on your audited tables
• creates one shadow table for each audited table, to contain the audit information
• builds special views on non-datetracked tables, which you can use to retrieve your audit data for reporting

5. Run the Audit Trail Update Datetracked Tables process. You do this in the Submit Requests window for an HRMS responsibility. For each datetracked table, this process:

• creates an index on the shadow table
• creates the function <tablename>_TT and the procedure < tablename>_VP, which extracts information from the shadow table when you run the predefined audit report

Attention: You must rerun these processes any time you update any of your audit definitions.

Disabling AuditTrail

You can disable the auditing of an audit group at any time by selecting a Disable state in the Audit Groups window.

Suggestion: If you are planning high volume transactions on an audited table, such as loading a batch of information from another system, consider disabling auditing for the table’s audit group. This will enable the batch loading to complete more quickly.

Before you restart auditing, you should archive your audit data, according to your business needs, and purge the shadow tables. You purge the tables by setting the audit group to Disable – Purge Table and running the Audit Trail Update Tables report. To restart auditing, you set the audit group to Enable Requested and rerun the Audit Trail Update Tables process and the Audit Trail Update Datetracked Tables process.

See Also

Setting Up Release 10 AuditTrail
*Oracle Applications System Administrator’s Guide*

Disabling AuditTrail and Archiving Audit Data
*Oracle Applications System Administrator’s Guide*
Reporting on Audit Information

For any non-datetracked tables, you can write a report that uses the views on the shadow tables to access the audit data. However, for datetracked tables, the information from the shadow tables must be extracted and written to the HR_AUDITS table and the HR_AUDIT_COLUMNS table before you can report on it.

The Oracle HRMS audit report performs this additional processing. You can use it as supplied or as an example of how to report on audit information. It can report on both datetracked and non-datetracked tables that have a numeric primary key.

**Note:** It can report on up to approximately 90 columns in datetracked tables and 80 columns in non-datetracked tables.

The report lists every change made to the table you select in the time period you specify when you run the report. You can restrict the reported changes to those made by a specified username. The changes are listed by date and time of the change. For each change, the report shows:

- the date and time of the change
- the user id who made the change
- the type of change
- the fields that changed and either their old values, or their new values, or both, depending on the type of change

Table 24 – 1 lists the 12 types of change and what information is shown in the audit report for each type.

<table>
<thead>
<tr>
<th>Type of Change</th>
<th>Field Values Shown in the Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Insert  (creates a non-datetracked record)</td>
<td>The non-null values in the new record.</td>
</tr>
<tr>
<td>Normal Update  (updates a non-datetracked record)</td>
<td>The old and new values for all fields that changed.</td>
</tr>
<tr>
<td>Normal Delete  (deletes a non-datetracked record)</td>
<td>The non-null values in the record that was deleted.</td>
</tr>
<tr>
<td>DT First Insert (creates a datetracked record)</td>
<td>The non-null values in the new record.</td>
</tr>
<tr>
<td>DT Update      (date-effectively ends the last row on a datetracked record and creates a new row)</td>
<td>The old and new values of all fields that changed, and the new effective end date on the old row.</td>
</tr>
</tbody>
</table>

Table 24 – 1 Transaction Types in the Audit Report
Field Values Shown in the Report

<table>
<thead>
<tr>
<th>Type of Change</th>
<th>Field Values Shown in the Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>DT Correction (corrects a row of a datetracked record and does not change the effective dates)</td>
<td>The old and new values of all fields that changed, and the effective dates of the corrected row.</td>
</tr>
<tr>
<td>DT Replace (creates a new row on a datetracked record that replaces all rows that start after its start date)</td>
<td>The non-null values in the rows that were deleted, the new effective end date on the row preceding the new row, and the old and new values of all fields that changed.</td>
</tr>
<tr>
<td>DT Insert (creates a new row on a datetracked record that ends on the old effective end date of the preceding row)</td>
<td>The old and new values of all fields that changed, and the new effective end date on the row preceding the new row.</td>
</tr>
<tr>
<td>DT Purge (deletes all rows of a datetracked record)</td>
<td>The non-null values in all rows of the record that was deleted.</td>
</tr>
<tr>
<td>DT End Date (adds an effective end date to the last row of a datetracked record)</td>
<td>The new effective end date of the row.</td>
</tr>
<tr>
<td>DT All (sets a new effective end date on a row of a datetracked record and deletes all following rows)</td>
<td>The non-null values in the rows that were deleted, and the new effective end date on the last row.</td>
</tr>
<tr>
<td>DT Next (deletes a row of a datetracked record and uses its effective end date to set an new end date on the preceding row)</td>
<td>The non-null values in the row that was deleted, and the old and new effective end dates on the preceding row.</td>
</tr>
</tbody>
</table>

Table 24 – 1 Transaction Types in the Audit Report

To run the predefined audit report:

1. In the Submit Requests window, select Audit Report in the Name field.
2. Enter the Parameters field to open the Parameters window.
3. Select an audited table (that is, one in an audit group).
4. Select a value for the Initialization parameter:
   - Yes means that the report removes obsolete data related to your selected table from the HR_AUDITS table and the HR_AUDIT_COLUMNS table. It populate the tables with new values, then reports on these.
   - No means that the report runs on the existing data in the HR_AUDITS table and the HR_AUDIT_COLUMNS table.
• **Refresh** means that the report removes all obsolete data from the HR_AUDITS table and the HR_AUDIT_COLUMNS table. It populate the tables with new values, then reports on these.

5. If you only want to report on the changes made by one user, enter the username.

6. Enter start and end dates to limit the time period for reporting audit information.

7. Choose the Submit button.

You can use the View Requests window to check the progress of the report.

---

**Designing Your Own Audit Report**

If you want to design your own audit report, you can copy the supplied report and use it as the basis of your own version. The supplied report uses a dynamic SQL structure to retrieve information for the report, and an Oracle Report to format it.

**Dynamic SQL Structure**

For a non–datetracked table, the dynamic SQL structure retrieves information and uses a private procedure to retrieve the new values for an update.

For a datetracked table, the dynamic SQL structure retrieves information from the function and procedure created for each datetracked table by the Audit Trail Update Datetracked Tables process:

- The `<tablename>_TT` function identifies the type of datetracked transaction represented by each row of the shadow table.
- The `<tablename>_VP` procedure gets new values from the shadow table for update and insert transactions. It writes these to the HR_AUDITS and HR_AUDIT_COLUMNS tables.

The dynamic SQL structure comprises several character strings, which are concatenated into one long string, then parsed and executed using the dynamic SQL generator. If you change a string, you must ensure that you do not exceed the text space allocated to it, as listed in the package header.

The structure is built up by identifying the audited table column information, which is retrieved from the FND_AUDIT_COLUMNS table. The logic varies depending on the data type being audited.
The package for the dynamic SQL is called `py_audit_report_pkg`. It is found in the script `pyadyn.pkh/pyadyn.pkb`.

**HR Audit Tables**

The HR_AUDITS table holds audit information about the transaction. The HR_AUDITOLUMNS table holds the changed column information for that transaction. The structure of these tables is as follows:

**HR_AUDITS Table**

<table>
<thead>
<tr>
<th>COLUMN</th>
<th>TYPE</th>
<th>NULL</th>
</tr>
</thead>
<tbody>
<tr>
<td>audit_id</td>
<td>number(15)</td>
<td>not null</td>
</tr>
<tr>
<td>commit_id</td>
<td>number(9)</td>
<td>not null</td>
</tr>
<tr>
<td>current_session_id</td>
<td>number</td>
<td>not null</td>
</tr>
<tr>
<td>primary_key</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>primary_key_value</td>
<td>number(15)</td>
<td>not null</td>
</tr>
<tr>
<td>sequence_id</td>
<td>number</td>
<td>not null</td>
</tr>
<tr>
<td>session_id</td>
<td>number</td>
<td>not null</td>
</tr>
<tr>
<td>table_name</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>timestamp</td>
<td>date</td>
<td>not null</td>
</tr>
<tr>
<td>transaction</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>transaction_type</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>user_name</td>
<td>varchar2(100)</td>
<td>not null</td>
</tr>
<tr>
<td>effective_end_date</td>
<td>date</td>
<td>null</td>
</tr>
<tr>
<td>effective_start_date</td>
<td>date</td>
<td>null</td>
</tr>
</tbody>
</table>

**HR_AUDIT_COLUMNS Table**

<table>
<thead>
<tr>
<th>COLUMN</th>
<th>TYPE</th>
<th>NULL</th>
</tr>
</thead>
<tbody>
<tr>
<td>audit_id</td>
<td>number(15)</td>
<td>not null</td>
</tr>
<tr>
<td>column_id</td>
<td>number(9)</td>
<td>not null</td>
</tr>
<tr>
<td>column_name</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>new_value</td>
<td>varchar2(240)</td>
<td>null</td>
</tr>
<tr>
<td>old_value</td>
<td>varchar2(240)</td>
<td>null</td>
</tr>
</tbody>
</table>
This appendix shows you the default menu path for every window in Oracle Human Resources and Oracle Payroll. Refer to chapter 19 *Customizing Windows and Menus* for information about setting up your own menu structures.

The first two sections show the structure of the default menus for the default responsibilities. The third section is arranged alphabetically by window title and shows how to find each window.
# Default Navigation Menus for HR with Payroll Responsibility

<table>
<thead>
<tr>
<th>MENU ENTRY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>People</strong></td>
<td></td>
</tr>
<tr>
<td>Enter and Maintain</td>
<td>Enter personal and assignment information</td>
</tr>
<tr>
<td>1 Person</td>
<td>Enter people, assignments, and applications</td>
</tr>
<tr>
<td>2 Address</td>
<td></td>
</tr>
<tr>
<td>2 Picture</td>
<td></td>
</tr>
<tr>
<td>2 Assignment</td>
<td></td>
</tr>
<tr>
<td>2 Special Info</td>
<td></td>
</tr>
<tr>
<td>2 Bookings</td>
<td></td>
</tr>
<tr>
<td>2 Absence</td>
<td></td>
</tr>
<tr>
<td>2 Contact</td>
<td></td>
</tr>
<tr>
<td>2 Application</td>
<td></td>
</tr>
<tr>
<td>2 Competence Profile</td>
<td></td>
</tr>
<tr>
<td>2 Qualifications</td>
<td></td>
</tr>
<tr>
<td>2 Work Choices</td>
<td></td>
</tr>
<tr>
<td>2 Schools and Colleges Attended</td>
<td></td>
</tr>
<tr>
<td>2 End Application</td>
<td></td>
</tr>
<tr>
<td>2 End Employment</td>
<td></td>
</tr>
<tr>
<td>2 Phones</td>
<td></td>
</tr>
<tr>
<td><strong>Events and Bookings</strong></td>
<td>Enter events and bookings</td>
</tr>
<tr>
<td><strong>Delete Personal Records</strong></td>
<td>Remove all records for any person</td>
</tr>
<tr>
<td><strong>Salary Management</strong></td>
<td>Manage salary details</td>
</tr>
<tr>
<td><strong>FastPath</strong></td>
<td>Enter personal and assignment information quickly</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>MENU ENTRY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Enter address details</td>
</tr>
<tr>
<td>Picture</td>
<td>Enter pictures for a person</td>
</tr>
<tr>
<td>Special Information</td>
<td>Enter special information</td>
</tr>
<tr>
<td>Contact Information</td>
<td>Enter contact information</td>
</tr>
<tr>
<td>Event for Person</td>
<td>Book a training event</td>
</tr>
<tr>
<td>Phone Numbers</td>
<td>Enter phone numbers</td>
</tr>
<tr>
<td>Absence Information</td>
<td>Enter absence information</td>
</tr>
<tr>
<td>Application</td>
<td>Enter application details</td>
</tr>
<tr>
<td>End Application</td>
<td>End a person’s application</td>
</tr>
<tr>
<td>Assignment</td>
<td>Enter a person’s assignment details</td>
</tr>
<tr>
<td>Assignment Costing</td>
<td>Enter costing for an assignment</td>
</tr>
<tr>
<td>Assignment Budget Values</td>
<td>Enter budget values for an assignment</td>
</tr>
<tr>
<td>Grade Step Placement</td>
<td>Enter grade step placement details</td>
</tr>
<tr>
<td>Secondary Status</td>
<td>Enter a person’s secondary status</td>
</tr>
<tr>
<td>Pay Method</td>
<td>Enter a pay method</td>
</tr>
<tr>
<td>End Employment</td>
<td>End a person’s employment</td>
</tr>
<tr>
<td>Employee Review</td>
<td>Perform an employee review</td>
</tr>
<tr>
<td>Salary Review</td>
<td>Perform a Salary Review</td>
</tr>
<tr>
<td>Salary History</td>
<td>View a person’s salary history</td>
</tr>
<tr>
<td>Element Entry</td>
<td>Enter compensation and benefits for employee assignment</td>
</tr>
<tr>
<td>Accruals</td>
<td>View net accruals to date</td>
</tr>
<tr>
<td>UK Tax Statement</td>
<td>Enter and view PAYE and NI information</td>
</tr>
<tr>
<td>UK Statement of Earnings</td>
<td>View statement of earnings</td>
</tr>
<tr>
<td>UK P45 Form</td>
<td>Print a P45 form</td>
</tr>
<tr>
<td>Adjust Balances</td>
<td>Adjust balances</td>
</tr>
<tr>
<td>QuickPay</td>
<td>Run QuickPay</td>
</tr>
<tr>
<td>Reverse Payroll Run</td>
<td>Run a reverse payroll</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>External Manual Payments</td>
<td>Enter external or manual payments</td>
</tr>
<tr>
<td>Recruitment</td>
<td>Manage recruiting</td>
</tr>
<tr>
<td>Requisition and Vacancy</td>
<td>Enter a requisition and any vacancies</td>
</tr>
<tr>
<td>Recruitment Activity</td>
<td>Enter a recruitment activity</td>
</tr>
<tr>
<td>Applicant Quick Entry</td>
<td>Quick entry of personal and application information</td>
</tr>
<tr>
<td>Mass Update of Applicants</td>
<td>Mass Update of Applicants</td>
</tr>
<tr>
<td>Request Recruitment Letter</td>
<td>Request a mailmerge file or a standard letter</td>
</tr>
<tr>
<td>Career Management</td>
<td>Career Management</td>
</tr>
<tr>
<td>Rating Scales</td>
<td>Define general methods of measuring competencies</td>
</tr>
<tr>
<td>Competencies</td>
<td>Define competencies</td>
</tr>
<tr>
<td>Competence Types</td>
<td>Group competencies into types</td>
</tr>
<tr>
<td>Competence Requirements</td>
<td>Define requirements for enterprise, organizations, jobs and positions</td>
</tr>
<tr>
<td>Schools &amp; Colleges</td>
<td>Define name and location of training establishments</td>
</tr>
<tr>
<td>Qualification Types</td>
<td>Define, categorize and rank qualifications</td>
</tr>
<tr>
<td>Assessment Template</td>
<td>Select competencies and rating scale for an assessment</td>
</tr>
<tr>
<td>Appraisal Template</td>
<td>Select questionnaire and rating scale for an appraisal</td>
</tr>
<tr>
<td>Work Structures</td>
<td>Enter work structures</td>
</tr>
<tr>
<td>Location</td>
<td>Enter locations</td>
</tr>
<tr>
<td>Organization</td>
<td>Enter organizational information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter information for an organization</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Structure organizations into hierarchies</td>
</tr>
<tr>
<td>Job</td>
<td>Enter job–related information</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Path Name</td>
<td>Enter names for job career paths</td>
</tr>
<tr>
<td>Career Path</td>
<td>Enter career paths for jobs</td>
</tr>
<tr>
<td>Position</td>
<td>Enter position-related information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter position names</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Structure positions into hierarchies</td>
</tr>
<tr>
<td>Mass Move</td>
<td>Enter details of a mass move</td>
</tr>
<tr>
<td>Grade</td>
<td>Enter grade-related information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter grade names</td>
</tr>
<tr>
<td>Grade Rate</td>
<td>Enter rates and values for grades</td>
</tr>
<tr>
<td>Pay Scale</td>
<td>Create a pay scale of fixed progression points</td>
</tr>
<tr>
<td>Point Values</td>
<td>Enter values for progression points</td>
</tr>
<tr>
<td>Grade Steps and Points</td>
<td>Enter grade steps and fixed point values for each step</td>
</tr>
<tr>
<td>Salary Basis</td>
<td>Enter available salary bases for salary administration</td>
</tr>
<tr>
<td>Budget Calendar</td>
<td>Define calendars for headcount and position budgets</td>
</tr>
<tr>
<td>Budget</td>
<td>Enter headcount and position budgets</td>
</tr>
<tr>
<td>Status</td>
<td>Define employee and applicant assignment statuses</td>
</tr>
<tr>
<td>Recruitment Letter Type</td>
<td>Associate letter types with applicant statuses</td>
</tr>
<tr>
<td>Payroll</td>
<td>Enter information for payrolls</td>
</tr>
<tr>
<td>Description</td>
<td>Enter payroll groups</td>
</tr>
<tr>
<td>Consolidation</td>
<td>Define consolidation sets for payroll run results</td>
</tr>
<tr>
<td>Payment Methods</td>
<td>Define available payment methods</td>
</tr>
<tr>
<td>GL Flexfield Map</td>
<td>Map payroll costing to Oracle GL flexfield segments</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update Payroll Run</td>
<td>Update consolidation set or pay advice date</td>
</tr>
<tr>
<td>Assignment Set</td>
<td>Define employee assignment sets</td>
</tr>
<tr>
<td>Element Set</td>
<td>Define element and distribution sets</td>
</tr>
<tr>
<td>RetroPay Set</td>
<td>Define retropay sets using balances and elements</td>
</tr>
<tr>
<td>Exchange Rates</td>
<td>Enter exchange rates for your base currency</td>
</tr>
<tr>
<td>Monetary Units</td>
<td>Enter monetary units for cash analysis and distribution</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Compensation and Benefits</strong></td>
<td></td>
</tr>
<tr>
<td>Element Description</td>
<td>Enter information on compensation and benefits</td>
</tr>
<tr>
<td>Link</td>
<td>Enter eligibility rules for compensations and benefits</td>
</tr>
<tr>
<td>Absence Types</td>
<td>Define absence types</td>
</tr>
<tr>
<td>Accrual Plans</td>
<td>Enter accrual plans</td>
</tr>
<tr>
<td>Write Formulas</td>
<td>Enter and modify formulas</td>
</tr>
<tr>
<td>Formula Results</td>
<td>Define what happens to formula results</td>
</tr>
<tr>
<td>Global Values</td>
<td>Enter global values for use in formulas</td>
</tr>
<tr>
<td>Balance</td>
<td>Enter balances with feeds and dimensions</td>
</tr>
<tr>
<td>Classification</td>
<td>Define additional element classifications</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>View</strong></td>
<td></td>
</tr>
<tr>
<td>Histories</td>
<td></td>
</tr>
<tr>
<td>Employee Assignment</td>
<td>Employee assignment history</td>
</tr>
<tr>
<td>Absence</td>
<td>Employee absence history folder</td>
</tr>
<tr>
<td>Run Results</td>
<td>Employee run result history</td>
</tr>
<tr>
<td>Salary</td>
<td>Salary history for an employee assignment</td>
</tr>
<tr>
<td>1 Assignment Folder ---&gt; 2 Salary History</td>
<td></td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Entries</td>
<td>Entry history for an employee assignment</td>
</tr>
<tr>
<td>1 Assignment Folder → 2 Entry</td>
<td></td>
</tr>
<tr>
<td>History</td>
<td></td>
</tr>
<tr>
<td>Lists</td>
<td></td>
</tr>
<tr>
<td>People Folder</td>
<td>People folder</td>
</tr>
<tr>
<td>Assignment Folder</td>
<td>Assignment folder</td>
</tr>
<tr>
<td>People by Assignment</td>
<td>List people by assignment folder</td>
</tr>
<tr>
<td>Assignments</td>
<td>List assignments folder</td>
</tr>
<tr>
<td>Employees by Organization</td>
<td>List employees by organization folder</td>
</tr>
<tr>
<td>Employees by Position</td>
<td>List employees by position folder</td>
</tr>
<tr>
<td>Emps by Position Hierarchy</td>
<td>List employees by position hierarchy folder</td>
</tr>
<tr>
<td>Employees by Element</td>
<td>List employees by element</td>
</tr>
<tr>
<td>Employees by Absence Type</td>
<td>List employees by absence type folder</td>
</tr>
<tr>
<td>People by Special Information</td>
<td>List people by special information folder</td>
</tr>
<tr>
<td>Vacancies</td>
<td>View vacancies folder</td>
</tr>
<tr>
<td>Organization Budgets</td>
<td>View organization budget variance folder</td>
</tr>
<tr>
<td>Position Budgets</td>
<td>View position budget variance folder</td>
</tr>
<tr>
<td>Grade Comparatio</td>
<td>View employee grade comparatio folder</td>
</tr>
<tr>
<td>Employee Accruals</td>
<td>View net accruals to date</td>
</tr>
<tr>
<td>1 Assignment Folder → 2 Accruals</td>
<td></td>
</tr>
<tr>
<td>Payroll Process Results</td>
<td>View process results for a payroll</td>
</tr>
<tr>
<td>Assignment Process Results</td>
<td>View process results for an employee assignment</td>
</tr>
<tr>
<td>System Messages</td>
<td>View system level messages</td>
</tr>
<tr>
<td>Processes and Reports</td>
<td></td>
</tr>
<tr>
<td>Submit Processes and Reports</td>
<td>Submit processes or run standard reports</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View Requests</td>
<td>View any requests submitted for processing</td>
</tr>
<tr>
<td>View Reports</td>
<td>View reports online</td>
</tr>
<tr>
<td>Workflow Notifications</td>
<td>Workflow Notifications In–Box</td>
</tr>
<tr>
<td>Define a QuickPaint Report</td>
<td>Set up the report layout</td>
</tr>
<tr>
<td>Run a QuickPaint Report</td>
<td>View or print the report for a set of people</td>
</tr>
<tr>
<td>Generate MS Word Letter</td>
<td>Generate MS Word Letter</td>
</tr>
<tr>
<td>Submit Custom Reports</td>
<td>Submit custom reports</td>
</tr>
<tr>
<td>Mass Information eXchange: MIX</td>
<td>Enter timecard and other information batches</td>
</tr>
<tr>
<td>Batch Element Entry</td>
<td>Enter, validate, and transfer element entry batches.</td>
</tr>
<tr>
<td>Other Definitions</td>
<td>Other Definitions</td>
</tr>
<tr>
<td>Person Types</td>
<td>Enter names for types of employees, applicants and other people</td>
</tr>
<tr>
<td>QuickCode Values</td>
<td>Enter values and meanings for QuickCode types</td>
</tr>
<tr>
<td>QuickCode Types</td>
<td>Define your own QuickCode types</td>
</tr>
<tr>
<td>Special Information Types</td>
<td>Join special information types to the current business group</td>
</tr>
<tr>
<td>Table Structure</td>
<td>Set up tables you require</td>
</tr>
<tr>
<td>Table Values</td>
<td>Enter table values</td>
</tr>
<tr>
<td>Time Periods</td>
<td>Define time period types for use in budget calendars</td>
</tr>
<tr>
<td>User Profile Options</td>
<td>Review your personal profile options</td>
</tr>
<tr>
<td>Formula Functions</td>
<td>Register your user defined functions</td>
</tr>
<tr>
<td>Security</td>
<td>Define security restrictions</td>
</tr>
<tr>
<td>Profile</td>
<td>Define security profiles to restrict record access</td>
</tr>
<tr>
<td>CustomForm</td>
<td>Define customizations to restrict information access in windows</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Report Sets</td>
<td>Define sets to restrict report and process access</td>
</tr>
<tr>
<td>Task Flow Nodes</td>
<td>Define task flow nodes and customizations</td>
</tr>
<tr>
<td>Task Flow Definitions</td>
<td>Define task flows</td>
</tr>
</tbody>
</table>
### Default Navigation Menus for Payroll Responsibility

<table>
<thead>
<tr>
<th>MENU ENTRY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>People</strong></td>
<td>Enter personal and assignment information</td>
</tr>
<tr>
<td><strong>Enter and Maintain</strong></td>
<td>Enter people, assignments, and applications</td>
</tr>
<tr>
<td><strong>1 Person</strong></td>
<td></td>
</tr>
<tr>
<td>2 Address</td>
<td></td>
</tr>
<tr>
<td>2 Picture</td>
<td></td>
</tr>
<tr>
<td>2 Assignment</td>
<td></td>
</tr>
<tr>
<td>2 Absence</td>
<td></td>
</tr>
<tr>
<td>2 Contact</td>
<td></td>
</tr>
<tr>
<td>2 End Employment</td>
<td></td>
</tr>
<tr>
<td>2 Phones</td>
<td></td>
</tr>
<tr>
<td>3 Salary</td>
<td></td>
</tr>
<tr>
<td>3 Entries</td>
<td></td>
</tr>
<tr>
<td>3 Tax Information</td>
<td></td>
</tr>
<tr>
<td>3 Pay Method</td>
<td></td>
</tr>
<tr>
<td>3 Costing</td>
<td></td>
</tr>
<tr>
<td>3 Grade Step</td>
<td></td>
</tr>
<tr>
<td>3 Secondary Status</td>
<td></td>
</tr>
<tr>
<td>3 Salary History</td>
<td></td>
</tr>
<tr>
<td>3 Entry History</td>
<td></td>
</tr>
<tr>
<td>3 Reviews</td>
<td></td>
</tr>
<tr>
<td>3 P45</td>
<td></td>
</tr>
<tr>
<td>3 QuickPay</td>
<td></td>
</tr>
<tr>
<td>3 Statement of Earnings</td>
<td></td>
</tr>
<tr>
<td>3 External/Manual Payment</td>
<td></td>
</tr>
<tr>
<td>3 Reverse Run</td>
<td></td>
</tr>
<tr>
<td>3 Adjust Balance</td>
<td></td>
</tr>
<tr>
<td>3 Advance Pay</td>
<td></td>
</tr>
<tr>
<td><strong>Delete Personal Records</strong></td>
<td>Remove all records for any person</td>
</tr>
<tr>
<td><strong>Salary Management</strong></td>
<td>Manage salary details</td>
</tr>
<tr>
<td><strong>FastPath</strong></td>
<td>Enter personal and assignment information quickly</td>
</tr>
<tr>
<td><strong>Address</strong></td>
<td>Enter address details</td>
</tr>
<tr>
<td><strong>Picture</strong></td>
<td>Enter pictures for a person</td>
</tr>
<tr>
<td><strong>Special Information</strong></td>
<td>Enter special information</td>
</tr>
<tr>
<td><strong>Contact Information</strong></td>
<td>Enter contact information</td>
</tr>
<tr>
<td><strong>Phone Numbers</strong></td>
<td>Enter phone numbers</td>
</tr>
<tr>
<td><strong>Absence Information</strong></td>
<td>Enter absence information</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------</td>
</tr>
<tr>
<td>Assignment</td>
<td>Enter a person’s assignment details</td>
</tr>
<tr>
<td>Assignment Costing</td>
<td>Enter costing for an assignment</td>
</tr>
<tr>
<td>Grade Step Placement</td>
<td>Enter grade step placement details</td>
</tr>
<tr>
<td>Secondary Status</td>
<td>Enter a person’s secondary status</td>
</tr>
<tr>
<td>Pay Method</td>
<td>Enter a pay method</td>
</tr>
<tr>
<td>End Employment</td>
<td>End a person’s employment</td>
</tr>
<tr>
<td>Employee Review</td>
<td>Perform an employee review</td>
</tr>
<tr>
<td>Salary Review</td>
<td>Perform a Salary Review</td>
</tr>
<tr>
<td>Salary History</td>
<td>View a person’s salary history</td>
</tr>
<tr>
<td>Element Entry</td>
<td>Enter compensation and benefits for employee assignment</td>
</tr>
<tr>
<td>Accruals</td>
<td>View net accruals to date</td>
</tr>
<tr>
<td>UK Tax Statement</td>
<td>Enter and view PAYE and NI information</td>
</tr>
<tr>
<td>UK Statement of Earnings</td>
<td>View statement of earnings</td>
</tr>
<tr>
<td>UK P45 Form</td>
<td>Print a P45 form</td>
</tr>
<tr>
<td>Adjust Balances</td>
<td>Adjust balances</td>
</tr>
<tr>
<td>QuickPay</td>
<td>Run QuickPay</td>
</tr>
<tr>
<td>Reverse Payroll Run</td>
<td>Run a reverse payroll</td>
</tr>
<tr>
<td>External Manual Payments</td>
<td>Enter external or manual payments</td>
</tr>
</tbody>
</table>

**Work Structures**

Location

Enter locations

Organization

Enter organizational information

Description

Enter information for an organization

Hierarchy

Structure organizations into hierarchies

Job

Description

Enter job-related information
<table>
<thead>
<tr>
<th>MENU ENTRY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>Enter position-related information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter position names</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Structure positions into hierarchies</td>
</tr>
<tr>
<td>Mass Move</td>
<td>Enter details of a mass move</td>
</tr>
<tr>
<td>Grade</td>
<td>Enter grade-related information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter grade names</td>
</tr>
<tr>
<td>Grade Rate</td>
<td>Enter rates and values for grades</td>
</tr>
<tr>
<td>Pay Scale</td>
<td>Create a pay scale of fixed progression points</td>
</tr>
<tr>
<td>Point Values</td>
<td>Enter values for progression points</td>
</tr>
<tr>
<td>Grade Steps and Points</td>
<td>Enter grade steps and fixed point values for each step</td>
</tr>
<tr>
<td>Salary Basis</td>
<td>Enter available salary bases for salary administration</td>
</tr>
<tr>
<td>Status</td>
<td>Define employee and applicant assignment statuses</td>
</tr>
<tr>
<td>Payroll</td>
<td>Enter information for payrolls</td>
</tr>
<tr>
<td>Description</td>
<td>Enter payroll groups</td>
</tr>
<tr>
<td>Consolidation</td>
<td>Define consolidation sets for payroll run results</td>
</tr>
<tr>
<td>Payment Methods</td>
<td>Define available payment methods</td>
</tr>
<tr>
<td>GL Flexfield Map</td>
<td>Map payroll costing to Oracle GL flexfield segments</td>
</tr>
<tr>
<td>Update Payroll Run</td>
<td>Update consolidation set or pay advice date</td>
</tr>
<tr>
<td>Assignment Set</td>
<td>Define employee assignment sets</td>
</tr>
<tr>
<td>Element Set</td>
<td>Define element and distribution sets</td>
</tr>
<tr>
<td>RetroPay Set</td>
<td>Define retropay sets using balances and elements</td>
</tr>
<tr>
<td>Exchange Rates</td>
<td>Enter exchange rates for your base currency</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Monetary Units</td>
<td>Enter monetary units for cash analysis and distribution</td>
</tr>
<tr>
<td>Compensation and Benefits</td>
<td>Enter information on compensation and benefits</td>
</tr>
<tr>
<td>Element Description</td>
<td>Enter compensation and benefit information</td>
</tr>
<tr>
<td>Link</td>
<td>Enter eligibility rules for compensations and benefits</td>
</tr>
<tr>
<td>Absence Types</td>
<td>Define absence types</td>
</tr>
<tr>
<td>Accrual Plans</td>
<td>Enter accrual plans</td>
</tr>
<tr>
<td>Write Formulas</td>
<td>Enter and modify formulas</td>
</tr>
<tr>
<td>Formula Results</td>
<td>Define what happens to formula results</td>
</tr>
<tr>
<td>Global Values</td>
<td>Enter global values for use in formulas</td>
</tr>
<tr>
<td>Balance</td>
<td>Enter balances with feeds and dimensions</td>
</tr>
<tr>
<td>Classification</td>
<td>Define additional element classifications</td>
</tr>
<tr>
<td>View</td>
<td>View HRMS information</td>
</tr>
<tr>
<td>Histories</td>
<td></td>
</tr>
<tr>
<td>Employee Assignment</td>
<td>Employee assignment history</td>
</tr>
<tr>
<td>Absence</td>
<td>Employee absence history folder</td>
</tr>
<tr>
<td>Run Results</td>
<td>Employee run result history</td>
</tr>
<tr>
<td>Salary</td>
<td>Salary history for an employee assignment</td>
</tr>
<tr>
<td>1 Assignment Folder → 2 Salary History</td>
<td></td>
</tr>
<tr>
<td>Entries</td>
<td>Entry history for an employee assignment</td>
</tr>
<tr>
<td>1 Assignment Folder → 2 Entry History</td>
<td></td>
</tr>
<tr>
<td>Lists</td>
<td></td>
</tr>
<tr>
<td>People Folder</td>
<td>People folder</td>
</tr>
<tr>
<td>Assignment Folder</td>
<td>Assignment folder</td>
</tr>
<tr>
<td>People by Assignment</td>
<td>List people by assignment folder</td>
</tr>
<tr>
<td>Assignments</td>
<td>List assignments folder</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Employees by Organization</td>
<td>List employees by organization folder</td>
</tr>
<tr>
<td>Employees by Position</td>
<td>List employees by position folder</td>
</tr>
<tr>
<td>Emps by Position Hierarchy</td>
<td>List employees by position hierarchy folder</td>
</tr>
<tr>
<td>Employees by Element</td>
<td>List employees by element folder</td>
</tr>
<tr>
<td>Employees by Absence Type</td>
<td>List employees by absence type folder</td>
</tr>
<tr>
<td>Grade Comparatio</td>
<td>View employee grade comparatio folder</td>
</tr>
<tr>
<td>Employee Accruals</td>
<td>View net accruals to date</td>
</tr>
<tr>
<td>Payroll Process Results</td>
<td>View process results for a payroll</td>
</tr>
<tr>
<td>Assignment Process Results</td>
<td>View process results for an employee assignment</td>
</tr>
<tr>
<td>System Messages</td>
<td>View system level messages</td>
</tr>
<tr>
<td>Processes and Reports</td>
<td>Submit processes or run standard reports</td>
</tr>
<tr>
<td>Submit Processes and Reports</td>
<td>View any requests submitted for processing</td>
</tr>
<tr>
<td>View Requests</td>
<td>View reports online</td>
</tr>
<tr>
<td>View Reports</td>
<td>Workflow Notifications</td>
</tr>
<tr>
<td>Workflow Notifications</td>
<td>In–Box</td>
</tr>
<tr>
<td>Define a QuickPaint Report</td>
<td>Set up the report layout</td>
</tr>
<tr>
<td>Run a QuickPaint Report</td>
<td>View or print the report for a set of people</td>
</tr>
<tr>
<td>Generate MS Word Letter</td>
<td>Generate MS Word Letter</td>
</tr>
<tr>
<td>Submit Custom Reports</td>
<td>Submit custom reports</td>
</tr>
<tr>
<td>Mass Information eXchange: MIX</td>
<td>Enter timecard and other information batches</td>
</tr>
<tr>
<td>Batch Element Entry</td>
<td>Enter, validate, and transfer element entry</td>
</tr>
<tr>
<td>Other Definitions</td>
<td>Other Definitions</td>
</tr>
<tr>
<td>Person Types</td>
<td>Enter names for types of employees, applicants</td>
</tr>
<tr>
<td></td>
<td>and other people</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>QuickCode Values</td>
<td>Enter values and meanings for QuickCode types</td>
</tr>
<tr>
<td>QuickCode Types</td>
<td>Define your own QuickCode types</td>
</tr>
<tr>
<td>Table Structure</td>
<td>Set up tables you require</td>
</tr>
<tr>
<td>Table Values</td>
<td>Enter table values</td>
</tr>
<tr>
<td>User Profile Options</td>
<td>Review your personal profile options</td>
</tr>
<tr>
<td>Formula Functions</td>
<td>Register your user defined functions</td>
</tr>
<tr>
<td>Security</td>
<td>Define security restrictions</td>
</tr>
<tr>
<td>Profile</td>
<td>Define security profiles to restrict record access</td>
</tr>
<tr>
<td>CustomForm</td>
<td>Define customizations to restrict information access in windows</td>
</tr>
<tr>
<td>Report Sets</td>
<td>Define sets to restrict report and process access</td>
</tr>
<tr>
<td>Task Flow Nodes</td>
<td>Define task flow nodes and customizations</td>
</tr>
<tr>
<td>Task Flow Definitions</td>
<td>Define task flows</td>
</tr>
</tbody>
</table>
Windows and their Navigation Paths

This topic shows the default navigation paths for all the windows in Oracle HRMS, as they are supplied. You can use taskflow windows directly from the menu, or from the People and Assignment windows.

The responsibility that you use determines which of these windows you can use and how you access them. Your system administrator sets up navigation menus and task flows for your responsibility. They may also create customized versions of some of these windows using different window titles.

Absence Detail

Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Choose the Others button and select Absence.
Or:
2. In the resulting Find window, query the person.

Absence Attendance Type

- Choose Compensation and Benefits –> Absence Types in the Navigator.

Accrual Bands

2. Enter or query an accrual plan name.
3. Choose the Accrual Bands button.

Accrual Plans

- Choose Compensation and Benefits –> Accrual Plans in the Navigator.

Accruals

Do one of the following:
1. Choose View –> Employee Accruals in the Navigator.
2. Run a query in the Assignments Folder window.
3. Select an employee assignment and choose the Accruals button.
   Or:
   1. Choose People –> Fastpath –> Accruals in the Navigator.
   2. In the resulting Find window, query the person.

   **Address**
   Do one of the following:
   1. Choose People –> Enter and Maintain in the Navigator.
   2. Enter or query a person.
   3. Choose the Address button.
   Or:
   1. Choose People –> Fastpath –> Address in the Navigator.
   2. In the resulting Find window, query the person.

   **Adjust Balance** (Oracle Payroll only)
   Do one of the following:
   1. Choose People –> Enter and Maintain in the Navigator.
   2. Enter or query an employee.
   3. Choose the Assignment button.
   4. Choose the Others button and select Adjust Balance.
   Or:
   1. Choose People –> Fastpath –> Adjust Balances in the Navigator.
   2. In the resulting Find window, query the person.

   **Advance Pay** (Oracle Payroll only)
   1. Choose People –> Enter and Maintain in the Navigator.
   2. Enter or query an employee.
   3. Choose the Assignment button.
   4. Choose the Others button and select Advance Pay.

   **Alter Effective Date**
   - Choose the Alter Effective Date icon from the toolbar.

   **Applicant Entry**
   - Choose Recruitment –> Applicant Quick Entry in the Navigator.
Applicant Interview
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an applicant.
3. Choose the Others button and select Application.
4. Choose the Interview button.

Application
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an applicant.
3. Choose the Others button and select Application.
Or:
1. Choose People -> Fastpath -> Application in the Navigator.
2. In the resulting Find window, query the person.

Appraisal Template
- Choose Career Management -> Appraisal Template in the Navigator.

Assessment Template
- Choose Career Management -> Assessment Template in the Navigator.

Assign Monetary Units to a Currency (Oracle Payroll only)
- Choose Payroll -> Monetary Units in the Navigator.

Assignment
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
Or:
1. Choose People -> Fastpath -> Assignment in the Navigator.
2. In the resulting Find window, query the person.

Assignment Budget Values
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an applicant or an employee.
3. Do one of the following:
   For an applicant:
   • Choose the Others button and select Application.
   • Choose the Budgets button.
   For an employee:
   • Choose the Assignment button.
   • Choose the Others button and select Budgets.

Or:
1. Choose People –> Fastpath –> Assignment Budget Values in the Navigator.
2. In the resulting Find window, query the person.

Assignment Criteria
1. Choose Payroll –> Assignment Set in the Navigator.
2. Enter or query an assignment set.
3. Choose the Criteria button.

Assignment History
■ Choose View –> Histories –> Employee Assignment in the Navigator.

Assignment Processes
1. Choose View –> Payroll Process Results in the Navigator.
2. Enter or query a payroll process.
3. Choose the Assignment Process button.

Assignment Set
■ Choose Payroll –> Assignment Set in the Navigator.

Assignment Statuses
■ Choose Work Structures –> Status in the Navigator.

Assignments Folder
■ Choose View –> Lists –> Assignments Folder in the Navigator.
Balance (Oracle Payroll only)
- Choose Compensation and Benefits –> Balance in the Navigator.

Balance Classifications (Oracle Payroll only)
2. Enter or query a balance.
3. Choose the Classifications button.

Balance Dimensions (Oracle Payroll only)
2. Enter or query a balance.
3. Choose the Dimensions button.

Balance Feed Control (Oracle Payroll only)
1. Choose Compensation and Benefits –> Element Description in the Navigator.
2. Enter or query an element.
3. Choose the Balance Feed Control button.

Balance Feeds (Oracle Payroll only)
- Note: This instance of the Balance Feeds window lets you select more than one element to feed the balance.
2. Enter or query a balance.
3. Choose the Feeds button.

Balance Feeds (Oracle Payroll only)
- Note: This instance of the Balance Feeds window lets you select more than one balance for the element to feed.
2. Enter or query an element.
3. Choose the Feeds button.

Batch Header
- Choose Mass Information eXchange: MIX –> Batch Element Entry in the Navigator.
Batch Lines
2. Choose the Lines button.

Book Events
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Others button and select Bookings.

Budget
• Choose Work Structures –> Budget in the Navigator.

Budget Value Defaults
2. Enter or query a Business Group.
3. Choose the Others button and select Budget Value Defaults.

Budgetary Calendar
• Choose Work Structures –> Budget Calendar in the Navigator.

Business Group Information
2. Enter or query a Business Group.
3. Choose the Others button and select Business Group Information.

Career Path Names
• Choose Work Structures –> Job –> Path Name in the Navigator.

Calendars (SSP/SMP only)
1. Choose SSP –> SSP Qualifying Patterns in the Navigator.
2. Enter or query a pattern.
3. Choose the Calendars button.

Calendar Usages (SSP/SMP only)
1. Choose SSP –> SSP Qualifying Patterns in the Navigator.
2. Enter or query a pattern.
3. Choose the Calendars button.
4. Choose the Calendar Usages button.

**Columns**
1. Choose Other Definitions -> Table Structure in the Navigator.
2. Enter or query a table.
3. Choose the Columns button.

**Competence Profile**
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Others button and select Competence Profile.

**Competence Requirements**
- Choose Career Management -> Competence Requirements in the Navigator.

**Competence Types**
- Choose Career Management -> Competence Types in the Navigator.

**Competencies**
- Choose Career Management -> Competencies in the Navigator.

**Concurrent Requests**
- Choose Processes and Reports -> View Requests in the Navigator.

**Consolidation Sets** (Oracle Payroll only)
- Choose Payroll -> Consolidation in the Navigator.

**Contact**
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Others button and select Contact.
Or:
1. Choose People -> Fastpath -> Contact Information in the Navigator.
2. In the resulting Find window, query the person.

Control Totals
2. Choose the Totals button.

Costing
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Costing.
Or:
1. Choose People -> Fastpath -> Costing in the Navigator.
2. In the resulting Find window, query the person.

Costing Information
2. Enter or query an organization.
3. Choose the Others button and select Costing Information.

Custom Reports
- Choose Processes and Reports -> Submit Custom Reports in the Navigator.

Database Items
1. Choose Compensation and Benefits -> Write Formulas in the Navigator.
2. Enter or query a formula.
3. Choose the Show Items button.

DateTrack History Change Field Summary
- Choose the DateTrack History icon from the toolbar.

Define Function
- Choose Other Definitions -> Formula Functions in the Navigator.
Define QuickPaint Report
- Choose Processes and Reports -> Define a QuickPaint Report in the Navigator.

Define Task Flow

Define Task Flow Nodes
- Choose Security -> Task Flow Nodes in the Navigator.

Delete Person
- Choose People -> Delete Personal Records in the Navigator.

Edit Formula
1. Choose Compensation and Benefits -> Write Formulas in the Navigator.
2. Enter or query a formula.
3. Choose the Edit button.

Element
- Choose Compensation and Benefits -> Element Description in the Navigator.

Element and Distribution Set
- Choose Payroll -> Element Set in the Navigator.

Element Classifications (Oracle Payroll only)
- Choose Compensation and Benefits -> Classification in the Navigator.

Element Entries
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Entries button.
Or:
1. Choose People -> Fastpath -> Element Entries in the Navigator.
2. In the resulting Find window, query the person.

**Element Link**
- Choose Compensation and Benefits → Link in the Navigator.

**Element Withholding Reasons** (SSP/SMP only)
- Choose SSP/SMP → Element Withholding Reasons in the Navigator.

**Employee Assignment Processes** (Oracle Payroll only)
- Choose View → Assignment Process Results in the Navigator.

**Employee Review**
Do one of the following:
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Reviews.

Or:
1. Choose People → Fastpath → Employee Review in the Navigator.
2. In the resulting Find window, query the person.

**Employee Run Result History** (Oracle Payroll only)
- Choose View → Histories → Run Results in the Navigator.

**End Application**
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Others button and select End Application.

Or:
1. Choose People → Fastpath → End Application in the Navigator.
2. In the resulting Find window, query the person.

**End Employment**
Do one of the following:
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Others button and select End Employment.

Or:
1. Choose People -> Fastpath -> End Employment in the Navigator.
2. In the resulting Find window, query the person.

Entry Values
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Entries button.
5. Select an entry and choose the Entry Values button.

Event Bookings
Do one of the following:
- Choose People -> Events and Bookings in the Navigator.

Or:
1. Choose People -> Fastpath -> Event for Person in the Navigator.
2. In the resulting Find window, query the person.

Exchange Rates (Oracle Payroll only)
- Choose Payroll -> Exchange Rates in the Navigator.

External/Manual Payments (Oracle Payroll only)
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select External Pay.

Or:
2. In the resulting Find window, query the person.

Form Customization
- Choose Security -> CustomForm in the Navigator.
Formula
- Choose Compensation and Benefits -> Write Formulas in the Navigator.

Formula Result Rules (Oracle Payroll only)
- Choose Compensation and Benefits -> Formula Results in the Navigator.

GL Map (Oracle Payroll only)
- Choose Payroll -> GL Flexfield Map in the Navigator.

Globals
- Choose Compensation and Benefits -> Global Values in the Navigator.

Grade Rate
- Choose Work Structures -> Grade -> Grade Rate in the Navigator.

Grade Scale
- Choose Work Structures -> Grade -> Grade Steps and Points in the Navigator.

Grade Step Placement
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Grade Step.
Or:
1. Choose People -> Fastpath -> Grade Step Placement in the Navigator.
2. In the resulting Find window, query the person.

Grades
- Choose Work Structures -> Grade -> Description in the Navigator.

Input Values
1. Choose Compensation and Benefits -> Element Description in the Navigator.
2. Enter or query an element.
3. Choose the Input Values button.

**Job**
- Choose Work Structures –> Job –> Description in the Navigator.

**Job Evaluation**
2. Enter or query a job.
3. Choose the Evaluation button.

**Job Requirements**
2. Enter or query a job.
3. Choose the Requirements button.

**Letter**
- Choose Work Structures –> Recruitment Letter Type in the Navigator.

**Link Input Values**
1. Choose Compensation and Benefits –> Link in the Navigator.
2. Enter or query an element.
3. Choose the Input Values button.

**List Assignments**
- Choose View –> Lists –> Assignments in the Navigator.

**List Budget Variance by Organization**
- Choose View –> Organization Budgets in the Navigator.

**List Employees by Absence Type**
- Choose View –> Lists –> Employees by Absence Type in the Navigator.

**List Employees by Element**
- Choose View –> Lists –> Employees by Element in the Navigator.

**List Employees by Organization**
- Choose View –> Lists –> Employees by Organization in the Navigator.
List Employees by Position
- Choose View -> Lists -> Employees by Position in the Navigator.

List Employees by Position Hierarchy
- Choose View -> Lists -> Emps by Position Hierarchy in the Navigator.

List People by Assignment
- Choose View -> Lists -> People by Assignment in the Navigator.

List People by Special Information
- Choose View -> Lists -> People by Special Information in the Navigator.

List Position Budget Variance
- Choose View -> Position Budgets in the Navigator.

Location
- Choose Work Structures -> Location in the Navigator.

Map Career Path
- Choose Work Structures -> Job -> Career Path in the Navigator.

Mass Move
- Choose Work Structures -> Mass Update in the Navigator.

Mass Move – Assignments
2. Complete the Mass Move window and save your work.
3. Choose the Positions button.
4. Complete the Find Positions window.
5. Choose the Find button.
7. Choose the Assignments button.

Mass Move – Messages
2. Complete the Mass Move window and save your work.
3. Choose the Positions button.
4. Complete the Find Positions window and choose the Find button.
5. Complete the Mass Move – Positions window and choose the Assignments button.
6. Complete the Mass Move – Assignments window and close it.
7. From the Mass Move – Positions window, choose the Valid Grades button.
8. Complete the Valid Grades window and close it.
10. From the Mass Move window, choose the Execute button.
11. If the Status field shows In Error or Complete with Warnings, a Message button appears.
12. If the Message button appears, choose it to view messages in the Mass Move – Messages window.

   **Note:** Alternatively, you can view messages for saved (but not yet successfully executed) mass moves as follows:
   2. Enter the name of the saved mass move in the Description field.
   3. When the Mass Move window is populated with data and the Message button appears, choose the Message button .

**Mass Move – Positions**
2. Complete the Mass Move window.
3. Save your work.
4. Choose the Positions button.
5. In the resulting Find Positions window, select or enter a Source Job and Source Position.
6. Choose the Find button.

**Mass Move – Valid Grades**
2. Complete the Mass Move window and save your work.
3. Choose the Positions button.
4. Complete the Find Positions window.
5. Choose the Find button.
7. Choose the Valid Grades button.

**Mass Update of Applicants**
- Choose Recruitment –> Mass Update of Applicants in the Navigator.

**Maternity (SSP/SMP only)**
1. Choose SSP/SMP –> Person Details in the Navigator.
2. Enter or query a person.
3. Choose the Maternity button.

**Maternity Evidence (SSP/SMP only)**
1. Choose SSP/SMP –> Person Details in the Navigator.
2. Enter or query a person.
3. Choose the Absence button.
4. Enter or query a maternity absence.
5. Choose the Evidence button.

**Maternity Pay (SSP/SMP only)**
1. Choose SSP/SMP –> Person Details in the Navigator.
2. Enter or query a person.
3. Choose the Absence button.
4. Enter or query a maternity absence.
5. Choose the SSP/SMP button.

**Messages**
2. Choose the Messages button.

**MIX Batch Header**
- Choose Mass Information eXchange: MIX –> Batch Element Entry in the Navigator.

**MIX Batch Lines**
2. Choose the Lines button.

**Net Calculation Rules**
2. Enter or query an accrual plan name.
3. Choose the Net Calculation Rules button.

**Organization**
- Choose Work Structures -> Organization -> Description in the Navigator.

**Organization Hierarchy**
- Choose Work Structures -> Organization -> Hierarchy in the Navigator.

**Organizational Payment Method**
- Choose Payroll -> Payment Methods in the Navigator.

**P45 (Oracle Payroll only)**
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Tax Information.

Or:
1. Choose People -> Fastpath -> UK P45 Form in the Navigator.
2. In the resulting Find window, query the person.

**Parent Organization**
2. Enter or query an organization.
3. Choose the Others button and select Parent Organization.

**Pattern (SSP/SMP only)**
- Choose SSP/SMP -> SSP Qualifying Patterns in the Navigator.
Pattern Time Units (SSP/SMP only)
- Choose SSP/SMP —> Pattern Time Units in the Navigator.

Pay Advice Report (Oracle Payroll only)
Do one of the following:
1. Choose People —> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Statement of Earnings.
   Or:
2. In the resulting Find window, query the person.

Pay Scale
- Choose Work Structures —> Grade —> Pay Scale in the Navigator.

Payroll
- Choose Payroll —> Description in the Navigator.

Payroll Processes (Oracle Payroll only)
- Choose View —> Payroll Process Results in the Navigator.

People
- Choose People —> Enter and Maintain in the Navigator.

People Folder
- Choose View —> Lists —> People Folder in the Navigator.

Performance
1. Choose People —> Enter and Maintain in the Navigator.
2. Enter or query an employee, and choose the Assignment button.
3. Choose the Salary button.
4. Choose the Performance button.

Period Dates
1. Choose Payroll —> Description in the Navigator.
2. Enter or query a payroll.
3. Choose the Period Dates button.

**Period Types**
- Choose Other Definitions –> Time Periods in the Navigator.

**Person Types**
- Choose Other Definitions –> Person Types in the Navigator.

**Personal Payment Method**
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Pay Method button, or choose the Others button and select Pay Method.

Or:
2. In the resulting Find window, query the person.

**Personal Profile Values**
- Choose Other Definitions –> User Profile Options in the Navigator.

**Phone Numbers**
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Others button.
4. Choose Phones.

Or:
1. Choose People –> Fastpath –> Phone Numbers in the Navigator.
2. In the resulting Find window, query the person.

**Picture**
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator
2. Enter or query a person.
3. Choose the Picture button.
Or:
2. In the resulting Find window, query the person.

Position
- Choose Work Structures –> Position –> Description in the Navigator.

Position Evaluation
2. Enter or query a position.
3. Choose the Evaluation button.

Position Hierarchy

Position Occupancy Folder
2. Query a position.
3. Choose the Occupancy button.

Position Reporting To
2. Enter or query a position.
3. Choose the Reporting To button.

Position Requirements
2. Enter or query a position.
3. Choose the Requirements button.

Prior Employment SSP (SSP1L) (SSP/SMP only)
1. Choose SSP/SMP –> Person Details in the Navigator.
2. Enter or query a person.
3. Choose the SSP1L button.

Qualifications
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Others button and select Qualifications.

Qualification Types
- Choose Career Management –> Qualification Types in the Navigator.

QuickCode Type Usages
1. Choose Other Definitions –> QuickCode Types in the Navigator.
2. Enter or query a user–defined Type.
3. Choose the Usages button.

QuickCode Types
- Choose Other Definitions –> QuickCode Types in the Navigator.

QuickCodes
- Choose Other Definitions –> QuickCode Values in the Navigator.

QuickPaint Inquiry
2. Query a report that has been run.
3. Choose the View Report button.

QuickPay (Oracle Payroll only)
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select QuickPay.
Or:
2. In the resulting Find window, query the person.

**Rating Scales**
- Choose Career Management –> Rating Scales in the Navigator.

**Recruiting For**
2. Enter or query a recruitment activity.
3. Choose the Recruiting For button.

**Recruitment Activity**
- Choose Recruitment –> Recruitment Activity in the Navigator.

**Request Letter**
- Choose Recruitment –> Request Recruitment Letter in the Navigator.

**Request Set**

**Requisition and Vacancy**
- Choose Recruitment –> Requisition and Vacancy in the Navigator.

**RetroPay Set** (Oracle Payroll only)
- Choose Payroll –> RetroPay Set in the Navigator.

**Reverse Payroll Run** (Oracle Payroll only)
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Reverse Run.

Or:
2. In the resulting Find window, query the person.

**Rows**
1. Choose Other Definitions –> Table Structure in the Navigator.
2. Enter or query a table.
3. Choose the Rows button.

**Run QuickPaint Report**
- Choose Processes and Reports --> Run a QuickPaint Report in the Navigator.

**Salary Administration**
Do one of the following:
1. Choose People --> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Salary button.

Or:
1. Choose People --> Fastpath --> Salary Administration in the Navigator.
2. In the resulting Find window, query the person.

**Salary Basis**
- Choose Work Structures --> Salary Basis in the Navigator.

**Salary History**
Do one of the following:
2. Run a query in the Assignments Folder window.
3. Select an employee assignment and choose the Salary History button.

Or:
1. Choose People --> Fastpath --> Salary History in the Navigator.
2. In the resulting Find window, query the person.

**Salary Management Folder**
- Choose People --> Salary Management in the Navigator.

**Scale Rate**
- Choose Work Structures --> Grade --> Point Values in the Navigator.
Schedules (SSP/SMP only)
1. Choose SSP/SMP –> SSP Qualifying Patterns in the Navigator.
2. Enter or query a pattern.
3. Choose the Calendars button.
4. Choose the Schedules button.

Schools and Colleges
- Choose Career Management –> Schools and Colleges in the Navigator.

Schools and Colleges (Attended)
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Others button and select Schools/Colleges.

Secondary Statuses
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an applicant or employee.
3. Do one of the following:
   For an applicant:
   - Choose the Others button and select Application.
   - Choose the Secondary Status button.
   For an employee:
   - Choose the Assignment button.
   - Choose the Others button and select Secondary Status.

Or:
2. In the resulting Find window, query the person.

Security Profile
- Choose Security –> Profile in the Navigator.

Sickness Control Rules (SSP/SMP only)
2. Enter or query a Business Group
3. Choose the Others button and select Sickness Control Rules.

**Sickness Evidence** (SSP/SMP only)
1. Choose SSP/SMP –> Person Details in the Navigator.
2. Enter or query a person.
3. Choose the Absence button.
4. Enter or query a sickness absence.
5. Choose the Evidence button.

**Sickness Pay** (SSP/SMP only)
1. Choose SSP/SMP –> Person Details in the Navigator.
2. Enter or query a person.
3. Choose the Absence button.
4. Enter or query a sickness absence.
5. Choose the SSP/SMP button.

**Special Information**

Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Special Info button.

Or:
1. Choose People –> Fastpath –> Special Information in the Navigator.
2. In the resulting Find window, query the person.

**Special Information Types**
- Choose Other Definitions –> Special Information Types in the Navigator.

**Statutory Details** (Oracle Payroll only)

Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Tax Information.
Or:
2. In the resulting Find window, query the person.

**Submit a New Request**
2. Select Single Request or a Request Set.

**Table Structure**
- Choose Other Definitions –> Table Structure in the Navigator.

**Table Values**
- Choose Other Definitions –> Table Values in the Navigator.

**Tax Details References**
2. Enter or query a Business Group.
3. Choose the Others button and select Tax Details References.

**Update Payroll Run** (Oracle Payroll only)
- Choose Payroll –> Update Payroll Run in the Navigator.

**Valid Grades**
2. Choose either Job –> Description or Position –> Description.
3. Enter or query a job or position.
4. Choose the Valid Grades button.

**Valid Payment Methods**
1. Choose Payroll –> Description in the Navigator.
2. Enter or query a payroll.
3. Choose the Valid Payment Methods button.

**View Absence History**
- Choose View –> Histories –> Absence in the Navigator.
View Element Entry History for Employee
2. Run a query in the Assignments Folder window.
3. Select an employee assignment and choose the Entry History button.

View Employee Grade Comparatio
- Choose View –> Grade Comparatio in the Navigator.

View Run Messages (Oracle Payroll only)
- Choose View –> System Messages in the Navigator.

View Vacancies
- Choose View –> Vacancies in the Navigator.

Work Choices (Job or Position)
2. Enter or query a job or position.
3. Choose the Work Choices button.

Work Choices (Person)
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Others button and select Work Choices.

Work Day Information
2. Enter or query an organization.
3. Choose the Others button and select Work Day Information.

Workflow Notifications
- Choose Processes and Reports –> Workflow Notifications in the Navigator
Key and Descriptive Flexfields

A flexfield is a flexible field that allows you to customize and extend Oracle Applications. Each flexfield has the characteristics of separate fields known as segments. There are two types of flexfield:

- Descriptive flexfields allow you to define additional information you want to record in the windows.
- Key flexfields are the mechanism by which you customize some important parts of the system.

Both types of flexfield have also been used by localization teams to customize Oracle HRMS for your legislation.

This chapter lists the flexfields in Oracle HRMS and summarizes what you need to set up.
User Definable Key Flexfields

In Oracle HRMS there are six user definable key flexfields, for each of which you can define up to 30 segments:

- Job
- Position
- Grade
- People Group
- Personal Analysis
- Cost Allocation

The Personal Analysis key flexfield is different from the others. You can set up an unlimited number of structures for this flexfield. Each separate structure can have up to 30 segments.

How the Key Flexfields Are Used

Oracle HRMS uses key flexfields in a number of distinct ways:

Unique Identifiers

The Job, Position, and Grade Name flexfields let you create a unique name, which is a combination of separate components or segments. You use these flexfields when you are defining the work structures that exist in your enterprise.

**Suggestion:** When you are defining your requirements for these key flexfields you should consider the following points.

The task of defining the segment combinations is normally restricted to one or two users only. Therefore, you may not need to use value sets, or cross validation rule options to control the values that can be entered.

The names that users see are made up of a combination of segment values. The segment values are displayed, not the meanings.

Avoid segments containing information that may change regularly. There is no history of changes to the combinations you create. For example, do not define minimum and maximum values for grades as segments of the Grade flexfield.
Analysis Information
The People Group and Personal Analysis flexfields let you add key information to records of employee assignments and people. You can use the individual segments of these flexfields to identify or report on specific groups of people.

Payroll Costing
The Cost Allocation key flexfield is used to collect and to accumulate costs associated with running a payroll.

What You Must Set Up
The key flexfields are central to Oracle HRMS, therefore you must create certain definitions before you can set up your Business Group.

Job, Position, And Grade Key Flexfields
- You can only define one structure per Business Group for each of these flexfields.
- You can define up to 30 segments within the structure.
- Use of these flexfields is optional, but almost all Oracle HRMS installations use job and grade. Positions are used most often in large, highly structured enterprises, such as those in the areas of government, education, and health care.
- You must define a structure name for these three flexfields before you can define a Business Group.
- You associate these structures with a Business Group in the Business Group Information window, which opens from the Organization window.

People Group Key Flexfield
- You can only define one structure per Business Group for this flexfield.
- You can define up to 30 segments within the structure.
- You do not create separate combinations of segments for the People Group flexfield. You enter values for each employee as part of the employee assignment.
- You must define a structure name for this flexfield before you can define a Business Group.
- You must define at least one segment for the People Group flexfield in order to be able to use the Assignment window.
Personal Analysis Key Flexfield

- You can create any number of structures per Business Group for this flexfield. Each one represents a Special Information Type.
- You can define up to 30 segments within each structure.
- You do not need to define any structures for the Personal Analysis flexfield before you can use Oracle HRMS.
- You link each structure to a Business Group in the Special Information Types window while you are logged on to that Business Group.
- You can customize windows to restrict access to specific Information Types, such as medical or disciplinary information.

Cost Allocation Key Flexfield

- You can only define one structure per Business Group for this flexfield.
- You can define up to 30 segments within the structure.
- You can control the levels at which users can enter cost information by using the flexfield qualifiers.
- You must define a structure name for this flexfield before you can define a Business Group.
- A number of windows in Oracle HRMS check for the existence of a valid flexfield structure for Cost Allocation. You must define at least one segment for your Cost Allocation flexfield.

Creating Key Flexfield Database Items

The Create Key Flexfield DB Items process turns data in key flexfields into database items that Oracle FastFormula can access. It is essential to run this process whenever you create or change the Grade, Job, Position, or People Group key flexfield definitions. Submit the process from the Submit Requests window.

See Also

Oracle Applications Flexfields Guide
User Definable Descriptive Flexfields

All window blocks in which you can enter information contain a user definable descriptive flexfield. You decide in which blocks you want to record additional information. Each user definable descriptive flexfield has 20 segments that you can define. After you define a descriptive flexfield, Oracle HRMS treats the segments as part of the window.

For each segment, you can define its prompt, the type of data it can contain, and the values a user can enter. You can provide a list or range of valid values. You also control the size and display characteristics of each segment and the order in which the segments appear.

You can define two types of descriptive flexfield segments:

- Global segments, which always appear in the window.
- Context sensitive segments, that appear only when a defined context exists. You can prompt the user to provide the context, or you can provide the context automatically from a reference field in the same block.

For example, a segment to hold information about an employee’s disability might appear only when the Disabled field is checked.

Attention: Some descriptive flexfields appear in more than one window. For example, the Additional Evaluation Details flexfield appears in the Job Evaluation window and the Position Evaluation window.

Check all of the windows that use a descriptive flexfield before you define any of the segments. This is especially important if you intend to make the flexfield context sensitive to another field. You must ensure that the reference field is present in all of the windows that use the flexfield.

Refer to Table B – 1 for a full list of descriptive flexfields in Oracle HRMS.
Creating Descriptive Flexfield Database Items

You can use descriptive flexfield segments in QuickPaint reports and formulas if there are database items for these segments. Table B – 1 marks the descriptive flexfields for which you can create database items. To do this you run the Create Descriptive Flexfield DB Items process. It is essential to run this process from the Submit Requests window whenever you create or change these descriptive flexfield definitions.

**Note:** The process can only create database items for global segments. It does not create database items for context–sensitive segments.

### List of Descriptive Flexfields

The following table lists all the descriptive flexfields in Oracle HRMS.

<table>
<thead>
<tr>
<th>Descriptive Flexfield Title</th>
<th>Window Title</th>
<th>Database Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Absence Details</td>
<td>Absence Detail, View Absence History</td>
<td>ABSENCES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Absence Type Details</td>
<td>Absence Attendance Type</td>
<td>ABSENCE_TYPES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Address Details</td>
<td>Address, Applicant Entry, Contact</td>
<td>PERSON_ADDRESSES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Application Details</td>
<td>Applicant Entry, Application, Terminate Applicant</td>
<td>APPLICATIONS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Assignment Details</td>
<td>Applicant Entry, Application, Assignment, Assignment History</td>
<td>ASSIGNMENTS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Assignment Status Details</td>
<td>Secondary Statuses</td>
<td></td>
</tr>
<tr>
<td>Additional Balance Type Information</td>
<td>Balance (Oracle Payroll only)</td>
<td></td>
</tr>
<tr>
<td>Additional Benefit Contribution Details</td>
<td>Benefit Contributions (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional Booking Details</td>
<td>Applicant Interview, Book Events, Employee Review, Event Bookings</td>
<td></td>
</tr>
<tr>
<td>Additional Budget Details</td>
<td>Budget</td>
<td></td>
</tr>
</tbody>
</table>

Table B – 1 User Definable Descriptive Flexfields

B – 6 Oracle Payroll UK User’s Guide
<table>
<thead>
<tr>
<th>Descriptive Flexfield Title</th>
<th>Window Title</th>
<th>Database Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Budget Version Details</td>
<td>Budget</td>
<td></td>
</tr>
<tr>
<td>Additional Calendar Information</td>
<td>Budgetary Calendar</td>
<td></td>
</tr>
<tr>
<td>Additional Career Path Details</td>
<td>Career Path Names</td>
<td></td>
</tr>
<tr>
<td>Additional COBRA Benefit Details</td>
<td>COBRA Benefits (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional COBRA Coverage Details</td>
<td>COBRA Coverage (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional COBRA Payment Details</td>
<td>COBRA Payment (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional COBRA Status Details</td>
<td>COBRA Status (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional Contact Relationship Details</td>
<td>Contact</td>
<td>CONTACTS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Element Entry Information</td>
<td>Adjust Balance (Oracle Payroll only), Element Entries, View Element Entry History for Employee</td>
<td></td>
</tr>
<tr>
<td>Additional Element Link Information</td>
<td>Element Link</td>
<td></td>
</tr>
<tr>
<td>Additional Element Type Details</td>
<td>Element</td>
<td></td>
</tr>
<tr>
<td>Additional Evaluation Details</td>
<td>Job, Position</td>
<td></td>
</tr>
<tr>
<td>Additional Event Details</td>
<td>Applicant Interview, Employee Review, Event Bookings</td>
<td>EVENTS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Grade Details</td>
<td>Grade</td>
<td>GRADES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Job Details</td>
<td>Job</td>
<td>JOBS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Letter Details</td>
<td>Letter</td>
<td></td>
</tr>
<tr>
<td>Additional Location Details</td>
<td>Location</td>
<td></td>
</tr>
<tr>
<td>Additional Organization Information</td>
<td>Organization</td>
<td></td>
</tr>
<tr>
<td>Additional Organization Payment Method Details</td>
<td>Organizational Payment Method</td>
<td></td>
</tr>
<tr>
<td>Additional Organization Structure Detail</td>
<td>Organization Hierarchy</td>
<td></td>
</tr>
<tr>
<td>Additional Organization Unit Details</td>
<td>Organization</td>
<td>ORGANIZATION_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Pay Scale Information</td>
<td>Pay Scale</td>
<td></td>
</tr>
</tbody>
</table>

**Table B – 1 User Definable Descriptive Flexfields**
<table>
<thead>
<tr>
<th>Descriptive Flexfield Title</th>
<th>Window Title</th>
<th>Database Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Pay Rate Details</td>
<td>Grade Rate, Scale Rate</td>
<td>PAYROLLS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Payroll Details</td>
<td>Payroll</td>
<td></td>
</tr>
<tr>
<td>Additional Period Information</td>
<td>Budgetary Calendar, Period Dates (Payroll form)</td>
<td></td>
</tr>
<tr>
<td>Additional Period of Service Details</td>
<td>Terminate</td>
<td>PERIODS_OF_SERVICE_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Period Type Information</td>
<td>Period Types</td>
<td></td>
</tr>
<tr>
<td>Additional Person Analysis Details</td>
<td>Special Information, List People By Special Information</td>
<td></td>
</tr>
<tr>
<td>Additional Personal Details</td>
<td>Applicant Entry, Contact, People, People Folder</td>
<td>PEOPLE_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Personal Payment Method</td>
<td>Personal Payment Method</td>
<td></td>
</tr>
<tr>
<td>Additional Position Details</td>
<td>Position, Find Positions (Mass Move form)</td>
<td>POSITION_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Position Structure Details</td>
<td>Position Hierarchy</td>
<td></td>
</tr>
<tr>
<td>Additional Recruitment Activity Details</td>
<td>Recruitment Activity</td>
<td>RECRUITMENT_ACTIVITIES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Requirement Details</td>
<td>Job, Position</td>
<td></td>
</tr>
<tr>
<td>Additional Requisition Details</td>
<td>Requisition and Vacancy</td>
<td></td>
</tr>
<tr>
<td>Additional Salary Administration Details</td>
<td>Salary Administration</td>
<td></td>
</tr>
<tr>
<td>Additional Salary Basis Information</td>
<td>Salary Basis</td>
<td></td>
</tr>
<tr>
<td>Additional Telephone Number Details</td>
<td>Phone Numbers</td>
<td></td>
</tr>
<tr>
<td>Additional Vacancy Details</td>
<td>Requisition and Vacancy</td>
<td></td>
</tr>
<tr>
<td>Additional Valid Grade Details</td>
<td>Job, Position</td>
<td></td>
</tr>
<tr>
<td>Additional Year Information</td>
<td>Budgetary Calendar</td>
<td></td>
</tr>
</tbody>
</table>

Table B – 1 User Definable Descriptive Flexfields
Descriptive Flexfields with Startup Data

Oracle HRMS supplies two predefined descriptive flexfields to hold address information in different styles for different countries. These are the Personal Address Information descriptive flexfield and the Location Address descriptive flexfield.

You can use these descriptive flexfields to add new address styles or to change the styles included in Oracle HRMS.

**Attention:** If you change the predefined styles, your changes will be overwritten when you upgrade Oracle HRMS. If you add new styles, your changes may be overwritten if new startup data contains address styles for these countries.

Changing Address Styles

Address styles vary between countries, so Oracle HRMS provides two descriptive flexfields that use context sensitive segments to hold each line of an address.

<table>
<thead>
<tr>
<th>Title</th>
<th>Table Name</th>
<th>Window Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal Address</td>
<td>PER_ADDRESSES</td>
<td>Address, Applicant Entry</td>
</tr>
<tr>
<td>Information</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Location Address</td>
<td>HR_LOCATIONS</td>
<td>Location, Organization</td>
</tr>
</tbody>
</table>

Table B – 2 Address Styles in Oracle HRMS

The available address styles are defined as the contexts for these flexfields. The values used are the territory codes. These codes can be found in the FND_TERRITORIES table. You can have only one Address Style for each Territory in the FND_TERRITORIES table.

Address styles are provided as startup data in these flexfields. If you require additional address styles, you need to define a new context and segments.

To change the address style for any country, disable those segments you do not want to use. Then define new segments to record your own information. However, these changes will be overwritten when you upgrade Oracle HRMS.
Protected Flexfields

Oracle HRMS supplies two key flexfields and six descriptive flexfields that are predefined and protected. Your localization team defines these flexfields to meet the specific legislative and reporting needs of your country.

The protected key flexfields are the Soft Coded Legislation key flexfield and the Bank Details key flexfield.

Table B – 3 lists the protected descriptive flexfields.

<table>
<thead>
<tr>
<th>Title</th>
<th>Table Name</th>
<th>Window Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Further Element Information</td>
<td>PAY_ELEMENT_TYPES_F</td>
<td>Element</td>
</tr>
<tr>
<td>Further Assignment Information</td>
<td>PER_ASSIGNMENT_EXTRA_INFO</td>
<td>Assignment</td>
</tr>
<tr>
<td>Further Payment Method Information</td>
<td>PAY_ORG_PAYMENT_METHODS_F</td>
<td>Organizational Payment Method</td>
</tr>
<tr>
<td>Further Person Information (Datetracked)</td>
<td>PER_PEOPLE_F</td>
<td>People, Applicant Entry</td>
</tr>
<tr>
<td>Further Person Information</td>
<td>PER_PEOPLE_EXTRA_INFO</td>
<td>People</td>
</tr>
<tr>
<td>Further Job Information</td>
<td>PER_JOB_EXTRA_INFO</td>
<td>Job</td>
</tr>
<tr>
<td>Further Position Information</td>
<td>PER_POSITION_EXTRA_INFO</td>
<td>Position</td>
</tr>
<tr>
<td>Further Organization Information</td>
<td>HR_ORGANIZATION_INFORMATION</td>
<td>Organization</td>
</tr>
<tr>
<td>Further Location Information</td>
<td>HR_LOCATION_EXTRA_INFO</td>
<td>Location</td>
</tr>
</tbody>
</table>

Table B – 3 Protected Descriptive Flexfields in Oracle HRMS

Your localization team determines which of these flexfields are required for your legislation, and what segments they should contain. Ensure that you select the appropriate legislation code when you define your Business Group so that you can see these flexfields.

⚠️ **Warning:** Do not attempt to alter the definitions of these protected flexfields. These definitions are a fundamental part of Oracle HRMS. Any change to them may lead to errors in the operating of the system.

It is possible that Oracle HRMS will use other segments of these flexfields in the future. Therefore, do not add segments to any protected flexfield. This can affect your ability to upgrade your system in the future.
Soft Coded Legislation Key Flexfield

This key flexfield holds legislation–specific information. The legislation of your Business Group determines the flexfield structure that you see. Each localization team defines a flexfield structure and uses qualifiers to define the level at which each segment is visible. Therefore, you may be able to enter information specific to your legislation at one or more of the following levels:

- Business Group – Organization window
- Payroll – Payroll window
- Employee Assignment – Assignment window

Bank Details Key Flexfield

This flexfield holds legislation–specific bank account information. The legislation of your Business Group determines the flexfield structure that you see. Each localization team defines a flexfield structure that allows you to record the bank account information relevant to your legislation. You enter this information in the Organizational Payment Method window and Personal Payment Method window.
Appendix C

Database Items

This appendix lists the database items available to you in Oracle HRMS for writing formulas and defining QuickPaint reports. The database items are grouped into two listings:

- Static Database Items
- Dynamic Database Items

Static database items are shipped with the system and you cannot modify them. Dynamic database items are created by Oracle HRMS processes whenever you define new elements or other related entities.
Static Database Items

Static database items are shipped with the system and you cannot modify them.

Applicant Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APL_DATE_END</td>
<td>The date the application ended</td>
</tr>
<tr>
<td>APL_DATE_RECEIVED</td>
<td>The date the application was received</td>
</tr>
</tbody>
</table>

Table C – 1

Employee Assignment Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_ASSIGNMENT_SEQUENCE</td>
<td>This is used as a default for assignment number</td>
</tr>
<tr>
<td>ASG_DATE_FROM</td>
<td>The date from which this assignment information is effective</td>
</tr>
<tr>
<td>ASG_DATE_TO</td>
<td>The date to which this assignment information is effective</td>
</tr>
<tr>
<td>ASG_EMPLOYMENT_CATEGORY</td>
<td>The employment category for the assignment</td>
</tr>
<tr>
<td>ASG_END_TIME</td>
<td>The standard end time for the assignment</td>
</tr>
<tr>
<td>ASG_FREQ</td>
<td>The frequency for which the assignment working hours are measured</td>
</tr>
<tr>
<td>ASGGRADE</td>
<td>The employee’s grade</td>
</tr>
<tr>
<td>ASG_GRADE_DATE_FROM</td>
<td>The date from which this assignment grade information is effective</td>
</tr>
<tr>
<td>ASG_GRADE_DATE_TO</td>
<td>The date to which this assignment grade information is effective</td>
</tr>
</tbody>
</table>

Table C – 2
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_GROUP</td>
<td>The employee’s group</td>
</tr>
<tr>
<td>ASG_HOURS</td>
<td>The standard number of working hours for the assignment</td>
</tr>
<tr>
<td>ASG_INT_ADDR_LINE</td>
<td>The internal address of the assignment</td>
</tr>
<tr>
<td>ASG_JOB</td>
<td>The employee’s job</td>
</tr>
<tr>
<td>ASG_JOB_DATE_FROM</td>
<td>The date from which this assignment job information is effective</td>
</tr>
<tr>
<td>ASG_JOB_DATE_TO</td>
<td>The date to which this assignment job information is effective</td>
</tr>
<tr>
<td>ASG_LAST_CHANGE_REASON</td>
<td>The reason the salary was changed</td>
</tr>
<tr>
<td>ASG_LAST_PERFORMANCE_DATE</td>
<td>Last performance review date</td>
</tr>
<tr>
<td>ASG_LAST_PERFORMANCE_LOCATION</td>
<td>Last performance review location</td>
</tr>
<tr>
<td>ASG_LAST_PERFORMANCE_RATING</td>
<td>Last performance review rating</td>
</tr>
<tr>
<td>ASG_LAST_PERFORMANCE_TYPE</td>
<td>Last performance review type</td>
</tr>
<tr>
<td>ASG_LAST_PROC_PAYROLL_NAME</td>
<td>The payroll name the assignment was last processed</td>
</tr>
<tr>
<td>ASG_LAST_PROC_PERIOD_ID</td>
<td>The time period ID the assignment was last processed</td>
</tr>
<tr>
<td>ASG_LAST_PROC_PERIOD_NAME</td>
<td>The period name the assignment was last processed</td>
</tr>
<tr>
<td>ASG_LAST_PROC_PERIOD_NUMBER</td>
<td>The period number the assignment was last processed</td>
</tr>
<tr>
<td>ASG_LAST_PROPOSED_SALARY_CHANGE</td>
<td>The proposed salary change</td>
</tr>
<tr>
<td>ASG_LAST_PROPOSED_SALARY_PERCENT</td>
<td>The proposed salary change as a percentage</td>
</tr>
<tr>
<td>ASG_LAST_SALARY_CHANGE_APPROVED</td>
<td>Whether the last proposed salary change has been approved</td>
</tr>
<tr>
<td>ASG_LAST_SALARY_DATE</td>
<td>The last salary change date</td>
</tr>
<tr>
<td>ASG_LOCATION</td>
<td>The employee’s location</td>
</tr>
<tr>
<td>ASG_LOC_INACTIVE_DATE</td>
<td>The date to which the location information is effective</td>
</tr>
</tbody>
</table>

Table C – 2
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_MANAGER</td>
<td>Whether the assignment is a managerial assignment (yes/no)</td>
</tr>
<tr>
<td>ASG_NEXT_PERFORMANCE_DATE</td>
<td>Next performance review date</td>
</tr>
<tr>
<td>ASG_NEXT_SALARY_DATE</td>
<td>The date of the next salary change</td>
</tr>
<tr>
<td>ASG_NUMBER</td>
<td>The assignment number</td>
</tr>
<tr>
<td>ASG_ORG</td>
<td>The employee’s organization</td>
</tr>
<tr>
<td>ASG_ORG_DATE_FROM</td>
<td>The date from which assignment organization information is effective</td>
</tr>
<tr>
<td>ASG_ORG_DATE_TO</td>
<td>The date to which assignment organization information is effective</td>
</tr>
<tr>
<td>ASG_PAYROLL</td>
<td>The employee’s payroll</td>
</tr>
<tr>
<td>ASG_PERFORMANCE_REVIEW_FREQUENCY</td>
<td>The performance review frequency for the assignment</td>
</tr>
<tr>
<td>ASG_PERFORMANCE_REVIEW_PERIOD</td>
<td>The performance review frequency for the assignment</td>
</tr>
<tr>
<td>ASG_PER_STATUS_DP</td>
<td>Personal status for the assignment (as of Date Paid)</td>
</tr>
<tr>
<td>ASG_POSITION</td>
<td>The employee’s position</td>
</tr>
<tr>
<td>ASG_POS_DATE_FROM</td>
<td>The date from which this assignment position information is effective</td>
</tr>
<tr>
<td>ASG_POS_DATE_TO</td>
<td>The date to which this assignment position information is effective</td>
</tr>
<tr>
<td>ASG_POS_END_TIME</td>
<td>The standard end time for the assignment position</td>
</tr>
<tr>
<td>ASG_POS_FREQ</td>
<td>The frequency for which the assignment position’s hours is measured</td>
</tr>
<tr>
<td>ASG_POS_HOURS</td>
<td>The standard number of working hours for the position</td>
</tr>
<tr>
<td>ASG_POS_PROB_PERIOD</td>
<td>The probation period for the assignment position</td>
</tr>
</tbody>
</table>

Table C - 2
### Database Items

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_POS_START_TIME</td>
<td>The standard start time for the assignment position</td>
</tr>
<tr>
<td>ASG_PRIMARY</td>
<td>Whether this is the employee’s primary assignment (yes/no)</td>
</tr>
<tr>
<td>ASG_PROB_END_DATE</td>
<td>The probation period end date</td>
</tr>
<tr>
<td>ASG_PROB_PERIOD</td>
<td>The assignment’s probation period</td>
</tr>
<tr>
<td>ASG_PROB_UNITS</td>
<td>The units of the assignment’s probation period</td>
</tr>
<tr>
<td>ASG_REC_FULL_NAME</td>
<td>The full name for the recruiter</td>
</tr>
<tr>
<td>ASG_RELIEF</td>
<td>The relief position if the current position holder is absent</td>
</tr>
<tr>
<td>ASG_SALARY</td>
<td>The current salary for an employee</td>
</tr>
<tr>
<td>ASG_SALARY_BASIS</td>
<td>The payment basis (i.e. frequency) for the assignment, e.g. monthly</td>
</tr>
<tr>
<td>ASG_SALARY_BASIS_CODE</td>
<td>The payment basis lookup code for the assignment</td>
</tr>
<tr>
<td>ASG_SALARY_BASIS_NAME</td>
<td>The salary basis name for the assignment</td>
</tr>
<tr>
<td>ASG_SALARY_ELEMENT</td>
<td>The display element name</td>
</tr>
<tr>
<td>ASG_SALARY_ELEMENT_VALUE_NAME</td>
<td>The display input value name</td>
</tr>
<tr>
<td>ASG_SALARY_GRADE_RATE</td>
<td>The display rate name</td>
</tr>
<tr>
<td>ASG_SALARY_RATE_BASIS</td>
<td>The salary rate basis</td>
</tr>
<tr>
<td>ASG_SALARY_REVIEW_FREQUENCY</td>
<td>The salary review frequency for the assignment</td>
</tr>
<tr>
<td>ASG_SALARY_REVIEW_PERIOD</td>
<td>The salary review period for the assignment</td>
</tr>
<tr>
<td>ASG_START_DATE</td>
<td>The start date of the assignment</td>
</tr>
<tr>
<td>ASG_START_TIME</td>
<td>The standard start time for the assignment</td>
</tr>
<tr>
<td>ASG_STATUS</td>
<td>The primary status for the assignment</td>
</tr>
<tr>
<td>ASG_SUCCESSOR</td>
<td>The position name that will succeed into this position</td>
</tr>
</tbody>
</table>

Table C – 2
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_SUP_FULL_NAME</td>
<td>The full name for the supervisor</td>
</tr>
<tr>
<td>ASG_TYPE</td>
<td>Whether this is an employee or applicant assignment</td>
</tr>
<tr>
<td>ASG_VACANCY</td>
<td>The name of the vacancy applied for</td>
</tr>
</tbody>
</table>

Table C - 2
## Contact Addresses

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CON_ADR_CITY</td>
<td>The name of the contact’s town or city</td>
</tr>
<tr>
<td>CON_ADR_COUNTRY</td>
<td>The name of the contact’s country</td>
</tr>
<tr>
<td>CON_ADR_DATE_FROM</td>
<td>The first date on which the contact can be contacted</td>
</tr>
<tr>
<td>CON_ADR_DATE_TO</td>
<td>The last date on which the contact can be contacted</td>
</tr>
<tr>
<td>CON_ADR_LINE_1</td>
<td>The first line of the contact’s address</td>
</tr>
<tr>
<td>CON_ADR_LINE_2</td>
<td>The second line of the contact’s address</td>
</tr>
<tr>
<td>CON_ADR_LINE_3</td>
<td>The third line of the contact’s address</td>
</tr>
<tr>
<td>CON_ADR_PHONE_1</td>
<td>The contact’s first telephone number</td>
</tr>
<tr>
<td>CON_ADR_PHONE_2</td>
<td>The contact’s second telephone number</td>
</tr>
<tr>
<td>CON_ADR_PHONE_3</td>
<td>The contact’s third telephone number</td>
</tr>
<tr>
<td>CON_ADR_POSTAL_CODE</td>
<td>The contact’s postal code</td>
</tr>
<tr>
<td>CON_ADR_REGION_1</td>
<td>The first line of the contact’s region</td>
</tr>
<tr>
<td>CON_ADR_REGION_2</td>
<td>The second line of the contact’s region</td>
</tr>
<tr>
<td>CON_ADR_REGION_3</td>
<td>The third line of the contact’s region</td>
</tr>
</tbody>
</table>

Table C – 3
### Contact Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CON_AGE</td>
<td>The contact’s age</td>
</tr>
<tr>
<td>CON_APP_NUMBER</td>
<td>The contact’s applicant number</td>
</tr>
<tr>
<td>CON_CURRENT_APP</td>
<td>Whether the contact is a current applicant (yes/no)</td>
</tr>
<tr>
<td>CON_CURRENT_EMP</td>
<td>Whether the contact is a current employee (yes/no)</td>
</tr>
<tr>
<td>CON_DATE_OF_BIRTH</td>
<td>The contact’s date of birth</td>
</tr>
<tr>
<td>CON_DISABLED</td>
<td>Whether the contact is disabled (yes/no)</td>
</tr>
<tr>
<td>CON_EMP_NUMBER</td>
<td>The contact’s employee number</td>
</tr>
<tr>
<td>CON_END_DATE</td>
<td>The date to which this contact information is effective</td>
</tr>
<tr>
<td>CON_FIRST_NAME</td>
<td>The contact’s first name</td>
</tr>
<tr>
<td>CON_FULL_NAME</td>
<td>The contact’s full name</td>
</tr>
<tr>
<td>CONKNOWN_NAME</td>
<td>The contact’s preferred name</td>
</tr>
<tr>
<td>CON_LAST_NAME</td>
<td>The contact’s last name</td>
</tr>
<tr>
<td>CON_MARITAL_STATUS</td>
<td>The contact’s marital status</td>
</tr>
<tr>
<td>CON_MIDDLE_NAMES</td>
<td>The contact’s middle names</td>
</tr>
<tr>
<td>CON_NATIONALITY</td>
<td>The contact’s nationality</td>
</tr>
<tr>
<td>CON_PERSON_TYPE</td>
<td>The contact’s person type – employee or applicant, for example</td>
</tr>
<tr>
<td>CON_RELATIONSHIP</td>
<td>The relationship of the contact to the employee</td>
</tr>
<tr>
<td>CON SEX</td>
<td>The contact’s sex</td>
</tr>
<tr>
<td>CON_START_DATE</td>
<td>The date from which this contact information is effective</td>
</tr>
</tbody>
</table>

Table C – 4
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CON_TITLE</td>
<td>The contact’s title</td>
</tr>
<tr>
<td>CON_WORK_PHONE</td>
<td>The contact’s work telephone number</td>
</tr>
</tbody>
</table>

Table C – 4
### Employee Hire Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMP_HIRE_DATE</td>
<td>The employee’s hire date</td>
</tr>
<tr>
<td>EMP_LAST_PROCESS_DATE</td>
<td>The date the employee was last processed</td>
</tr>
<tr>
<td>EMP_LEAVING_REASON</td>
<td>The reason the employee left</td>
</tr>
<tr>
<td>EMP_TERM_ACCEPTED_BY</td>
<td>The person who accepted the employee’s notice</td>
</tr>
<tr>
<td>EMP_TERM_DATE</td>
<td>The employee’s termination date</td>
</tr>
</tbody>
</table>

Table C – 5

### Location Details

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC_ADR_LINE_1</td>
<td>The first line of the assignment’s work address</td>
</tr>
<tr>
<td>LOC_ADR_LINE_2</td>
<td>The second line of the assignment’s work address</td>
</tr>
<tr>
<td>LOC_ADR_LINE_3</td>
<td>The third line of the assignment’s work address</td>
</tr>
<tr>
<td>LOC_ADR_POSTAL_CODE</td>
<td>The postal code for the assignment’s work address</td>
</tr>
<tr>
<td>LOC_ADR_REGION_1</td>
<td>The first line of the assignment’s region</td>
</tr>
<tr>
<td>LOC_ADR_REGION_2</td>
<td>The second line of the assignment’s region</td>
</tr>
<tr>
<td>LOC_ADR_REGION_3</td>
<td>The third line of the assignment’s region</td>
</tr>
<tr>
<td>LOC_ADR_PHONE_1</td>
<td>The assignment’s first work telephone number</td>
</tr>
<tr>
<td>LOC_ADR_PHONE_2</td>
<td>The assignment’s second work telephone number</td>
</tr>
<tr>
<td>LOC_ADR_PHONE_3</td>
<td>The assignment’s third work telephone number</td>
</tr>
</tbody>
</table>

Table C – 6
### Database Items

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC_ADR_CITY</td>
<td>The town or city where the assignment works</td>
</tr>
<tr>
<td>LOC_ADR_COUNTRY</td>
<td>The country where the assignment works</td>
</tr>
</tbody>
</table>

#### Work Address Details (US only)

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC_ADR_US_COUNTY</td>
<td>The assignment’s work county (US only)</td>
</tr>
<tr>
<td>LOC_ADR_US_STATE</td>
<td>The assignment’s work state (US only)</td>
</tr>
<tr>
<td>LOC_ADR_US_STATE_CODE</td>
<td>The assignment’s work state code (US only)</td>
</tr>
</tbody>
</table>

#### Work Address Details (UK only)

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC_ADR_UK_COUNTY</td>
<td>The assignment’s work county (UK only)</td>
</tr>
</tbody>
</table>
## Payroll Details

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAY_PERIODS_PER_YEAR</td>
<td>The number of pay periods in the year</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_CUT_OFF_DATE</td>
<td>The cut off date for the payroll period</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_DATE_PAID</td>
<td>The date the payroll was paid</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_DIRECT_DEPOSIT_DATE</td>
<td>The direct deposit date for the payroll period</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_END_DATE</td>
<td>The end date of the payroll period</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_ID</td>
<td>The ID of the time period for the payroll</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_NAME</td>
<td>The period name for the payroll</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_NUMBER</td>
<td>The current period number for the payroll</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_PAY_ADVICE_DATE</td>
<td>The pay advice date for the payroll period</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_START_DATE</td>
<td>The start date of the payroll period</td>
</tr>
</tbody>
</table>

Table C – 9
People Addresses

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_ADR_CITY</td>
<td>The name of the person's town or city</td>
</tr>
<tr>
<td>PER_ADR_COUNTRY</td>
<td>The name of the person’s country</td>
</tr>
<tr>
<td>PER_ADR_DATE_FROM</td>
<td>The first date on which the person can be contacted at this address</td>
</tr>
<tr>
<td>PER_ADR_DATE_TO</td>
<td>The last date on which the person can be contacted at this address</td>
</tr>
<tr>
<td>PER_ADR_LINE_1</td>
<td>The first line of the person’s address</td>
</tr>
<tr>
<td>PER_ADR_LINE_2</td>
<td>The second line of the person’s address</td>
</tr>
<tr>
<td>PER_ADR_LINE_3</td>
<td>The third line of the person’s address</td>
</tr>
<tr>
<td>PER_ADR_PHONE_1</td>
<td>The person’s first contact number</td>
</tr>
<tr>
<td>PER_ADR_PHONE_2</td>
<td>The person’s second contact number</td>
</tr>
<tr>
<td>PER_ADR_PHONE_3</td>
<td>The person’s third contact number</td>
</tr>
<tr>
<td>PER_ADR_POSTAL_CODE</td>
<td>The person’s postal code</td>
</tr>
<tr>
<td>PER_ADR_REGION_1</td>
<td>The first line of the person’s region</td>
</tr>
<tr>
<td>PER_ADR_REGION_2</td>
<td>The second line of the person’s region</td>
</tr>
<tr>
<td>PER_ADR_REGION_3</td>
<td>The third line of the person’s region</td>
</tr>
</tbody>
</table>

Table C – 10

Home Address Details (US only)

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_ADR_US_COUNTY</td>
<td>The person’s county (US only)</td>
</tr>
<tr>
<td>PER_ADR_US_STATE</td>
<td>The person’s state (US only)</td>
</tr>
<tr>
<td>PER_ADR_US_STATE_CODE</td>
<td>The person’s state code (US only)</td>
</tr>
</tbody>
</table>

Table C – 11
Home Address Details (UK only)

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_ADR_UK_COUNTY</td>
<td>The person's home county (UK only)</td>
</tr>
</tbody>
</table>

Table C – 12
## People Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_AGE</td>
<td>The person’s age</td>
</tr>
<tr>
<td>PER_APPLICANT_NUMBER</td>
<td>The person’s applicant number</td>
</tr>
<tr>
<td>PER_CURRENT_APP</td>
<td>Whether the person is a current applicant (yes/no)</td>
</tr>
<tr>
<td>PER_CURRENT_EMP</td>
<td>Whether the person is a current employee (yes/no)</td>
</tr>
<tr>
<td>PER_DATE_OF_BIRTH</td>
<td>The person’s date of birth</td>
</tr>
<tr>
<td>PER_DATE_VERIFIED</td>
<td>The date the employee last verified his or her personal data</td>
</tr>
<tr>
<td>PER_DISABLED</td>
<td>Whether the person is disabled (yes/no)</td>
</tr>
<tr>
<td>PER_EMP_NUMBER</td>
<td>The person’s employee number</td>
</tr>
<tr>
<td>PER_FIRST_NAME</td>
<td>The person’s first name</td>
</tr>
<tr>
<td>PER_FULL_NAME</td>
<td>The person’s full name</td>
</tr>
<tr>
<td>PER_KNOWN_AS</td>
<td>The person’s preferred name</td>
</tr>
<tr>
<td>PER_LAST_NAME</td>
<td>The person’s last name</td>
</tr>
<tr>
<td>PER_MAIL_DESTINATION</td>
<td>The person’s mail destination</td>
</tr>
<tr>
<td>PER_MARITAL_STATUS</td>
<td>The person’s marital status</td>
</tr>
<tr>
<td>PER_MIDDLE_NAMES</td>
<td>The person’s middle names</td>
</tr>
<tr>
<td>PER_NATIONALITY</td>
<td>The person’s nationality</td>
</tr>
<tr>
<td>PER_NATIONAL_IDENTIFIER</td>
<td>The person’s national identifier</td>
</tr>
<tr>
<td>PER_PERSON_TYPE</td>
<td>Type of person – employee or applicant, for example</td>
</tr>
<tr>
<td>PER_PREV_LAST_NAME</td>
<td>The person’s previous last name</td>
</tr>
<tr>
<td>PER_SEND_EXPENSES</td>
<td>Where to send the person’s expenses (home/office)</td>
</tr>
<tr>
<td>PER_SEX</td>
<td>The person’s sex</td>
</tr>
</tbody>
</table>

Table C – 13
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_TITLE</td>
<td>The person’s title</td>
</tr>
<tr>
<td>PER_WORK_PHONE</td>
<td>The person’s work telephone number</td>
</tr>
</tbody>
</table>

Table C – 13
## Recruiter Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>REC_CURRENT_APP</td>
<td>Whether the recruiter is a current applicant (yes/no)</td>
</tr>
<tr>
<td>REC_CURRENT_EMP</td>
<td>Whether the recruiter is a current employee (yes/no)</td>
</tr>
<tr>
<td>REC_EMP_NUMBER</td>
<td>The recruiter’s employee number</td>
</tr>
<tr>
<td>REC_GRADE</td>
<td>The recruiter’s grade</td>
</tr>
<tr>
<td>REC_INT_ADDR_LINE</td>
<td>The recruiter’s internal address</td>
</tr>
<tr>
<td>REC_JOB</td>
<td>The recruiter’s job</td>
</tr>
<tr>
<td>REC_LOCATION</td>
<td>The recruiter’s work location</td>
</tr>
<tr>
<td>REC_MANAGER</td>
<td>Whether the assignment is a managerial assignment (yes/no)</td>
</tr>
<tr>
<td>REC_ORG</td>
<td>The name of the recruiter’s organization</td>
</tr>
<tr>
<td>REC_PERSON_TYPE</td>
<td>The recruiter’s person type – employee or applicant, for example</td>
</tr>
<tr>
<td>RECPOSITION</td>
<td>The recruiter’s position</td>
</tr>
<tr>
<td>REC_WORK_PHONE</td>
<td>The recruiter’s work telephone number</td>
</tr>
</tbody>
</table>

Table C – 14
### Supervisor Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUP_CURRENT_EMP</td>
<td>Whether the supervisor is a current employee (yes/no)</td>
</tr>
<tr>
<td>SUP_DATE_FROM</td>
<td>The date from which this supervisor information is effective</td>
</tr>
<tr>
<td>SUP_DATE_TO</td>
<td>The date to which this supervisor information is effective</td>
</tr>
<tr>
<td>SUP_EMP_NUMBER</td>
<td>The supervisor’s employee number</td>
</tr>
<tr>
<td>SUP_GRADE</td>
<td>The supervisor’s grade</td>
</tr>
<tr>
<td>SUP_INT_ADDR_LINE</td>
<td>The supervisor’s internal address</td>
</tr>
<tr>
<td>SUP_JOB</td>
<td>The supervisor’s job</td>
</tr>
<tr>
<td>SUP_LOCATION</td>
<td>The supervisor’s work location</td>
</tr>
<tr>
<td>SUP_MANAGER</td>
<td>Whether the assignment is a managerial assignment (yes/no)</td>
</tr>
<tr>
<td>SUP_ORG</td>
<td>The supervisor’s organization</td>
</tr>
<tr>
<td>SUP_PERSON_TYPE</td>
<td>The supervisor’s person type</td>
</tr>
<tr>
<td>SUP_POSITION</td>
<td>The supervisor’s position</td>
</tr>
<tr>
<td>SUP_WORK_PHONE</td>
<td>The supervisor’s work telephone number</td>
</tr>
</tbody>
</table>

Table C – 15

### Date Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SESSION_DATE</td>
<td>The effective date from FND_SESSIONS</td>
</tr>
<tr>
<td>SYSDATE</td>
<td>The system date</td>
</tr>
</tbody>
</table>

Table C – 16
Dynamic Database Items

Dynamic database items are created by Oracle HRMS processes whenever you define new elements or other related entities.

Element Database Items

When you define a new element, Oracle HRMS runs a process to create a number of related database items for it. To ensure easy recognition of these items, the process adds the element name `<ENAME>` to each one. It also creates further database items for each pay and input value you use `<INAME>`.

Here is a list of database items created each time you define an element using the Element window:

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ENAME&gt;_BEN_CLASS</code></td>
<td>The element’s benefit classification</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_CLASSIFICATION</code></td>
<td>The element’s classification</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_CLOSED_FOR_ENTRY</code></td>
<td>Yes/no flag: if yes, the element’s entries cannot be modified</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_CLOSED_FOR_ENTRY_CODE</code></td>
<td>Yes/no flag: if yes, the element’s entries cannot be modified</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_COSTABLE_TYPE</code></td>
<td>The element’s costable type (from lookup table)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_COSTABLE_TYPE_CODE</code></td>
<td>The element’s costable type (code values)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_COUNT</code></td>
<td>The element entry count</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_END_DATE</code></td>
<td>The date to which this element is effective</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_INPUT_CURRENCY_CODE</code></td>
<td>The element’s input currency code</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_LENGTH_OF_SERVICE</code></td>
<td>The element’s qualifying length of service</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_OUTPUT_CURRENCY_CODE</code></td>
<td>The element’s output currency code</td>
</tr>
</tbody>
</table>

Table C – 17
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ENAME&gt;_PROCESSING_PRIORITY</code></td>
<td>The element’s processing priority</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_QUALIFYING_AGE</code></td>
<td>The element’s qualifying age</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_QUALIFYING_UNITS_CODE</code></td>
<td>The qualifying length of service units (code values)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_QUALIFYING_UNITS</code></td>
<td>The qualifying length of service units (from lookup table)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_REPORTING_NAME</code></td>
<td>The element’s reporting name</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_STANDARD_LINK</code></td>
<td>Yes/no flag: yes = standard, no = discretionary</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_STANDARD_LINK_CODE</code></td>
<td>Yes/no flag: yes = standard, no = discretionary</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_UNIT_OF_MEASURE</code></td>
<td>The element’s unit of measure (from lookup table)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_UNIT_OF_MEASURE_CODE</code></td>
<td>The element’s unit of measure (code values)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_DEFAULT</code></td>
<td>The element’s default input value</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_MIN</code></td>
<td>The element’s minimum input value</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_MAX</code></td>
<td>The element’s maximum input value</td>
</tr>
</tbody>
</table>

Table C – 17

In addition to the items above, Oracle HRMS creates the following four items for elements defined with multiple entries not allowed:

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_ENTRY_VALUE</code></td>
<td>The element value</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_USER_ENTERED_CODE</code></td>
<td>Whether a value exists at the element entry level (yes/no)</td>
</tr>
</tbody>
</table>

Table C – 18
In addition to the common list above, Oracle HRMS creates the following item for elements defined with multiple entries allowed whose input values are numeric (that is, hours, integer, money or number).

The units for `<ENAME> <INAME> ENTRY VALUE` are generated for both recurring and nonrecurring elements and are user-definable. Oracle HRMS modifies the definition text to retrieve the entry value in the unit of measure as specified in the ‘pay_input_values_f’ table.
Grade Rate Database Items

When you define a grade rate, Oracle HRMS runs a process to create a number of related database items for it. To ensure easy recognition of these items, the process adds the grade rate name <NAME> to each one.

Here is a list of database items created each time you define a grade rate using the Grade Rate window:

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRADE_&lt;NAME&gt;_VALUE</td>
<td>The grade rate’s value</td>
</tr>
<tr>
<td>GRADE_&lt;NAME&gt;_MINIMUM</td>
<td>The grade rate’s minimum value</td>
</tr>
<tr>
<td>GRADE_&lt;NAME&gt;_MAXIMUM</td>
<td>The grade rate’s maximum value</td>
</tr>
</tbody>
</table>

Table C – 20

Pay Scale Rate Database Items

When you define a pay scale rate, Oracle HRMS runs a process to create the following database item for it. To ensure easy recognition of this item, the process adds the rate name <NAME> to it.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPINE_&lt;NAME&gt;_VALUE</td>
<td>The pay scale rates value</td>
</tr>
</tbody>
</table>

Table C – 21
### Descriptive Flexfield Database Items

When you define descriptive flexfield segments you make them available for use in QuickPaint by running the Create Descriptive Flexfield DB Items process from the Submit Requests window. This process creates database items for each of the descriptive flexfields listed below.

To ensure easy recognition of these items, the process adds the descriptive flexfield segment name `<SEGMENT_NAME>` to each one.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PEOPLE_&lt;SEGMENT_NAME&gt;</td>
<td>People descriptive flexfield database items</td>
</tr>
<tr>
<td>PAYROLLS_&lt;SEGMENT_NAME&gt;</td>
<td>Payroll descriptive flexfield database items</td>
</tr>
<tr>
<td>ASSIGNMENTS_&lt;SEGMENT_NAME&gt;</td>
<td>Assignment descriptive flexfield database items</td>
</tr>
<tr>
<td>GRADES_&lt;SEGMENT_NAME&gt;</td>
<td>Grade descriptive flexfield database items</td>
</tr>
<tr>
<td>ABSENCES_&lt;SEGMENT_NAME&gt;</td>
<td>Absence descriptive flexfield database items</td>
</tr>
<tr>
<td>ABSENCE_TYPES_&lt;SEGMENT_NAME&gt;</td>
<td>Absence type descriptive flexfield database items</td>
</tr>
<tr>
<td>PERSON_ADDRESSES_&lt;SEGMENT_NAME&gt;</td>
<td>Person Address descriptive flexfield database items</td>
</tr>
<tr>
<td>EVENTS_&lt;SEGMENT_NAME&gt;</td>
<td>Events descriptive flexfield database items</td>
</tr>
<tr>
<td>JOBS_&lt;SEGMENT_NAME&gt;</td>
<td>Jobs descriptive flexfield database items</td>
</tr>
<tr>
<td>CONTACTS_&lt;SEGMENT_NAME&gt;</td>
<td>Contacts descriptive flexfield database items</td>
</tr>
<tr>
<td>PERIODS_OF_SERVICE_&lt;SEGMENT_NAME&gt;</td>
<td>Periods of Service descriptive flexfield database items</td>
</tr>
<tr>
<td>RECRUITMENT_ACTIVITIES_&lt;SEGMENT_NAME&gt;</td>
<td>Recruitment Activities descriptive flexfield database items</td>
</tr>
<tr>
<td>POSITION_&lt;SEGMENT_NAME&gt;</td>
<td>Position descriptive flexfield database items</td>
</tr>
</tbody>
</table>

Table C – 22
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPLICATIONS_&lt;SEGMENT_NAME&gt;</td>
<td>Applications descriptive flexfield database items</td>
</tr>
<tr>
<td>ORGANIZATION_&lt;SEGMENT_NAME&gt;</td>
<td>Organization descriptive flexfield database items</td>
</tr>
</tbody>
</table>

Table C – 22
Key Flexfield Database Items

When you define key flexfield segments you make them available for use in QuickPaint by running the Create Key Flexfield DB Items process from the Submit Requests window. This process creates database items for each of the key flexfields listed below.

To ensure easy recognition of these items, the process adds the key flexfield segment name `<SEGMENT_NAME>` to each one.

Run this process for each of your Business Groups. If you define context-dependent key flexfield structures using BUSINESS_GROUP_ID as the reference field, the process creates database items for those flexfield segments as well. BUSINESS_GROUP_ID is the only reference field that the Create Key Flexfield DB Items process supports.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRADE_KF_&lt;SEGMENT_NAME&gt;</td>
<td>Grade key flexfield database items</td>
</tr>
<tr>
<td>JOB_KF_&lt;SEGMENT_NAME&gt;</td>
<td>Job key flexfield database items</td>
</tr>
<tr>
<td>POS_KF_&lt;SEGMENT_NAME&gt;</td>
<td>Position key flexfield database items</td>
</tr>
<tr>
<td>GROUP_KF_&lt;SEGMENT_NAME&gt;</td>
<td>Group key flexfield database items</td>
</tr>
</tbody>
</table>

Table C – 23
Absence Database Items

When you define an absence type, Oracle HRMS runs a process to create the following database item for it. To ensure easy recognition of this item, the process adds the absence type name `<ABSENCE_NAME>` to it.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ABSENCE_NAME&gt;_CUM_BALANCE</code></td>
<td>The cumulative balance for an absence type</td>
</tr>
</tbody>
</table>

Table C – 24
Glossary

A

Absence Types  Categories of absence, such as medical leave or vacation leave, that you define for use in absence windows.

Alternative Regions  Parts of a window that appear in a stack so that only one is visible at any time. You click on the name of the region to pop up a list of the other regions in the stack. Select the name of a region to bring it to the top of the stack.

Applicant  A candidate for employment in a Business Group.

Appraisal  A ‘superset’ of recording opinions and setting and achieving objectives, plans and so on. See also: Assessment.

Arrestment  Scottish court order made out for unpaid debts or maintenance payments. See also: Court Order.

Assessment  An information gathering exercise, from one or many sources, to evaluate a person’s ability to do a job. See also: Appraisal.

Assignment  An employee’s assignment identifies his or her role and payroll within a Business Group. The assignment is made up of a number of assignment components. Of these, organization is mandatory, and payroll is a required component for payment purposes.

Assignment Number  A number that uniquely identifies an employee’s assignment. An employee with multiple assignments has multiple assignment numbers.

Assignment Set  A grouping of employees and/or applicants that you define for running QuickPaint reports and processing payrolls. See also: QuickPaint Report.

Assignment Status  For employees, used to track their permanent or temporary departures from your enterprise, and to control the remuneration they receive. For applicants, used to track the progress of their applications.
BACS  Banks Automated Clearing System.  This is the UK system for making direct deposit payments to employees.

Balances  Positive or negative accumulations of values over periods of time normally generated by payroll runs. A balance can sum pay values, time periods or numbers. See also: Predefined Components

Balance Adjustment  A correction you make to a balance. You can adjust user balances and assignment level predefined balances only.

Balance Dimension  The period for which a balance sums its balance feeds, or the set of assignments/transactions for which it sums them. There are five time dimensions: Run, Period, Quarter, Year and User. You can choose any reset point for user balances.

Balance Feeds  These are the input values of matching units of measure of any elements defined to feed the balance.

Base Currency  The currency in which Oracle Payroll performs all payroll calculations for your Business Group. If you pay employees in different currencies to this, Oracle Payroll calculates the amounts based on exchange rates defined on the system.

Behavioral Indicators  Characteristics that identify how a competence is exhibited in the work context. See also: Proficiency Level

Benefit  Any part of an employee’s remuneration package that is not pay. Vacation time, employer-paid medical insurance and stock options are all examples of benefits. See also: Elements

Block  The largest subordinate unit of a window, containing information for a specific business function or entity. Every window consists of at least one block. Blocks contain fields and, optionally, regions. They are delineated by a bevelled edge. You must save your entries in one block before navigating to the next. See also: Region, Field

Budget Value  In Oracle Human Resources you can enter staffing budget values and actual values for each assignment to measure variances between actual and planned staffing levels in an organization or hierarchy.

Business Group  The highest level organization in the Oracle HRMS system. A Business Group may correspond to the whole of your enterprise or to a major grouping such as a subsidiary or operating division. Each Business Group must correspond to a separate implementation of Oracle HRMS.

C

Calendars  In Oracle Human Resources you define calendars that determine the start and end dates for budgetary years, quarters and periods. For each calendar you select a basic period type. In Oracle SSP/SMP you define calendars to determine the start date and time for SSP qualifying patterns.
Calendar Exceptions  In Oracle SSP/SMP you define calendar exceptions for an SSP qualifying pattern, to override the pattern on given days. Each calendar exception is another pattern which overrides the usual pattern.

Career Map  A plan showing the expected routes by which employees can progress from one job to another within the Business Group.

Cash Analysis  A specification of the different currency denominations required for paying your employees in cash. Union contracts may require you to follow certain cash analysis rules.

Compensation  The pay you give to employees, including wages or salary, and bonuses. See also: Elements

Competence  Any measurable behavior required by an organization, job or position that a person may demonstrate in the work context. A competence can be a piece of knowledge, a skill, an attitude or an attribute.

Competence Profile  Where you record applicant and employee accomplishments, for example, proficiency in a competence.

Competence Requirements  Competencies required by an organization, job or position. See also: Competence, Core Competencies

Competence Type  A group of related competencies

Consolidation Set  A grouping of payroll runs within the same time period for which you can schedule reporting, costing, and post–run processing.

Contact  A person who has a relationship to an employee that you want to record. Contacts can be dependents, relatives, partners or persons to contact in an emergency.

Core Competencies  Competencies required by every person to enable the enterprise to meet its goals. See also: Competence

Costable Type  A feature that determines the processing an element receives for accounting and costing purposes. There are four costable types in Oracle HRMS: costed, distributed costing, fixed costing, and not costed.

Costing  Recording the costs of an assignment for accounting or reporting purposes. Using Oracle Payroll, you can calculate and transfer costing information to your general ledger and into systems for project management or labor distribution.

Court Order  A ruling from a court that requires an employer to make deductions from an employee’s salary for maintenance payments or debts, and to pay the sums deducted to a court or local authority. See also: Arrestment

Customizable Forms  Forms that your system administrator can modify for ease of use or security purposes by means of Custom Form restrictions. The Form Customization window lists the forms and their methods of customization.
D

**Database Item**  An item of information in Oracle HRMS that has special programming attached, enabling Oracle FastFormula to locate and retrieve it for use in formulas.

**Date To and Date From**  These fields are used in windows not subject to DateTrack. The period you enter in these fields remains fixed until you change the values in either field. See also: *DateTrack, Effective Date*

**DateTrack**  When you change your effective date (either to past or future), DateTrack enables you to enter information that takes effect on your new effective date, and to review information as of the new date. See also: *Effective Date*

**Deployment Factors**  See: *Work Choices*

**Descriptive Flexfield**  A field that your organization can customize to capture additional information required by your business but not otherwise tracked by Oracle Applications. See also: *Key Flexfield*

E

**Effective Date**  The date for which you are entering and viewing information. You set your effective date in the Alter Effective Date window. See also: *DateTrack*

**Elements**  Components in the calculation of employee pay. Each element represents a compensation or benefit type, such as salary, wages, stock purchase plans, and pension contributions.

**Element Classifications**  These control the order in which elements are processed and the balances they feed. Primary element classifications and some secondary classifications are predefined by Oracle Payroll. Other secondary classifications can be created by users.

**Element Entry**  The record controlling an employee’s receipt of an element, including the period of time for which the employee receives the element and its value. See also: *Recurring Elements, Nonrecurring Elements*

**Element Link**  The association of an element to one or more components of an employee assignment. The link establishes employee eligibility for that element. Employees whose assignment components match the components of the link are eligible for the element. See also: *Standard Link*

**Element Set**  A group of elements that you define to process in a payroll run, or to control access to compensation information from a customized form, or for distributing costs.


**Event**  An activity such as a training day, review, or meeting, for employees or applicants.

**Expected Week of Confinement (EWC)**  The week in which an employee’s baby is due. The Sunday of the expected week of confinement is used in the calculations for Statutory Maternity Pay (SMP).

F

**Field**  A view or entry area in a window where you enter, view, update, or delete information. See also: *Block, Region*

**Form**  A predefined grouping of functions, called from a menu and displayed, if necessary, on several windows. Forms have blocks, regions and fields as their components. See also: *Block, Region, Field*
G

Global Value A value you define for any formula to use. Global values can be dates, numbers or text.

Grade A component of an employee’s assignment that defines their level and can be used to control the value of their salary and other compensation elements.

Grade Comparison A comparison of the amount of compensation an employee receives with the mid-point of the valid values defined for his or her grade.

Grade Rate A value or range of values defined as valid for a given grade. Used for validating employee compensation entries.

Grade Scale A sequence of steps valid for a grade, where each step corresponds to one point on a pay scale. You can place each employee on a point of their grade scale and automatically increment all placements each year, or as required. See also: Pay Scale

Grade Step An increment on a grade scale. Each grade step corresponds to one point on a pay scale. See also: Grade Scale

Group A component that you define, using the People Group key flexfield, to assign employees to special groups such as pension plans or unions. You can use groups to determine employees’ eligibility for certain elements, and to regulate access to payrolls.

H

Hierarchy An organization or position structure showing reporting lines or other relationships. You can use hierarchies for reporting and for controlling access to Oracle HRMS information.

I

Input Values Values you define to hold information about elements. In Oracle Payroll, input values are processed by formulas to calculate the element’s run result. You can define up to fifteen input values for an element.

K

Key Flexfield A flexible data field made up of segments. Each segment has a name you define and a set of valid values you specify. Used as the key to uniquely identify an entity, such as jobs, positions, grades, cost codes, and employee groups. See also: Descriptive Flexfield

Leaver’s Statement Records details of Statutory Sick Pay (SSP) paid during a previous employment (issued as form SSP1L) which is used to calculate a new employee’s entitlement to SSP. If a new employee falls sick, and the last date that SSP was paid for under the previous employment is less than eight calendar weeks before the first day of the PIW for the current sickness, the maximum liability for SSP is reduced by the number of weeks of SSP shown on the statement.

Linking Interval The number of days that separate two periods of incapacity for work. If a period of incapacity for work (PIW) is separated from a previous PIW by less than the linking interval, they are treated as one PIW according to the legislation for entitlement to Statutory Sick Pay (SSP). An employee can only receive SSP for the maximum number of weeks defined in the legislation for one PIW.
Linked PIWs  Linked periods of incapacity for work are treated as one to calculate an employee’s entitlement to Statutory Sick Pay (SSP). A period of incapacity for work (PIW) links to an earlier PIW if it is separated by less than the linking interval. A linked PIW can be up to three years long.

Lower Earnings Limit (LEL)  The minimum average weekly amount an employee must earn to pay National Insurance contributions. Employees who do not earn enough to pay National Insurance cannot receive Statutory Sick Pay (SSP) or Statutory Maternity Pay (SMP).

Oracle FastFormula  An Oracle tool that allows you to write Oracle HRMS formulas without using a programming language.

Organization  A required component of employee assignments. You can define as many organizations as you want within your Business Group. Organizations can be internal, such as departments, or external, such as recruitment agencies. You can structure your organizations into organizational hierarchies for reporting purposes and for system access control.

Maternity Pay Period  The period for which Statutory Maternity Pay (SMP) is paid. It may start at any time from the start of the 11th week before the expected week of confinement and can continue for up to 18 weeks. The start date is usually agreed with the employee, but can start at any time up to the birth. An employee is not eligible to SMP for any week in which she works or for any other reason for ineligibility, defined by the legislation for SMP.

Menus  You set up your own navigation menus, to suit the needs of different users.

Nonrecurring Elements  Elements that process for one payroll period only unless you make a new entry for an employee. See also: Recurring Elements

Pay Scale  A set of progression points, which can be related to one or more rates of pay. Employee’s are placed on a particular point on the scale according to their grade and, usually, work experience. See also: Grade Scale

Payment Type  There are three standard payment types for paying employees: check, cash and direct deposit. You can define your own payment methods corresponding to these types.
Payroll  A group of employees that Oracle Payroll processes together with the same processing frequency, for example, weekly, monthly or bimonthly. Within a Business Group, you can set up as many payrolls as you need.

Performance (within Assessment)  An expectation of “normal” performance of a competence over a given period. For example, a person may exceed performance expectation in the communication competence. See also: Proficiency (within Assessment), Competence, Assessment

Period of Incapacity for Work (PIW)  A period of sickness that lasts four or more days in a row, and is the minimum amount of sickness for which Statutory Sick Pay can be paid. If a PIW is separated by less then the linking interval, a linked PIW is formed and the two PIWs are treated as one.

Period Type  A time division in a budgetary calendar, such as week, month, or quarter.

Person Type  There are eight system person types in Oracle HRMS. Seven of these are combinations of employees, ex–employees, applicants, and ex–applicants. The eighth category is ‘External’. You can create your own user person types based on the eight system types.

Position  A specific role within the Business Group derived from an organization and a job. For example, you may have a position of Shipping Clerk associated with the organization Shipping and the job Clerk.

Predefined Components  Some elements and balances, all primary element classifications and some secondary classifications are defined by Oracle Payroll to meet legislative requirements, and are supplied to users with the product. You cannot delete these predefined components.

Proficiency (within Assessment)  The perceived level of expertise of a person in a competence, in the opinion of the assessor, over a given period. For example, a person may demonstrate the communication competence at Expert level. See also: Performance (within Assessment), Competence, Assessment

Proficiency Level  A system for expressing and measuring how a competence is exhibited in the work context. See also: Behavioral Indicators.

Progression Point  A pay scale is calibrated in progression points, which form a sequence for the progression of employees up the pay scale. See also: Pay Scale
Qualification Type  An identified qualification method of achieving proficiency in a competence, such as an award, educational qualification, a license or a test. See: Competence

Qualifying Days  Days on which Statutory Sick Pay (SSP) can be paid, and the only days that count as waiting days. Qualifying days are normally work days, but other days may be agreed.

Qualifying Pattern  See: SSP Qualifying Pattern

Qualifying Week  The week during pregnancy that is used as the basis for the qualifying rules for Statutory Maternity Pay (SMP). The date of the qualifying week is fifteen weeks before the expected week of confinement and an employee must have been continuously employed for at least 26 weeks continuing into the qualifying week to be entitled to SMP.

QuickCode Types  Categories of information, such as nationality, address type and tax type, that have a limited list of valid values. You can define your own QuickCode Types, and you can add values to some predefined QuickCode Types.

QuickPaint Report  A method of reporting on employee and applicant assignment information. You can select items of information, paint them on a report layout, add explanatory text, and save the report definition to run whenever you want. See also: Assignment Set

Rating Scale  Used to describe an enterprise’s competencies in a general way. You do not hold the proficiency level at the competence level. See also: Proficiency Level

Recruitment Activity  An event or program to attract applications for employment. Newspaper advertisements, career fairs and recruitment evenings are all examples of recruitment activities. You can group several recruitment activities together within an overall activity.

Recurring Elements  Elements that process regularly at a predefined frequency. Recurring element entries exist from the time you create them until you delete them, or the employee ceases to be eligible for the element. Recurring elements can have standard links. See also: Nonrecurring Elements, Standard Link

Region  A collection of logically related fields in a window, set apart from other fields by a rectangular box or a horizontal line across the window. See also: Block, Field

Report Parameters  Inputs you make when submitting a report to control the sorting, formatting, selection, and summarizing of information in the report.

Report Security Group  A list of reports and processes that can be submitted by holders of a particular responsibility. See also: Responsibility

Report Set  A group of reports and concurrent processes that you specify to run together.

Requisition  The statement of a requirement for a vacancy or group of vacancies.

Rates  A set of values for employee grades or progression points. For example, you can define salary rates and overtime rates.
Responsibility  A level of authority in an application. Each responsibility lets you access a specific set of Oracle Applications forms, menus, reports, and data to fulfill your business role. Several users can share a responsibility, and a single user can have multiple responsibilities. See also: Security Profile, User Profile Options, Report Security Group

Retry  Method of correcting a payroll run or other process before any post–run processing takes place. The original run results are deleted and the process is run again.

Reversal  Method of correcting payroll runs or QuickPay runs after post–run processing has taken place. The system replaces positive run result values with negative ones, and negative run result values with positive ones. Both old and new values remain on the database.

Rollback  Method of removing a payroll run or other process before any post–run processing takes place. All assignments and run results are deleted.

S

Salary Basis  The period of time for which an employee’s salary is quoted, such as hourly or annually. Defines a group of employees assigned to the same salary basis and receiving the same salary element.

Security Profile  Security profiles control access to organizations, positions and employee and applicant records within the Business Group. System administrators use them in defining users’ responsibilities. See also: Responsibility, User Profile Options

SMP  See: Statutory Maternity Pay

Special Information Types  Categories of personal information, such as skills, that you define in the Personal Analysis key flexfield.

SSP  See: Statutory Sick Pay

SSP Qualifying Pattern  An SSP qualifying pattern is a series of qualifying days that may be repeated weekly, monthly or some other frequency. Each week in a pattern must include at least one qualifying day. Qualifying days are the only days for which Statutory Sick Pay (SSP) can be paid, and you define SSP qualifying patterns for all the employees in your organization so that their entitlement to SSP can be calculated.

Standard Link  Recurring elements with standard links have their element entries automatically created for all employees whose assignment components match the link. See also: Element Link, Recurring Elements

Statutory Maternity Pay  You pay Statutory Maternity Pay (SMP) to female employees who take time off work to have a baby, providing they meet the statutory requirements set out in the legislation for SMP.

Statutory Sick Pay  You pay Statutory Sick Pay (SSP) to employees who are off work for four or more days because they are sick, providing they meet the statutory requirements set out in the legislation for SSP.
**T**

**Task Flows** A sequence of windows linked by buttons to take you through the steps required to complete a task, such as hiring a new recruit. System administrators can create task flows to meet the needs of groups of users.

**Terminating Employees** You terminate an employee when he or she leaves your organization. Information about the employee remains on the system but all current assignments are ended.

**Termination Rule** Specifies when entries of an element should close down for an employee who leaves your enterprise. You can define that entries end on the employee’s actual termination date or remain open until a final processing date.

**V**

**Waiting Days** Statutory Sick Pay is not payable for the first three qualifying days in period of incapacity for work (PIW), which are called waiting days. They are not necessarily the same as the first three days of sickness, as waiting days can be carried forward from a previous PIW if the linking interval between the two PIWs is less than 56 days.

**Work Choices** Also known as Deployment or Work Factors. These can affect a person’s capacity to be deployed within an enterprise, such willingness to travel or relocate. You can hold work choices at both job and position, or at person level.

**Work Structures** The fundamental definitions of organizations, jobs, positions, grades, payrolls and other employee groups within your enterprise that provide the framework for defining the work assignments of your employees.

**User Profile Options** Features that allow system administrators and users to tailor Oracle HRMS to their exact requirements. See also: *Responsibility, Security Profile*
Index

A
Absence categories, for absence types, 10 – 2 to 10 – 4
Absence elements
  balances for, 10 – 5 to 10 – 7
  definition and linking of, 10 – 9 to 10 – 10
Absence types
  database items, C – 26
  definition of, 10 – 11 to 10 – 15
  listing by, 10 – 16
ABSENCECATEGORY, 10 – 8, 10 – 11
ABSENCE_REASON, 10 – 8, 10 – 11
Absences
  authorization of and replacements for, 10 – 7
  batch entry of, 10 – 30
  defining and linking elements for, 10 – 9
  defining types of, 10 – 11 to 10 – 15
  elements for, 10 – 4 to 10 – 7
  employee’s history of, 10 – 15
  initializing balances for, 10 – 6
  recording of, 10 – 7, 10 – 13 to 10 – 14
  referencing in payroll runs, 10 – 6
  relief position, 3 – 11
  reporting for, 10 – 17
  reviewing, 10 – 15 to 10 – 17
  setup for recording, 10 – 8 to 10 – 12
  types, categories and reasons, 10 – 2 to 10 – 4
Accrual plans. See PTO accrual plans
Additional element entries, 12 – 27, 12 – 45
  and payroll run reversals, 17 – 13
Address styles, B – 9
ADDRESS_TYPE, 9 – 10
Addresses
  floor or office numbers, 11 – 9
  for people, 9 – 10
  for work sites, 2 – 2 to 2 – 3
Adjustments, for Pay Values, 12 – 46
Advance Pay process, 17 – 37
Applicant assignment statuses
  reporting on, 11 – 29
  user statuses for, 8 – 7
Applicant Details Report, 9 – 29
Applicant information, 9 – 6
Applicant number, 9 – 5
Applicants, listing, 9 – 3
Application Data Export, 21 – 5
Arrestments
  closing, 16 – 16
  conjoined, 16 – 7
  current maintenance, 16 – 7
  earnings, 16 – 7
  elements and balances, 16 – 9 to 16 – 11
  entering, 16 – 14 to 16 – 20
  legislation, 16 – 2
  viewing, 16 – 19
Assignment Details Report, 9 – 29
Assignment processes
retrying and rolling back, 17 – 55 to 17 – 57
viewing, 17 – 55 to 17 – 57
viewing messages, 17 – 58
Assignment reporting
Assignment Status Report, 11 – 29
Assignments Folder, 11 – 22
Assignment sets, 17 – 2, 18 – 15
and consolidation sets, 17 – 18
Assignments
for employees, 11 – 4
verifying for a mass move, 3 – 32
Attachments, 21 – 6
Audit groups, 24 – 2
AuditTrail, 24 – 2
setting up audit groups, 24 – 2

B
Background check information, 9 – 7
BACS, setting processing date, 5 – 6
BACS process, 17 – 26 to 17 – 28
BACS tape, creating, 17 – 28
Balance dimensions, 13 – 5
Balance feeds, 13 – 2
Balances
adjusting, 13 – 11
balance categories, 13 – 2
defining, 13 – 8
dimensions, 13 – 5
for NI class 1a, 15 – 48
overview, 13 – 2
predefined, 15 – 5, 15 – 21
Balancing qualifier, 6 – 4
Bank account information, B – 11
Bank information, for BACS payment
methods, 11 – 20
Base currency, 22 – 7
Batch entry using MIX, 12 – 50
BEE, procedures for, 12 – 51
Blood type, entry of, 9 – 7
Budget value defaults, 2 – 16
BUDGET_MEASUREMENT_TYPE, 2 – 16

Budgets
for salaries, 14 – 18 to 14 – 19
in centralized management enterprises, 14 – 19
in devolved management enterprises, 14 – 19
in project based enterprises, 7 – 5
in rule based enterprises, 7 – 8, 14 – 18
Business Groups, 2 – 4 to 2 – 5
additional information for, 2 – 12
defaults for, 2 – 16
defining, 2 – 10 to 2 – 13
startup data, 2 – 5

C
Calendars
for employee absences, 10 – 7
for payrolls, 5 – 8
for PTO accrual plans, 10 – 18
Cash process, 17 – 29
Cheque Writer process, 17 – 23
College attendances, 9 – 15
Comments, 21 – 6
Company car, employer’s contributions, 15 – 45 to 15 – 53
Comparatio values for grades, 4 – 10
Compensation and benefits
costing, 12 – 19
eligibility for, 12 – 16 to 12 – 19
entering, 12 – 11, 12 – 42 to 12 – 47
history, 12 – 61
inquiries, 12 – 59
planning, 12 – 41
qualifying conditions, 12 – 17, 12 – 25
relating grades to, 4 – 3, 4 – 6
salary administration, 14 – 2 to 14 – 17
steps to setting up, 12 – 21 to 12 – 23
tracking changes, 12 – 40 to 12 – 41
Competence profile, copying competencies, 9 – 15
Competence profiles, 9 – 15
Competencies, copying, competence profile, 9 – 15
Concurrent managers, 18 – 5
Consolidation sets, 17 – 17
   changing, 17 – 18 to 17 – 20
   defining and deleting, 17 – 18 to 17 – 20
CONTACT, 9 – 13
Contacts, 8 – 2, 9 – 13
Contract staff, 7 – 12
CONTROL_TYPE, 12 – 51
Copying competencies, competence profile, 9 – 15
Cost Allocation key flexfield, 6 – 3, B – 4
   mapping segments to GL, 6 – 6
Cost centers, 6 – 5
   for organizations, 2 – 7
Costing
   accumulating cost figures, 6 – 2
   for assignments, 6 – 5, 12 – 45
   for elements, 6 – 4, 12 – 19, 12 – 36
   for organizations, 2 – 20, 6 – 5
   for payrolls, 5 – 7
   salary budgeting, 14 – 18 to 14 – 19
Costing information, for projects, 7 – 4
Costing process, 17 – 31
Country–specific features
   address styles, B – 9
   in key flexfields, B – 10
Court orders
   AEOs, 16 – 3
   community charge, 16 – 5
   council tax, 16 – 5
   deduction from earnings, 16 – 6
   elements and balances, 16 – 9 to 16 – 11
   entering, 16 – 11 to 16 – 20
   legislation, 16 – 2
   priority and non–priority, 16 – 4
   processing priority, 16 – 8
   viewing, 16 – 19
Currencies
   enabling, 22 – 7
   of element entries, 12 – 25
Current and Projected Progression Point
   Values Report, 4 – 19
Customizing
   Element Entries window, 12 – 39
   List People by Special Information window, 9 – 26
   menu structures, 19 – 18 to 19 – 20
   People Folder window, 9 – 3
   People window, 9 – 4
   QuickPaint Report window, 18 – 14
   Special Information window, 9 – 24
   Table Values window, 20 – 13
   windows, 19 – 2, 19 – 3 to 19 – 9

D

Database items
   from element input values, 12 – 28
   in QuickPaint reports, 18 – 11
   list of dynamic items, C – 19
   list of static items, C – 2
DateTrack, 1 – 11, 1 – 13 to 1 – 21
   changing datetracked information, 1 – 16 to 1 – 17
   Date Security user profile option, 1 – 13
   deleting datetracked information, 1 – 18
   Reminder user profile option, 1 – 14
DateTrack History, 1 – 15
DateTrack:Date Security, 22 – 6
DateTrack:Reminder, 22 – 6
Define Rate form, modes, 19 – 22
Dependents, 9 – 13
Descriptive flexfields
   creating database items, B – 6
   defining segments of, 19 – 2 to 19 – 4
   explained, 19 – 2, B – 5
   for address styles, B – 9
   list of user definable, B – 6 to B – 9
   protected, B – 10
Dimensions (of balances), 13 – 5
Directors
   NIC for, 15 – 37 to 15 – 44
   paying employer’s NIC on account, 15 – 42
   paying NIC on account, 15 – 41
   updating employment status, 15 – 41
   viewing processing results, 15 – 44
Disability leave, 8 – 7
Distribution sets, 17 – 3, 19 – 6
Double entry accounting, 6 – 4

E

Education leave, 8 – 7
Effective dates, 1 – 11, 1 – 13
ELE_ENTRY_REASON, 12 – 45
Element classifications, 12 – 4
  balance feeds, 12 – 4
  defining secondary, 12 – 8 to 12 – 20
  predefined secondary, 12 – 10
  primary, 12 – 6 to 12 – 7
Element entries, 12 – 42 to 12 – 47
  additional, 12 – 27, 12 – 45
  arrestments, 16 – 14 to 16 – 20
  automatic, 12 – 18, 12 – 43
  batch, 12 – 50
  court order, 16 – 11 to 16 – 20
  customizing Element Entries window, 12 – 39
  defaults for different groups, 12 – 17
  for NI class 1a, 15 – 50
  history, 12 – 61
  hot defaults, 12 – 28, 12 – 45
  multiple, 12 – 24, 12 – 27
  nonrecurring, 12 – 43
  overrides, 12 – 45
  recurring, 12 – 43
  skip rules, 12 – 20
  validation, 12 – 14, 12 – 22
Element Link Details Report, 12 – 38
Element links
costing, 6 – 4
defining, 12 – 35 to 12 – 38
maintaining, 12 – 40
reporting on, 12 – 38
standard, 12 – 18, 12 – 25
using, 12 – 16 to 12 – 19
Element sets, 17 – 3, 19 – 6
Elements, 1 – 5
  and run results, 12 – 3
data entry rules for, 12 – 3
database items, C – 19
defining, 12 – 22 to 12 – 26
defining, for absence types, 10 – 9 to 10 – 11
  eligibility rules, 12 – 16 to 12 – 19
  entering, 12 – 11 to 12 – 17, 12 – 44 to 12 – 47
  examples of, 12 – 2
  for salaries, 14 – 5
  formula result rules, 12 – 32
  generated, for PTO accrual plans, 10 – 18 to 10 – 19
  input values for, 12 – 13 to 12 – 17, 12 – 28 to 12 – 29
  maintaining, 12 – 40
  nonrecurring, 5 – 2
  qualifying conditions, 12 – 17, 12 – 25, 12 – 37
Email ID information, entry of, 9 – 6
EMP_ASSIGN_REASON, 11 – 9
Employee assignment number, 11 – 9
Employee assignment statuses, 8 – 5 to 8 – 6
  and payroll processing, 8 – 5
  element entries valid for, 8 – 5
  reporting on, 11 – 29
  secondary statuses, 8 – 6
Employee assignments, 1 – 4
  allocation of costs for, 11 – 6
  and work structures, 11 – 4 to 11 – 17
  changes to, and DateTrack, 11 – 11
  components of, 11 – 5
  defining as primary, 11 – 9
  definition, 11 – 4
  ending all, 11 – 14 to 11 – 15
  ending one of multiple, 11 – 13
  entering, 11 – 8 to 11 – 10
  history, 11 – 32
  inquiring and reporting on, 11 – 22 to 11 – 32
  manager–level, 11 – 9
  multiple, 15 – 23
  numbers for, 11 – 6
  payment methods for, 11 – 19 to 11 – 21
  position based, 7 – 6
  primary assignments, 11 – 5
  project based, 7 – 2 to 7 – 6
  using multiple assignments, 11 – 5
Employee groups, 5 – 10
Employee Increment Results Report, 4 – 19
Employee lists
  by absence type, 10 – 16
  by assignment components, 11 – 22
by assignment statuses, 11 – 29
by organization, 11 – 25
by personal information, 9 – 3
by position, 11 – 27
by position hierarchy, 11 – 28
by special information type, 9 – 26
Employee numbers, 9 – 5, 11 – 6
Employee Organization Movements Report, 11 – 30
Employee Payroll Movements Report, 11 – 30
Employee Summary Report, 11 – 30
Employment
hiring, 9 – 8
history, 11 – 32
Employment categories
adding new, 11 – 5
assigning employees to, 11 – 9
full time and part time, 11 – 5
in startup data, 11 – 5
Employment information
making changes to, 11 – 3
table of, 11 – 2
updating an employee to director, 15 – 40
End assignment status, 8 – 5, 11 – 13
End Dates, removing, 1 – 18
End of Year process, 15 – 10
accuracy requirements, 15 – 12
P35 listing, 15 – 10
printing details, 15 – 12
writing magnetic report to tape, 15 – 13
EVAL_SYSTEM, 3 – 13
EVAL_SYSTEM_MEAS, 3 – 13
Evaluation systems, 3 – 13
Exchange rates, defining, 17 – 3
External organizations, 2 – 6, 2 – 7

F
Folders, 18 – 3 to 18 – 9
FORM_MODE, 19 – 22
Formulas
for validation, 8 – 4, 12 – 29
formula result rules, 12 – 32
FREQUENCY, 2 – 19
Full Personal Details Report Set, 9 – 29
Further name information, 9 – 7

G
GAYE, 12 – 6
General Ledger, 6 – 4
Generate Secure User process, 23 – 15
Grade Name key flexfield, 4 – 2, B – 3
Grade rates, 4 – 8 to 4 – 10
for salary proposal validation, 14 – 7
Grade scales, 4 – 12
Grade steps, 4 – 15
incrementing placements, 4 – 18
placing employees on, 4 – 17
Grades, 4 – 2 to 4 – 5
assigning an employee to, 11 – 8
comparatio values, 4 – 10
defining, 4 – 4 to 4 – 6
relating to progression points, 4 – 15
valid grades for jobs and positions, 3 – 15, 4 – 3
Grant Permissions To Roles process, 23 – 15
Graphics, 9 – 13

H
Health and safety requirements, for jobs or positions, 3 – 6
Hiring people, 9 – 8
History
of assignments, 11 – 32
of element entries, 12 – 61
Honors, entry of, 9 – 7
Hot defaults, of element entries, 12 – 28, 12 – 45
Hours of work, 11 – 9
entering defaults for, 2 – 5, 2 – 19
HR Organizations, additional information for, 2 – 13
HR User Type, 12 – 22, 21 – 3
HR:Business Group, 22 – 5
HR:Query Only Mode, 22 – 5
HR:Security Profile, 22 – 5
HR:Use Standard Attachments, 22 – 5
HR:User Type, 22 – 5
HR_CUSTOMIZATION, 19 – 22

Human resource management
- evaluating jobs and positions, 3 – 13 to 3 – 16
- salary administration and performance reviews, 14 – 2 to 14 – 17

I
Implementation of HRMS
- in hybrid enterprise structures, 7 – 10 to 7 – 12
- in project based enterprises, 7 – 2 to 7 – 6
- in rule based enterprises, 7 – 6 to 7 – 13

Increment Progression Points process, 4 – 18
Input values, 12 – 13, 12 – 28, 12 – 37
Inquiry windows, list of, 18 – 3
Insurance carriers, defining, 2 – 11
International relocation, employee preferences, 9 – 19

J
Job codes, 3 – 5
Job Name key flexfield, 3 – 5, B – 3
Jobs
- assigning an employee to, 11 – 9
- contrasted with positions, 3 – 2
- defining, 3 – 8
- entering valid grades, 3 – 15
- evaluating, 3 – 13
- in project based enterprises, 7 – 4
- representing jobs and positions, 3 – 2 to 3 – 7
- skill requirements of, 3 – 16
- work choices, 3 – 17

K
Key flexfields, 1 – 19
Bank Details, B – 11

Cost Allocation, 6 – 3
creating database items, B – 4
for country-specific information, B – 10 to B – 12
Grade Name, 4 – 2
Job Name, 3 – 5
People Group, 5 – 10
Personal Analysis, 8 – 10
Position Name, 3 – 5
protected, B – 10
setting up, B – 3
Soft Coded Legislation, B – 11
uses of, B – 2

L
Legislation Code, 2 – 15
Length of service bands
- for PTO accrual plans, 10 – 21
- setup of, 10 – 25 to 10 – 26
Links
- defining, 12 – 35 to 12 – 38
- maintaining, 12 – 40
- reporting on, 12 – 38
- standard, 12 – 18, 12 – 25
- using, 12 – 16 to 12 – 19
LISTGEN, 23 – 15
Location, entering for an office, 9 – 7
Locations, 2 – 2 to 2 – 3
- assigning an employee to, 11 – 8
Lookups, 12 – 29, 20 – 2

M
Mail location information, entry of, 9 – 6
Mailstop, entry of, 9 – 6, 9 – 8
Manager-level assignments, 11 – 25
Managing change, 1 – 11
Manual payments, recording details, 17 – 64
Marital Status information, entry of, 9 – 6
Mass Information Exchange (MIX), 12 – 50
Mass Move, 3 – 26
- deleting, 3 – 37
Index – 7

---

describing, 3 – 28
executing, 3 – 35
making decisions for, 3 – 27
managing your collection of, 3 – 37
preparing for, 3 – 27 to 3 – 29
prerequisites for, 3 – 27 to 3 – 29
reviewing the results of, 3 – 35
status of, 3 – 35
summary of tasks, 3 – 28
Maternity leave, 8 – 7
Matrix management, hierarchies for, 2 – 24
Medical information, 8 – 10, 9 – 7, 9 – 24
Menu Structures Report, 19 – 19
Menus
default menu paths, A – 1
defining, 19 – 18 to 19 – 23
for security, 23 – 2, 23 – 8
query–only access, 19 – 21
Messages, payroll run, 17 – 58
Military leave, 8 – 7
MIX, 12 – 50
Monetary units, assigning to a currency, 17 – 29
Multiple assignments
aggregating earnings for NIC, 15 – 23
priority of processing, 15 – 24
sequencing payroll runs, 15 – 25
Multiple element entries, 12 – 24, 12 – 27

---

N

Name, entry of additional name information for an employee, 9 – 7
Net Accrual Calculation, 10 – 26 to 10 – 27
NI car elements, 15 – 46 to 15 – 54
entering, 15 – 50
updating, 15 – 51
viewing run results, 15 – 52
NIC
age and pension factors, 15 – 19
and Oracle Payroll, 15 – 21 to 15 – 31
arrears, 15 – 20
category codes, 15 – 17
class 1a, 15 – 45 to 15 – 53
correcting category code entries, 15 – 34 to 15 – 35
earnings periods, 15 – 19
entering details, 15 – 29 to 15 – 31
for directors, 15 – 37 to 15 – 44
legislative details, 15 – 17 to 15 – 31
lower earnings limit, 15 – 18
multiple assignments, 15 – 23
overriding system, 15 – 36
upper earnings limit, 15 – 18
viewing class 1a run results, 15 – 52
what is NIable, 15 – 18
NIC holiday, 15 – 32
setting up the NIC Holiday element, 15 – 33
Nonrecurring elements, 5 – 2, 12 – 11
and payroll run reversals, 17 – 13
entering, 12 – 43

O

Office location, entry of, 9 – 6
Office number, entry of, 9 – 6, 9 – 7
Oracle General Ledger, 6 – 4
Oracle Human Resources
using with Oracle Payroll, 21 – 2 to 21 – 5
using with spreadsheets, 21 – 5
ORACLE IDs, 23 – 11
Oracle Payroll, 21 – 2
and contractual information, 1 – 8 to 1 – 10
overview, 1 – 4 to 1 – 10
ORG_TYPE, 2 – 6
Organization hierarchies, 2 – 23 to 2 – 30
adding to, 2 – 20 to 2 – 22
creating, 2 – 26 to 2 – 30
for matrix management, 2 – 24
in security profiles, 23 – 5
versions of, 2 – 25
Organization Hierarchy Report, 2 – 29
Organizations, 2 – 6 to 2 – 7
adding to hierarchies, 2 – 13, 2 – 20
additional information for, 2 – 12
assigning an employee to, 11 – 8
classifications for, 2 – 11
cost centers for, 2 – 7
defining, 2 – 10 to 2 – 13
deleting, 2 – 22
entering site addresses for, 2 – 2
external, 2 – 7
in project based enterprises, 7 – 3
levels of internal, 2 – 6
listing employees assigned to, 11 – 25
used with position control, 3 – 4
Other information, entering for an employee, 9 – 7
Overrides for element entries, 12 – 45

P
Parent organizations, 2 – 20
Part time employment category, 11 – 6
Paternity leave, 8 – 7
Pay periods, 12 – 43
    selecting, 5 – 6
Pay scales, 4 – 12
    defining, 4 – 13
    defining rates for, 4 – 14
Pay value, 12 – 14, 12 – 28
    adjusting, 12 – 46
PAYE
    and Oracle Payroll, 15 – 5 to 15 – 31
    balances, 15 – 5
    entering details, 15 – 27 to 15 – 31
    how HRMS processes, 15 – 4
    legislative details, 15 – 2 to 15 – 31
    validating tax codes, 15 – 28
Payee organization, defining, 2 – 12
Payment methods
    for a payroll, 5 – 8
    for employee assignments, 11 – 19 to 11 – 21
    for the enterprise, 5 – 3
Payroll code number, 11 – 7
Payroll information, security of, 1 – 6
Payroll management, integrating with human resource management, 1 – 3
Payroll process information, 17 – 51
Payroll processes
    Advance Pay, 17 – 37
    and run sets, 17 – 60
    BACS, 17 – 26 to 17 – 28
    Cash, 17 – 29
    Cheque Writer, 17 – 23
    Costing, 17 – 31
    End of Year, 15 – 10
    Pre-payments, 17 – 20
    reports, 17 – 60
    RetroPay, 17 – 34 to 17 – 36
    retrying or rolling back, 17 – 52 to 17 – 66
    Start of Year, 15 – 6
    Transfer to GL, 17 – 32
    viewing, 17 – 52 to 17 – 66
    viewing messages, 17 – 58
Payroll processing, 1 – 5
Payroll runs
    element sets, 17 – 3
    retries, 17 – 10 to 17 – 12
    reversals, 17 – 12
    reversing, 17 – 12 to 17 – 14
    rollbacks, 17 – 14
    skip rules, 12 – 20
    standard and QuickPay, 17 – 2
    starting standard runs, 17 – 5
    viewing run result histories, 17 – 59
Payrolls
    assigning employees to, 11 – 8
    defining, 5 – 5 to 5 – 10
    deleting, 5 – 9
    in security profiles, 23 – 7
    using in HRMS, 5 – 2
Pension groups, 5 – 10
People folders, 9 – 3
People Group key flexfield, B – 3
    setting up, 5 – 10
People groups, assigning employees to, 11 – 9
Performance reviews, and salary proposals, 14 – 9 to 14 – 11
Period of service, 11 – 32
Person Details Report, 9 – 29
Person types, 8 – 2 to 8 – 4
Personal Analysis key flexfield, 8 – 10, B – 4
Personal information
    deleting, 9 – 30
    entering, 9 – 4
    entering special information, 9 – 24
    inquiring and reporting on, 9 – 3, 9 – 29
    office location, mailstop, 9 – 6
    tracking roles and activities, 9 – 28
Physician’s name, entry of, 9 – 7
Pictures, 9 – 13
PLACEMENT_REASON, 4 – 17
Position hierarchies, 3 – 3
  adding a new position, 3 – 11
  creating, 3 – 22 to 3 – 37
  creating new versions, 3 – 23
  in security profiles, 23 – 6
Position Hierarchy Report, 3 – 25
Position Name key flexfield, 3 – 5, B – 3
Positions
  assigning an employee to, 11 – 9
  contrasted with jobs, 3 – 2
  defining, 3 – 10 to 3 – 13
  entering valid grades, 3 – 15
  evaluating, 3 – 13
  in rule based enterprises, 7 – 6
  listing employees assigned to, 11 – 27
  representing jobs and positions, 3 – 2 to 3 – 7
  salary budgets, 14 – 18
  skill requirements of, 3 – 16
  source, 3 – 29
  target, 3 – 31
  viewing occupancy, 3 – 20
  work choices, 3 – 17
Post–run processes, 1 – 6, 17 – 17
Pre–payments process, 17 – 20
Predefined elements
  for NI class 1a, 15 – 46 to 15 – 54
  NIC Holiday, 15 – 33
Prefix information, entry of, 9 – 5
Primary assignment statuses, for employees, 8 – 5, 11 – 5 to 11 – 6
Primary reporting hierarchy, 2 – 23
Probation period, 3 – 10, 3 – 11
  entering on assignments, 11 – 9
Processes
  Create Descriptive Flexfield DB Items, B – 6, C – 23
  Create Key Flexfield DB Items, B – 4, C – 25
  Generate Secure User, 23 – 15
  Grant Permissions To Roles, 23 – 15
  PTO Carry Over, 10 – 21 to 10 – 22, 10 – 30
  Security List Maintenance, 23 – 15
  security of, 23 – 9
Processing type, 12 – 23
Progression points
  defining, 4 – 13
  entering special ceiling for, 11 – 9
  relating to grades, 4 – 15
Project based enterprises, 7 – 2 to 7 – 6
Promotions, recording information about, 11 – 4 to 11 – 6, 11 – 11
PROPOSAL_REASON, 14 – 4
PTO (paid time off)
  calculation of net accrued, 10 – 27
  carry over process for, 10 – 30 to 10 – 34
  manual or batch entry of time taken, 10 – 30
  residual and carried over, 10 – 21 to 10 – 22
  review of net time accrued, 10 – 32 to 10 – 34
  sale or purchase of, 10 – 22, 10 – 30
PTO accrual plans
  elements for, 10 – 18 to 10 – 19
  enrollment in, 10 – 29
  length of service factors, 10 – 21 to 10 – 23
  maintenance of, 10 – 29
  operation and structure of, 10 – 18 to 10 – 22
  period of ineligibility under, 10 – 19
  setup steps for, 10 – 23 to 10 – 28
  start rule options for, 10 – 19 to 10 – 20
Public sector, implementation in, 7 – 6 to 7 – 13, 14 – 18
Purge, 1 – 18

Q
Qualifications, 9 – 15
Qualifiers, for flexfield segments, 6 – 3
QUALIFYING_UNITS, 3 – 10
Query–only access to windows, 19 – 21
QuickCodes
  access levels, 20 – 2
  creating QuickCode values, 20 – 3
  defining QuickCode types, 20 – 5
  list of predefined types, 20 – 6 to 20 – 8
removing QuickCode values, 20 – 4
QuickPaint reports, 18 – 9
customizing, 18 – 14
defining, 18 – 10 to 18 – 12
running, 18 – 13 to 18 – 14
QuickPay, 17 – 61 to 17 – 66
running post–run processes, 17 – 63 to 17 – 66

R

Rates
for grades, 4 – 8
for pay scales, 4 – 14
Re–hiring an employee, 9 – 8
Recurring elements, 12 – 11
  entering, 12 – 43
Reference information, for a rehire applicant, 9 – 7
Rehire information, 9 – 7
Relief position, to cover absence, 3 – 11
Relocation, employee preferences, 9 – 15
Reorganizing, positions and assignments, 3 – 26
Reporting lines, 2 – 24, 3 – 3, 3 – 22
Reporting users, 23 – 8
Reports
  Absences, 10 – 17
  Assignment Status, 11 – 29
  Assignments Unavailable for Processing Listing, 17 – 8
  Costing Breakdown for Costing Run, 17 – 32
  Costing Breakdown for Date Range, 17 – 32
  Current and Projected Progression Point Values, 4 – 19
defining, 18 – 7
  Element Link Details, 12 – 38
  Element Result Listing, 12 – 61
  Employee Increment Results, 4 – 19
  Employee Organization Movements, 11 – 30
  Employee Payroll Movements, 11 – 30
  Employee Summary, 11 – 30
  Full Personal Details, 9 – 29
  Gross to Net, 17 – 7
  list of, 18 – 5 to 18 – 7
  Menu Structure, 19 – 19
  Multiple Assignments, 15 – 10, 15 – 26
  NI Car Detail, 15 – 53
  Organization Hierarchy, 2 – 29
  P35 Listing, 15 – 10
  P60, 15 – 10
  Pay Advice, 17 – 21
  Pay Advice Alignment, 17 – 22
  Payments Summary, 17 – 7
  Payroll Statutory Calendar, 17 – 8
  Position Hierarchy, 3 – 25
  QuickPaint, 18 – 10 to 18 – 18
  Salary Review, 14 – 17
  security of, 23 – 9
  Start of Year: Unprocessed P9 Records, 15 – 8
  Tax Payments Listing, 15 – 31
  Terminations, 11 – 16
  Reports and inquiries, 1 – 6
  Responsibilities, 19 – 18, 23 – 2
defining, 23 – 11
Restricting access to records
  by menu structures, 19 – 18, 23 – 8
  by organization hierarchy, 23 – 5
  by payroll, 23 – 7
  by position hierarchy, 23 – 6
  by Responsibilities, 23 – 2 to 23 – 4
  by security profiles, 23 – 4
  from other tools, 23 – 8
Resumes, entry of status information on, 9 – 6
Retries
  other processes, 17 – 16
  payroll runs, 17 – 10 to 17 – 12
RetroPay process, 17 – 34 to 17 – 36
Reversals, 17 – 12 to 17 – 14
Reviews
  of employee performance, 11 – 10, 14 – 2 to 14 – 17
  of salaries, 11 – 10
ROLEGEN, 23 – 15
Rollbacks
  other processes, 17 – 16
  payroll runs, 17 – 14
Rule based enterprises, 7 – 6 to 7 – 13
budgeting, 14 – 18

S
Salary
  relating to grades, 4 – 3
  reporting on, 14 – 17
  ways to review, 14 – 3 to 14 – 5
Salary administration
  for entry of salaries and wage rates, 14 – 2 to 14 – 17
  setup of, 14 – 4 to 14 – 5
Salary bases, 14 – 4
Salary basis
  assigning an employee to, 11 – 10
  definition of, 14 – 6 to 14 – 7
  for salary administration, 14 – 2
Salary budgets, 14 – 18 to 14 – 19
Salary proposals, 14 – 2
  approving, 14 – 12
  correcting, 14 – 15
  entry of, 14 – 9, 14 – 11 to 14 – 12
  grade rates for validation of, 14 – 7
Scale rates, 4 – 14
School attendances, 9 – 15
SECGEN, 23 – 15
Secondary assignment statuses, 8 – 6
  adding reasons for, 8 – 6
Secondary statuses
  defining, 8 – 7, 8 – 8
  entering for employees or applicants, 11 – 21
Security, 1 – 6, 23 – 2 to 23 – 9
  creating Oracle IDs, 23 – 11
  enabling currencies, 22 – 7
  list of user profile options, 22 – 5 to 22 – 8
  of reports and processes, 23 – 3, 23 – 9
  restrictions by HR:User Type, 21 – 4
  setting up, 23 – 10 to 23 – 12
  setting user profile options, 22 – 4
Security groups, 23 – 3, 23 – 9
Security List Maintenance process, 23 – 15
Security profiles, 23 – 2, 23 – 4 to 23 – 7
  defining, 23 – 13 to 23 – 15
Skills information, 9 – 24
Skip rules, 12 – 20
Social security number, as employee number, 11 – 6
Soft coded legislation, B – 11
Source positions, identifying, 3 – 29
Special ceiling points, 11 – 9
Special information types
  enabling, 8 – 11
  entering, 9 – 24
  setting up, 8 – 10 to 8 – 12
Spreadsheets, 14 – 19, 21 – 5
SSP and SMP, 10 – 2
Standard element links, 12 – 18, 12 – 25
Standard runs, 17 – 2
Standard work day, 11 – 9
Start of Year process, 15 – 6
Status, of assignments, 8 – 5
Statutory information, entering, 5 – 7
Subsidiaries, as Business Groups, 2 – 4
Succession planning, 3 – 11
Suffix information, entry of, 9 – 5
Supervisor, entering on assignments, 11 – 9
Suspended assignment status, 8 – 5
System administrator, role of in OHR, 22 – 2

T
Tables, user–defined, 20 – 9
  accessing values in, 20 – 9
  entering values into, 20 – 13
  setting up, 20 – 10 to 20 – 12
Target positions, identifying, 3 – 31 to 3 – 33
Task flows, 19 – 10 to 19 – 17
  adding to a menu, 19 – 22
  defining nodes, 19 – 14
Tax calendar, 15 – 3
Tax codes, 15 – 2
Tax information, 2 – 18
Temporary cover, 3 – 11
Terminate assignment status, 8 – 5, 11 – 13
Terminating employees
  adding to reasons for, 11 – 14
assignment statuses for, 11 – 15 to 11 – 17
cancelling a termination, 11 – 16
processing pay after, 11 – 15 to 11 – 17
procedure for, 11 – 14 to 11 – 15
processing pay after, 8 – 9
reporting on, 11 – 16 to 11 – 18
Termination, of employees, 11 – 14 to 11 – 15
Termination dates, 11 – 15
Termination rules, 8 – 9, 12 – 23
Terminations Report, 11 – 16
Third party payments
defining a personal payment method, 11 – 20
entering a payments recipient, 9 – 14
overview, 12 – 47 to 12 – 49
payee organizations for, 2 – 12
Title information, entry of, 9 – 5
Training information, 9 – 24
Transfer to GL process, 17 – 32
Transfers or relocations, recording information on, 11 – 4 to 11 – 6, 11 – 11
Turnover, reporting on, 11 – 30 to 11 – 31

U
Union membership, 5 – 10
Union pay scales, 4 – 12
University attendances, 9 – 15
User profile options, 21 – 4, 23 – 3, 23 – 11
User statuses
defining, 8 – 7
for employee assignments, 8 – 7
renaming, 8 – 7
User tables, 20 – 9
Users, creating, 23 – 11

V
Valid grades, 3 – 15
Validation
of element entries, 12 – 14, 12 – 22, 12 – 29
of tax codes, 15 – 28
Views, list of, 18 – 3

W
Windows
Absence Attendance Type, 10 – 11
Absence Detail, 10 – 13
Accrual Bands, 10 – 25
Accrual Plan, 10 – 23
Accruals, 10 – 32 to 10 – 34
Address, 9 – 10
Adjust Balance, 13 – 11
Alter Effective Date, 1 – 14
Assign Monetary Units to a Currency, 17 – 29
Assignment, 11 – 8
Assignment Criteria, 18 – 16
Assignment History, 11 – 32
Assignment Processes, 17 – 55
Assignment Set, 18 – 15
Assignment Statuses, 8 – 7
Assignments Folder, 11 – 22
Balance, 13 – 8
Balance Classifications, 13 – 10
Balance Dimensions, 13 – 10
Balance Feed Control, 12 – 31
Balance Feeds, 12 – 30, 13 – 9
Batch Header, 12 – 51
Batch Lines, 12 – 51
Business Group Information, 2 – 14
Columns, 20 – 11
Competence Profile, 9 – 16
Consolidation Sets, 17 – 18
Costing, 6 – 5
DateTrack History Change Field Summary, 1 – 15
default navigation paths, A – 14
Define Task Flow, 19 – 15
Define Task Flow Nodes, 19 – 14
Delete Person, 9 – 30
Element, 12 – 22, 14 – 5
Element and Distribution Set, 19 – 6
Element Classifications, 12 – 8
Element Entries, 12 – 44
Element Link, 12 – 35
Employee Assignment Processes, 17 – 55
Employee Run Result History, 17 – 59
Entry Values, 12 – 45
Exchange Rates, 17 – 3
dates, 1 – 11, 1 – 12
setup examples, 7 – 1 to 7 – 14

WORKFLOW_NAME, 19 – 22
Reader’s Comment Form

Oracle Payroll™ UK User’s Guide
Part No. A58383–01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this publication. Your input is an important part of the information used for revision.

- Did you find any errors?
- Is the information clearly presented?
- Do you need more information? If so, where?
- Are the examples correct? Do you need more examples?
- What features did you like most about this manual?

If you find any errors or have any other suggestions for improvement, please indicate the topic, chapter, and page number below:

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

Please send your comments to:
Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood City, CA  94065
Phone: (650) 506–7000     Fax: (650) 506–7200

If you would like a reply, please give your name, address, and telephone number below:

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

Thank you for helping us improve our documentation.